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Introduction

I'm really glad that you've chosen this book to learn essential Microsoft Visual Basic 2008
programming skills and techniques. Although we're meeting for the first time in this para-
graph, the chances are that we're not all that different. | work with a computer every day and
| spend a lot of time helping friends and colleagues make their lives better (or at least more
efficient!) with new software and related technologies. Over the years, | have learned dozens
of computer applications, languages, and tools, and | have a knack for weaving them together
to solve real-world business problems. You're probably the same—the go-to tech person

in your office, school, or home—which is why you're now needing to learn, or upgrade to,
Visual Basic 2008—one of the most powerful development tools in use today.

Microsoft Visual Basic 2008 Step by Step is a comprehensive introduction to Visual Basic
programming using the Microsoft Visual Basic 2008 software. I've designed this practical,
hands-on tutorial with a variety of skill levels in mind. The result is that new programmers
can learn software development fundamentals in the context of useful, real-world applica-
tions, and experienced Visual Basic programmers can quickly master the essential tools and
programming techniques offered in the Visual Basic 2008 upgrade.

Complementing this comprehensive approach is the book's structure—4 topically organized
parts, 20 chapters, and 53 step-by-step exercises and sample programs. By using this book,
you'll quickly learn how to create professional-quality Visual Basic 2008 applications for the
Windows operating system and a variety of Web browsers. You'll also have fun!

What Is Visual Basic 2008?

Visual Basic 2008 is a development tool that you can use to build software applications
that perform useful work and look great within a variety of settings. Using Visual Basic
2008, you can create applications for the Windows operating system, the Web, hand-held
devices, and a host of other environments and settings. The most important advantage

of Visual Basic is that it has been designed to increase productivity in your daily development
work—especially if you need to use information in databases or create solutions for the
Internet—but an important additional benefit is that once you become comfortable with
the development environment in Microsoft Visual Studio 2008, you can use the same tools
to write programs for Microsoft Visual C++ 2008, Microsoft Visual C# 2008, Microsoft Visual
Web Developer 2008, and other third-party tools and compilers.

xvii
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Introduction

Visual Basic .NET Versions

So how did we get here, anyway? The first version of Visual Basic .NET (Microsoft Visual
Basic .NET 2002) was released in February 2002. The second release (Microsoft Visual Basic
.NET 2003) was widely available in March 2003. Next came Visual Basic 2005 in late 2005,
and after a long period of development and integration work, Microsoft released Visual
Basic 2008 in early 2008. Visual Basic 2008 is now so tightly integrated with Visual Studio
that it is only available as a component in the Visual Studio 2008 programming suite,
which includes Visual C#, Visual C++, Visual Web Developer, and other Microsoft .NET
development tools.

Visual Studio 2008 is sold in several different product configurations, including Standard
Edition, Professional Edition, Team Suite, and Express Edition. I've written this book to be
compatible with all editions of Visual Basic 2008 and Visual Studio 2008, but especially

with the tools and techniques available in Visual Studio Standard Edition and Visual Studio
Professional Edition. Although Visual Basic 2008 is similar in many ways to Visual Basic 2005,
there are many important differences and improvements, so | recommend that you complete
the exercises in this book using the Visual Basic 2008 software.

Note The Visual Basic 2008 software is not included with this book! The CD distributed with
most versions of this book contains practice files, sample databases, and other useful information
that requires the Visual Basic 2008 software (sold separately) for use.

Upgrading from Microsoft Visual Basic 6.0

Before Visual Basic .NET, of course, the programming world was blessed to have Visual Basic
6, originally released ten years ago in September 1998. Visual Basic 6 was so popular that
many programming enthusiasts continue to use it, especially developers outside of Europe
and North America, where hardware upgrades can be a little harder to come by. (For those
of you Visual Basic 6 users who have written me letters from Africa and Asia, thank you!) In
some respects, | can't blame you—Visual Basic 6 was and is awesome for its ease-of-use and
straightforward programming methods. But, as many of us know now, Visual Basic 6 also
made creating real professional-grade applications a bit of a chore. As a result, | always felt
like | had a speed and size complex when | chatted with friends who wrote about their fast
and tiny-footprint Visual C++ programs. To write really complex Visual Basic 6 applications,

| usually had to jump through a number of hoops.
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Ten years down the road, Visual Basic 2008 makes it much, much easier to write professional-
grade Windows- and Internet-based applications that compete on an equal playing field
with Visual C++, Visual C#, and Java applications. And the beauty of Visual Basic is that it is
much easier to learn than other programming tools. Although there are a few speed bumps,
upgrading from Visual Basic 6 to Visual Basic 2008 is quite straightforward. Visual Studio
2008 offers an upgrade wizard that begins the conversion process for you, and you'll find
that many of the legacy controls, statements, functions, methods, and properties that you've
learned to use are still a part of Visual Basic 2008.

In this book | offer upgrade notes for readers who are upgrading from Visual Basic 6
because | get it: | was once a Visual Basic 6 programmer and | know what it feels like to
upgrade programs to Visual Basic .NET. So as you read this book, you'll see a comment
now and then about how syntax or conceptual paradigms have changed, and how you
can use what you know to become a solid Visual Basic 2008 programmer. And believe
me, you want this qualification on your resumé.

And here's a message for all programmers: | encourage you to assess where your overall
development skills are, and not focus only on the newest features of a programming lan-
guage that you are preparing to learn. Underlying skills, such as working with algorithms,
data structures, object-oriented programming, and debugging skills, will help you to write
better programs. For this reason, it might be just as important for you to fully understand
user-interface design and database management techniques, as it is to learn the newest
switches for a particular feature that you read about in the press. It is here that Visual Basic
6 developers want to assess and take forward all that they know about software develop-
ment. The tools change but the underlying skills often remain the same.

Finding Your Best Starting Point in This Book

This book is designed to help you build skills in a number of essential areas. You can use it if
you're new to programming, switching from another programming language, or upgrading
from Visual Basic 6 or Visual Basic 2005. Use the table on the following page to find your best
starting point in this book.
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If you are
New

To programming

Upgrading

From Visual Basic
.NET 2002, 2003,
or 2005

From Visual
Basic 6

Referencing

This book after
working through
the chapters

Follow these steps

. Install the practice files as described in the section “Installing and Using the

Practice Files” later in this introduction.

. Learn basic skills for using Visual Basic 2008 by working sequentially from

Chapter 1 through Chapter 17.

. Complete Part IV, “Database and Web Programming,” as your level of interest

or experience dictates.

. Install the practice files as described in “Installing and Using the Practice

Files” later in this section.

. Complete Chapters 1 through 4, skim Chapters 5 through 17, and complete

Chapters 18 through 20.

. For a discussion of specific features that have changed in this upgrade, read

Chapters 1,4, 5,7, 8, 13, 18, 19, 20.

. Install the practice files as described in the section “Installing and Using the

Practice Files.”

. Read Chapters 1 through 4 carefully to learn the new features of the Visual

Studio 2008 development environment.

. Pay special attention to comments that | make in several chapters that high-

light significant differences between Visual Basic 6 and Visual Basic 2008.

. Skim Chapters 5 through 13 to review the fundamentals of event-driven

programming, using variables, and writing decision structures. Give special
attention to Chapters 5, 6, 9, and 12.

. Work sequentially from Chapters 14 through 20 to learn the new Visual Basic

2008 features related to user interface design, database programming, and
Web programming.

. Use the index to locate information about specific topics, and use the table

of contents to locate information about general topics.

. Read the Quick Reference at the end of each chapter for a brief review of the

major tasks in the chapter. The Quick Reference topics are listed in the same
order as they're presented in the chapter.
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Visual Studio 2008 System Requirements

You'll need the following hardware and software to complete the exercises in this book:

Windows Vista, or Windows XP with Service Pack 2, or Windows Server 2003 with
Service Pack 1

Microsoft Visual Studio 2008 (Standard Edition, Professional Edition, or Team Suite)

Minimum hardware requirement: 1.6 GHz CPU, 384 MB RAM, 1024x768 display, 5400
RPM hard disk drive

Recommended hardware requirement: 2.2 GHz or higher CPU, 1024 MB or more RAM,
1280x1024 display, 7200 RPM or higher hard disk drive. (For Windows Vista, 2.4 GHz
CPU and 768 MB RAM is recommended.)

1.22 GB of available hard disk space for the minimum installation; 2 GB of available disk
space for the full installation

CD or DVD drive

Microsoft Mouse or compatible pointing device

Note This book and the practice files were tested using Visual Studio 2008 Standard Edition and
Professional Edition on Windows Vista. You might notice a few differences if you're using other
editions of Visual Studio 2008. In particular, if you're using Visual Studio 2008 Express Edition, a
few features will be unavailable to you. In addition, all of the screen shots in this book were cap-
tured using Windows Vista. If you are using Windows XP or Windows Server 2003, you'll notice a
few differences in some of the screen shots.

Prerelease Software

This book was reviewed and tested against the Beta 2 release of Visual Studio 2008. The
Beta 2 release was the last preview before the final release of Visual Studio 2008. This book is
expected to be fully compatible with the final release of Visual Studio 2008 and Visual Basic
2008. If there are any changes or corrections for this book, they will be collected and added
to an easy-to-access Microsoft Knowledge Base article on the Web. See "Support for This
Book” later in this section.
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Installing and Using the Practice Files

The CD inside this book contains the practice files that you'll use as you perform the exer-
cises in the book. For example, when you're learning how to display database tables on a
form by using the DataGridView control, you'll open one of the practice files—an academic
database named Students.mdb—and then use Visual Studio database programming tools
to access the database. By using the practice files, you won't waste time creating files that
aren't relevant to the exercise. Instead, you can concentrate on learning how to master
Visual Basic 2008 programming techniques. With the files and the step-by-step instructions
in the chapters, you'll also learn by doing, which is an easy and effective way to acquire
and remember new skills.

W Important Before you break the seal on the CD, be sure that this book matches your version
of the software. This book is designed for use with Visual Studio 2008 and the Visual Basic 2008
programming language. To find out what software you're running, you can check the product
package, or you can start the software, open a project, and then click About Microsoft Visual
Studio on the Help menu at the top of the screen.

Installing the Practice Files

Installing the practice files on your hard disk requires approximately 10 MB of disk space.
Follow these steps to install the practice files on your computer’s hard disk drive so that you
can use them with the exercises in this book.

1. Remove the CD from the package inside this book, and insert it into your CD drive.

Note An End-User License Agreement should open automatically. If this agreement does
not appear, you can double-click StartCD.exe on the CD. If you have Windows Vista, click
Computer on the Start menu, double-click the icon for your CD drive, and then double-
click StartCD.exe.

2. Review the End-User License Agreement. If you accept the terms, select the accept
option, and then click Next.

A menu appears with options related to the book.

3. Click Install Practice Files.
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4. Follow the on-screen instructions.

Note For best results when using the practice files with this book, accept the preselected

installation location, which by default is c:\vb08sbs. If you change the installation location,
you'll need to manually adjust the paths in several practice files to locate essential compo-
nents, such as artwork and database files, when you use them.

5. When the files have been installed, remove the CD from your drive and replace it in the
package inside the back cover of your book.

If you accepted the default settings, a folder named c:\vb08sbs has been created on
your hard disk drive, and the practice files have been placed in that folder. You'll find
one folder in c:\\vb08sbs for each chapter in the book. (Some of the files represent
completed projects, and others will require that you enter some program code.) If
you have trouble running any of the practice files, refer to the text in the book that
describes those files.

Using the Practice Files

Each chapter in this book explains when and how to use the practice files for that chapter.
When it's time to use a practice file, the book includes instructions for opening the file. The
chapters are built around scenarios that simulate real programming projects so that you can
easily apply the skills you learn to your own work.

Note Visual Basic 2008 features a new file format for its projects and solutions. Accordingly, you
won't be able to open the practice files for this book if you're using an older version of the Visual
Basic or Visual Studio software. To see what version of Visual Basic or Visual Studio you're using,
click the About command on the Help menu.

Visual Studio is extremely customizable and can be configured to open and save projects
and solutions in different ways. The instructions in this book generally rely on the default
setting for Visual Studio. For more information about how settings within the development
environment affect how you write programs and use the practice files, see the section
“Customizing IDE Settings to Match Step-by-Step Exercises” in Chapter 1, “Exploring the
Visual Studio Integrated Development Environment.”
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For those of you who like to know all the details, here’s a list of the Visual Basic projects
included on the CD. Each project is located in its own folder and has several support files.
Look at all the things you will be doing!

Description

A simple trivia program that welcomes you to the programming course and
displays a digital photo.

Your first program—a game that simulates a Las Vegas Lucky Seven slot machine.

Uses the DateTimePicker control to pick a date.
Demonstrates the CheckBox control and its properties.
A “Hello, world!" program that demonstrates the Label and TextBox controls.

The user interface for a graphical ordering environment, assembled using sev-
eral powerful input controls.

Demonstrates the LinkLabel control that opens a Web browser in your Visual
Basic application.

Demonstrates how to use Visual Studio dialog box controls, toolbars, and
menus.

Advanced use of operators for integer division, remainder division, exponentia-
tion, and string concatenation.

Basic use of operators for addition, subtraction, multiplication, and division.
Uses a constant to hold a fixed mathematical entity.

Demonstrates Visual Basic fundamental data types and their use with
variables.

Demonstrates the .NET Framework classes with mathematical methods.
Receives input with the InputBox function.

Declares and uses variables to store information.

Uses a Select...Case decision structure and a ListBox control to display a
welcome message in several languages.

Uses the If...Then...Else decision structure and a MaskedTextBox control to
manage a logon process.
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Description

Converts temperatures from Fahrenheit to Celsius by using a Do loop.

A simple digital clock program that demonstrates the Timer control.

Demonstrates using a For...Next loop to display text in a TextBox control, and
using the Chr function to create a wrap character.

Uses a global counter variable in an event procedure as an alternative to loops.
This program also displays images by using a PictureBox control.

Demonstrates how to use a Timer control to create a logon program with a
password time-out feature.

Shows how to use the new Insert Snippet command to display the current
version of Windows running on a user’s computer.

A simulated debugging problem, designed to be solved using the Visual Studio
debugging tools.

Crashes when a CD or DVD drive is used incorrectly. This project is used as the
basis of a Visual Basic error handler.

Completed error handler for loading files that demonstrates the Try...Catch
syntax.

A general-purpose Sub procedure that adds items to a list box.

A clean version of the Lucky7 slot machine project from Chapter 2, which
you enhance by using public variables and a function that computes the
game's win rate.

Shows how to create and manipulate large integer arrays.
Demonstrates the Array.Sort and Array.Reverse methods and how to use a
ProgressBar control to give the user visual feedback during long sorts.

Computes the average temperature for any number of days by using a
dynamic array.

Computes the average weekly temperature by using a fixed-length array.

Uses a For Each...Next loop and the Visual Studio Controls collection to move
objects on a form.

Demonstrates a user-defined collection containing a list of Web addresses
(URLSs) recently visited by the user.

continued
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Chapter 16
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Description

A simple note-taking utility that demonstrates the FileOpen function and the
TextBox, MenuStrip, and SaveFileDialog controls.

A text file editor with a menu bar that demonstrates how to manage Open,
Close, Save As, Insert Date, Sort Text, and Exit commands in a program.
Contains a ShellSort module for sorting arrays that can be added to other
programming projects.

Displays the contents of a text file in a Visual Basic program. Demonstrates
menu commands, a Try...Catch error handler, and the FileOpen and Linelnput
functions, and serves as a foundation for the other programs in this chapter.

Demonstrates how controls are added to a Windows Form at run time by using
program code (not the Designer).

Uses the Anchor and Dock properties of a form to align objects at run time.

Uses the StartPosition and DesktopBounds properties to position a Windows
Form at run time. Also demonstrates the FormBorderStyle property, Rectangle
structure, and ShowDialog method.

The enhanced Lucky7 program (TrackWins) from Chapter 10, which you enhance
again through the addition of a second form to display Help information.

Demonstrates a few of the useful graphics methods in the System.Drawing
namespace, including DrawEllipse, FillRectangle, and DrawCurve.

Animates an icon on the form, moving it from the top of the form to the
bottom each time that you click the Move Down button.

Demonstrates how to change the transparency of a form by using the Me
object and the Opacity property.

Simulates zooming in, or magnifying, an object on a form (in this case, the
planet Earth).

Uses the Visual Studio Inheritance Picker to create a form that inherits its
characteristics and functionality from another form.

Demonstrates how to create new classes, properties, and methods in a Visual
Basic project. The new Person class is an employee record with first name, last
name, and date of birth fields, and it contains a method that computes the
current age of an employee.
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Description

Demonstrates how to create Print Preview and Page Setup dialog boxes.

Handles more sophisticated printing tasks, including printing a multipage text
file with wrapping lines. Includes lots of code to use in your own projects.

Prints graphics from within a Visual Basic program by using an error handler,
the Print method, and the Drawimage method.

Demonstrates how simple text is printed in a Visual Basic program.

Demonstrates how ADO.NET is used to establish a connection to a Microsoft
Office Access 2007 database and display information from it.

Shows how the DataGridView control is used to display multiple tables of data
on a form. Also demonstrates how navigation bars, datasets, and table adapters
are interconnected and bound to objects on a form.

Demonstrates using Visual Web Developer and ASP.NET to create a car loan
calculator that runs in a Web browser, offers Help information, and displays
database records.

Uninstalling the Practice Files

Use the following steps to remove the practice files added to your hard disk drive by the
Visual Basic 2008 Step by Step installation program. After uninstalling the practice files, you
can manually delete any Visual Basic project files that you have created on your own, should
you choose to do so.

If you are running the Windows Vista operating system:

1. In Control Panel, in the Programs category, click Uninstall A Program.

2. Select Microsoft Visual Basic 2008 Step by Step in the list of programs, and then click

Uninstall.

3. Follow the on-screen instructions to remove the practice files.

If you are running the Windows XP operating system:

1. In Control Panel, open Add Or Remove Programs.

2. In the Currently Installed Programs list, click Microsoft Visual Basic 2008 Step by Step.
Then click Remove.

3. Follow the on-screen instructions to remove the practice files.
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Conventions and Features in This Book

Before you start the exercises in this book, you can save time by understanding how | provide
instructions and the elements | use to communicate information about Visual Basic program-
ming. The following lists identify stylistic conventions and discuss helpful features of the book.

Conventions

The names of all program elements—controls, objects, methods, functions, properties,
and so on—appear in italic.

Hands-on exercises for you to follow are given in numbered lists of steps (1, 2, and so
on). A round bullet (@) indicates an exercise that has only one step.

Text that you need to type appears in bold.

As you work through steps, you'll occasionally see tables with lists of properties that
you'll set in Visual Studio. Text properties appear within quotes, but you don't need to
type the quotes.

A plus sign (+) between two key names means that you must press those keys at the
same time. For example, "Press Alt+Tab” means that you hold down the Alt key while
you press Tab.

Elements labeled Note, Tip, More Info, or Important provide additional information
or alternative methods for a step. You should read these before continuing with the
exercise.

Other Features

You can learn special programming techniques, background information, or fea-
tures related to the information being discussed by reading the sidebars that appear
throughout the chapters. These sidebars often highlight difficult terminology or sug-
gest future areas for exploration.

You can learn about options or techniques that build on what you learned in a chapter
by trying the One Step Further exercise at the end of that chapter.

You can get a quick reminder of how to perform the tasks you learned by reading the
Quick Reference at the end of a chapter.
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Helpful Support Links

You are invited to check out the following links that provide support for the Visual Studio
2008 software and this book’s contents.

Visual Studio 2008 Software Support

For questions about the Visual Studio 2008 software, | recommend two Microsoft
Web sites:

B http://msdn2.microsoft.com/en-us/vbasic/ (the Microsoft Visual Basic Developer Center
home page)

B http://www.microsoft.com/communities/ (technical communities related to Microsoft
software products and technologies)

Both Web sites give you access to professional Visual Basic developers, Microsoft employees,
Visual Basic blogs, newsgroups, webcasts, technical chats, and interesting user groups. For
additional information about these and other electronic and printed resources, see the
Appendix, “Where To Go for More Information.”

Microsoft Press Web Site

The Microsoft Press Web site has descriptions for the complete line of Microsoft Press
books, information about ordering titles, notice of special features and events, additional
content for Microsoft Press books, and much more.

http://www.microsoft.com/learning/books/

Support for This Book

Every effort has been made to ensure the accuracy of this book and companion content.
Microsoft Press provides corrections for books through the Web at the following address:

http.//www.microsoft.com/mspress/support/search.aspx
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To connect directly to Microsoft Help and Support to enter a query regarding a question or
issue you may have, go to the following address:

http://support.microsoft.com

If you have comments, questions, or ideas regarding the book or companion content or if
you have questions that are not answered by querying the Knowledge Base, please send
them to Microsoft Press using either of the following methods:

E-mail:
mspinput@microsoft.com
Postal mail:

Microsoft Press

Attn: Microsoft Visual Basic 2008 Step by Step
One Microsoft Way

Redmond, WA 98052-6399

Please note that product support is not offered through the preceding mail addresses. For
support information, please visit the Microsoft Product Support Web site at:

http://support.microsoft.com



Part |

Getting Started with
Microsoft Visual Basic 2008

Chapter 1, Exploring the Visual Studio Integrated Development Environment. . 3

Chapter 2, Writing Your First Program ........... ... .. ittt 37
Chapter 3, Working with Toolbox Controls ............................... 69
Chapter 4, Working with Menus, Toolbars, and Dialog Boxes ............... 97

In Part I, you'll receive an overview of essential Visual Basic 2008 programming techniques
and an introduction to the tools and features that you will work with during most Visual Basic
programming sessions. You'll learn to use the Visual Studio 2008 Integrated Development
Environment, with its fulsome collection of programming tools, windows, and menu commands,
and you'll receive step-by-step instruction on how to build and run several interesting pro-
grams from scratch. This is the place to start if you're new to Visual Basic programming, or
upgrading from an earlier version.

Chapter 2 introduces how controls, forms, properties, and program code can be used in
combination to create an entertaining Lucky Seven slot machine game. Chapter 3 provides
an overview of the most useful Toolbox controls, which help you present information or
program choices to the user, gather input, work with dates and times, and connect to the
Web. Chapter 4 focuses on adding menus, toolbars, and dialog boxes to Visual Basic pro-
grams that will give your program the flair of a commercial Windows application.






Chapter 1

Exploring the Visual Studio
Integrated Development
Environment

After completing this chapter, you will be able to:
B Start Visual Studio 2008.
B Use the Visual Studio Integrated Development Environment.
B Open and run a Visual Basic program.
B Change property settings.
B Move, resize, dock, and automatically hide tool windows.
B Use the IDE Navigator.
B Open a Web browser within Visual Studio.
B Use new Help commands and customize Help.
B Customize IDE settings to match this book'’s step-by-step instructions.
B Save your changes, and exit Visual Studio.

Are you ready to start working with Microsoft Visual Studio 2008? This chapter gives you the
skills you need to get up and running with the Visual Studio 2008 Integrated Development
Environment (IDE)—the place where you will write Microsoft Visual Basic programs. You
should read this chapter whether you are new to Visual Basic programming or you have used
previous versions of Visual Basic or Visual Studio.

In this chapter, you'll learn how to start Visual Studio 2008 and how to use the IDE to

open and run a simple program. You'll learn the essential Visual Studio menu commands
and programming procedures; you'll open and run a simple Visual Basic program named
Music Trivia; you'll change a programming setting called a property; and you'll practice
moving, sizing, docking, and hiding tool windows. You'll also learn how to switch between
files and tools with the IDE Navigator, open a Web browser within Visual Studio, get more
information by using online Help, and customize the IDE to match this book's step-by-step
instructions. Finally, you'll exit the development environment and save your changes.
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The Visual Studio Development Environment

Although the programming language you'll be learning in this book is Visual Basic, the
development environment you'll be using to write programs is called the Microsoft Visual
Studio Integrated Development Environment, or IDE for short. Visual Studio is a powerful
and customizable programming workshop that contains all the tools you need to build
robust programs for Windows and the Web quickly and efficiently. Most of the features
in the Visual Studio IDE apply equally to Visual Basic, Microsoft Visual C++, and Microsoft
Visual C#. Use the following procedures to start Visual Studio now.

v Important If you haven't yet installed this book’s practice files, work through “Finding
Your Best Starting Point” and “About the CD and Practice Files” in this book's Introduction.
(I recommend that you place the project files and related subfolders in the c:\\vb08sbs folder.)
Then return to this chapter.

Start Visual Studio 2008

1. On the Windows taskbar, click Start, click All Programs, and then click the Microsoft
Visual Studio 2008 folder.

The folders and icons in the Microsoft Visual Studio 2008 folder appear in a list.

Note To perform the steps in this book, you must have a version of the Microsoft Visual
Studio 2008 software installed. Most of the procedures that | describe are designed to work
with either Visual Studio 2008 Standard Edition, Visual Studio 2008 Professional Edition,
or Visual Studio 2008 Express Edition. If you are especially lucky, you might have access to
Visual Studio 2008 Team Suite as well. If this is the case, you'll be able to follow the proce-
dures in this book without difficulty, but you will also have access to some cool advanced
features and capabilities. However, even though it is tempting, don't try to use this book if
you have an earlier version of the Visual Basic software. If that's your situation, you'll be bet-
ter served by locating an earlier edition of my book, such as Microsoft Visual Basic 2005 Step
by Step (which describes the Visual Basic 2005 software) or Microsoft Visual Basic Professional
6.0 Step by Step (which describes the Microsoft Visual Basic 6.0 software).

2. Click the Microsoft Visual Studio 2008 icon.

If this is the first time you are starting Visual Studio, it might take a few minutes to con-
figure the environment. If you are prompted to specify the settings to use, select the
Visual Basic development settings.
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When Visual Studio starts, you see the development environment on the screen

with its many menus, tools, and component windows. (These windows are sometimes
called tool windows.) You also should see a Start Page containing a set of links, MSDN
articles, and project options. The Start Page is a comprehensive source of information
about your project, as well as resources within the Visual Basic development commu-
nity. This is one avenue for receiving new information about Visual Studio after you
purchase the software.
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Ready

The first thing most developers do when they start Visual Studio is open an existing project—
either a completed solution they want to work with again or an ongoing development project.
Try opening an existing project that | created for you—the Music Trivia program.

Open a Visual Basic project

1. On the Start Page, in the Recent Projects pane, click the Open Project link.

The Open Project dialog box shown in the illustration on the next page opens on the
screen. (You can also display this dialog box by clicking the Open Project command on
the File menu or by pressing Ctrl+0.) Even if you haven't used Visual Studio before, the
Open Project dialog box will seem straightforward because it resembles the familiar
Open dialog box in Microsoft Office Word or Microsoft Office Excel.
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@ Tip In the Open Project dialog box, you see a number of links along the left side of the
window. The Projects link is particularly useful; it opens the Projects folder inside the

Documents\Visual Studio 2008 folder on your system. By default, Visual Studio saves your
projects in this Projects folder, giving each project its own subfolder. We'll use a different
projects folder to organize your programming coursework, however, as you'll learn below.
Additional links to useful locations on your system will appear now too. The exact shape and
content of the links will depend on the version of Windows you are using, and the way that
you have configured dialog box views. (The screen shots in this book show Windows Vista.)

2. Browse to the c:\vb08sbs folder on your hard disk.

The c:\vb08sbs folder is the default location for this book'’s extensive sample file col-
lection, and you'll find the files there if you followed the instructions in “Installing and
Using the Practice Files” in the Introduction. If you didn't install the sample files, close
this dialog box and install them now by using the CD included with this book. Then re-
turn to this procedure and continue.

3. Open the chap01\musictrivia folder, and then double-click the MusicTrivia solution file.
(If your system shows file name extensions, this file will end with .sIn.)
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Visual Studio loads the MusicTrivia form, properties, and program code for the
MusicTrivia solution. The Start Page probably is still visible, but in the upper-right
corner of the screen, Solution Explorer lists some of the files in the solution.

% Troubleshooting If you see an error message indicating that the project you want to
open is in a newer file format, you might be trying to load Visual Basic 2008 files into
the older Visual Basic .NET 2002, 2003, or 2005 software. (Earlier versions of Visual Basic
can't open the Visual Basic 2008 projects included on the companion CD.) To check
which version of Visual Basic you're using, click the About command on the Help menu.

Visual Studio provides a special check box named Always Show Solution to control several
options related to solutions within the IDE. The check box is located on the Projects and
Solutions/General tab of the Options dialog box, which you open by clicking the Options
command on the Tools menu. If the check box is selected, a subfolder is created for each
new solution, placing the project and its files in a separate folder beneath the solution. Also,
if you select the Always Show Solution check box, a few options related to solutions appear
in the IDE, such as commands on the File menu and a solution entry in Solution Explorer. If
you like the idea of creating separate folders for solutions and seeing solution-related com-
mands and settings, select this check box. You'll learn more about these options at the end
of the chapter.

Projects and Solutions

In Visual Studio, programs under development are typically called projects or solutions
because they contain many individual components, not just one file. Visual Basic 2008
programs include a project file (vbproj) and a solution file (.sIn), and if you examine
these files within a file browsing utility such as Windows Explorer, you'll notice that the
solution file icons have a tiny 9 in them, an indication of their version number. (Visual
Basic 2008 is referred to as VB 9 internally.)

A project file contains information specific to a single programming task. A solution file
contains information about one or more projects. Solution files are useful to manage
multiple related projects and are similar to project group files (vbg) in Visual Basic 6.
The samples included with this book typically have a single project for each solution, so
opening the project file (vbproj) has the same effect as opening the solution file (.sIn).
But for a multi-project solution, you will want to open the solution file. Visual Basic 2008
offers a new file format for its projects and solutions, but the basic terminology that you
might have learned while using Visual Basic .NET 2002, 2003, or 2005 still applies.
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The Visual Studio Tools

At this point, you should take a few moments to study the Visual Studio IDE and identify
some of the programming tools and windows that you'll be using as you complete this
course. If you've written Visual Basic programs before, you'll recognize many (but probably
not all) of the programming tools. Collectively, these features are the components that you
use to construct, organize, and test your Visual Basic programs. A few of the programming
tools also help you learn more about the resources on your system, including the larger
world of databases and Web site connections available to you. There are also several pow-
erful Help tools.

The menu bar provides access to most of the commands that control the development envi-
ronment. Menus and commands work as they do in all Windows-based programs, and you can
access them by using the keyboard or the mouse. Located below the menu bar is the Standard
toolbar, a collection of buttons that serve as shortcuts for executing commands and controlling
the Visual Studio IDE. My assumption is that you've used Word, Excel, or some other Windows
application enough to know quite a bit about toolbars, and how to use familiar toolbar com-
mands, such as Open, Save, Cut, and Paste. But you'll probably be impressed with the number
and range of toolbars provided by Visual Studio for programming tasks. In this book, you'll
learn to use several toolbars; you can see the full list of toolbars at any time by right-clicking
any toolbar in the IDE.

Along the bottom of the screen you may see the Windows taskbar. You can use the taskbar
to switch between various Visual Studio components and to activate other Windows-based
programs. You might also see taskbar icons for Windows Internet Explorer, antivirus utilities,
and other programs installed on your system. In most of my screen shots, I'll hide the taskbar,
to show more of the IDE.

The following illustration shows some of the tools and windows in the Visual Studio IDE.
Don't worry that this illustration looks different from your current development environment
view. You'll learn more about these elements (and how you adjust your views) as you work
through the chapter.

The main tools visible in this Visual Studio IDE are the Designer, Solution Explorer, the
Properties window, and the Toolbox. You might also see more-specialized tools such as
Server Explorer and Object Browser, or they may appear as tabs within the IDE. Because
no two developers’ preferences are exactly alike, it is difficult to predict what you'll see if
your Visual Studio software has already been used. (What | show is essentially the “fresh
download” or "out-of-the-box" view.)
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If a tool isn't visible and you want to see it, click the View menu and select the tool. Because
the View menu has expanded steadily over the years, Microsoft has moved some of the less
frequently used View tools to a submenu called Other Windows. Check there if you don't see
what you need.

The exact size and shape of the tools and windows depend on how your development envi-
ronment has been configured. With Visual Studio, you can align and attach, or dock, windows
to make visible only the elements that you want see. You can also partially conceal tools as
tabbed documents along the edge of the development environment and then switch back
and forth between documents quickly. Trying to sort out which tools are important to you
now and which you can learn about later is a difficult early challenge when you're learning
the busy Visual Studio interface. Your development environment will probably look best

if you set your monitor and Windows desktop settings so that they maximize your screen
space, but even then things can get a little crowded.

Tip Although I use a screen resolution of 800 x 600 for most of the screen shots in this book—
so that you can see the IDE clearly—I usually use 1024 x 768 for writing code. You can change
the screen resolution in Windows Vista by right-clicking the Windows desktop and clicking
Personalize. In Windows XP, you right-click the Windows desktop and click Properties.
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The purpose of all this tool complexity is to add many new and useful features to the IDE
while providing clever mechanisms for managing the clutter. These mechanisms include fea-
tures such as docking, auto hiding, floating, and a few other window states that I'll describe
later. If you're just starting out with Visual Studio, the best way to deal with this feature ten-
sion is to hide the tools that you don't plan to use often to make room for the important
ones. The crucial tools for beginning Visual Basic programming—the ones you'll start using
right away in this book—are the Designer, the Properties window, Solution Explorer, and the
Toolbox. You won't use the Server Explorer, Class View, Object Browser, or Debug windows
until later in the book.

In the following exercises, you'll start experimenting with the crucial tools in the Visual Studio
IDE. You'll also learn how to display a Web browser within Visual Studio and how to hide the
tools that you won't use for a while.

The Designer

If you completed the last exercise (“Open a Visual Basic project”), the MusicTrivia project is
loaded in the Visual Studio development environment. However, the user interface, or form,
for the project might not yet be visible in Visual Studio. (More sophisticated projects might
contain several forms, but this simple trivia program needs only one.) To make the form of
the MusicTrivia project visible in the IDE, you display it by using Solution Explorer.

Display the Designer

1. Locate the Solution Explorer window near the upper-right corner of the Visual Studio
development environment. If you don't see Solution Explorer (if it is hidden as a tab in
a location that you cannot see or isn't currently visible), click Solution Explorer on the
View menu to display it.

When the MusicTrivia project is loaded, Solution Explorer looks like this:

Solution Explorer &l
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o [ My Project
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2. Click the MusicTrivia.vb form in the Solution Explorer window.

All form files, including this one, have a tiny form icon next to them so that you
can easily identify them. When you click the form file, Visual Studio highlights it in
Solution Explorer, and some information about the file appears in the Properties
window (if it is visible).

3. Click the View Designer button in Solution Explorer to display the program'’s user
interface.

The MusicTrivia form is displayed in the Designer, as shown here:

MusicTrivia.vb [Design] | Start Page

o Music Trivia [E=HEoH|Ex5)|

Ywhat rock and roll
instrument is often played
with sharp, slapping thumb
movements?

e ] —rmr—

ju

Notice that a tab for the Start Page is still visible near the top of the Designer. You
can click this tab to display the Start Page, where you can view articles and Web links,
or open additional project files. To return to Designer view, click the MusicTrivia.vb
[Design] tab near the top of the MusicTrivia form.

@ Tip If you don't see the Start Page and MusicTrivia.vb [Design] tabs, your development

environment might be in Multiple Documents view instead of Tabbed Documents view. To
change this option, click Options on the Tools menu. On the left side of the Options dialog
box, expand the Environment category, and then click General. On the right, under Window
Layout, click the Tabbed Documents option, and then click OK. The next time you start
Visual Studio, the various windows that you open have tabs, and you can switch between
them with a simple button click.

Now try running a Visual Basic program with Visual Studio.
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Running a Visual Basic Program

Music Trivia is a simple Visual Basic program designed to familiarize you with the program-
ming tools in Visual Studio. The form you see now has been customized with five objects
(two labels, a picture, and two buttons), and I've added three lines of program code to make
the trivia program ask a simple question and display the appropriate answer. (The program
“gives away" the answer now because it is currently in design mode, but the answer is hidden
when you run the program.) You'll learn more about creating objects and adding program
code in Chapter 2, “Writing Your First Program.” For now, try running the program in the
Visual Studio IDE.

Run the Music Trivia program

1. Click the Start Debugging button (the green right-pointing arrow) on the Standard
toolbar to run the Music Trivia program in Visual Studio.

Tip You can also press F5 or click the Start Debugging command on the Debug menu to
run a program in the Visual Studio development environment.

Visual Studio loads and compiles the project into an assembly (a structured collection
of modules, data, and manifest information for a program), prepares the program for
testing or debugging, and then (if the compilation is successful) runs the program in
the development environment. While the program is running, an icon for the program
appears on the Windows taskbar. After a moment, you see the MusicTrivia form again,
this time with the photograph and answer label hidden from view, as shown here:

o5 Music Trivia EI@

Ywhat rock and roll
instrument is often played
with sharp, slapping thumb
movements?

| Anzwer | | Guit |

Music Trivia now asks its important question: What rock and roll instrument is often
played with sharp, slapping thumb movements?
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2. Click the Answer button to reveal the solution to the question.

The program displays the answer (The Bass Guitar) below the question and then displays
a photograph of an obscure Seattle bass player demonstrating the technique. The test
program works.

o Music Trivia == s

Ywhat rock and roll
instrument is often played
with sharp, slapping thumb
movements?

e —

3. Click Quit to close the program.

The form closes, and the Visual Studio IDE becomes active again.

Thinking About Properties

In Visual Basic, each user interface element in a program (including the form itself)

has a set of definable properties. You can set properties at design time by using the
Properties window. Properties can also be referenced in code to do meaningful work
while the program runs. (User interface elements that receive input often use proper-
ties to convey information to the program.) At first, you might find properties a difficult
concept to grasp. Viewing them in terms of something from everyday life can help.

Consider this bicycle analogy: a bicycle is an object you use to ride from one place to
another. Because a bicycle is a physical object, it has several inherent characteristics. It
has a brand name, a color, gears, brakes, and wheels, and it's built in a particular style.
(It might be a touring bike, a mountain bike, or a bicycle built for two.) In Visual Basic
terminology, these characteristics are properties of the bicycle object. Most of the
bicycle’s properties were defined when the bicycle was built. But others (tires, travel
speed, and options such as reflectors and mirrors) are properties that change while the
bicycle is used. The bike might even have intangible (that is, invisible) properties, such
as manufacture date, current owner, or rental status. As you work with Visual Basic,
you'll use object properties of both types—visible and invisible.
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The Properties Window

You use the Properties window to change the characteristics, or property settings, of the
user interface elements on a form. A property setting is a quality of one of the objects in
your program. You can change property settings from the Properties window while you're
creating your user interface, or you can add program code via the Code Editor to change
one or more property settings while your program is running. For example, the trivia ques-
tion that the Music Trivia program displays can be modified to appear in a different font or
font size or with a different alignment. (With Visual Studio, you can display text in any font
installed on your system, just as you can in Excel or Word.)

The Properties window contains an Object list that itemizes all the user interface elements
(objects) on the form. The window also lists the property settings that can be changed for
each object. You can click one of two convenient buttons to view properties alphabetically
or by category. You'll practice changing the Font property of the first label in the Music
Trivia program now.

Change a property

1. Click the Labell object on the form. (Labell contains the text “What rock and roll
instrument is often played with short, slapping thumb movements?”)

To work with an object on a form, you must first select the object. When you select an
object, resize handles appear around it, and the property settings for the object are
displayed in the Properties window.

2. Click the Properties Window button on the Standard toolbar.

The Properties window might or might not be visible in Visual Studio, depending on
how it's been configured and used on your system. It usually appears below Solution
Explorer on the right side of the development environment. (If it is visible, you don't
need to click the button, but you should click the window to activate it.)

You'll see a window similar to the one shown on the next page:

The Properties window lists all the property settings for the first label object (Label1)
on the form. (In Visual Basic 2008, more than 60 properties are associated with
labels.) Property names are listed in the left column of the window, and the current
setting for each property is listed in the right column. Because there are so many
properties (including some that are rarely modified), Visual Studio organizes them
into categories and displays them in outline view. If a category has a plus sign (+) next
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to it, you can click the collection title to display all the properties in that category. If a
category has a minus sign (-) next to it, the properties are all visible, but you can hide

the list under the category name by clicking the minus sign.

Properties

Labell SysternVindows.Forms.Label
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Q Tip The Properties window has two handy buttons that you can use to further organize
properties. Clicking the Alphabetical button lists all the properties in alphabetical order

and puts them in just a few categories. Clicking the Categorized button organizes the
property list into many logical categories. | recommend Categorized view if you are new

to Visual Studio.

3. Scroll the Properties window list box until the Font property is visible.

The Properties window scrolls like a regular list box. If you are in Categorized view,

Font is in the Appearance category.

4. Click the Font property name (in the left column).

The current font (Microsoft Sans Serif) is partially displayed in the right column, and a
button with three dots on it appears by the font name. This button is called an ellipsis
button and indicates that a dialog box is available to customize the property setting.

5. Click the Font ellipsis button in the Properties window.
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Visual Studio displays the Font dialog box, which you can use to specify new formatting
characteristics for the text in the selected label on your form. The Font dialog box con-
tains more than one formatting option; for each option you select, a different property
setting will be modified.

Fant (=3
FEont: Fant style: Size:
Fegular 1 | ful'd |
o ¢ *| [Ccancel |
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O Microsait Y aHei Bold 14 (2
) Microsoft i B aiti Buald Italic 16 b
O MingLill 18
€ MingLil_HK5CS 20
) MingLil_HKSCS-ExtB ~ 2 3
Effects Sample
Strikeout
Underline AaBbeZZ
Script:
Western -

6. Change the font style from Regular to Italic, and then click OK to confirm your changes.

Visual Studio records your changes and adjusts the property settings accordingly. You
can examine the changes by viewing your form in the Designer or by expanding the
Font category in the Properties window.

Now change a property setting for the Label? object (the label that contains the text
“The Bass Guitar”).

7. In the Designer, click the second label object (Label2).
When you select the object, resize handles surround it.
8. Click the Font property in the Properties window.

The Label2 object has its own unique set of property settings. Although the property
names are the same as those of the Labell object, the values in the property settings
are distinct and allow the Label2 object to act independently on the form.

9. Click the Font ellipsis button, set the font style to Bold and the font size to 12 points,
and then click OK.

10. Scroll to the ForeColor property in the Properties window, and then click it in the left
column.

11. Click the ForeColor arrow in the right column, click the Custom tab, and then click a
dark purple color.
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The text in the Label2 object is now bold and purple on the form.

o Music Trivia [E=HE=H|E=D|

Vihat rock and rolf
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éThe Bass Guitar
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Congratulations! You've just learned how to set properties in a Visual Basic program by
using the Visual Studio Properties window—one of the important skills in becoming a
Visual Basic programmer.

Moving and Resizing the Programming Tools

With numerous programming tools to contend with on the screen, the Visual Studio IDE

can become a pretty busy place. To give you complete control over the shape and size of
the elements in the development environment, Visual Studio lets you move, resize, dock,
and auto hide most of the interface elements that you use to build programs.

To move one of the tool windows in Visual Studio, simply click the title bar and drag the
object to a new location. If you align one window along the edge of another window, it
attaches to that window, or docks itself. Dockable windows are advantageous because they
always remain visible. (They don't become hidden behind other windows.) If you want to
see more of a docked window, simply drag one of its borders to view more content.

If you want to completely close a window, click the Close button in the upper-right corner
of the window. You can always open the window again later by clicking the appropriate
command on the View menu.

If you want an option somewhere between docking and closing a window, you might try
auto hiding a tool window at the side of the Visual Studio IDE by clicking the tiny Auto Hide
pushpin button on the right side of the tool’s title bar. This action removes the window from
the docked position and places the title of the tool at the edge of the development environ-
ment in an unobtrusive tab. When you auto hide a window, you'll notice that the tool window
remains visible as long as you keep the mouse pointer in the area of the window. When you
move the mouse to another part of the IDE, the window slides out of view.
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To restore a window that you have auto hidden, click the tool tab at the edge of the devel-
opment environment or hold your mouse over the tab. (You can recognize a window that is
auto hidden because the pushpin in its title bar is pointing sideways.) By holding the mouse
pointer over the title, you can use the tools in what | call “peek-a-boo” mode—in other words,
to quickly display an auto hidden window, click its tab, check or set the information you need,
and then move the mouse to make the window disappear. If you ever need the tool displayed
permanently, click the Auto Hide pushpin button again so that the point of the pushpin faces
down, and the window then remains visible.

A useful capability of Visual Studio is also the ability to display windows as tabbed documents
(windows with tab handles that partially hide behind other windows) and to dock windows by
using docking guides, as shown in the following illustration.
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Docking guides are changeable icons that appear on the surface of the IDE when you move
a window or tool from a docked position to a new location. Because the docking guides are
associated with shaded, rectangular areas of the IDE, you can preview the results of your
docking maneuver before you actually make it.

Docking and auto hiding techniques definitely take some practice to master. Use the follow-
ing exercises to hone your windows management skills and experiment with the features of
the Visual Studio development environment. After you complete the exercises here, feel free
to configure the Visual Studio tools in a way that seems comfortable for you.
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Moving and Resizing Tool Windows

To move and resize one of the programming tool windows in Visual Studio, follow these
steps. This exercise demonstrates how to manipulate the Properties window, but you can
work with a different tool window if you want to.

Move and resize the Properties window

1.

If the Properties window isn't visible in the development environment, click the
Properties Window button on the Standard toolbar.

The Properties window is activated in the IDE, and its title bar is highlighted.

Double-click the Properties window title bar to display the window as a floating
(undocked) window.

Using the Properties window title bar, drag the window to a new location in the
development environment, but don't dock it (yet).

Moving windows around the Visual Studio IDE gives you some flexibility with the tools
and the look of your development environment. Now you'll resize the Properties win-
dow to see more object property settings at once.

Point to the lower-right corner of the Properties window until the pointer changes to
a double-headed arrow (the resizing pointer). Then drag the lower-right border of the
window down and to the right to enlarge the window.
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ForeColor
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You can work more quickly and with more clarity of purpose in a bigger window. Feel
free to move or resize a window when you need to see more of its contents.
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Docking Tool Windows

If a tool window is floating over the development environment, you can return it to its original
docked position by double-clicking the window's title bar. (Notice that you used this same tech-
nique in the previous exercise to undock a docked window. Double-clicking a title bar works
like a toggle, a state that switches back and forth between two standard positions.) You can

also attach or dock a floating tool in a different place. You might want to do this if you need

to make more room in Visual Studio for a particular programming task, such as creating a user
interface with the Designer. Try docking the Properties window in a different location now.

Dock the Properties window

1. Verify that the Properties window (or another tool that you want to dock) is floating
over the Visual Studio IDE in an undocked position.

If you completed the previous exercise, the Properties window is undocked now.

2. Drag the title bar of the Properties window to the top, bottom, right, or left edge of
the development environment (your choice!), taking care to drag the mouse pointer
over one of the docking guides (small arrows) on the edge of the Visual Studio IDE, or
the collection of four docking guides (called a diamond guide) in the center.

As you move the mouse over a docking guide, the Properties window snaps into place,
and a blue shaded rectangle indicates how your window will appear when you release
the mouse button. Note that there are several valid docking locations for tool windows
in Visual Studio, so you might want to try two or three different spots until you find
one that looks right to you. (A window should be located in a place that's handy and
not in the way of other needed tools.)

9 MusicTrivia - Microsoft Visual Studio o [ |[=
File Edit Wiew Project Build Debug Data Tools Test ‘Window Help

FeE A -Hd i 2BR|REE(9-o-8- 3 ElEc: | QAR B aL

x Start Page " MusicTrivia.vb [Design] ~ X | Solution Explorer > I x
= " 2| & F| EER

(| | o usic Trivia == =2 (2] MusicTrivia

L [l My Project

5] MusicTriviavh

What rock and rolf |
instument is offen plaved |
with sharp, siapping thomb

mavements? |

Properties | = |
Brswer ‘ | Qi ‘ Label2 Systern Mindos Forms.Lsbel
e I
Erabled True
Flatstyle Standar
Font Microsd
ForeCalor M ru
GenerateMember True
Image [ in
Trsgedlign Middle
Irnagelndes 1 i
Use the guide diamond to choose a dacking Iocation, To prevent dacking, hald down CTRL, Trnagekey [Tin




Chapter 1 Exploring the Visual Studio Integrated Development Environment 21
3. Release the mouse button to dock the Properties window.

The window snaps into place in its new home.

Q Tip To switch between dockable, tabbed documents, and floating window styles, right-
click the window's title bar (or tab, if it is a tabbed document), and then click the option
you want. Although the Properties window works very well as a dockable window, you'll
probably find that larger windows (the Visual Studio Start Page, for example) work best
as tabbed document windows.

4. Try docking the Properties window several more times in different places to get the feel
of how docking works.

| guarantee that although a few of these window procedures seem confusing at first,
after a while they'll become routine for you. In general, you want to create window
spaces that have enough room for the information you need to see and use while you
work on more important tasks in the Designer and in the Code Editor.

Hiding Tool Windows

To hide a tool window, click the Auto Hide pushpin button on the right side of the title bar to
conceal the window beneath a tool tab on the edge of the IDE, and click it again to restore the
window to its docked position. You can also use the Auto Hide command on the Window menu
(or right-click a title bar and select Auto Hide) to auto hide a tool window. Give it a try now.

Use the Auto Hide feature

1. Locate the Auto Hide pushpin button on the title bar of the Properties window.

The pushpin is currently in the “down,” or “pushed in,” position, meaning that the
Properties window is “pinned” open and auto hide is disabled.

2. Click the Auto Hide button on the Properties window title bar.

The Properties window slides off the screen and is replaced by a small tab named
Properties. The benefit of enabling auto hide, of course, is that the process frees up
additional work area in Visual Studio. But the hidden window is also quickly accessible.

3. Hold the mouse pointer over the Properties tab. (You can also click the Properties tab
if you want.)

The Properties window immediately slides back into view.
4. Click elsewhere within the IDE, and the window disappears again.

5. Finally, display the Properties window again, and then click the pushpin button on the
Properties window title bar.

The Properties window returns to its familiar docked position, and you can use it
without worrying about it sliding away.
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Spend some time moving, resizing, docking, and auto hiding tool windows in Visual
Studio now, to create your version of the perfect work environment. As you work
through this book, you'll want to adjust your window settings periodically to adapt
your work area to the new tools you're using.

@ Tip Visual Studio 2008 lets you save your window and programming environment settings and
copy them to a second computer or share them with members of your programming team. To
experiment with this feature, click the Import And Export Settings command on the Tools menu
and follow the wizard instructions to export (save) or import (load) settings from a file.

Switching Among Open Files and Tools by Using
the IDE Navigator

Visual Studio 2008 has a feature that makes it even easier to switch among open files and
programming tools in the development environment. This feature is called the IDE Navigator,
and it lets you cycle through open files and tools by using key combinations, in much the
same way that you cycle through open programs on the Windows taskbar. Give it a try now.

Use the IDE Navigator

1. Hold down the Ctrl key and press Tab to open the IDE Navigator.

The IDE Navigator opens, and displays the open files and tools in the IDE. Your screen
will look similar to the following:
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2. While holding down the Ctrl key, press Tab repeatedly to cycle through the open files
until the file you want is highlighted.

To cycle through the files in the reverse direction, hold down Ctrl+Shift and press Tab.
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3. While holding down the Ctrl key, press the arrow keys to cycle through both the open
files and the open tools.

You can also select an open file (or tool) by clicking its name.
4. When you're finished with the IDE Navigator, release the Ctrl key.

The last selected item in the IDE Navigator will become active.

Tip To cycle through open tools without opening the IDE Navigator, you can also press Alt+F7.
Shift+Alt+F7 lets you cycle through the tools in the reverse direction.

Opening a Web Browser Within Visual Studio

A handy feature in Visual Studio is the ability to open a simple Web browser within the de-
velopment environment. The browser appears as a tabbed document window in the IDE, so it
takes up little space but can be opened immediately when needed. You could open a stand-
alone Web browser (such as Internet Explorer) and keep it nearby on the Windows taskbar,
but running a Web browser within Visual Studio makes examining Web sites and copying
data into Visual Studio even easier. Try using the Visual Studio Web browser now.

Open the Visual Studio Web browser

1. Click the Other Windows submenu on the View menu, and then click the Web Browser
command.

The Web Browser window appears, as shown here:
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The browser is a tabbed document window by default, but you can change it into a
floating window or a docked window by right-clicking the window title bar and then
clicking the Floating or Dockable commands.

Q Tip You can change the default page that appears in the Web Browser window by
changing the setting in the Options dialog box. Open the Options dialog box by clicking
Options on the Tools menu. Select the Show All Settings checkbox, expand Environment,
and then click Web Browser. Change the Home Page setting to a URL you want for the
default page.

2. Experiment with the browser and how it functions within the IDE.

Although the browser is more basic than Internet Explorer or another full-featured
browser, you will soon find it a useful addition to the Visual Studio tool collection.

3. When you're finished, click the Close button on the right side of the Web browser title
bar to close the window. (If your browser window appears as a tabbed window, you
might need to change it to a floating window first.)

Getting Help

Visual Studio includes an electronic reference center called Microsoft Visual Studio 2008
Documentation that you can use to learn more about the Visual Studio IDE, the Visual Basic
programming language, resources in the Microsoft .NET Framework, online communities that
specialize in Visual Basic and Visual Studio, and the remaining tools in the Visual Studio suite.
Take a moment to explore these Help resources now before moving on to Chapter 2, where
you'll build your first program.

Two Sources for Help: Local Help Files and Online Content
Essentially, there are two basic resources for electronic help within Visual Studio:

B You can access the local Help files that were installed during the Visual Studio 2008
setup process.

B You can access online (Internet-based) Help via MSDN Online, MSDN newsgroups,
and a collection of developer Web sites sponsored by Microsoft called the Codezone
Community. The Codezone Community is especially valuable, because the group in-
cludes professional developers who are using Visual Studio and Visual Basic 2008 to
write real-world applications; the content and advice they offer is continually updated
and therefore reflects current trends, concerns, and triumphs within the Visual Basic
programming community.
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Configure your Help system now to offer both local and online Help resources as you learn
about Visual Basic.

Set Help system options

1.

Click How Do | on the Help menu to open the Help system.

Visual Studio offers its assistance through an HTML-based tool called Microsoft Document
Explorer. You can use several commands on the Help menu to open Document Explorer.
Each command opens and configures Document Explorer to display a different type of
information. How Do | is one of the best starting places; it presents a hierarchical list of
common programming tasks that you can use to quickly find the information you need.
Your screen looks something like this:
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more

Data Access (How Do 1 in Visual Basic)
Getting Started .. Load Data ... Validate Data

more

Deployment (How Do 1 in Visual Basic)
Deploy with ClickOnce .. Use Setup Projects

Use other Deployment Projects . more

Windows Applications (How Do I in Visual Basic)
Forms and Controls . Data .. Printing .. more

. m 5

Click one or more topics within the How Do | list to explore the type of material

provided.

The Help system contains hundreds of technical descriptions and tutorials (many with
sample code). Now you'll configure Help to display just the content that you want when

it opens.

On the Document Explorer menu bar, click Tools, and then click the Options command.

You are presented with customization options that you can use to configure how the
Help system works and (most importantly) what resources Help checks when it searches

for information.
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Expand the Help category and then click Online.

Your screen looks similar to the following:

Options [ (asa]
Ervironment When loading Help content
a Help @ Try online first, then local
General Try local first, then anline
Online Try local only, not anline
International Settings
Keyboard Search these providers: Codezone Community:
Vel Browser V| Local Help |T| V| 4GuysFromRolla.com e
| MSDM Online |T| V| Aspdlliance.com =
V| Codezone Community V| C# Corner.com
V| Questions V| CodeGuru.com
V| DewCitynet

| Developer Fusion (UK) S

4GuysFromRolla.com is one of the =
Internet's largest Active Server Pages
and MET resource sites, 4Guys

Bead the privacy statement...

| Ok | | Cancel

My recommendation is that you set your online options as shown in this screen.
Select the top option button to load Help content first from online sources (the

most up-to-date), and then from local sources on your hard disk. (If you have a slow
Internet connection or no Internet connection, you'll probably be better served by
using only local sources, however.) Next be sure that MSDN Online and Codezone
Community are selected so that Visual Studio loads recent articles from Visual Basic
developers each time that you use the Search command. If you find after a while that
you prefer one or two Codezone communities over the others, you can adjust the
search order or remove items from the list.

Select the configuration options that make sense to you, and then click OK to save them.

You can return to the Options menu within Document Explorer any time that the Help
system is open. Now try using another useful feature, the Help favorites list, which
operates much like the Favorites list within Internet Explorer.
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Maintain a Favorites list within Help

1.

O

On the Document Explorer toolbar, click the Add To Help Favorites button (the one
next to the Help Favorites button, with the icon of a page with a plus sign (+) on it).

When you click this button, Document Explorer adds the article that is currently visible
to your preferred list of Help documents. Now you can always have your favorite Help
resources organized and right at your fingertips!

Click the Search tab at the top of the Document Explorer window.

The Search window opens, providing a tool that you can use to make specific text-based
searches within your local and online Help resources.

Click the Language arrow (a content filter), and remove the check marks from all
languages except Visual Basic.

You can configure the Help system to limit your search to just the languages, tech-
nologies, and topics that you want by using the filter arrows. Because you are just

starting with Visual Studio, you might want to limit your search to just Visual Basic
for now.

In the Search text box, type data controls, and press Enter.

Visual Studio searches for the text strings ‘data’ and ‘controls’ in your local Help files
and online in MSDN, newsgroup, and Codezone communities. Pay particular attention
to the Sort By list box in the Search window, which you can use to select how articles
found by Search are displayed.

Click the MSDN Online Help source on the right side of the window to display the
results of your online search.

The online Help information displayed is dynamic; it will change periodically to reflect
new information published on MSDN.

Save the first (highlighted) item to your Help Favorites list.

Click the Search tab and then click the Save Search button on the Document Explorer
toolbar.

Tip In addition to Help articles, you can save important search results in your Favorites list.
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Your screen looks similar to the following illustration. Notice that the Help Favorites
window now holds the two new favorites that you have saved: “How Do | in Visual
Basic” (under Help Topics) and “data controls” (under Help Searches).

©) Search - Microsoft Wisual Studia Docurmentatian - Microsoft Document Explarer e e
File Edit View Tools Windew Help
Back @ A°| @ HowDol » Q Search [3Index € Contents (3] Help Favorites %) MSDM Forums A, =
Help Favorites > 1 x How Do Lin Yisual Basic” Search v X
de X dlata cantrals v [ seans
= Help Topics - Language: Yisual Basic
How Do Lin Visual Basic Servers & Enterprise, SO Server 2000, SQL Server 2005, Visual Studio 2005, Web | -
DataSet Class 7 Technalogyt  poelopment, Windows Forms, Windsws Vists i
Walkthrough: Creating a Basic = ContentType:  Addins & Macras, Templates 8 Starter Kits
Walkthrough: Det ek
Walkthrough: Sending Datsset | goorpa far data controls Sort by Rank o] &l 1-20of 100 results b

How to: Bind Data to the Yind
Howy ta: Hide Colurmns in the
BindingMavigatar Control {W/ir
BindingSource Component O

Custom Data Controls Sample Local Help (3
This sample demanstrates howto use your own
cantrols with the Data Sources window. .. Dewnload

A5CH Character Codes sample. This sample dermonstrates how to use your
Walkthrough; Creating Yfour O own controls with the Data Sources window.
Wihat's Mew in Wisusl Basic
= Help Searches R MSDN Online (100

Custom Data Controls Sample

Data Source Controls Owerview
ASPNET includes data source cantrals that allow you Dats Source Contrals, Part 1t The Basic

to wark with differant types of data sources such 35 a
database, an XML file, ar 3 middle-tier business
object. Codezone Community (100)

Bind Option Buttons to Data Contrals
Using Dynasets vs. Using Data Cantrol
How to use twa different Data Control

Data Source Controls Overview

Data Source Controls, Part 1: The Basics
Mikhil Kothari Microzoft Corporation, Movernber
2005, Applies to:  Microsoft Visual Studio Questions (100}
2005 Microsoft ASP.MET 2.0 Data Source Contrals, Ro Miats conreac imuicibla in Enmen Mo
I J 3

« M

@ Contents || 3 Index| [T Help Fa.. [ ||« ]

Ready

Click the Rename button in the Help Favorites window. (You can also right-click the
search that you saved, and then click Rename.)

Document Explorer highlights the name that you used for your search and allows you
to rename it so that your favorite more closely matches the actual search. This step is
optional, but | find it useful.

Type Data Sources window and controls, and press Enter.

Document Explorer changes the name of the search within your Favorites list. | chose
this title because it seemed clearer to me than my original search string. (However, you
might want to specify a different title that more closely matches the search results that
you have achieved.)

Click How Do I In Visual Basic in the Help Favorites window.

The first article that you saved appears in Document Explorer. Now you'll practice de-
leting a favorite, a skill that becomes important when your list of favorite Help articles
grows long and you need to thin it out.

Right-click the How Do | In Visual Basic item in the Help Favorites window and then
click Delete.

If you are prompted to confirm your intention to delete this favorite, click Yes.
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The How Do | article is deleted from your favorites list (but not from the Help system).

13. Click the Close button on the Document Explorer title bar.

There are additional Help features to learn and experiment with, but now is a good time for
me to summarize the important Help commands and for you to turn to the writing of your

first program in the next chapter.

Summary of Help Commands

Here is a short compilation of useful Help commands and their uses within the Visual

Studio IDE.

To get Help information
Organized by programming task

About the feature or command
you're currently using

By topic or activity
While working in the Code Editor

While working in a dialog box

By searching for a specific
keyword

From MSDN and independent
Visual Studio Web sites

About contacting Microsoft for
product support

Do this
On the Visual Studio Help menu, click How Do I.
On the Visual Studio Help menu, click Dynamic Help.

On the Visual Studio Help menu, click Contents.

Click the keyword or program statement you're interested in,
and then press F1.

Click the Help button (question mark) in select dialog boxes
(for example, the dialog box displayed when you choose the
Options command on the Tools menu).

On the Help menu, click Search, and type the term you're
looking for. Filter and organize the search results using the
Sort By list box.

On the Help menu, click MSDN Forums.

On the Help menu, click Technical Support.

Customizing IDE Settings to Match Step-by-Step
Exercises

Like the tool windows and the Help system, the compiler settings within the Visual Studio
development environment are highly customizable. It is important to review a few of these
settings now so that your version of Visual Studio is configured in a way that is compatible
with the step-by-step programming exercises that follow. You will also learn how to cus-
tomize Visual Studio generally so that as you gain programming experience, you can set
up Visual Studio in the way that is most productive for you.
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Setting the IDE for Visual Basic Development

The first setting that you need to check was established when Visual Studio was first installed
on your machine. During setup, you were asked how you wanted Visual Studio to configure
your general development environment. Since Visual Studio is a multi-purpose programming
tool, you had many options—Visual Basic development, Visual C++ development, Visual C#
development, Web development, and even a general-purpose programming environment
that closely matches previous versions of Visual Studio. The selection you made configured
not only the Code Editor and the development tools available to you, but also the menu and
toolbar commands, and the contents of several tool windows. For this reason, if you plan to
use this book to learn Visual Basic programming but originally configured your software for
a different language, a few of the menu commands and procedures described in this book
will not exactly match your current software configuration. (The location of the Web Browser
command, discussed above, is one example.)

Fortunately, you can fix this inconsistency and practice changing your environment settings

by using the Import And Export Settings command on the Tools menu. The following steps

show you how to change your environment setting to Visual Basic development, the recom-
mended setting for this book.

Set the IDE for Visual Basic development

1. On the Tools menu, click Import And Export Settings.

You can use the wizard that appears to save your environment settings for use on
another computer, load settings from another computer, or reset your settings—the
option that you want to select now.

2. Click Reset All Settings, and then click Next.

Visual Studio asks you if you want to save your current settings in a file before you
configure the IDE for a different type of programming. It is always a good idea to
save your current settings as a backup, so that you can return to them if the new
ones don't work out.

3. Verify that the Yes, Save My Current Settings button is selected, and note the file name
and folder location in which Visual Studio plans to save the settings.

If you want to go back to these settings, you'll use this same wizard and the Import
Selected Environmental Settings button to restore them.

4. Click Next to view the default list of settings that you can use for Visual Studio.

Depending on what Visual Studio components are installed, you will see a list of settings
similar to those shown in the following illlustration:
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Import and Export Settings Wiizard @

&/ 3 v Choose a Default Collection of Settings

Which collection of settings do you want to reset to?

5L General Development Settings Description:

Optirmizes the environment so you can

focus on building warld-class applications.

This collection of settings contains

customizations to the window [ayout,

(5 Wreb Developrent Settings command menus and keyboard shortcuts
to make commaon Yisual Basic cornrmands
rnore accessible,

Zh
5L Wisual C# Development Settings
3 Wisual C++ Development Settings

| < Previous | | Einish || Cancel |

5. Click Visual Basic Development Settings (if it is not already selected), and click Finish.

The wizard switches your IDE settings, including menu commands, toolbars, and settings
within a few dialog boxes, tool windows, and the Code Editor. If a Help window is still
open from an earlier exercise, you see a warning reminding you that the Help system
cannot be updated fully until you close and restart Help.

Feel free to repeat this customization process any time that you need to reset your
settings (for example, if you make a customization mistake that you regret), or if you
want to customize Visual Studio for another programming tool.

6. Click Close to close the wizard.

Checking Project and Compiler Settings

If you just reset your environment settings for Visual Basic development, you are now ready
to begin the programming exercises. But if you didn't reset your settings—for example, if
you were already configured for Visual Basic development and have been using Visual Studio
2008 for a while, or if your computer is a shared resource used by other programmers who
might have modified the default settings (perhaps in a college computer lab)—complete the
following steps to verify that your settings related to projects, solutions, and the Visual Basic
compiler match those that | use in the book.
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Check project and compiler settings

1.

Click the Options command on the Tools menu to display the Options dialog box.

The Options dialog box is your window to many of the customizable settings within
Visual Studio. To see all the settings that you can adjust, click to select the Show All
Settings check box in the lower-left corner of the dialog box.

Expand the Projects And Solutions category and then click the General item in the
Options dialog box.

This group of check boxes and options configures the Visual Studio project and solution
settings.

So that your software matches the settings used in this book, adjust your settings to

match those shown in the following dialog box:

— Set this to the location of the book's
practice files (c:\vb08sbs)

S =

Ermironment Visual Studio projects location:
Projects and Solutions CiwblBsks E

General ) )

Build and fun Visual Studic user praject templates location:

B Defaults CiUsers\Michael Halvorsor\Documentsiyisual Studio 20084 Templates\Proje E

WC++ Directories Visual Studio user itern temnplates lacation:

WG+ Project Settings Ci\Users\Michael Halvorsom\Docurnents\Wisual Studio 20084 Termplates\ltern E
Source Contrel
Text Editor ] Always show Error List if build finishes with errors mm—
Database Taals [7] Track Agtive Item in Solution Explarer Remove Checkma rks
Debugging [ Show advanced build configurations
Devic Teol [E} Aty showrsoltion from boxes so that
HTML Designer
Office Tools [] Save new projects when created instructions related tO
Test Tools [7]Warn userwhen the project [0cation is N0t Ut e—— . X
Text Templating [T Show Qutput window when build starts Openlng prOJeCtS
Windaws Forms Designer [T Prormpt for symbolic renaming when renaming files
Workfcw Designer match the book

|-Se|ect this checkbox to show
all available settings

In particular, | recommend that you clear the check marks from the Always Show
Solution and Save New Projects When Created check boxes. The first option shows
additional solution commands in the IDE, which is not necessary for solutions that con-
tain only one project (the situation for most programs in this book). The second option
(in contrast with Visual Studio .NET 2003 and Visual Basic 6) causes Visual Studio to
postpone saving your project until you click the Save All command on the File menu
and provide a location for saving the file. This “delayed save” feature allows you to
create a test program, compile and debug the program, and even run it without actu-
ally saving the project on disk—a useful feature when you want to create a quick test
program that you might want to discard instead of saving. (An equivalent situation in
word-processing terms is when you open a new Word document, enter an address for
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a mailing label, print the address, and then exit Word without saving the file.) With this
default setting, the exercises in this book prompt you to save your projects after you
create them, although you can also save your projects in advance by selecting the Save
New Projects When Created check box.

You'll also notice that | have highlighted the c:\vb08sbs folder as the location for Visual
Studio projects, the default location for this book's sample files. Most of the projects
that you create will be stored in this folder, and they will have a "“My” prefix to distin-
guish them from the completed project | provide for you to examine.

After you have adjusted these settings, you're ready to check four Visual Basic compiler
settings.

. Click the VB Defaults item in the Options dialog box.

Visual Studio displays a list of four compiler settings: Option Explicit, Option Strict,
Option Compare, and Option Infer. Your screen looks like this:

Options 7=

Errvironrnent Default project settings:

Projects and Solutions . i ———
General Option Explicit: |C)r17V|
Build and Run Option Strict: |Of'f v|
WB Defaults —_——
WC++ Directories
WC++ Project Settings

Source Control

Text Editor

Database Tools

Cebugging

Option Compare: |Binary v|

Option Infer: |On v|

Device Tools

HTrAL Designer

Office Toaols

Test Tools

Text Ternplating
Windows Forms Designer
Weorkflow Designer

| Show all settings | Ok | | Cancel |

Although a detailed description of these settings is beyond the scope of this chapter,
you'll want to verify that Option Explicit is set to On and Option Strict is set to Off—the
default settings for Visual Basic programming within Visual Studio. Option Explicit On

is a setting that requires you to declare a variable before using it in a program—a very
good programming practice that | want to encourage. Option Strict Off allows variables
and objects of different types to be combined under certain circumstances without
generating a compiler error. (For example, a number can be assigned to a text box
object without error.) Although this is a potentially worrisome programming practice,
Option Strict Off is a useful setting for certain types of demonstration programs. If you
don't keep this setting, a few projects will display error messages when you run them.
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Option Compare determines the comparison method when different strings are com-
pared and sorted. For more information about comparing strings and sorting text, see
Chapter 13, “Exploring Text Files and String Processing.”

Option Infer is a new setting in Visual Basic 2008. If you set Option Strict to Off and you
set Option Infer to On, you can declare variables without explicitly stating a data type.
Or rather, if you make such a declaration, the Visual Basic compiler will infer (or take

an educated guess) about the data type based on the initial assignment you made for
the variable. The designers of Visual Basic have allowed this type of declaration in the
hopes of saving you computer memory. You'll learn more about the feature in Chapter
5, “Visual Basic Variables and Formulas, and the .NET Framework”.

As a general rule, | recommend that you set Option Infer to Off to avoid unexpected
results in how variables are used in your programs. | have set Option Infer to Off in
most of the sample projedcts included on the companion CD.

Feel free to examine additional settings in the Options dialog box related to your pro-
gramming environment and Visual Studio. When you're finished, click OK to close the
Options dialog box.

You're ready to exit Visual Studio and start programming.

One Step Further: Exiting Visual Studio

Each chapter in this book concludes with a section titled “One Step Further” that enables

you to practice an additional skill related to the topic at hand. After the "One Step Further”
tutorial, I've compiled a Quick Reference table that reprises the important concepts dis-

cussed in each chapter.

When you're finished using Visual Studio for the day, save any projects that are open, and

close the development environment. Give it a try.

Exit Visual Studio

1.

Save any changes you've made to your program by clicking the Save All button on the
Standard toolbar.

As you learned in the preceding section, the default behavior in Visual Studio 2008

is that you give your program a name when you begin a project or solution, but you
don't specify a file location and save the project until you click the Save All button or
the Save All command on the File menu. You've made a few changes to your project, so
you should save your changes now.

On the File menu, click the Exit command.

The Visual Studio program closes. Time to move on to your first program in Chapter 2!
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Chapter 1 Quick Reference

To
Start Visual Studio

Open an existing
project

Compile and run a
program

Set properties

Resize a tool window

Move a tool window

Dock a tool window

Auto hide a docked
tool window

Disable Auto Hide for
a docked tool window

Switch between open
files

Switch between open
tools

Get Help

Customize Help

Configure the Visual
Studio environment
for Visual Basic
development

Customize IDE
settings

Exit Visual Studio

Do this

Click Start on the taskbar, click All Programs, click the Microsoft Visual Studio
2008 folder, and then click the Microsoft Visual Studio 2008 program icon.

Start Visual Studio. Click Open Project on the File menu.
or
On the Start Page, click Project at the bottom of the Recent Projects pane.

Click the Start Debugging button on the Standard toolbar.
or
Press F5.

Click the form object whose properties you want to set. In the Properties
window, click the property name in the left column, and then change the
corresponding property setting in the right column.

Display the tool as a floating window (if it is currently docked), and resize it
by dragging its edges.

Display the tool as a floating window (if it is in a docked state), and then
drag its title bar.

With the mouse pointer, drag the window's title bar over a docking guide to
preview how it will appear, and then release the mouse button to snap the
tool into place.

Click the Auto Hide pushpin button on the right side of the title bar of the
tool window. The window hides behind a small tab at the edge of the devel-
opment environment until you hold the mouse over it.

Click the tool tab, and then click the Auto Hide pushpin button.

Hold down the Ctrl key and press Tab to display the IDE Navigator. While
holding down the Ctrl key, press Tab to scroll through the list of open files.
Use the arrow keys to scroll through both the list of open files and tools. You
can also click on a file or tool in the IDE Navigator to switch to it.

Press Alt+F7 to scroll in a forward direction through the open tools in the
IDE. Press Alt+Shift+F7 to scroll in the reverse direction.

Start the Help system (hosted by the Microsoft Document Explorer) by click-
ing a command on the Help menu.

In Document Explorer, click the Options command on the Tools menu.

Click the Import And Export Settings command on the Tools menu, click
Reset All Settings and the Next button. Click Yes, Save My Current Settings,
and the Next button. Finally click Visual Basic Development Settings and the
Finish button, and then click Close.

Click the Options command on the Tools menu, and then customize Visual
Studio settings by category. To view and customize project settings, click the
General item in the Projects And Solutions category. To view and customize
compiler settings, click the VB Defaults item in the same category.

On the File menu, click Exit.






Chapter 2
Writing Your First Program

After completing this chapter, you will be able to:

Create the user interface for a new program.

Set the properties for each object in your user interface.
Write program code.

Save and run the program.

Build an executable file.

As you learned in Chapter 1, “Exploring the Visual Studio Integrated Development Environment,”
the Microsoft Visual Studio 2008 Integrated Development Environment (IDE) contains several
powerful tools to help you run and manage your programs. Visual Studio also contains every-
thing you need to build your own applications for Windows and the Web from the ground up.

In this chapter, you'll learn how to create a simple but attractive user interface with the con-
trols in the Visual Studio Toolbox. Next you'll learn how to customize the operation of these
controls with property settings. Then you'll see how to identify just what your program should
do by writing program code. Finally, you'll learn how to save and run your new program (a Las
Vegas-style slot machine) and how to compile it as an executable file.

Lucky Seven: Your First Visual Basic Program

The Windows-based application you're going to construct is Lucky Seven, a game program
that simulates a lucky number slot machine. Lucky Seven has a simple user interface and can
be created and compiled in just a few minutes using Microsoft Visual Basic. Here's what your
program will look like when it's finished:

o5 Forml [E=H o8 (=T

| Spin |

7 < S

End

Lucky Seven

37
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Programming Steps

The Lucky Seven user interface contains two buttons, three lucky number boxes, a digital
photo depicting your winnings, and the label “Lucky Seven.” | produced these elements

by creating seven objects on the Lucky Seven form and then changing several properties
for each object. After | designed the interface, | added program code for the Spin and End
buttons to process the user’s button clicks and produce the random numbers. To re-create
Lucky Seven, you'll follow three essential programming steps in Visual Basic: Create the user
interface, set the properties, and write the program code. The following table shows the
process for Lucky Seven.

Programming step Number of items
1. Create the user interface. 7 objects

2. Set the properties. 13 properties

3. Write the program code. 2 objects

Creating the User Interface

In this exercise, you'll start building Lucky Seven by first creating a new project and then
using controls in the Toolbox to construct the user interface.

Create a new project

1. Start Visual Studio 2008.

2. On the Visual Studio File menu, click New Project.

Tip You can also start a new programming project by clicking the blue Project link to the
right of Create at the bottom of the Recent Projects pane on the Start Page.

The New Project dialog box opens.
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Mew Project 7 ==
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The New Project dialog box provides access to the major project types available for
writing Windows applications. If you indicated during setup that you are a Visual Basic
programmer, Visual Basic is your primary development option (as shown here), but
the other languages in Visual Studio (Visual C# and C++) are always available through
this dialog box. Although you will select a basic Windows application project in this
exercise, this dialog box is also the gateway to other types of development projects,
such as a Web application, console application, smart device (Microsoft NET Compact
Framework) application, or Visual Studio deployment project.

In the upper-right corner of the New Project dialog box, you will notice a drop-down list
box. This is a new feature of Visual Studio 2008 that is called multi-targeting. This drop-
down list allows you specify the version of the .NET Framework that your application will
target. For example, if you select .NET Framework 3.5, any computer that your applica-
tion will run on must have the .NET Framework 3.5 installed. Visual Studio will show only
options that will work with the selected version of the .NET Framework. Applications
created with Visual Basic 2005 all targeted the .NET Framework 2.0. If you upgrade
programs created in Visual Basic 2005 to Visual Basic 2008, they will continue to target
the .NET Framework 2.0. Unless you have a specific need, you can just leave this drop-
down list at its default setting of .NET Framework 3.5. You'll learn more about the .NET
Framework in Chapter 5, “Visual Basic Variables and Formulas, and the .NET Framework.”
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3. Click the Windows Forms Application icon in the Templates area of the dialog box, if it
is not already selected.

Visual Studio prepares the development environment for Visual Basic Windows
application programming.

4. In the Name text box, type MyLucky7.

Visual Studio assigns the name MyLucky7 to your project. (You'll specify a folder loca-
tion for the project later.) I'm recommending the “My" prefix here so you don't confuse
your new application with the Lucky7 project I've created for you on disk.

Q Tip If your New Project dialog box contains Location and Solution Name text boxes, you
need to specify a folder location and solution name for your new programming project now.
The presence of these text boxes is controlled by a check box in the Tools/Options dialog
box, but it is not the default setting. Throughout this book, you will be instructed to save
your projects (or discard them) after you have completed the programming exercise. For
more information about this “"delayed saving” feature and default settings, see “Customizing
IDE Settings to Match Step-by-Step Exercises” in Chapter 1.

5. Click OK to create the new project in Visual Studio.

Visual Studio cleans the slate for a new programming project and displays the blank
Windows form that you will use to build your user interface.

Now you'll enlarge the form and create the two buttons in the interface.

Create the user interface

1. Point to the lower-right corner of the form until the mouse pointer changes to a
resizing pointer, and then drag to increase the size of the form to make room for
the objects in your program.

As you resize the form, scroll bars might appear in the Designer to give you access to
the entire form you're creating. Depending on your screen resolution and the Visual
Studio tools you have open, you might not be able to see the entire form at once.
Don't worry about this—your form can be small or it can fill the entire screen because
the scroll bars give you access to the entire form.
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Size your form so that it is about the size of the form shown here. If you want to match
my example exactly, you can use the width and height dimensions (485 pixels x 278
pixels) shown in the lower-right corner of the screen.
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To see the entire form without obstruction, you can resize or close the other program-
ming tools, as you learned in Chapter 1. (Return to Chapter 1 if you have questions
about resizing windows or tools.)

Now you'll practice adding a button object on the form.
Click the Toolbox tab to display the Toolbox window in the IDE.

The Toolbox contains all of the controls that you'll use to build Visual Basic programs in
this book. The controls suitable for creating a Windows application are visible now be-
cause you selected the Windows Application project type earlier. Controls are organized
by type, and by default the Common Controls category is visible. (If the Toolbox is not
visible now, click Toolbox on the View menu to display it.)
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3. Double-click the Button control in the Toolbox, and then move the mouse pointer away
from the Toolbox.

Visual Studio creates a default-sized button object on the form and hides the Toolbox,
as shown here:

The button is named Buttonl because it is the first button in the program. (You should make a
mental note of this button name—you'll see it again when you write your program code.) The
new button object is selected and enclosed by resize handles. When Visual Basic is in design
mode (that is, whenever the Visual Studio IDE is active), you can move objects on the form by
dragging them with the mouse, and you can resize them by using the resize handles. While a
program is running, however, the user can't move interface elements unless you've changed a
property in the program to allow this. You'll practice moving and resizing the button now.

Move and resize a button

1. Point to the button so that the pointer changes to a four-headed arrow, and then drag
the button down and to the right.

The button moves across the surface of the form. If you move the object near the edge of
the form or another object (if other objects are present), it automatically aligns itself to a
hidden grid when it is an inch or so away. A little blue “snapline” also appears to help you
gauge the distance of this object from the edge of the form or the other object. The grid
is not displayed on the form by default, but you can use the snapline to judge distances
with almost the same effect.

Q Tip If you want to display the design mode grid as in Microsoft Visual Studio .NET 2003
and Visual Basic 6, click the Options command on the Tools menu, expand Windows
Form Designer, and then click General. Set ShowGrid to True, and set LayOutMode to
SnapToGrid. You will need to close and reopen the form for the change to take effect.
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Position the mouse pointer on the lower-right corner of the button.

When the mouse pointer rests on a resize handle of a selected object, it becomes a
resizing pointer. You can use the resizing pointer to change the size of an object.

Enlarge the button by dragging the pointer down and to the right.
When you release the mouse button, the button changes size and snaps to the grid.

Use the resizing pointer to return the button to its original size.

Now you'll add a second button to the form, below the first button.

Add a second button

1.
2.

O

Click the Toolbox tab to display the Toolbox.

Click the Button control in the Toolbox (single-click this time), and then move the
mouse pointer over the form.

The mouse pointer changes to crosshairs and a button icon. The crosshairs are designed
to help you draw the rectangular shape of the button on the form, and you can use this
method as an alternative to double-clicking to create a control of the default size.

Drag the pointer down and to the right. Release the mouse button to complete the
button, and watch it snap to the form.

Resize the button object so that it is the same size as the first button, and then move it
below the first button on the form. (Use the snapline feature to help you.)

Tip At any time, you can delete an object and start over again by selecting the object
on the form and then pressing Delete. Feel free to create and delete objects to practice
creating your user interface.

Now you'll add the labels used to display the numbers in the program. A label is a special
user interface element designed to display text, numbers, or symbols when a program runs.
When the user clicks the Lucky Seven program’s Spin button, three random numbers appear
in the label boxes. If one of the numbers is a 7, the user wins.

Add the number labels

1.

Double-click the Label control in the Toolbox.

Visual Studio creates a label object on the form. If you're familiar with earlier versions
of Visual Studio or Visual Basic, you'll notice that the label object is smaller than in
previous versions by default. It is just large enough to hold the text contained in the
object, but it can also be resized.
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2. Drag the Labell object to the right of the two button objects.

Your form looks something like this:

o5 Forml [l ]

[ Butoml | bl

| Button2 |

. Double-click the Label control in the Toolbox to create a second label object.
This label object will be named Label2 in the program.

. Double-click the Label control again to create a third label object.

. Move the second and third label objects to the right of the first one on the form.

Allow plenty of space between the three labels because you will use them to display
large numbers when the program runs.

Now you'll use the Label control to add a descriptive label to your form. This will be the
fourth and final label in the program.

. Double-click the Label control in the Toolbox.

. Drag the Label4 object below the two command buttons.

When you've finished, your four labels should look like those in the following illustration.
(You can move your label objects if they don't look quite right.)

2 Farml =) E | =)

Label Label2 Label3

| Buttari

| Button2

o-
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Now you'll add a picture box to the form to graphically display the payout you'll receive
when you draw a 7 and hit the jackpot. A picture box is designed to display bitmaps, icons,
digital photos, and other artwork in a program. One of the best uses for a picture box is to
display a JPEG image file.

Add a picture

1. Click the PictureBox control in the Toolbox.

2. Using the control’s drawing pointer, create a large rectangular box below the second
and third labels on the form.

Leave a little space below the labels for their size to grow as | mentioned earlier. When
you've finished, your picture box object looks similar to this:

o5 Forml E=H|ED] |@

| Buttar Label Label2 Label3

| Button2

Labeld

This object will be named PictureBox1 in your program; you'll use this name later in the
program code.

Now you're ready to customize your interface by setting a few properties.

Setting the Properties

As you discovered in Chapter 1, you can change properties by selecting objects on the form
and changing their settings in the Properties window. You'll start by changing the property
settings for the two buttons.

Set the button properties

1. Click the first button (Buttonl) on the form.

The button is selected and is surrounded by resize handles.
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2. Click the Properties window title bar.

O

Tip If the Properties window isn't visible, click the Properties Window command on the
View menu, or press F4.

3. A the top of the Properties window, click the Categorized button.

For information about categorized properties, see “The Properties Window" in Chapter 1.

Resize the Properties window (if necessary) so that there is plenty of room to see the
property names and their current settings.

Once you get used to setting properties, you will probably use the Properties win-
dow without enlarging it, but making it bigger helps when you first try to use it. The
Properties window in the following illustration is a good size for setting properties:

Properties &l
Buttonl Systernindows.Forms. Button -
=21 ||E | 7
BackgroundImagelayout Tile e
Cursar Default

]

Flat&ppearance

FlatStyle Standard =
Fant Microsoft Sans Serif, 8.25p

FareColar - ControlText

Image I:l {none)

Imagedlign MiddleCenter

Imagelndex I:l {none)

Imagekey I:l (hone)

Imagelist {none)

RightToleft Mo

Buttonl |Z|

Textdlign MiddleCenter -

Text

The text associated with the contral,

The Properties window lists the settings for the first button. These include settings for
the background color, text, font height, and width of the button. Because there are so
many properties, Visual Studio organizes them into categories and displays them in
outline view. If you want to see the properties in a category, click the plus sign (+) next
to the category title.

Scroll in the Properties window until you see the Text property located in the
Appearance category.

6. Double-click the Text property in the left column of the Properties window.
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The current Text setting ("Buttonl”) is highlighted in the Properties window.
7. Type Spin, and press Enter.

The Text property changes to “Spin” in the Properties window and on the button on
the form. Now you'll change the Text property of the second button to “End”. (You'll
select the second button in a new way this time.)

8. Open the Object list at the top of the Properties window.

A list of the interface objects in your program appears as follows:

Properties

Button2 Systern.\Windows.Forms.Button

Form1 Systemifindows. Forms.Form

Labell Systemifindows. Forms.Label

Label2 Systemifindows, Forms.Label

Label3 Systemdifindows. Forms.Label

Labeld System\ifindows, Forms.Label
PictureBox1 Systern.iindows Forms PictureBox

Image [T tnane)

Imagedlign MiddleCenter

Imagelndex I:l {none)

Imagekey I:l (hone)

Imagelist {none)

RightToleft Mo

Text Spin

Textdlign MiddleCenter -
Text

The text associated with the contral,

9. Click Button2 System.Windows.Forms.Button (the second button) in the list box.

The property settings for the second button appear in the Properties window, and
Visual Studio highlights Button2 on the form.

10. Double-click the current Text property ("Button2”), type End, and then press Enter.

The text of the second button changes to “End".

Tip Using the Object list is a handy way to switch between objects in your program. You
can also switch between objects on the form by clicking each object.

Now you'll set the properties for the labels in the program. The first three labels will hold the
random numbers generated by the program and will have identical property settings. (You'll
set most of them as a group.) The descriptive label settings will be slightly different.
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Set the number label properties

1.

Click the first number label (Labell), hold down the Shift key, click the second and third
number labels, and then release the Shift key. (If the Properties window is in the way,
move it to a new place.)

A selection rectangle and resize handles appear around each label you click. You'll
change the TextAlign, BorderStyle, and Font properties now so that the numbers that
will appear in the labels will be centered, boxed, and identical in font and font size. (All
of these properties are located in the Appearance category of the Properties window.)
You'll also set the AutoSize property to False so that you can change the size of the labels
according to your precise specifications. (The AutoSize property is located in the Layout
category.)

Tip When more than one object is selected, only those properties that can be changed
for the group are displayed in the Properties window.

Click the AutoSize property in the Properties window, and then click the arrow that
appears to the right.

Set the AutoSize property to False so that you can size the labels manually.
Click the TextAlign property, and then click the arrow that appears to the right.

A graphical assortment of alignment options appears in the list box; you can use these
settings to align text anywhere within the borders of the label object.

Click the center option (MiddleCenter).

The TextAlign property for each of the selected labels changes to MiddleCenter.

. Click the BorderStyle property, and then click the arrow that appears to the right.

The valid property settings (None, FixedSingle, and Fixed3D) appear in the list box.
Click FixedSingle in the list box to add a thin border around each label.

Click the Font property, and then click the ellipsis button (the button with three dots
that's located next to the current font setting).

The Font dialog box opens.

Change the font to Times New Roman, the font style to Bold, and the font size to 24,
and then click OK.

The label text appears in the font, style, and size you specified.
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Now you'll set the text for the three labels to the number 0—a good “placeholder” for
the numbers that will eventually fill these boxes in your game. (Because the program
produces the actual numbers, you could also delete the text, but putting a placeholder
here gives you something to base the size of the labels on.)

Click a blank area on the form to remove the selection from the three labels, and
then click the first label.

Double-click the Text property, type 0, and then press Enter.

The text of the Labell object is set to 0. You'll use program code to set this property to
a random “slot machine” number later in this chapter.

Change the text in the second and third labels on the form to 0 also.
Move and resize the labels now so that they are appropriately spaced.

Your form looks something like this:

a5 Forml

Spin

End

—
—

Labeld

Now you'll change the Text, Font, and ForeColor properties of the fourth label.

Set the descriptive label properties

1.

2
3.
4

Click the fourth label object (Label4) on the form.

. Change the Text property in the Properties window to Lucky Seven.

Click the Font property, and then click the ellipsis button.

. Use the Font dialog box to change the font to Arial, the font style to Bold, and the font

size to 18. Then click OK.

The font in the Label4 object is updated, and the label is resized automatically to hold
the larger font size because the object’s AutoSize property is set to True.
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5. Click the ForeColor property in the Properties window, and then click the arrow in the

second column.

Visual Studio displays a list box with Custom, Web, and System tabs for setting the

foreground colors (the color of text) of the label object. The Custom tab offers many of
the colors available in your system. The Web tab sets colors for Web pages and lets you
pick colors using their common names. The System tab displays the current colors used

for user interface elements in your system.
6. Click the purple color on the Custom tab.
The text in the label box changes to purple.

Now you're ready to set the properties for the last object.

Reading Properties in Tables

In this chapter, you've set the properties for the Lucky Seven program step by

step. In future chapters, the instructions to set properties will be presented in table
format unless a setting is especially tricky. Here are the properties you've set so far in
the Lucky Seven program in table format, as they'd look later in the book. Settings you
need to type in are shown in quotation marks. You shouldn't type the quotation marks.

Object Property
Buttonl Text
Button2 Text
Labell, Label2, Label3 AutoSize
BorderStyle
Font
Text
TextAlign
Label4 Text
Font
ForeColor
PictureBox1 Image
SizeMode

Visible

Setting

“Spin”

"End”

False

FixedSingle

Times New Roman, Bold, 24-point
o

MiddleCenter

“Lucky Seven”

Arial, Bold, 18-point

Purple
"c:\vb08sbs\chap02\paycoins.jpg”
Stretchimage

False
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The Picture Box Properties

When the person playing your game hits the jackpot (that is, when at least one 7 appears

in the number labels on the form), the picture box object will contain a picture of a person
dispensing money. This picture is a digitized image from an unpublished fourteenth-century
German manuscript stored in JPEG format. (As a history professor, | run across these things.)
You need to set the SizeMode property to accurately size the picture and set the Image
property to specify the name of the JPEG file that you will load into the picture box. You
also need to set the Visible property, which specifies the picture state at the beginning of
the program.

Set the picture box properties

1.
2.

Click the picture box object on the form.

Click the SizeMode property in the Properties window (listed in the Behavior
category), click the arrow to the right, and then click Stretchimage.

Setting SizeMode to Stretchlmage before you open a graphic causes Visual Studio to
resize the graphic to the exact dimensions of the picture box. (Typically, you set this
property before you set the Image property.)

Click the Image property in the Properties window, and then click the ellipsis button in
the second column.

The Select Resource dialog box opens.

Click the Local Resource option, and then click the Import button.
In the Open dialog box, navigate to the c:\vb08sbs\chap02 folder.
This folder contains the digital photo PayCoins.jpg.

Select PayCoins.jpg, and then click Open.
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A medieval illustration of one person paying another appears in the Select Resource
dialog box. (The letter "W" represents winning.)

Select Resource

Resource context

@ Local resource:

Impaortt.. | | Clear

1 Project resource file:
Resources.resx

[N

| Ok ‘ | Cancel

Click OK.

The PayCoins photo is loaded into the picture box. Because the photo is relatively small
(24 KB), it opens quickly on the form.

Resize the picture box object now to fix any distortion problems that you see in the
image.

| sized my picture box object to be 148 pixels wide by 143 pixels high. You can match
this size by using the width and height dimensions located on the lower-right side of
the Visual Studio IDE. (The dimensions of the selected object are given on the lower-
right side, and the location on the form of the object’s upper-left corner is given to
the left of the dimensions.)

This particular image displays best when the picture box object retains a square shape.

Note Asyou look at the picture box object, you might notice a tiny shortcut arrow near
its upper-right corner. This arrow is a button that you can click to quickly change a few
common picture box settings and open the Select Resource dialog box. (You'll see the
shortcut arrow again in Chapter 4, "Working with Menus, Toolbars, and Dialog Boxes,”
when you use the ToolStrip control.)

Now you'll change the Visible property to False so that the image will be invisible when
the program starts.

Click the Visible property in the Behavior category of the Properties window, and
then click the arrow to the right.
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The valid settings for the Visible property appear in a list box.
10. Click False to make the picture invisible when the program starts.

Setting the Visible property to False affects the picture box when the program runs, but
not now while you're designing it. Your completed form looks similar to this:

-

a5 Forml = IraEirEs]

| Spin |

| End 0 0 0

Lucky Seven

Tip You can also double-click property names that have True and False settings (so-called
Boolean properties), to toggle back and forth between True and False. Default Boolean
properties are shown in regular type, and changed settings appear in bold.

11. You are done setting properties for now, so if your Properties window is floating,
double-click its title bar to return it to the docked position.

Writing the Code

Now you're ready to write the code for the Lucky Seven program. Because most of the
objects you've created already "know” how to work when the program runs, they're ready
to receive input from the user and process it. The inherent functionality of objects is one
of the great strengths of Visual Studio and Visual Basic—after objects are placed on a form
and their properties are set, they're ready to run without any additional programming.
However, the “meat” of the Lucky Seven game—the code that actually calculates random
numbers, displays them in boxes, and detects a jackpot—is still missing from the program.
This computing logic can be built into the application only by using program statements—
code that clearly spells out what the program should do at each step of the way. Because
the Spin and End buttons drive the program, you'll associate the code for the game with
those buttons. You enter and edit Visual Basic program statements in the Code Editor.

In the following steps, you'll enter the program code for Lucky Seven in the Code Editor.
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Use the Code Editor

1.

Double-click the End button on the form.

The Code Editor appears as a tabbed document window in the center of the Visual
Studio IDE, as shown here:

[ LurkyT - Microsoft Wisusl Studin = el
Ele Edit Wiew Project DBuild Debug Date Tocl Tegt MWindow Help
enic W= R ™ - N e =29 -0 b SEE |G AR BEL
FormL.vb*| Formiub [Design]* | Start Fage « X | Selution Explarer LB x
¥ Button? - 7 Click C=2 2E EE &
O Puslic Class Formi | Ludky?
S B My Project
L. B Formlub

Private 3ub ButtonZ_Click(ByVal sender is $ystem.cbject, Byval

End Sub
End Class

= ._-;Sn\utiun Explo..., _‘jData Sources
Properties ~ 1 x
Button2 Click Attributes -

5= &)

4 T »

Ready Ln4 Cold Chg NS

Inside the Code Editor are program statements associated with the current form.
Program statements that are used together to perform some action are typically
grouped in a programming construct called a procedure. A common type of proce-
dure is a Sub procedure, sometimes called a subroutine. Sub procedures include a Sub
keyword in the first line and end with End Sub. Procedures are typically executed when
certain events occur, such as when a button is clicked. When a procedure is associated
with a particular object and an event, it is called an event handler or an event procedure.

When you double-clicked the End button (Button?2), Visual Studio automatically added
the first and last lines of the Button2_Click event procedure, as the following code shows.
(The first line was wrapped to stay within the book margins.) You may notice other bits
of code in the Code Editor (words like Public and Class), which Visual Studio has added
to define important characteristics of the form, but | won't emphasize them here.

Private Sub Button2_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button2.Click

End Sub
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The body of a procedure fits between these lines and is executed whenever a user ac-
tivates the interface element associated with the procedure. In this case, the event is a
mouse click, but as you'll see later in the book, it could also be a different type of event.

2. Type End, and then press the Enter key.

When you type the statement, Visual Studio recognizes End as a unique reserved
word or keyword and displays it in a list box with Common and All tabs. This list box
is called IntelliSense because it tries to intelligently help you write code, and you can
browse through various Visual Basic keywords and objects alphabetically. (In this way,
the language is partially discoverable through the IDE itself.)

After you press the Enter key, the letters in End turn blue and are indented, indicating
that Visual Basic recognizes End as one of several hundred unique keywords within the
Visual Basic language. You use the End keyword to stop your program and remove it
from the screen. In this case, End is also a complete program statement, a self-contained
instruction executed by the Visual Basic compiler, the part of Visual Studio that processes
or parses each line of Visual Basic source code, combining the result with other resources
to create an executable file. Program statements are a little like complete sentences in

a human language—statements can be of varying lengths but must follow the gram-
matical “rules” of the compiler. In Visual Studio, program statements can be composed
of keywords, properties, object names, variables, numbers, special symbols, and other
values. You'll learn more about how program statements are constructed in Chapter 5.

As you enter program statements and make other edits, the Code Editor handles many
of the formatting details for you, including adjusting indentation and spacing and add-
ing any necessary parentheses. The exact spelling, order, and spacing of items within
program statements is referred to as statement syntax.

When you pressed the Enter key, the End statement was indented to set it apart from
the Private Sub and End Sub statements. This indenting scheme is one of the program-
ming conventions you'll see throughout this book to keep your programs clear and
readable. The group of conventions regarding how code is organized in a program is
often referred to as program style.

Now that you've written the code associated with the End button, you'll write code for the
Spin button. These program statements will be a little more extensive and will give you a
chance to learn more about statement syntax and program style. You'll study many of the
program statements later in this book, so you don't need to know everything about them
now. Just focus on the general structure of the code and on typing the program statements
exactly as they are printed.
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Write code for the Spin button

1. Click the View Designer button in the Solution Explorer window to display your form

again.

Note When the Code Editor is visible, you won't be able to see the form you're working
on. The View Designer button is one mechanism you can use to display it again. (If more
than one form is loaded in Solution Explorer, click the form you want to display first.) You
can also click the Form1l.vb [Design] tab at the top edge of the Code Editor. If you don't
see tabs at the top of the Code Editor, enable Tabbed Documents view in the Options
dialog box, as discussed in a Tip in Chapter 1.

Double-click the Spin button.

After a few moments, the Code Editor appears, and an event procedure associated with
the Buttonl button appears near the Button2 event procedure.

Although you changed the text of this button to “Spin”, its name in the program is still
Buttonl. (The name and the text of an interface element can be different to suit the
needs of the programmer.) Each object can have several procedures associated with
it, one for each event it recognizes. The click event is the one you're interested in now
because users will click the Spin and End buttons when they run the program.

. Type the following program lines between the Private Sub and End Sub statements.

Press Enter after each line, press Tab to indent, and take care to type the program
statements exactly as they appear here. (The Code Editor will scroll to the left as you
enter the longer lines.) If you make a mistake (usually identified by a jagged underline),
delete the incorrect statements and try again.

Tip Asyou enter the program code, Visual Basic formats the text and displays different
parts of the program in color to help you identify the various elements. When you begin
to type a property, Visual Basic also displays the available properties for the object you're
using in a list box, so you can double-click the property or keep typing to enter it yourself.
If Visual Basic displays an error message, you might have misspelled a program statement.
Check the line against the text in this book, make the necessary correction, and continue
typing. (You can also delete a line and type it from scratch.) In addition, Visual Basic might
add necessary code automatically. For example, when you type the following code, Visual
Basic automatically adds the End If line. Readers of previous editions of this book have
found this first typing exercise to be the toughest part of this chapter—"But Mr. Halvorson,
| know | typed it just as you wrote it!"—so please give this program code your closest
attention. | promise you, it works!
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numbers

is 7 display picture and beep
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When you've finished, the Code Editor looks as shown in the following graphic:
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4. Click the Save All command on the File menu to save your additions to the program.

The Save All command saves everything in your project—the project file, the form
file, any code modules, and other related components in your application. Since
this is the first time that you have saved your project, the Save Project dialog box
opens, prompting you for the name and location of the project. (If your copy of
Visual Studio is configured to prompt you for a location when you first create your
project, you won't see the Save Project dialog box now—Visual Studio just saves

your changes.)

5. Browse and select a location for your files.

| recommend that you use the c:\vb08sbs\chap02 folder (the location of the book’s
sample files), but the location is up to you. Since you used the “My" prefix when you
originally opened your project, this version won't overwrite the Lucky7 practice file

that | built for you on disk.

57
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6. Clear the Create Directory For Solution check box.

When this check box is selected, it creates a second folder for your program'’s solution
files, which is not necessary for solutions that contain only one project (the situation for
most programs in this book).

7. Click Save to save your files.

Note If you want to save just the item you are currently working on (the form, the code
module, or something else), you can use the Save command on the File menu. If you want
to save the current item with a different name, you can use the Save As command.

A Look at the Buttonl Click Procedure

The Button1_Click procedure is executed when the user clicks the Spin button on the form. The
procedure uses some pretty complicated statements, and because | haven't formally introduced
them yet, it might look a little confusing. However, if you take a closer look, you'll probably see

a few things that look familiar. Taking a peek at the contents of these procedures will give you a
feel for the type of program code you'll be creating later in this book. (If you'd rather not stop for
this preview, feel free to skip to the next section, “Running Visual Basic Applications.”)

The Button1_Click procedure performs three tasks:

B [t hides the digital photo.
B |t creates three random numbers for the number labels.
B |t displays the photo when the number 7 appears.

Let's look at each of these steps individually.

Hiding the photo is accomplished with the following line:
PictureBoxl.Visible = False ' hide picture

This line is made up of two parts: a program statement and a comment.

The PictureBox1.Visible = False program statement sets the Visible property of the picture
box object (PictureBox1) to False (one of two possible settings). You might remember that
you set this property to False once before by using the Properties window. You're doing it
again now in the program code because the first task is a spin and you need to clear away
a photo that might have been displayed in a previous game. Because the property will

be changed at run time and not at design time, you must set the property by using pro-
gram code. This is a handy feature of Visual Basic, and I'll talk about it more in Chapter 3,
“Working with Toolbox Controls.”
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The second part of the first line (the part displayed in green type on your screen) is called
a comment. Comments are explanatory notes included in program code following a single
quotation mark ('). Programmers use comments to describe how important statements
work in a program. These notes aren't processed by Visual Basic when the program runs;
they exist only to document what the program does. You'll want to use comments often
when you write Visual Basic programs to leave an easy-to-understand record of what
you're doing.

The next three lines handle the random number computations. Does this concept sound
strange? You can actually make Visual Basic generate unpredictable numbers within specific
guidelines—in other words, you can create random numbers for lottery contests, dice games,
or other statistical patterns. The Rnd function in each line creates a random number between
0 and 1 (a number with a decimal point and several decimal places), and the Int function
returns the integer portion of the result of multiplying the random number by 10. This com-
putation creates random numbers between 0 and 9 in the program—just what you need for
this particular slot machine application.

Labell.Text = CStr(Int(Rnd() * 10)) ' pick numbers

You then need to jump through a little hoop in your code. You need to copy these random
numbers into the three label boxes on the form, but first the numbers need to be converted
to text with the CStr (convert to string) function. Notice how CStr, Int, and Rnd are all con-
nected together in the program statement—they work collectively to produce a result like a
mathematical formula. After the computation and conversion, the values are assigned to the
Text properties of the first three labels on the form, and the assignment causes the numbers
to be displayed in bold, 24-point, Times New Roman font in the three number labels.

The following illustration shows how Visual Basic evaluates one line of code step by step
to generate the random number 7 and copy it to a label object. Visual Basic evaluates the
expression just like a mathematician solving a mathematical formula.

Graphic 2-15

Exarmple:
Labell. Text = CStrilnt(Rnd() * 100

Code Result
Rnd() 0.7055475
Rnd() =10 7.055475
Int(Rnd() * 10 7
CStr(int(Rnd() = 107 i

Labell.Text = CStrint(Rnd() * 105 7
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The last group of statements in the program checks whether any of the random numbers is 7.
If one or more of them is, the program displays the medieval manuscript depiction of a pay-
out, and a beep announces the winnings.

' if any number is 7 display picture and beep
If (Labell.Text = "7") Or (Label2.Text = "7") _
Or (Label3.Text = "7") Then

PictureBox1l.Visible = True

Beep()
End If

Each time the user clicks the Spin button, the ButtonI_Click procedure is executed, or called,
and the program statements in the procedure are run again.

Running Visual Basic Applications

Congratulations! You're ready to run your first real program. To run a Visual Basic program
from the development environment, you can do any of the following:

B Click Start Debugging on the Debug menu.
B Click the Start Debugging button on the Standard toolbar.
B Press F5.

Try running your Lucky Seven program now. If Visual Basic displays an error message, you
might have a typing mistake or two in your program code. Try to fix it by comparing the
printed version in this book with the one you typed, or load Lucky7 from your hard disk
and run it.

Run the Lucky Seven program

1. Click the Start Debugging button on the Standard toolbar.

The Lucky Seven program compiles and runs in the IDE. After a few seconds, the user
interface appears, just as you designed it.

2. Click the Spin button.

The program picks three random numbers and displays them in the labels on the form,
as follows:
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o Farml =[5 | R
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| End 7 5 5

Lucky Seven

Because a 7 appears in the first label box, the digital photo depicting the payoff appears,
and the computer beeps. You win! (The sound you hear depends on your Default Beep
setting in the Sound Control Panel. To make this game sound really cool, change the
Default Beep sound to something more dynamic.)

. Click the Spin button 15 or 16 more times, watching the results of the spins in the
number boxes.

About half the time you spin, you hit the jackpot—pretty easy odds. (The actual odds
are about 2.8 times out of 10; you're just lucky at first.) Later on you might want to
make the game tougher by displaying the photo only when two or three 7s appear,
or by creating a running total of winnings.

. When you've finished experimenting with your new creation, click the End button.

The program stops, and the development environment reappears on your screen.

Tip If you run this program again, you might notice that Lucky Seven displays exactly
the same sequence of random numbers. There is nothing wrong here—the Visual Basic
Rnd function was designed to display a repeating sequence of numbers at first so that
you can properly test your code using output that can be reproduced again and again.
To create truly “random” numbers, use the Randomize function in your code, as shown
in the exercise at the end of this chapter. The .NET Framework, which you'll learn to use
later, also supplies random number functions.
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Sample Projects on Disk

If you didn't build the MyLucky7 project from scratch (or if you did build the project and want
to compare what you created to what | built for you as | wrote the chapter), take a moment to
open and run the completed Lucky7 project, which is located in the c:\vb08sbs\chap02\lucky7
folder on your hard disk (the default location for the practice files for this chapter). If you need
a refresher course on opening projects, see the detailed instructions in Chapter 1. If you are
asked if you want to save changes to the MyLucky7 project, be sure to click Save.

This book is a step-by-step tutorial, so you will benefit most from building the projects on your
own and experimenting with them. But after you have completed the projects, it is often a
good idea to compare what you have with the practice file “solution” that | provide, especially
if you run into trouble. To make this easy, | will give you the name of the solution files on disk
before you run the completed program in most of the step-by-step exercises.

After you have compared the MyLucky7 project to the Lucky7 solution files on disk, re-open
MyLucky7, and prepare to compile it as an executable file. If you didn’t create MyLucky7, use
my solution file to complete the exercise.

Building an Executable File

Your last task in this chapter is to complete the development process and create an appli-
cation for Windows, or an executable file. Windows applications created with Visual Studio
have the file name extension .exe and can be run on any system that contains Windows
and the necessary support files. (Visual Basic installs these support files—including the .NET
Framework files—automatically.) If you plan to distribute your applications, see “Deploying
Your Application” later in the chapter.

At this point, you need to know that Visual Studio can create two types of executable files for
your project: a debug build and a release build.

Debug builds are created automatically by Visual Studio when you create and test your
program. They are stored in a folder called bin\debug within your project folder. The debug
executable file contains debugging information that makes the program run slightly slower.

Release builds are optimized executable files stored in the bin\release folder within your
project. To customize the settings for your release build, you click the [ProjectName]
Properties command on the Project menu, and then click the Compile tab, where you
see a list of compilation options that looks like this:



Try creating a release build named MyLucky7.exe now.

Create an executable file
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4.

On the Build menu, click the Build MyLucky7 command.

The Build command creates a bin\release folder in which to store your project (if the
folder doesn't already exist) and compiles the source code in your project. The result is
an executable file named MyLucky7.exe. To save you time, Visual Studio often creates
temporary executable files while you develop your application; however, it's always a
good idea to recompile your application manually with the Build or Rebuild commands
when you reach an important milestone.

Try running this program outside the Visual Studio IDE now from the Windows Start
menu.

On the Windows taskbar, click Start.
The next command depends on the version of Windows you're using.

If you have Windows Vista, type run in the Search text box and press Enter to open
the Run dialog box. If you have Windows XP or earlier, click the Run command to
open the Run dialog box.

Click Browse and then navigate to the c:\vb08sbs\chap02\mylucky7\bin\release folder.
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5. Click the MyLucky7.exe application icon, click Open, and then click OK.

The Lucky Seven program loads and runs in Windows. Because this is a simple test
application and it does not possess a formal publisher certificate that emphasizes its
reliability or authenticity, you may see the following message: “The publisher could
not be verified. Are you sure you want to run this software?” If this happens to you,
click Yes to run the program anyway. (Creating such certificates is beyond the scope
of this book, but this program is quite safe.)

6. Click Spin a few times to verify the operation of the game, and then click End.

Q Tip You can also run Windows applications, including compiled Visual Basic programs, by
opening Windows Explorer and double-clicking the executable file. To create a shortcut
icon for MyLucky7.exe on the Windows desktop, right-click the Windows desktop, point
to New, and then click Shortcut. When you're prompted for the location of your applica-
tion file, click Browse, and select the MyLucky7.exe executable file. Click the OK, Next, and
Finish buttons. Windows places an icon on the desktop that you can double-click to run
your program.

7. On the File menu, click Exit to close Visual Studio and the MyLucky7 project.

The Visual Studio development environment closes.

Deploying Your Application

Visual Studio helps you distribute your Visual Basic applications by providing several options
for deployment—that is, for installing the application on one or more computer systems.
Whereas Visual Basic 6 requires a sophisticated setup program that copies dynamic-link
libraries (DLLs) and support files and registers the application with the operating system,
Visual Studio 2008 applications are compiled as assemblies—deployment units consisting

of one or more files necessary for the program to run. Assemblies contain four elements:
Microsoft intermediate language (MSIL) code, metadata, a manifest, and supporting files
and resources.

Assemblies are so comprehensive and self-describing that Visual Studio applications don't
need to be formally registered with the operating system to run. This means that theoretically
a Visual Basic 2008 application can be installed by simply copying the assembly for the pro-
gram to a second computer that has the correct version of the .NET Framework installed—a
process called XCOPY installation, after the MS-DOS XCOPY command that copies a complete
directory (folder) structure from one location to another. In practice, however, it isn't practical
to deploy Visual Basic applications by using a copy procedure such as XCOPY (via the com-
mand prompt) or Windows Explorer. For commercial applications, an installation program
with a graphical user interface is usually preferred, and it's often desirable to register the pro-
gram with the operating system so that it can be uninstalled later by using Control Panel.
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Although the advanced options related to deployment and security go beyond the scope of
this book, you should be familiar with your deployment options. To manage the deployment
process, Visual Studio 2008 supports two deployment technologies, ClickOnce and Windows
Installer.

With ClickOnce you can create an installation service for desktop applications that users can
access on their own with minimal interaction. With ClickOnce you can specify prerequisites,
such as the .NET Framework, and you can easily publish updates as you make improvements
to your program. You can publish your program to a Web server or a file server. You can get
started with ClickOnce at any time by using the Publish command on the Build menu. You can
also specify ClickOnce settings by using the Properties command on the Project menu. You
specify ClickOnce settings on the Publish tab of the Project Designer.

Windows Installer is a more classic installation process. In Visual Studio, you add a setup or
a Windows Installer project to your solution, which automatically creates a setup program
for the application. This setup project can be customized to allow for different methods

of installation, such as from CD-ROMs or Web servers. You can get started with Windows
Installer by using the New Project command on the File menu to create a custom setup
project. (Select the Setup And Deployment option under Other Project Types to see a list
of setup templates and wizards.)

One Step Further: Adding to a Program

You can restart Visual Studio at any time and work on a programming project you've stored
on disk. You'll restart Visual Studio now and add a Randomize statement to the Lucky Seven
program.

Reload Lucky Seven

1. On the Windows taskbar, click Start, click All Programs, click Microsoft Visual Studio
2008, and then click the Microsoft Visual Studio 2008 program icon.

A list of the projects that you've most recently worked on appears on the Visual Studio
Start Page in the Recent Project pane. Because you just finished working with Lucky
Seven, the MyLucky7 project should be first on the list.

2. Click the MyLucky7 link to open the Lucky Seven project.

The Lucky Seven program opens, and the MyLucky7 form appears. (If you don't see the
form, click Form1.vb in Solution Explorer, and then click the View Designer button.)

Now you'll add the Randomize statement to the Form_Load procedure, a special
procedure that is associated with the form and that is executed each time the pro-
gram is started.
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3. Double-click the form (not one of the objects) to display the Form_Load procedure.

The Form_Load procedure appears in the Code Editor, as shown here:
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4. Type Randomize, and then press Enter.

The Randomize statement is added to the program and will be executed each time
the program starts. Randomize uses the system clock to create a truly random starting
point, or seed, for the Rnd statement used in the Button1_Click procedure. As | men-
tioned earlier, without the Randomize statement, the Lucky Seven program produces
the same string of random spins every time you restart the program. With Randomize
in place, the program spins randomly every time it runs, and the numbers don't follow
a recognizable pattern.

5. Run the new version of Lucky Seven, and then save the project. If you plan to use the
new version a lot, you might want to create a new .exe file, too.

6. When you're finished, click Close Project on the File menu.

The files associated with the Lucky Seven program are closed.
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Chapter 2 Quick Reference

Do this

Use Toolbox controls to place objects on your form, and then set the
necessary properties. Resize the form and the objects as appropriate.
Point to the object, and when a four-headed arrow appears, drag the object.
Click the object to select it, and then drag the resize handle attached to the
part of the object you want to resize.

Click the object, and then press the Delete key.

Double-click an object on the form (or the form itself).

or

Select a form or a module in Solution Explorer, and then click the View Code
button.

Type Visual Basic program statements associated with objects in the Code
Editor.

On the File menu, click the Save All command.

or

Click the Save All button on the Standard toolbar.

Make sure the form is open, and then on the File menu, click the Save
command.

or

Click the Save button on the Standard toolbar.

On the Build menu, click the Build or Rebuild command.

Click the Publish command on the Build menu, and then use the Publish
wizard to specify the location and settings for the application.

On the File menu, click the Open Project command.

or

On the File menu, point to Recent Projects, and then click the desired
project.

or

Click the project in the recent projects list on the Visual Studio Start Page.






Chapter 3
Working with Toolbox Controls

After completing this chapter, you will be able to:
B Use TextBox and Button controls to create a Hello World program.
B Use the DateTimePicker control to display your birth date.
B Use CheckBox, RadioButton, ListBox, and ComboBox controls to process user input.

B Use the LinkLabel control and the Process.Start method to display a Web page by using
your system’s default browser.

As you learned in earlier chapters, Microsoft Visual Studio 2008 controls are the graphical
tools you use to build the user interface of a Microsoft Visual Basic program. Controls are
located in the development environment'’s Toolbox, and you use them to create objects on
a form with a simple series of mouse clicks and dragging motions.

Windows Forms controls are specifically designed for building Microsoft Windows applications,
and you'll find them organized on the All Windows Forms tab of the Toolbox, although many
of the controls are also accessible on tabs such as Common Controls, Containers, and Printing.
(You used a few of these controls in the previous chapter.) You'll learn about other controls, in-
cluding the tools you use to build database applications and Web pages, later in the book.

In this chapter, you'll learn how to display information in a text box, work with date and time
information on your system, process user input, and display a Web page within a Visual Basic
program. The exercises in this chapter will help you design your own Visual Basic applications
and will teach you more about objects, properties, and program code.

The Basic Use of Controls: The Hello World Program

A great tradition in introductory programming books is the Hello World program, which
demonstrates how the simplest utility can be built and run in a given programming lan-
guage. In the days of character-based programming, Hello World was usually a two-line or
three-line program typed in a program editor and assembled with a stand-alone compiler.
With the advent of complex operating systems and programming tools, however, the typical
Hello World has grown into a more sophisticated program containing dozens of lines and
requiring several programming tools for its construction. Fortunately, creating a Hello World
program is still quite simple with Visual Studio and Visual Basic 2008. You can construct a
complete user interface by creating two objects, setting two properties, and entering one
line of code. Give it a try.
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Create a Hello World program

1. Start Visual Studio 2008 if it isn't already open.
2. On the File menu, click New Project.

Visual Studio displays the New Project dialog box, which prompts you for the name of
your project and for the template that you want to use.

Note Use the following instructions each time you want to create a new project on your
hard disk.

3. Ensure that the Visual Basic project type and the Windows category are selected, and
then click the Windows Forms Application template.

These selections indicate that you'll be building a stand-alone Visual Basic application
that will run under Windows.

4. Remove the default project name (WindowsApplicationl) from the Name text box, and

then type MyHello.

Note Throughout this book, | ask you to create sample projects with the "“My" prefix,
to distinguish your own work from the practice files | include on the companion
CD-ROM. However, I'll usually show projects in the Solution Explorer without the
"My" prefix (because I've built the projects without it.)

The New Project dialog box now looks like this:
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5. Click OK to create your new project.
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The new project is created, and a blank form appears in the Designer, as shown in the
following illustration. The two controls you'll use in this exercise, Button and TextBox,

are visible in the Toolbox, which appears in the illustration as a docked window. If your
programming tools are configured differently, take a few moments to organize them as
shown in the illustration. (Chapter 1, "Exploring the Visual Studio Integrated Development
Environment,” describes how to configure the IDE if you need a refresher course.)
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6. Click the TextBox control on the Common Controls tab of the Toolbox.

7. Draw a text box similar to this:

- Farml =5 e =
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0 0

Text boxes are used to display text on a form or to get user input while a program is
running. How a text box works depends on how you set its properties and how you ref-
erence the text box in the program code. In this program, a text box object will be used
to display the message “Hello, world!” when you click a button object on the form.
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Note Readers who experimented with Visual Basic some time ago will notice that the
TextBox control no longer contains a default Text property value of “TextBox1". The de-
fault text box is now empty.

You'll add a button to the form now.

. Click the Button control in the Toolbox.

. Draw a button below the text box on the form.

Your form looks something like this:

a5 Farml = EoE T

Buttor

As you learned in Chapter 2, “Writing Your First Program,” buttons are used to get the
most basic input from a user. When a user clicks a button, he or she is requesting that
the program perform a specific action immediately. In Visual Basic terms, the user is
using the button to create an event that needs to be processed in the program. Typical
buttons in a program are the OK button, which a user clicks to accept a list of options
and to indicate that he or she is ready to proceed; the Cancel button, which a user
clicks to discard a list of options; and the Quit button, which a user clicks to exit the
program. In each case, you should use these buttons in the standard way so that they
work as expected when the user clicks them. A button’s characteristics (like those of all
objects) can be modified with property settings and references to the object in pro-
gram code.

Set the following property for the button object by using the Properties window:

Object Property Setting
Buttonl Text 2 objects

For more information about setting properties and reading them in tables, see the
section entitled "The Properties Window" in Chapter 1.

Double-click the OK button, and type the following program statement between the
Private Sub Buttonl_Click and End Sub statements in the Code Editor:
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TextBox1l.Text = "Hello, world!"

Note Asyou type statements, Visual Studio displays a list box containing all valid items
that match your text. After you type the TextBox1 object name and a period, Visual Studio
displays a list box containing all the valid properties and methods for text box objects,
to jog your memory if you've forgotten the complete list. This list box is called Microsoft
IntelliSense and can be very helpful when you are writing code. If you click an item in the
list box, you will typically get a ToolTip that provides a short description of the selected
item. You can add the property from the list to your code by double-clicking it or by using
the arrow keys to select it and then pressing Tab. You can also continue typing to enter the
property yourself. (I usually just keep typing, unless I'm exploring new features.)

The statement you've entered changes the Text property of the text box to “Hello,
world!” when the user clicks the button at run time. (The equal sign (=) assigns every-
thing between the quotation marks to the Text property of the TextBox1 object.) This
example changes a property at run time—one of the most common uses of program
code in a Visual Basic program.

Now you're ready to run the Hello World program.

Run the Hello World program

Q Tip The complete Hello World program is located in the c:\vb08sbs\chap03\hello folder.

1. Click the Start Debugging button on the Standard toolbar.

The Hello World program compiles and, after a few seconds, runs in the Visual Studio
IDE.

2. Click OK.

The program displays the greeting “Hello, world!" in the text box, as shown here:

a5 Farml = e

Hello, waorld!
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When you clicked the OK button, the program code changed the Text property of the
empty TextBoxI text box to “Hello, world!” and displayed this text in the box. If you
didn't get this result, repeat the steps in the previous section, and build the program
again. You might have set a property incorrectly or made a typing mistake in the pro-
gram code. (Syntax errors appear with a jagged underline in the Code Editor.)

. Click the Close button in the upper-right corner of the Hello World program window to

stop the program.

Note To stop a program running in Visual Studio, you can also click the Stop Debugging
button on the Standard toolbar to close the program.

. Click the Save All button on the Standard toolbar to save your new project to disk.

Visual Studio now prompts you for a name and a location for the project.

. Click the Browse button.

The Project Location dialog box opens. You use this dialog box to specify the location
of your project and to create new folders for your projects if necessary. Although you
can save your projects in any location (the Documents\Visual Studio 2008\Projects
folder is a common location), in this book I instruct you to save your projects in the
c\vb08sbs folder, the default location for your Step by Step practice files. If you ever
want to remove all the files associated with this programming course, you'll know
just where the files are, and you'll be able to remove them easily by deleting the
entire folder.

. Browse to the c:\\vb08sbs\chap03 folder.
. Click the Select Folder or Open button to open the folder you specified.

. Clear the check mark from the Create Directory For Solution check box if it is selected.

Because this solution contains only one project (which is the case for most of the solu-
tions in this book), you don't need to create a separate root folder to hold the solution
files for the project. (However, you can create an extra folder if you want.)

Click Save to save the project and its files.

Congratulations—you've joined the ranks of programmers who've written a Hello World
program. Now let’s try another control.
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Using the DateTimePicker Control

Some Visual Basic controls display information, and others gather information from the
user or process data behind the scenes. In this exercise, you'll work with the DateTimePicker
control, which prompts the user for a date or time by using a graphical calendar with scroll
arrows. Although your use of the control will be rudimentary at this point, experimenting
with DateTimePicker will give you an idea of how much Visual Basic controls can do for you
automatically and how you process the information that comes from them.

The Birthday Program

The Birthday program uses a DateTimePicker control and a Button control to prompt the user
for the date of his or her birthday. It then displays that information by using a message box.
Give it a try now.

Build the Birthday program

1. On the File menu, click Close Project to close the MyHello project.
The files associated with the Hello World program close.

2. On the File menu, click New Project.
The New Project dialog box opens.

3. Create a new Visual Basic Windows Forms Application project named MyBirthday.
The new project is created, and a blank form appears in the Designer.

4. Click the DateTimePicker control in the Toolbox.

5. Draw a date/time picker object in the middle of the form, as shown in the following
illustration.

o5 Forml |?||ﬁ|
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The date/time picker object by default displays the current date, but you can adjust the
displayed date by changing the object’s Value property. Displaying the date is a handy
design guide—it lets you size the date/time picker object appropriately when you're
creating it.

Click the Button control in the Toolbox, and then add a button object below the date/
time picker.

You'll use this button to display your birth date and to verify that the date/time picker
works correctly.

In the Properties window, change the Text property of the button object to Show My
Birthday.

Now you'll add a few lines of program code to a procedure associated with the button
object. This is an event procedure because it runs when an event, such as a mouse click,
occurs, or fires, in the object.

Double-click the button object on the form to display its default event procedure, and
then type the following program statements between the Private Sub and End Sub
statements in the Button1_Click event procedure:

MsgBox("Your birth date was " & DateTimePickerl.Text)
MsgBox("Day of the year: " & _

DateTimePickerl.Value.DayOfYear.ToString())
These program statements display two message boxes (small dialog boxes) with infor-
mation from the date/time picker object. The first line uses the Text property of the
date/time picker to display the birth date information you select when using the object
at run time. The MsgBox function displays the string value “Your birth date was” in addi-
tion to the textual value held in the date/time picker’s Text property. These two pieces
of information are joined together by the string concatenation operator (&).
You'll learn more about the MsgBox function and the string concatenation operator
in Chapter 5, “Visual Basic Variables and Formulas, and the .NET Framework.”

The second and third lines collectively form one program statement and have been
broken by the line continuation character (_) because the statement was a bit too long
to print in this book.
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Note Program lines can be more than 65,000 characters long in the Visual Studio Code
Editor, but it's usually easiest to work with lines of 80 or fewer characters. You can divide
long program statements among multiple lines by using a space and a line continuation
character (_) at the end of each line in the statement, except the last line. (You cannot
use a line continuation character to break a string that's in quotation marks, however.)

| use the line continuation character in this exercise to break the second line of code
into two parts.

The statement DateTimePickerl.Value.DayOfYear.ToString() uses the date/time picker
object to calculate the day of the year in which you were born, counting from January
1. This is accomplished by the DayOfYear property and the ToString method, which
converts the numeric result of the date calculation to a textual value that's more easily
displayed by the MsgBox function.

Methods are special statements that perform an action or a service for a particular ob-

ject, such as converting a number to a string or adding items to a list box. Methods dif-
fer from properties, which contain a value, and event procedures, which execute when

a user manipulates an object. Methods can also be shared among objects, so when you
learn how to use a particular method, you'll often be able to apply it to several circum-
stances. We'll discuss several important methods as you work through this book.

After you enter the code for the Buttonl_Click event procedure, the Code Editor looks
similar to this:

Start Page Forml.vb - X
[ liGeneral) ~ [](Declarations) -
EPublic Class Formil =

-

Frivate Zub Buttonl Click(EyVal sender Ais Zystem.Chject, Eyval e
M=gBox ("Your birth date was " & DateTimePickerl.Text)

M=gBox ("Day of the year: " & _
DateTimePickerl.Value.Daylf¥ear. ToString())
End Zub
End Class

9. Click the Save All button to save your changes to disk, and specify c:\vb08sbs\chap03 as

the folder location.

Now you're ready to run the Birthday program.
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Run the Birthday program

Q Tip The complete Birthday program is located in the c:\vb08sbs\chap03\birthday folder.

1. Click the Start Debugging button on the Standard toolbar.

The Birthday program starts to run in the IDE. The current date is displayed in the
date/time picker.

2. Click the arrow in the date/time picker to display the object in Calendar view.

Your form looks like the following illustration, with a different date.

s/ Farml (= e )

“Wednesday, September 10, 2008 | [+

4 September, 2008 L4

Sun Mon Tue Wed Thu Fri  Sat
il 1 2 3 4 5 6
7 8 9 1 12 13
14 15 18 17 18 19 20
21 2 23 M¥ B 2w
28 29 30 1 2 3 4
5 6 7 8 9 1 1
[ Today: 8/10/2008

3. Click the Left scroll arrow to look at previous months on the calendar.

Notice that the text box portion of the object also changes as you scroll the date. The
“today” value at the bottom of the calendar doesn’t change, however.

Although you can scroll all the way back to your exact birthday, you might not have
the patience to scroll month by month. To move to your birth year faster, select the
year value in the date/time picker text box and enter a new year.

4. Select the four-digit year in the date/time picker text box.
When you select the date, the date/time picker closes.

5. Type your birth year in place of the year that's currently selected, and then click the
arrow again.

The calendar reappears in the year of your birth.
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6. Click the scroll arrow again to locate the month in which you were born, and then click

the exact day on which you were born.
If you didn't know the day of the week you were born on, now you can find out!

When you select the final date, the date/time picker closes, and your birth date is dis-
played in the text box. You can click the button object to see how this information is
made available to other objects on your form.

Click the Show My Birthday button.

Visual Basic executes your program code and displays a message box containing the
day and date of your birth. Notice how the two dates match:

a5 Forml = [ = [E2

Saturday . Apil 18,1964 [+

Birthday (=3

Your birth date was Saturday, &pril 18, 1964

—s

Click OK in the message box.

A second message box appears indicating the day of the year on which you were born—
everything seems to work! You'll find this control to be quite capable—not only does it
remember the new date or time information that you enter, but it also keeps track of the
current date and time, and it can display this date and time information in a variety of
useful formats.

Note To configure the date/time picker object to display times instead of dates, set the
object’s Format property to Time.

Click OK to close the message box, and then click the Close button on the form.

You're finished using the DateTimePicker control for now.
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A Word About Terminology

So far in this book I've used several different terms to describe items in a Visual Basic program.
Do you know what all these items are yet? It's worth listing several of them now to clear up
any confusion.

Program statement
A program statement is a line of code in a Visual Basic program, a self-contained in-
struction executed by the Visual Basic compiler that performs useful work within the
application. Program statements can vary in length (some contain only one Visual Basic
keyword!), but all program statements must follow syntax rules defined and enforced by
the Visual Basic compiler. In Visual Studio 2008, program statements can be composed
of keywords, properties, object names, variables, numbers, special symbols, and other
values. (See Chapter 2 and Chapter 5.)

Keyword
A keyword is a reserved word within the Visual Basic language that is recognized by the
Visual Basic compiler and performs useful work. (For example, the End keyword stops
program execution.) Keywords are one of the basic building blocks of program state-
ments; they work together with objects, properties, variables, and other values to form
complete lines of code and (therefore) instructions for the compiler and operating sys-
tem. Most keywords are shown in blue type in the Code Editor. (See Chapter 2.)

Variable
A variable is a special container used to hold data temporarily in a program. The pro-
grammer creates variables by using the Dim statement and then uses these variables
to store the results of a calculation, file names, input, and so on. Numbers, names, and
property values can be stored in variables. (See Chapter 5.)

Control
A control is a tool you use to create objects in a Visual Basic program (most commonly,
objects are created on a form). You select controls from the Toolbox and use them to
draw objects with the mouse on a form. You use most controls to create user interface
elements, such as buttons, picture boxes, and list boxes. (See especially Chapters 2
through 4.)

Object
An object is an element that you create in a Visual Basic program with a control in
the Toolbox. (In addition, objects are sometimes supplied by other system components
and many of these objects contain data.) In Visual Basic, the form itself is also an object.
Technically speaking, objects are instances of a class that supports properties, methods,
and events. Objects also have what is known as inherent functionality—they know
how to operate and can respond to certain situations on their own. (A list box
“knows” how to scroll, for example.) (See Chapters 1 through 4.)
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Class
A class is a blueprint or template for one or more objects that defines what the object
does. Accordingly, a class defines what an object can do, but is not the object itself. In
Visual Basic, you can use existing Visual Studio classes (like System.Math and System.
Windows.Forms.Form), and you can build your own classes and inherit properties, meth-
ods, and events from them. (Inheritance allows one class to acquire the pre-existing
interface and behavior characteristics of another class.) Although classes might sound
esoteric at this point, they are a key feature of Visual Studio 2008, and in this book, you
will use them to build user interfaces rapidly and to extend the work that you do to
other programming projects. (See Chapters 5 and 16.)

Namespace
A namespace is a hierarchical library of classes organized under a unique name, such
as System.Windows or System.Diagnostics. To access the classes and underlying objects
within a namespace, you place an Imports statement at the top of your program code.
Every project in Visual Studio also has a root namespace, which is set using the project’s
Properties page. Namespaces are referred to as object libraries or class libraries in
Visual Studio books and documentation. (See Chapter 5.)

Property
A property is a value, or characteristic, held by an object. For example, a button
object has a Text property to specify the text that appears on the button and an
Image property to specify the path to an image file that should appear on the but-
ton face. In Visual Basic, properties can be set at design time by using the Properties
window or at run time by using statements in the program code. In code, the format
for setting a property is

Object.Property = Value

where Object is the name of the object you're customizing, Property is the characteristic
you want to change, and Value is the new property setting. For example,

Buttonl.Text = "Hello"

could be used in the program code to set the Text property of the Buttonl object to
“Hello". (See Chapters 1 through 3.)

Event procedure
An event procedure is a block of code that's executed when an object is manipulated
in a program. For example, when the Buttonl object is clicked, the ButtonI_Click event
procedure is executed. Event procedures typically evaluate and set properties and
use other program statements to perform the work of the program. (See Chapters 1
through 3.)
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Method
A method is a special statement that performs an action or a service for a particular
object in a program. In program code, the notation for using a method is

Object.Method(Value)

where Object is the name of the object you want to work with, Method is the action
you want to perform, and Value is an optional argument to be used by the method.
For example, the statement

ListBox1l.Items.Add("Check™)

uses the Add method to put the word Check in the ListBox1 list box. Methods and prop-
erties are often identified by their position in a collection or object library, so don't be
surprised if you see long references such as System.Drawing.Image.FromFile, which would
be read as "the FromFile method, which is a member of the Image class, which is a mem-
ber of the System.Drawing object library.” (See Chapters 1 through 5.)

Controls for Gathering Input

Visual Basic provides several mechanisms for gathering input in a program. Text boxes
accept typed input, menus present commands that can be clicked or chosen with the
keyboard, and dialog boxes offer a variety of elements that can be chosen individually or
selected in a group. In this exercise, you'll learn how to use four important controls that
help you gather input in several different situations. You'll learn about the RadioButton,
CheckBox, ListBox, and ComboBox controls. You'll explore each of these objects as you
use a Visual Basic program called Input Controls, which is the user interface for a simple,
graphics-based ordering system. As you run the program, you'll get some hands-on ex-
perience with the input objects. In the next chapter, I'll discuss how these objects can be
used along with menus in a full-fledged program.

As a simple experiment, try using the CheckBox control now to see how user input is
processed on a form and in program code.

Experiment with the CheckBox control

1. On the File menu, click Close Project to close the Birthday project.
2. On the File menu, click New Project.
The New Project dialog box opens.
3. Create a new Visual Basic Windows Forms Application project named MyCheckBox.

The new project is created, and a blank form appears in the Designer.
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. Click the CheckBox control in the Toolbox.

. Draw two check box objects on the form, one above the other.

Check boxes appear as objects on your form just as other objects do. You'll have to
click the CheckBox control in the Toolbox a second time for the second check box.

. Using the PictureBox control, draw two square picture box objects beneath the two
check boxes.

. Set the following properties for the check box and picture box objects:

Object Property Setting
CheckBox1 Checked True
Text "Calculator”
CheckBox2 Text "Copy machine”
PictureBox1 Image c:\vb08sbs\chap03\calcultr
SizeMode Stretchimage
PictureBox2 SizeMode Stretchimage

In this walkthrough, you'll use the check boxes to display and hide images of a calculator
and a copy machine. The Text property of the check box object determines the contents
of the check box label in the user interface. With the Checked property, you can set a
default value for the check box. Setting Checked to True places a check mark in the box,
and setting Checked to False (the default setting) removes the check mark. | use the
SizeMode properties in the picture boxes to size the images so that they stretch to fit

in the picture box.

Your form looks something like this:

s/ Farml (= Hem )

| Calculatar

Copy machine
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Double-click the first check box object to open the CheckBox1_CheckedChanged event
procedure in the Code Editor, and then enter the following program code:

If CheckBoxl.CheckState = 1 Then

PictureBoxl.Image = System.Drawing.Image.FromFile _

("c:\vb08sbs\chap03\calcultr™)

PictureBox1l.Visible = True
Else

PictureBox1l.Visible = False
End If
The CheckBox1_CheckedChanged event procedure runs only if the user clicks in the first
check box object. The event procedure uses an If.. Then decision structure (described
in Chapter 6, "Using Decision Structures”) to confirm the current status, or state, of the
first check box, and it displays a calculator picture from the c:\vb08sbs\chap03 folder if
a check mark is in the box. The CheckState property holds a value of 1 if there’s a check
mark present and 0 if there's no check mark present. (You can also use the CheckState.
Checked enumeration, which appears in IntelliSense when you type, as an alternative to
setting the value to 1.) | use the Visible property to display the picture if a check mark
is present or to hide the picture if a check mark isn't present. Notice that | wrapped the
long line that loads the image into the picture box object by using the line continuation
(U) character.

Click the View Designer button in Solution Explorer to display the form again,
double-click the second check box, and then add the following code to the
CheckBox2_Checked-Changed event procedure:

If CheckBox2.CheckState = 1 Then
PictureBox2.Image = System.Drawing.Image.FromFile
("c:\vb08sbs\chap03\copymach™)
PictureBox2.Visible = True
Else
PictureBox2.Visible = False
End If

This event procedure is almost identical to the one that you just entered; only the
names of the image (copymach), the check box object (CheckBox2), and the picture
box object (PictureBox?2) are different.

Click the Save All button on the Standard toolbar to save your changes, specifying the
c\vb08sbs\chap03 folder as the location.

Run the CheckBox program

O

1.

Tip The complete CheckBox program is located in the c:\vb08sbs\chap03\checkbox folder.

Click the Start Debugging button on the Standard toolbar.
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Visual Basic runs the program in the IDE. The calculator image appears in a picture box
on the form, and the first check box contains a check mark.

. Select the Copy Machine check box.

Visual Basic displays the copy machine image, as shown here:

a5 Farml =5 o =

|| Calculator

[¥] Copy machine

Experiment with different combinations of check boxes, selecting or clearing the boxes
several times to test the program. The program logic you added with a few short lines
of Visual Basic code manages the boxes perfectly. (You'll learn much more about pro-
gram code in upcoming chapters.)

4. Click the Close button on the form to end the program.

The Input Controls Demo

Now that you've had a little experience with check boxes, run and examine the Input Controls
demonstration program that | created to simulate a graphical ordering environment that
makes more extensive use of check boxes, radio buttons, a list box, and a combo box. If you
work in a business that does a lot of order entry, you might want to expand this program
into a full-featured graphical order entry program. After you experiment with Input Controls,
spend some time learning how the four input controls work in the program. They were
created in a few short steps by using Visual Basic and the techniques you just learned.

Run the Input Controls program

1.

On the File menu, click Open Project.
The Open Project dialog box opens.

Open the c:\vb08sbs\chap03\input controls folder, and then double-click the Input
Controls project file (Input Controls.vbproj).
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As | mentioned earlier, you may open either the project file (Input Controls.vbproj) or
the solutions file (Input Controls.sIn) to open solutions with only one project. In either
case, the Input Controls project opens in the IDE.

3. If the project’s form isn't visible, click the Form1.vb form in Solution Explorer, and then
click the View Designer button.

4. Move or close the windows that block your view of the form so that you can see how
the objects are laid out.

You see a form similar to this:

a5 Online Shopper [E=HE=R(ExD|
The Online Shopper
Outfit your office now by choosing the office products you need Products Ordered

uging radio buttons, check boxes, a list box, and a combo box,
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o FC [ListBax1
|

]
|
; |
Macintosh |
|
| |
Laptop |

 —

Qffice Equipment [0-3]

Payment kethod [ —

Anzwering Machine

Calculator

Cluit

Copy maching

The Input Controls form contains radio button, check box, list box, combo box, picture
box, button, and label objects. These objects work together to create a simple order
entry program that demonstrates how the Visual Basic input objects work. When the
Input Controls program is run, it loads images from the c:\vb08sbs\chap03\input con-
trols folder and displays them in the six picture boxes on the form.

Note If you installed the practice files in a location other than the default c:\vb08sbs
folder, the statements in the program that load the artwork from the disk contain an in-
correct path. (Each statement begins with c:\\vb08sbs\chap03\input controls, as you'll see
soon.) If this is the case, you can make the program work by renaming your practice files
folder \vb08sbs or by changing the paths in the Code Editor by using the editing keys or
the Quick Replace command on the Edit menu.

5. Click the Start Debugging button on the Standard toolbar.
The program runs in the IDE.
6. Click the Laptop radio button in the Computer box.
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The image of a laptop computer appears in the Products Ordered area on the right
side of the form. The user can click various options, and the current choice is depicted
in the order area on the right. In the Computer box, a group of radio buttons is used
to gather input from the user.

Radio buttons force the user to choose one (and only one) item from a list of possibili-
ties. (Radio buttons are called option buttons in Visual Basic 6.) When radio buttons are
placed inside a group box object on a form, the radio buttons are considered to be part
of a group, and only one option can be chosen. To create a group box, click the GroupBox
control on the Containers tab of the Toolbox, and then draw the control on your form.
(The GroupBox control replaces the Frame control in Visual Basic 6.) You can give the
group of radio buttons a title (as | have) by setting the Text property of the group box
object. When you move a group box object on the form, the controls within it also move.

. Click to select the Answering Machine, Calculator, and Copy Machine check boxes in
the Office Equipment box.

Check boxes are used in a program so that the user can select more than one option

at a time from a list. Click to clear the Calculator check box again, and notice that the
picture of the calculator disappears from the order area. Because each user interface
element responds to click events as they occur, order choices are reflected immediately.
The code that completes these tasks is nearly identical to the code you entered earlier
in the CheckBox program.

. Click Satellite Dish in the Peripherals list box.
A picture of a satellite dish is added to the order area.

List boxes are used to get a single response from a list of choices. They are created with
the ListBox control, and might contain many items to choose from. (Scroll bars appear
if the list of items is longer than the list box.) Unlike radio buttons, a list box doesn't
require that the user be presented with a default selection. And from a programmatic
standpoint, items in a list box can be added to, removed from, or sorted while the pro-
gram is running. If you would like to see check marks next to the items in your list box,
use the CheckedListBox control in the Toolbox instead of the ListBox control.

. Now choose U.S. Dollars (sorry, no credit) from the payment list in the Payment
Method combo box.

Combo boxes, or drop-down list boxes, are similar to regular list boxes, but they take
up less space. (The “combo” in a combo box basically comes from a “combination”

of an editable text box and a drop-down list.) Visual Basic automatically handles the
opening, closing, and scrolling of the list box. All you do as a programmer is create the
combo box by using the ComboBox control in the Toolbox, set the Text property to
provide directions or a default value, and then write code to add items to the combo
box and to process the user’'s combo box selection. You'll see examples of each task in
the program code for the Input Controls demonstration in the next section.
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After you make your order selections, your screen looks something like this:

o5 Online Shopper [E=HE=R(E=D|
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Outfit your office now by choosing the office products you need Products Ordered
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Quit

Iv Copy machine

10. Practice making a few more changes to the order list (try different computers, peripherals,
and payment methods), and then click the Quit button in the program to exit.

When you click Quit, the program closes, and the IDE appears.

Looking at the Input Controls Program Code

Although you haven't had much formal experience with program code yet, it's worth taking a
quick look at a few event procedures in Input Controls to see how the program processes input
from the user interface elements. In these procedures, you'll see the If...Then and Select Case
statements at work. You'll learn about these and other decision structures in Chapter 6. For
now, concentrate on the CheckState property, which changes when a check box is selected,
and the SelectedIndex property, which changes when a list box is selected.

Examine check box and list box code

1. Be sure the program has stopped running, and then double-click the Answering
Machine check box in the Office Equipment group box to display the CheckBox1_
CheckedChanged event procedure in the Code Editor.

You see the following program code:

'If the CheckState property for a check box is 1, it has a mark in it
If CheckBoxl.CheckState = 1 Then
PictureBox2.Image = System.Drawing.Image.FromFile _
("c:\vb08sbs\chap03\input controls\answmach™)
PictureBox2.Visible = True
Else
'If there is no mark, hide the image
PictureBox2.Visible = False
End If
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As you learned in Chapter 2, the first line of this event procedure is a comment. Comments
are displayed in green type and are simply notes written by the programmer to describe
what's important or interesting about this particular piece of program code. (Comments
are also occasionally generated by automated programming tools that compile programs
or insert code snippets.) | wrote this comment to remind myself that the CheckState
property contains a crucial value in this routine—a value of 1 if the first check box

was checked.

The rest of the event procedure is nearly identical to the one you just wrote in the
CheckBox program. If you scroll down in the Code Editor, you see a similar event pro-
cedure for the CheckBox2 and CheckBox3 objects.

. At the top edge of the Code Editor, click the Form1.vb [Design] tab to display the form
again, and then double-click the Peripherals list box on the form.

The ListBox1_SelectedindexChanged event procedure appears in the Code Editor. You
see the following program statements:

'The item you picked (0-2) is held in the SelectedIndex property
Select Case ListBoxl.SelectedIndex
Case 0
PictureBox3.Image = System.Drawing.Image.FromFile _
("c:\vb08sbs\chap03\input controls\harddisk")
Case 1
PictureBox3.Image = System.Drawing.Image.FromFile
("c:\vb08sbs\chap03\input controls\printer")
Case 2
PictureBox3.Image = System.Drawing.Image.FromFile _
("c:\vb08sbs\chap03\input controls\satedish")
End Select

Here you see code that executes when the user clicks an item in the Peripherals list box in
the program. In this case, the important keyword is ListBox1.SelectedIindex, which is read
“the SelectedIndex property of the list box object named ListBox1." After the user clicks an
item in the list box, the Selectedindex property returns a number that corresponds to the
location of the item in the list box. (The first item is numbered 0, the second item is num-
bered 1, and so on.)

In the previous code, SelectedIndex is evaluated by the Select Case decision structure,
and a different image is loaded depending on the value of the Selectedindex property.
If the value is O, a picture of a hard disk is loaded; if the value is 1, a picture of a printer
is loaded; and if the value is 2, a picture of a satellite dish is loaded. You'll learn more
about how the Select Case decision structure works in Chapter 6.

. At the top edge of the Code Editor, click the Form1.vb [Design] tab to display the form
again, and then double-click the form (not any of the objects) to display the code asso-
ciated with the form itself.
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The Form1_Load event procedure appears in the Code Editor. This is the procedure that's
executed each time the Input Controls program is loaded into memory. Programmers
put program statements in this special procedure when they want them executed every
time a form loads. (Your program can display more than one form, or none at all, but
the default behavior is that Visual Basic loads and runs the FormI_Load event procedure
each time the user runs the program.) Often, as in the Input Controls program, these
statements define an aspect of the user interface that couldn’t be created by using the
controls in the Toolbox or the Properties window.

Here's what the FormI_Load event procedure looks like for this program:

'These program statements run when the form loads
PictureBox1l.Image = System.Drawing.Image.FromFile _
("c:\vb08sbs\chap03\input controls\pcomputr")
'Add items to a 1list box Tike this:
ListBox1l.Items.Add("Extra hard disk")
ListBox1l.Items.Add("Printer™)
ListBox1l.Items.Add("Satellite dish")
'Combo boxes are also filled with the Add method:
ComboBox1.Items.Add("U.S. Dollars")
ComboBox1.Items.Add("Check™)
ComboBox1.Items.Add("English Pounds™)
Three lines in this event procedure are comments displayed in green type. The second
line in the event procedure loads the personal computer image into the first picture
box. (This line is broken in two using a space and the line continuation character, but
the compiler still thinks of it as one line.) Loading an image establishes the default set-
ting reflected in the Computer radio button group box. Note also that text between

double quotes is displayed in red type.

The next three lines add items to the Peripherals list box (ListBoxI) in the program. The
words in quotes will appear in the list box when it appears on the form. Below the list
box program statements, the items in the Payment Method combo box (ComboBox1)
are specified. The important keyword in both these groups is Add, which is a special
function, or method, that adds items to list box and combo box objects.

You're finished using the Input Controls program. Take a few minutes to examine any other

parts of the program you're interested in, and then move on to the next exercise.
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Q Tip As noted on the previous page, most of the images in this simple example were

loaded using an absolute path name in the program code. This works fine as long as the
image exists at the specified path. However, in a commercial application, you can't always be
sure that your user won't move around your application files, causing programs like this one
to generate an error when the files they use are no longer in the expected location. To make
your applications more seaworthy or robust, it is usually better to use relative paths when ac-
cessing images and other resources. You can also embed images and other resources within
your application. For information about this handy technique, which is carefully described
within your very own Visual Studio documentation files, see “How to: Create Embedded
Resources” and “Accessing Application Resources” in the Visual Studio 2008 documentation.

One Step Further: Using the LinkLabel Control

Providing access to the Web is now a standard feature of many Windows applications, and
with Visual Studio, adding this functionality is easier than ever. You can create a Visual Basic
program that runs from a Web server by creating a Web Forms project and using controls

in the Toolbox optimized for the Web. Alternatively, you can use Visual Basic to create a
Windows application that opens a Web browser within the application, providing access to
the Web while remaining a Windows program running on a client computer. We'll postpone
writing Web Forms projects for a little while longer in this book, but in the following exercise
you'll learn how to use the LinkLabel Toolbox control to create a Web link in a Windows pro-
gram that provides access to the Internet through Windows Internet Explorer or the default
Web browser on your system.

Note To learn more about writing Web-aware Visual Basic 2008 applications, read Chapter 20,
“Creating Web Sites and Web Pages Using Visual Web Developer and ASP.NET.”

Create the WebLink program
1. On the File menu, click Close Project to close the Input Controls project.
2. On the File menu, click New Project.
The New Project dialog box opens.
3. Create a new Visual Basic Windows Forms Application project named MyWebLink.

The new project is created, and a blank form appears in the Designer.
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Click the LinkLabel control in the Toolbox, and draw a rectangular link label object on
your form.

Link label objects look like label objects, except that all label text is displayed in blue
underlined type on the form.

Set the Text property of the link label object to the URL for the Microsoft Press home
page:
http://www.microsoft.com/learning/books/

Your form looks like this:

o5 Forml =R

Click the form in the IDE to select it. (Click the form itself, not the link label object.)

This is the technique you use to view the properties of the default form, Form1, in the
Properties window. Like other objects in your project, the form also has properties that
you can set.

Set the Text property of the form object to Web Link Test.

The Text property for a form controls what appears on the form'’s title bar at design
time and when the program runs. Although this customization isn't related exclusively
to the Web, | thought you'd enjoy picking up that skill now, before we move on to
other projects. (We'll customize the title bar in most of the programs we build.)

Double-click the link label object, and then type the following program code in the
LinkLabell_LinkClicked event procedure:

' Change the color of the Tink by setting LinkVisited to True.

LinkLabell.LinkVisited = True

' Use the Process.Start method to open the default browser

' using the Microsoft Press URL:

System.Diagnostics.Process.Start _
("http://www.microsoft.com/learning/books/")
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I've included comments in the program code to give you some practice entering them.
As soon as you enter the single quote character ('), Visual Studio changes the color of
the line to green, identifying the line as a comment. Comments are for documentation
purposes only—they aren't evaluated or executed by the compiler.

The two program statements that aren't comments control how the link works. Setting
the LinkVisited property to True gives the link that dimmer color of purple, which indi-
cates in many browsers that the HTML document associated with the link has already
been viewed. Although setting this property isn't necessary to display a Web page,

it's a good programming practice to provide the user with information in a way that's
consistent with other applications.

The second program statement (which | have broken into two lines) runs the default
Web browser (such as Internet Explorer) if the browser isn't already running. (If the
browser is running, the URL just loads immediately.) The Start method in the Process
class performs the important work, by starting a process or executable program ses-
sion in memory for the browser. The Process class, which manages many other aspects
of program execution, is a member of the System.Diagnostics namespace. By including
an Internet address or a URL along with the Start method, I'm letting Visual Basic know
that | want to view a Web site, and Visual Basic is clever enough to know that the de-
fault system browser is the tool that would best display that URL, even though | didn't
identify the browser by name.

An exciting feature of the Process.Start method is that it can be used to run other
Windows applications, too. If | did want to identify a particular browser by name to
open the URL, | could have specified one using the following syntax. (Here I'll request
the Internet Explorer browser.)

System.Diagnostics.Process.Start("IExplore.exe", _
"http://www.microsoft.com/Tearning/books/")

Here two arguments are used with the Start method, separated by a comma. The exact

location for the program named IExplore.exe on my system isn't specified, but Visual

Basic will search the current system path for it when the program runs.

If I wanted to run a different application with the Start method—for example, if | wanted
to run the Microsoft Word application and open the document c:\myletter.doc—I could
use the following syntax:

System.Diagnostics.Process.Start("Winword.exe", _
"c:\myTletter.doc™)

As you can see, the Start method in the Process class is very useful.

Now that you've entered your code, you should save your project. (If you experimented
with the Start syntax as | showed you, restore the original code shown at the beginning
of step 8 first.)
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9. Click the Save All button on the Standard toolbar to save your changes, and specify c:\
vb08sbs\chap03 as the location.

You can now run the program.

Run the WebLink program

@ Tip The complete WebLink program is located in the c:\vb08sbs\chap03\weblink folder.

1. Click the Start Debugging button on the Standard toolbar to run the WebLink program.
The form opens and runs, showing its Web site link and handsome title bar text.
2. Click the link to open the Web site at http.//www.microsoft.com/learning/books/.

Recall that it's only a happy coincidence that the link label Text property contains the
same URL as the site you named in the program code. (It is not necessary that these
two items match.) You can enter any text you like in the link label. You can also use
the Image property for a link label to specify a picture to display in the background
of the link label. The following figure shows what the Microsoft Press Web page looks
like (in English) when the WebLink program displays it using Internet Explorer.
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3. Display the form again. (Click the Web Link Test form icon on the Windows taskbar if
the form isn't visible.)

Notice that the link now appears in a dimmed style. Like a standard Web link, your link
label communicates that it's been used (but is still active) by the color and intensity that

it appears in.

4. Click the Close button on the form to quit the test utility.

You're finished writing code in this chapter, and you're gaining valuable experience with
some of the Toolbox controls available for creating Windows Forms applications. Let’s

keep going!

To

Create a text box
Create a button
Change a property at

run time

Create a radio button

Create a check box
Create a list box

Create a drop-down
list box

Add items to a list box

Use a comment in
code

Display a Web page

Chapter 3 Quick Reference

Do this

Click the TextBox control, and draw the box.

Click the Button control, and draw the button.

Change the value of the property by using program code. For example:
Labell.Text = "Hello!"

Use the RadioButton control. To create multiple radio buttons, place more
than one button object inside a box that you create by using the GroupBox
control.

Click the CheckBox control, and draw a check box.
Click the ListBox control, and draw a list box.

Click the ComboBox control, and draw a drop-down list box.

Include statements with the Add method in the Form1_Load event procedure
of your program. For example:

ListBox1l.Items.Add("Printer™)

Type a single quotation mark (') in the Code Editor, and then type a descrip-
tive comment that will be ignored by the compiler. For example:

' Use the Process.Start method to start IE

Create a link to the Web page by using the LinkLabel control, and then open
the link in a browser by using the Process.Start method in program code.






Chapter 4
Working with Menus, Toolbars, and
Dialog Boxes

After completing this chapter, you will be able to:
B Add menus to your programs by using the MenuStrip control.
B Process menu and toolbar selections by using event procedures and the Code Editor.
B Add toolbars and buttons by using the ToolStrip control.
®  Use the OpenFileDialog and ColorDialog controls to create standard dialog boxes.
B Add access keys and shortcut keys to menus.

In Chapter 3, “Working with Toolbox Controls,” you used several Microsoft Visual Studio 2008
controls to gather input from the user while he or she used a program. In this chapter, you'll
learn how to present choices to the user by creating professional-looking menus, toolbars,
and dialog boxes.

A menu is located on the menu bar and contains a list of related commands; a toolbar con-
tains buttons and other tools that perform useful work in a program. Most menu and toolbar
commands are executed immediately after they're clicked; for example, when the user clicks
the Copy command on the Edit menu, information is copied to the Clipboard immediately. If a
menu command is followed by an ellipsis (...), however, clicking the command displays a dialog
box requesting more information before the command is carried out, and many toolbar but-
tons also display dialog boxes.

In this chapter, you'll learn how to use the MenuStrip and ToolStrip controls to add a profes-
sional look to your application’s user interface. You'll also learn how to process menu, toolbar,
and dialog box commands.

97
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Adding Menus by Using the MenuStrip Control

The MenuStrip control is a tool that adds menus to your programs, which you can customize
with property settings in the Properties window. With MenuStrip, you can add new menus,
modify and reorder existing menus, and delete old menus. You can also create a standard
menu configuration automatically, and you can enhance your menus with special effects,
such as access keys, check marks, and keyboard shortcuts. The menus look perfect—just like
a professional Microsoft Windows application—but MenuStrip creates only the visible part of
your menus and commands. You still need to write event procedures that process the menu
selections and make the commands perform useful work. In the following exercise, you'll take
your first steps with this process by using the MenuStrip control to create a Clock menu con-
taining commands that display the current date and time.

Create a menu

1. Start Visual Studio.
2. On the File menu, click New Project.
The New Project dialog box opens.
3. Create a new Windows Forms Application project named MyMenu.

4. Click the MenuStrip control on the Menus & Toolbars tab of the Toolbox, and then draw
a menu control on your form.

Don't worry about the location—Visual Studio will move the control and resize it
automatically. Your form looks like the one shown here:

,::“f Forml =x =] |%l
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The menu strip object doesn't appear on your form, but below it. That's different from
Microsoft Visual Basic 6, which in one way or another displays all objects on the form
itself—even those that don't have a visual representation when the program ran, such
as the Timer control. But in Visual Studio, non-visible objects, such as menus and timers,
are displayed in the IDE in a separate pane named the component tray, and you can
select them, set their properties, or delete them from this pane.

In addition to the menu strip object in the component tray, Visual Studio displays a
visual representation of the menu you created at the top of the form. The Type Here
tag encourages you to click the tag and enter the title of your menu. After you enter the
first menu title, you can enter submenu titles and other menu names by pressing

the arrow keys and typing additional names. Best of all, you can come back to this
in-line Menu Designer later and edit what you've done or add additional menu items—
the menu strip object is fully customizable and with it you can create an exciting menu-
driven user interface like the ones you've seen in the best Windows applications.

. Click the Type Here tag, type Clock, and then press Enter.

The word “Clock” is entered as the name of your first menu, and two additional Type
Here tags appear with which you can create submenu items below the new Clock menu
or additional menu titles. The submenu item is currently selected.

. Type Date to create a Date command for the Clock menu, and then press Enter.
Visual Studio adds the Date command to the menu and selects the next submenu item.
. Type Time to create a Time command for the menu, and then press Enter.

You now have a Clock menu with two menu commands, Date and Time. You could
continue to create additional menus or commands, but what you've done is sufficient
for this example program. Your form looks like the one shown here:

a! Forml ===

Clock |
Date
Tirme

[ TypeHere ]
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8. Click the form to close the Menu Designer.

The Menu Designer closes, and your form opens in the IDE with a new Clock menu.
You're ready to start customizing the menu now.

Adding Access Keys to Menu Commands

With most applications, you can access and execute menu commands by using the key-
board. For example, in Visual Studio you can open the File menu by pressing the Alt

key and then pressing the F key. Once the File menu is open, you can open a project

by pressing the P key. The key that you press in addition to the Alt key and the key that
you press to execute a command in an open menu are called access keys. You can identify
the access key of a menu item because it's underlined.

Visual Studio makes it easy to provide access key support. To add an access key to a menu
item, activate the Menu Designer, and then type an ampersand (&) before the appropriate
letter in the menu name. When you open the menu at run time (when the program is run-
ning), your program automatically supports the access key.

Menu Conventions

By convention, each menu title and menu command in a Windows application has an
initial capital letter. File and Edit are often the first two menu names on the menu bar,
and Help is usually the last. Other common menu names are View, Format, and Window.
No matter what menus and commands you use in your applications, take care to be
clear and consistent with them. Menus and commands should be easy to use and should
have as much in common as possible with those in other Windows-based applications.
As you create menu items, use the following guidelines:

B Use short, specific captions consisting of one or two words at most.

B Assign each menu item an access key. Use the first letter of the item if possible,
or the access key that is commonly assigned (such as x for Exit).

B Menu items at the same level must have a unique access key.

B |f a command is used as an on/off toggle, place a check mark to the left of the
item when it's active. You can add a check mark by setting the Checked property
of the menu command to True in the Properties window.

B Place an ellipsis (...) after a menu command that requires the user to enter more
information before the command can be executed. The ellipsis indicates that
you'll open a dialog box if the user selects this item.
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Note By default, most versions of Windows don't display the underline for access keys in a pro-
gram until you press the Alt key for the first time. In Windows 2000, you can turn off this option
(making the underline visible at all times) by clicking the Effects tab of the Display control panel.
In Windows XP and Windows Server 2003, you can turn off this option by using the Effects but-

ton on the Appearance tab of the Display Properties control panel. In Windows Vista, you can
turn off this option by clicking the Appearance And Personalization option in Control Panel,
clicking Ease Of Access Center, clicking Make The Keyboard Easier To Use, and then selecting
Underline Keyboard Shortcuts And Access Keys.

Try adding access keys to the Clock menu now.

Add access keys

1.

Click the Clock menu name on the form, pause a moment, and then click it again.

The menu name is highlighted, and a blinking I-beam (text-editing cursor) appears at the
end of the selection. With the I-beam, you can edit your menu name or add the amper-
sand character (&) for an access key. (If you double-clicked the menu name, the Code Editor
might have opened. If that happened, close the Code Editor and repeat step 1.)

Press the Left Arrow key five times to move the I-beam to just before the Clock
menu name.

The I-beam blinks before the letter C in Clock.
Type & to define the letter C as the access key for the Clock menu.
An ampersand appears in the text box in front of the word Clock.

Click the Date command in the menu list, and then click Date a second time to display
the I-beam.

. Type & before the letter D.

The letter D is now defined as the access key for the Date command.

Click the Time command in the menu list, and then click the command a second time
to display the I-beam.

Type & before the letter T.

The letter T is now defined as the access key for the Time command.
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8. Press Enter.

Pressing Enter locks in your text-editing changes. Your form looks this:

a Forml [E=5[ESE =)
Clock

Date

Had |

Now you'll practice using the Menu Designer to switch the order of the Date and Time
commands on the Clock menu. Changing the order of menu items is an important skill
because at times you'll think of a better way to define your menus.

Change the order of menu items

1. Click the Clock menu on the form to display its menu items.

To change the order of a menu item, simply drag the item to a new location on the
menu. Try it now.

2. Drag the Time menu on top of the Date menu, and then release the mouse button.

Dragging one menu item on top of another menu item means that you want to place
the first menu item ahead of the second menu item on the menu. As quickly as that,
Visual Studio moved the Time menu item ahead of the Date item.

You've finished creating the user interface for the Clock menu. Now you'll use the menu
event procedures to process the user's menu selections in the program.

Note To delete a menu item from a menu, click the unwanted item in the menu list, and then
press the Delete key. (If you try this now, remember that Visual Studio also has an Undo com-
mand, located on both the Edit menu and the Standard toolbar, so you can reverse the effects
of the deletion.)
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Processing Menu Choices

After menus and commands are configured by using the menu strip object, they also
become new objects in your program. To make the menu objects do meaningful work,
you need to write event procedures for them. Menu event procedures typically contain
program statements that display or process information on the user interface form and
modify one or more menu properties. If more information is needed from the user to
process the selected command, you can write your event procedure so that it displays
a dialog box or one of the input controls you used in Chapter 3.

In the following exercise, you'll add a label object to your form to display the output of the
Time and Date commands on the Clock menu.

Add a label object to the form
1. Click the Label control in the Toolbox.

2. Create alabel in the middle of the form.

The label object appears on the form and bears the name Labell in the program code.

3. Set the following properties for the label:

Object Property Setting
Labell AutoSize False
BorderStyle FixedSingle
Font Microsoft Sans Serif, Bold, 14-point
Text (empty)
TextAlign MiddleCenter

4. Resize the label object so that it is larger (it will be holding clock and date values), and
position it in the center of the form. Your form should look similar to the following:

- Forml =)
Clock




104 Part |

Getting Started with Microsoft Visual Basic 2008

Now you'll add program statements to the Time and Date event procedures to process the
menu commands.

Note In the following exercises, you'll enter program code to process menu choices. It's OK if
you're still a bit hazy on what program code does and how you use it—you'll learn much more
about program statements in Chapters 5 through 7.

Edit the menu event procedures

1. Click the Clock menu on the form to display its commands.

2. Double-click the Time command in the menu to open an event procedure for the

command in the Code Editor.

The TimeToolStripMenultem_Click event procedure appears in the Code Editor. The
name TimeToolStripMenultem_Click includes the name Time that you gave this menu
command. The words ToolStripMenultem indicate that in its underlying technology,
the MenuStrip control is related to the ToolStrip control. (We'll see further examples
of that later in this chapter.) The _Click syntax means that this is the event procedure
that runs when a user clicks the menu item.

We'll keep this menu name for now, but if you wanted to create your own internal
names for menu objects, you could select the object, open the Properties window,
and change the Name property. Although | won't bother with that extra step in this
chapter, later in the book you'll practice renaming objects in your program to con-
form more readily to professional programming practices.

. Type the following program statement:

Labell.Text = TimeString

This program statement displays the current time (from the system clock) in the Text
property of the Labell object, replacing the previous Labell text (if any). TimeString
is a property that contains the current time formatted for display or printing. You can
use TimeString at any time in your programs to display the time accurately down to
the second. (TimeString is essentially a replacement for the older Visual Basic TIME$
statement.)

Note The Visual Basic TimeString property returns the current system time. You can set
the system time by using the Clock, Language, and Region category in the Windows Vista
Control Panel.
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Press Enter.

Visual Basic interprets the line and adjusts capitalization and spacing, if necessary.
(Visual Basic checks each line for syntax errors as you enter it.)

Tip You can enter a line by pressing Enter or Esc.

Click the View Designer button in Solution Explorer, and then double-click the Date
command on the Clock menu.

The DateToolStripMenultem_Click event procedure appears in the Code Editor. This event
procedure is executed when the user clicks the Date command on the Clock menu.

. Type the following program statement:

Labell.Text = DateString

This program statement displays the current date (from the system clock) in the Text
property of the Labell object, replacing the previous Labell text. The DateString prop-
erty is also available for general use in your programs. Assign DateString to the Text
property of an object whenever you want to display the current date on a form.

Note The Visual Basic DateString property returns the current system date. You can set
the system date by using the Clock, Language, and Region category in the Windows Vista
Control Panel.

Press Enter to enter the line.

Your screen looks similar to this:

Forml.wb® | Forrnlwb [Design]* | Start Page

S TimeToolStriphenultern - ¥ Click -
EPublic Class Formil 1

-

Frivate Zub DateToolZtripMenultem Click(EyVal sender iz Zystem. ok
Lakell.Text = Dateltring

End Zub

Frivate Zub TimeToolZtripMenultem Click(EyvVal sender iz Zystem. ok
Lakell.Text = Time3tring
End Zub
End Class =
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You've finished entering the menu demonstration program. Now you'll save your
changes to the project and prepare to run it.

8. Click the Save All button on the Standard toolbar, and then specify the c:\vb08sbs\chap04
folder as the location.

Run the Menu program

Q Tip The complete Menu program is located in the c:\vb08sbs\chap04\menu folder.

1. Click the Start Debugging button on the Standard toolbar.
The Menu program runs in the IDE.

2. Click the Clock menu on the menu bar.
The Clock menu appears.

3. Click the Time command.

The current system time appears in the label box, as shown here:

o5 Forml =] =)
Clock

11:26:42

Now you'll try displaying the current date by using the access keys on the menu.
4. Press and release the Alt key, and then press the letter C.
The Clock menu opens and the first item on it is highlighted.
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5. Press D to display the current date.
The current date appears in the label box.
6. Click the Close button on the program’s title bar to stop the program.

Congratulations! You've created a working program that makes use of menus and access
keys. In the next exercise, you'll learn how to use toolbars.

System Clock Properties and Functions

You can use various properties and functions to retrieve chronological values from the
system clock. You can use these values to create custom calendars, clocks, and alarms

in your programs. The following table lists the most useful system clock functions. For
more information, check the Visual Studio online Help.

Property or function Description

TimeString This property sets or returns the current time from the system
clock.

DateString This property sets or returns the current date from the system
clock.

Now This property returns an encoded value representing the cur-

rent date and time. This property is most useful as an argu-
ment for other system clock functions.

Hour (date) This function extracts the hour portion of the specified date/
time value (0 through 23).

Minute (date) This function extracts the minute portion of the specified
date/time value (0 through 59).

Second (date) This function extracts the second portion of the specified
date/time value (0 through 59).

Month (date) This function extracts a whole number representing the
month (1 through 12).

Year (date) This function extracts the year portion of the specified date/
time value.

Weekday (date) This function extracts a whole number representing the day of

the week (1 is Sunday, 2 is Monday, and so on).
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Adding Toolbars with the ToolStrip Control

Parallel to the MenuStrip control, you can use the Visual Studio ToolStrip control to quickly
add toolbars to your program'’s user interface. The ToolStrip control is placed on a Visual
Basic form but resides in the component tray in the IDE, just like the MenuStrip control.
You can also add a variety of features to your toolbars, including labels, combo boxes,
text boxes, and split buttons. Toolbars look especially exciting when you add them, but
remember that as with menu commands, you must write an event procedure for each
button that you want to use in your program. Still, compared with earlier versions of
Visual Basic, it is amazing how much toolbar programming and configuring the IDE

does for you. Practice creating a toolbar now.

Create a toolbar

1. Click the ToolStrip control on the Menus & Toolbars tab of the Toolbox, and then draw
a toolbar control on your form.

Don't worry about the location—Visual Studio will create a toolbar on your form
automatically and extend it across the window. The tool strip object itself appears
below the form in the component tray. On the form, the default toolbar contains
one button. Now you'll use a special shortcut feature to populate the toolbar
automatically.

2. Click the tiny shortcut arrow in the upper-right corner of the new toolbar.

The shortcut arrow points to the right and looks similar to the shortcut arrow we
saw in the PictureBox control in Chapter 2, "Writing Your First Program.” This short-
cut arrow is called a smart tag. When you click the arrow, a ToolStrip Tasks window
opens that includes a few of the most common toolbar tasks and properties. You
can configure the toolbar quickly with these commands.

3. Click Insert Standard Items.

Visual Studio adds a collection of standard toolbar buttons to the toolbar, including
New, Open, Save, Print, Cut, Copy, Paste, and Help. Your form looks similar to the
illustration on the next page.



Chapter 4 Working with Menus, Toolbars, and Dialog Boxes 109

[E= o )

B4

¥ G @ @[T

= MenuStripl

It is not necessary for you to start with a full toolbar of buttons as | have done here—
I'm merely demonstrating one of the useful “automatic” features of Visual Studio 2008.
You could also create the buttons on your toolbar one by one using the ToolStrip edit-
ing commands, as I'll demonstrate shortly. But for many applications, clicking Insert
Standard Items is a time-saving feature. Remember, however, that although these tool-
bar buttons look professional, they are not functional yet. They need event procedures
to make them work.

4. Click the Add ToolStripButton arrow on the right side of the new toolbar, then click the
Button item.

Add ToolStripButton adds additional items to your toolbar, such as buttons, labels,
split buttons, text boxes, combo boxes, and other useful interface elements. You've
now created a custom toolbar button; by default it contains a picture of a mountain
and a sun.

5. Widen the form window to ensure that you can see all of the tool strip items.
6. Right-click the new button, point to DisplayStyle, and click ImageAndText.

Your new button displays both text and a graphical image on the toolbar. Visual
Studio names your new button ToolStripButtonl in the program, and this name
appears by default on the toolbar. If necessary, widen the form window to see the
new button, because it contains the default text value ToolStripButtonl.
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Select the ToolStripButtonl object.

Change the ToolStripButtonl object’s Text property to Color, which is the name of your
button on the form, and then press Enter.

The Color button appears on the toolbar. You'll use this button later in the program to
change the color of text on the form. Now insert a custom bitmap for your button.

Right-click the Color button, and then click the Set Image command.
Click Local Resource (if it is not already selected), and then click the Import button.

Browse to the c:\vb08sbs\chap04 folder, click the ColorButton bitmap file that | created
for you, click Open, and then click OK.

Visual Studio loads the pink, blue, and yellow paint icon into the Color button, as
shown in the following illustration:

a5 Forml = |[&][82
Clock
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Your new button is complete, and you have learned how to add your own buttons to the
toolbar, in addition to the default items supplied by Visual Studio. Now you'll learn how to
delete and rearrange toolbar buttons.

Move and delete toolbar buttons

1.

Drag the new Color button to the left side of the toolbar.
Visual Studio lets you rearrange your toolbar buttons by using simple drag movements.
Right-click the second button in the toolbar (New), then click the Delete command.

The New button is removed from the toolbar. With the Delete command, you can de-
lete unwanted buttons, which makes it easy to customize the standard toolbar buttons
provided by the ToolStrip control.

Delete the Save and Print buttons, but be sure to keep the Color and Open buttons.

Now you'll learn to use dialog box controls and connect them to toolbar buttons.
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Using Dialog Box Controls

Visual Studio contains eight standard dialog box controls on the Dialogs and Printing tabs
of the Toolbox. These dialog boxes are ready-made, so you don't need to create your own
custom dialog boxes for the most common tasks in Windows applications, such as opening,
saving, and printing files. In many cases, you'll still need to write the event procedure code
that connects these dialog boxes to your program, but the user interfaces are built for you
and conform to the standards for common use among Windows applications.

The eight standard dialog box controls available to you are listed in the following table. With
a few important exceptions, they're similar to the objects provided by the CommonDialog
control in Visual Basic 6. The PrintPreviewControl control isn't listed here, but you'll find it
useful if you use the PrintPreviewDialog control.

Control name Purpose

OpenfFileDialog Gets the drive, folder name, and file name for an existing file

SaveFileDialog Gets the drive, folder name, and file name for a new file

FontDialog Lets the user choose a new font type and style

ColorDialog Lets the user select a color from a palette

FolderBrowserDialog Lets the user navigate through a computer’s folder structure and select a
folder

PrintDialog Lets the user set printing options

PrintPreviewDialog Displays a print preview dialog box like the Microsoft Word program does

PageSetupDialog Lets the user control page setup options, such as margins, paper size, and
layout

In the following exercises, you'll practice using the OpenFileDialog and ColorDialog con-
trols. The OpenFileDialog control lets your program open bitmap files, and the ColorDialog
control enables your program to change the color of the clock output. You'll connect these
dialog boxes to the toolbar that you just created, although you could just as easily connect
them to menu commands.

Add OpenfileDialog and ColorDialog controls

1. Click the OpenFileDialog control on the Dialogs tab of the Toolbox, and then click
the form.

An open file dialog box object appears in the component tray.

2. Click the ColorDialog control on the Dialogs tab of the Toolbox, and then click the
form again.
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The component tray now looks like this:

= MenuStripl 25 ToolStripl jOpenFileDialogl

Just like the menu strip and tool strip objects, the open file dialog box and color dialog box
objects appear in the component tray, and they can be customized with property settings.

Now you'll create a picture box object by using the PictureBox control. As you've seen, the
picture box object displays artwork on a form. This time, you'll display artwork in the picture
box by using the open file dialog box object.

Add a picture box object

1. Click the PictureBox control in the Toolbox.
2. Draw a picture box object on the form, below the label.

3. Use the shortcut arrow in the picture box object to set the SizeMode property of the
picture box to Stretchlmage.

Now you'll create event procedures for the Color and Open buttons on the toolbar.

Event Procedures That Manage Common Dialog Boxes

After you create a dialog box object, you can display the dialog box in a program by doing
the following:

B Type the dialog box name with the ShowDialog method in an event procedure associated
with a toolbar button or menu command.

B [f necessary, set one or more dialog box properties by using program code before
opening the dialog box.

B Use program code to respond to the user’s dialog box selections after the dialog box
has been manipulated and closed.

In the following exercise, you'll enter the program code for the OpenToolStripButton_Click
event procedure, the routine that executes when the Open command is clicked. You'll set
the Filter property in the OpenFileDialogl object to define the file type in the Open com-
mon dialog box. (You'll specify Windows bitmaps.) Then you'll use the ShowDialog method
to display the Open dialog box. After the user has selected a file and closed this dialog box,
you'll display the file he or she selected in a picture box by setting the Image property of
the picture box object to the file name the user selected.
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Edit the Open button event procedure

1. Double-click the Open button on your form’s toolbar.
The OpenToolStripButton_Click event procedure appears in the Code Editor.

2. Type the following program statements in the event procedure. Be sure to type each
line exactly as it's printed here, and press the Enter key after the last line.

OpenFileDialogl.Filter = “Bitmaps (*.bmp)|*.bmp”
If OpenFileDialogl.ShowDialog() = DialogResult.OK Then
PictureBoxl.Image = System.Drawing.Image.FromFile
(OpenFileDialogl.FileName)
End If

The first three statements in the event procedure refer to three different properties of
the open file dialog box object. The first statement uses the Filter property to define

a list of valid files. (In this case, the list has only one item: *.bmp.) This is important for
the Open dialog box because a picture box object can display a number of file types,
including:

B Bitmaps (bmp files)

®  Windows metafiles (emf and .wmf files)

B |cons (.ico files)

B Joint Photographic Experts Group format (jpg and .jpeg files)
B Portable Network Graphics format (.png files)

B Graphics Interchange Format (.gif files)

To add additional items to the Filter list, you can type a pipe symbol (|) between items.
For example, this program statement

OpenFileDialogl.Filter = “Bitmaps (*.bmp)|*.bmp|Metafiles (¥*.wmf)|*.wmf”
allows both bitmaps and Windows metafiles to be chosen in the Open dialog box.

The second statement in the event procedure displays the Open dialog box in the
program. ShowDialog is similar to the Show method in Visual Basic 6, but it can

be used with any Windows form. The ShowDialog method returns a result named
DialogResult, which indicates the button on the dialog box that the user clicked. To
determine whether the user clicked the Open button, an If..Then decision structure

is used to check whether the returned result equals DialogResult.OK. If it does, a valid
.bmp file path should be stored in the FileName property of the open file dialog box
object. (You'll learn more about the syntax of /f..Then decision structures in Chapter 6,
“Using Decision Structures.”)
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The third statement uses the file name selected in the dialog box by the user. When
the user selects a drive, folder, and file name and then clicks Open, the complete path
is passed to the program through the OpenfFileDialogl.FileName property. The System.
Drawing.Image.FromFile method, which loads electronic artwork, is then used to copy
the specified Windows bitmap into the picture box object. (I broke this statement with
the line continuation character (_) because it was rather long.)

Now you'll write an event procedure for the Color button that you added to the toolbar.

Write the Color button event procedure

1.

3.

Display the form again, and then double-click the Color button on the toolbar that you
added to the form.

An event procedure named ToolStripButton1_Click appears in the Code Editor. The
object name includes Buttonl because it was the first non-standard button that you
added to the toolbar. (You can change the name of this object to something more in-
tuitive, such as ColorToolStripButton, by clicking the button on the form and changing
the Name property in the Properties window.)

. Type the following program statements in the event procedure:

ColorDialogl.ShowDialog()

Labell.ForeColor = ColorDialogl.Color

The first program statement uses the ShowDialog method to open the color dialog
box. As you learned earlier in this chapter, ShowDialog is the method you use to open
any form as a dialog box, including a form created by one of the standard dialog box
controls that Visual Studio provides. The second statement in the event procedure
assigns the color that the user selected in the dialog box to the ForeColor property of
the Labell object. You might remember Labell from earlier in this chapter—it's the
label box you used to display the current time and date on the form. You'll use the
color returned from the color dialog box to set the color of the text in the label.

Note that the Color dialog box can be used to set the color of any user interface
element that supports color. Other possibilities include the background color of the
form, the colors of shapes on the form, and the foreground and background colors
of objects.

Click the Save All button on the Standard toolbar to save your changes.
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Controlling Color Choices by Setting Color Dialog Box Properties

If you want to further customize the color dialog box, you can control what color
choices the dialog box presents to the user when the dialog box opens. You can adjust

these color settings by using the Properties window, or by setting properties by using

program code before you display the dialog box with the ShowDialog method. The

following table describes the most useful properties of the ColorDialog control. Each

property should be set with a value of True to enable the option or False to disable

the option.
Property Meaning
AllowFullOpen Set to True to enable the Define Custom Colors button in the dialog box.
AnyColor Set to True if the user can select any color shown in the dialog box.
FullOpen Set to True if you want to display the Custom Colors area when the dialog

box first opens.

ShowHelp Set to True if you want to enable the Help button in the dialog box.
SolidColorOnly Set to True if you want the user to select only solid colors (dithered colors—

those that are made up of pixels of different colors—are disabled).

Now you'll run the Menu program and experiment with the menus and dialog boxes you've
created.

Run the Menu program

O

Tip The complete Menu program is located in the c:\vb08sbs\chap04\menu folder.

1. Click the Start Debugging button on the Standard toolbar.

The program runs, and the Clock menu and the toolbar appear at the top of the screen.
On the form'’s toolbar, click Open.

The Open dialog box opens. It looks great, doesn't it? Notice the Bitmaps (*.bmp) entry
in the dialog box. You defined this entry with the statement

OpenFileDialogl.Filter = “Bitmaps (*.bmp)|*.bmp”

in the OpenToolStripButton_Click event procedure. The first part of the text in quotes—
Bitmaps (*.bmp)—specifies which items are listed in the Files Of Type box. The second
part—*bmp—specifies the file name extension of the files that are to be listed in the
dialog box.
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3. Open a folder on your system that contains bitmap images. I'm using c:\program files\
microsoft office\clipart\pub60cor\, a folder containing Microsoft Publisher files.
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4. Select one of the bitmap files, and then click the Open button.

A picture of the bitmap appears in the picture box. (I've selected a clock image.) Your
form looks similar to this:

& Form1 =8 o )

Clock
[@colr 5| % B2 @ | @

Now you'll practice using the Clock menu.
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5. On the Clock menu, click the Time command.
The current time appears in the label box.
6. Click the Color button on the toolbar.

The Color dialog box opens, as shown here:
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The Color dialog box contains elements that you can use to change the color of the
clock text in your program. The current color setting, black, is selected.

7. Click the blue box, and then click OK.

The Color dialog box closes, and the color of the text in the clock label changes to blue.
(Not visible in this book, alas, but you'll see it on screen.)
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8. On the Clock menu, click the Date command.

The current date is displayed in blue type. Now that the text color has been set in the
label, it remains blue until the color is changed again or the program closes.

9. Close the program.
The application terminates, and the Visual Studio IDE appears.

That's it! You've learned several important commands and techniques for creating menus,
toolbars, and dialog boxes in your programs. After you learn more about program code,
you'll be able to put these skills to work in your own programs.

Adding Nonstandard Dialog Boxes to Programs

What if you need to add a dialog box to your program that isn't provided by one of
the eight dialog box controls in Visual Studio? No problem—but you'll need to do a
little extra design work. As you'll learn in future chapters, a Visual Basic program can
use more than one form to receive and display information. To create nonstandard
dialog boxes, you need to add new forms to your program, add input and output
objects, and process the dialog box clicks in your program code. (These techniques
will be discussed in Chapter 14, “Managing Windows Forms and Controls at Run
Time.") In Chapter 5, “Visual Basic Variables and Formulas, and the .NET Framework,”
you'll learn how to use two handy dialog boxes that are specifically designed for
receiving text input (InputBox) and displaying text output (MsgBox). These dialog
boxes help bridge the gap between the dialog box controls and the dialog boxes
that you need to create on your own.

One Step Further: Assigning Shortcut Keys to Menus

The MenuStrip control lets you assign shortcut keys to your menus. Shortcut keys are key
combinations that a user can press to activate a command without using the menu bar. For
example, on a typical Edit menu in a Windows application, such as Microsoft Word, you
can copy selected text to the Clipboard by pressing Ctrl+C. With the MenuStrip control’s
ShortcutKeys property, you can customize this setting. Try assigning two shortcut keys to
the Clock menu in the Menu program now.
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Assign shortcut keys to the Clock menu

1. Make sure that your program has stopped running and is in design mode.

You can modify a program only when it isn't running. (For an exception to this rule, see
Chapter 8: "Debugging Visual Basic Programs.”)

2. Click the Clock menu, and then click the Time command to highlight it.

Before you set the shortcut key for a menu command, you must select it. You assign
a shortcut key by setting the ShortcutKeys property for the command by using the
Properties window. (In Visual Basic .NET 2002 and 2003, this property was named
Shortcut.) The menu strip object provides an easy way for you to do this.

3. Open the Properties window, click the ShortcutKeys property, and then click the arrow
in the second column.

A pop-up menu appears that helps you assign the shortcut key.
4. Select the Ctrl check box, click the Key list box, and select the letter “T" in the list.

The Properties window looks like this:
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ShortcutKeys

The shortcut key associated with the menu iterm.

Q Tip Visual Basic normally displays the shortcut key combination in the menu when you

run the program, to give users a hint about which keys to press. To hide shortcut key
combinations from the user (if you're running out of space) set the ShowShortcutKeys
property to False. The shortcut key still works, but users won't see a visual reminder for
it. You can also set what will be displayed within the program as a shortcut key by setting
the ShortcutKeyDisplayString property.
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Click the Date command, and then change its ShortcutKeys property setting to Ctrl+D.
Now you'll run the program and try the shortcut keys.

Click the form to close the Clock menu.

Click the Start Debugging button on the Standard toolbar.

Press Ctrl+D to run the Date command.

The current date appears in the program.

Press Ctrl+T to run the Time command.

The current time appears in the program.

Click the Clock menu.

The shortcut keys are listed beside the Time and Date commands, as shown in the
following illustration. Visual Basic adds these key combinations when you define the
shortcuts by using the ShortcutKeys property.

a Forml (=l EE
Clock

Time  Ctrl+T B | @
Date  Ctrl+D
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Close the program.

The Menu program closes, and the development environment appears.

You're ready to move deeper into writing programs now, in the part of the book | call
“Programming Fundamentals.”
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Chapter 4 Quick Reference

Do this

Click the MenuStrip control, and draw a menu on your form. Click the Type
Here tag on your form, and type the name of the menus and commands
that you want to create.

Click the menu item twice to display the I-beam, and then type an ampersand
(&) followed by the letter you want to use as an access key.

Set the ShortcutKeys property of the menu item by using the Properties
window. A list of common shortcut keys is provided.

Drag the menu item you want to move to a new location.

Click the ToolStrip control, and draw a toolbar on your form. Right-click
buttons to customize them. Double-click buttons and write event proce-
dures to configure them.

Add one of the eight standard dialog box controls to your form, and then
customize it with property settings and program code. Dialog box controls
are located on the Dialogs and Printing Toolbar tabs.

Add the OpenFileDialog control to your form. Display the dialog box with
the ShowDialog method. The FileName property contains the name of the
file selected.

Add the ColorDialog control to your form. Display the dialog box with
the ShowDialog method. The Color property contains the color the user
selected.
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In Part I, “Getting Started with Microsoft Visual Basic 2008,” you learned how to create
the user interface of a Microsoft Visual Basic 2008 program and how to build and run a

program in the Microsoft Visual Studio 2008 development environment. In the nine chap-
ters in Part Il, “Programming Fundamentals,” you'll learn more about Visual Basic program

code—the statements and keywords that form the core of a Visual Basic program. You'll

learn how to manage information within programs and control how your code is executed,
and you'll learn how to use decision structures, loops, timers, arrays, collections, and text

files. You'll also learn how to debug your programs and handle run-time errors if they
occur. After you complete Part Il, you'll be ready for more advanced topics, such as
customizing the user interface, database programming, and Web programming.
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Chapter 5
Visual Basic Variables and Formulas,
and the .NET Framework

After completing this chapter, you will be able to:
®  Use variables to store data in your programs.
B Get input by using the InputBox function.
B Display messages by using the MsgBox function.
B Work with different data types.
B Use variables and operators to manipulate data.
B Use methods in the .NET Framework.
B Use arithmetic operators and functions in formulas.

In this chapter, you'll learn how to use variables and constants to store data temporarily in your
program, and how to use the InputBox and MsgBox functions to gather and present informa-
tion by using dialog boxes. You'll also learn how to use functions and formulas to perform
calculations, and how to use arithmetic operators to perform tasks such as multiplication and
string concatenation. Finally, you'll learn how to tap into the powerful classes and methods of
the Microsoft .NET Framework 3.5 to perform mathematical calculations and other useful work.

The Anatomy of a Visual Basic Program Statement

As you learned in Chapter 2, “Writing Your First Program,” a line of code in a Visual Basic
program is called a program statement. A program statement is any combination of Visual
Basic keywords, properties, object names, variables, numbers, special symbols, and other
values that collectively create a valid instruction recognized by the Visual Basic compiler.
A complete program statement can be a simple keyword, such as

End

which halts the execution of a Visual Basic program, or it can be a combination of elements,
such as the following statement, which uses the TimeString property to assign the current
system time to the Text property of the Labell object:

Labell.Text = TimeString

125
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The rules of construction that must be used when you build a programming statement are
called statement syntax. Visual Basic shares many of its syntax rules with earlier versions of
the BASIC programming language and with other language compilers. The trick to writing
good program statements is learning the syntax of the most useful language elements and
then using those elements correctly to process the data in your program. Fortunately, Visual
Basic does a lot of the toughest work for you, so the time you spend writing program code is
relatively short, and you can reuse the results in future programs. The Visual Studio IDE also
points out potential syntax errors and suggests corrections, much like the AutoCorrect fea-
ture of Microsoft Office Word.

In this chapter and the following chapters, you'll learn the most important Visual Basic key-
words and program statements, as well as many of the objects, properties, and methods
provided by Visual Studio controls and the .NET Framework. You'll find that these keywords
and objects complement nicely the programming skills you've already learned and will help
you write powerful programs in the future. The first topics—variables and data types—are
critical features of nearly every program.

Using Variables to Store Information

A variable is a temporary storage location for data in your program. You can use one or
many variables in your code, and they can contain words, numbers, dates, properties,
or other values. By using variables, you can assign a short and easy-to-remember name
to each piece of data you plan to work with. Variables can hold information entered by
the user at run time, the result of a specific calculation, or a piece of data you want to
display on your form. In short, variables are handy containers that you can use to store
and track almost any type of information.

Using variables in a Visual Basic program requires some planning. Before you can use a
variable, you must set aside memory in the computer for the variable’s use. This process is
a little like reserving a seat at a theater or a baseball game. I'll cover the process of making
reservations for, or declaring, a variable in the next section.

Setting Aside Space for Variables: The Dim Statement

Since the release of Microsoft Visual Basic .NET 2003, it has been necessary for Visual

Basic programmers to explicitly declare variables before using them. This was a change
from Visual Basic 6 and earlier versions of Visual Basic, where (under certain circumstances)
you could declare variables implicitly—in other words, simply by using them and without

a Dim statement. The earlier practice was flexible but rather risky—it created the potential
for variable confusion and misspelled variable names, which introduced potential bugs into
the code that might or might not be discovered later.
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In Visual Basic 2008, a bit of the past has returned in the area of variable declaration. It is
possible once again to declare a variable implicitly. | don't recommend this, however, so |
won't discuss this new feature until you learn the recommended programming practice,
which experienced programmers far and wide will praise you for adopting.

To declare a variable in Visual Basic 2008, type the variable name after the Dim statement.
(Dim stands for dimension.) This declaration reserves room in memory for the variable when
the program runs and lets Visual Basic know what type of data it should expect to see later.
Although this declaration can be done at any place in the program code (as long as the
declaration happens before the variable is used), most programmers declare variables in
one place at the top of their event procedures or code modules.

For example, the following statement creates space for a variable named LastName that will
hold a textual, or string, value:

Dim LastName As String

Note that in addition to identifying the variable by name, I've used the As keyword to give the
variable a particular type, and I've identified the type by using the keyword String. (You'll learn
about other data types later in this chapter.) A string variable contains textual information:
words, letters, symbols—even numbers. | find myself using string variables a lot; they hold
names, places, lines from a poem, the contents of a file, and many other “wordy” data.

Why do you need to declare variables? Visual Basic wants you to identify the name and the
type of your variables in advance so that the compiler can set aside the memory the program
will need to store and process the information held in the variables. Memory management
might not seem like a big deal to you (after all, modern personal computers have lots of
RAM and gigabytes of free hard disk space), but in some programs, memory can be con-
sumed quickly, and it's a good practice to take memory allocation seriously even as you
take your first steps as a programmer. As you'll soon see, different types of variables have
different space requirements and size limitations.

Note In some earlier versions of Visual Basic, specific variable types (such as String or Integer)
aren't required—information is simply held by using a generic (and memory hungry) data type
called Variant, which can hold data of any size or format. Variants are not supported in Visual
Basic 2008. Although they are handy for beginning programmers, their design makes them slow
and inefficient, and they allow variables to be converted from one type to another too easily—
often causing unexpected results. As you'll learn later, however, you can still store information
in generic containers called Object, which are likewise general-purpose in function but rather
inefficient in size.
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After you declare a variable, you're free to assign information to it in your code by using
the assignment operator (=). For example, the following program statement assigns the last
name "Jefferson” to the LastName variable:

LastName = "Jefferson"

Note that | was careful to assign a textual value to the LastName variable because its data
type is String. | can also assign values with spaces, symbols, or numbers to the variable,
such as

LastName = "1313 Mockingbird Lane"

but the variable is still considered a string value. The number portion could be used in a
mathematical formula only if it were first converted to an integer or a floating-point value
by using one of a handful of conversion functions I'll discuss later in this book.

After the LastName variable is assigned a value, it can be used in place of the name
“Jefferson” in your code. For example, the assignment statement

Labell.Text = LastName

displays “Jefferson” in the label named Labell on your form.

Implicit Variable Declaration

If you really want to declare variables “the old way" in Visual Basic 2008 —that is, without
explicitly declaring them by using the Dim statement—you can place the Option Explicit Off
statement at the very top of your form’s or module’s program code (before any event proce-
dures), and it will turn off the Visual Basic default requirement that variables be declared before
they're used. As | mentioned earlier, | don't recommend this statement as a permanent addi-
tion to your code, but you might find it useful temporarily as you convert older Visual Basic
programs to Visual Studio 2008.

Another possibility is to use the new Option Infer statement, which has been added to Visual
Basic 2008. If Option Infer is set to “On", Visual Basic will deduce or infer the type of a variable
by examining the initial assignment you make. This allows you to declare variables without
specifically identifying the type used, and allowing Visual Basic to make the determination.
For example, the expression

Dim attendance = 100

will declare the variable named attendance as an Integer, because 100 is an integer expression.
In other words, with Option Infer set to “On”, it is the same as typing

Dim attendance As Integer = 100
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Likewise, the expression

Dim address = "1012 Daisy Lane"

will declare the variable address as type String, because its initial assignment was of type
String. If you set Option Infer to “Off", however, Visual Basic will declare the variable as type
Object—a general (though somewhat bulky and inefficient) container for any type of data.

If you plan to use Option Infer to allow this type of inferred variable declaration (a flexible
approach, but one that could potentially lead to unexpected results), place the following
two statements at the top of your code module (above the Class Form statement):

Option Explicit Off
Option Infer On

Option Explicit Off allows variables to be declared as they are used, and Option Infer On
allows Visual Basic to determine the type automatically. You can also set these options
using the Options command on the Tools menu as discussed in Chapter 1, “Exploring
the Visual Studio Integrated Development Environment.”

Using Variables in a Program

Variables can maintain the same value throughout a program, or they can change values
several times, depending on your needs. The following exercise demonstrates how a variable
named LastName can contain different text values and how the variable can be assigned to
object properties.

Change the value of a variable

1. Start Visual Studio.
2. On the File menu, click Open Project.
The Open Project dialog box opens.
3. Open the Variable Test project in the c:\\vb08sbs\chapO5\variable test folder.

4. If the project’s form isn't visible, click Form1.vb in Solution Explorer, and then click the
View Designer button.

The Variable Test form opens in the Designer. Variable Test is a skeleton program—it
contains a form with labels and buttons for displaying output, but little program code.
(I create these skeleton programs now and then to save you time, although you can
also create the project from scratch.) You'll add code in this exercise.
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The Variable Test form looks like this:

o5 Wariable Test |£||ﬂ|@

| Show ‘ Labell

Label2
‘ Cluit | e

The form contains two labels and two buttons. You'll use variables to display information
in each of the labels.

Note The label objects look like boxes because | set their BorderStyle properties to
Fixed3D.

5. Double-click the Show button.
The Button1_Click event procedure appears in the Code Editor.

6. Type the following program statements to declare and use the LastName variable:
Dim LastName As String

LastName = "Luther"
Labell.Text = LastName

LastName = "Bodenstein von Karlstadt"

Label2.Text = LastName

The program statements are arranged in three groups. The first statement declares
the LastName variable by using the Dim statement and the String type. After you
type this line, Visual Studio places a green jagged line under the LastName variable,
because it has been declared but not used in the program. There is nothing wrong
here—Visual Studio is just reminding you that a new variable has been created and
is waiting to be used.

Tip If the variable name still has a jagged underline when you finish writing your program,
it could be a sign that you misspelled a variable name somewhere within your code.
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The second and third lines assign the name “Luther” to the LastName variable and
then display this name in the first label on the form. This example demonstrates one
of the most common uses of variables in a program—transferring information to

a property. As you have seen before, all string values assigned to variables are dis-
played in red type.

The fourth line assigns the name “Bodenstein von Karlstadt” to the LastName variable
(in other words, it changes the contents of the variable). Notice that the second string
is longer than the first and contains a few blank spaces. When you assign text strings
to variables, or use them in other places, you need to enclose the text within quotation
marks. (You don't need to do this with numbers.)

Finally, keep in mind another important characteristic of the variables being declared
in this event procedure—they maintain their scope, or hold their value, only within the
event procedure you're using them in. Later in this chapter, you'll learn how to declare
variables so that they can be used in any of your form's event procedures.

7. Click the Forml.vb [Design] tab to display the form again.
8. Double-click the Quit button.

The Button2_Click event procedure appears in the Code Editor.
9. Type the following program statement to stop the program:

End

Your screen looks like this:

Forml.vb® | Forrnlwh [Design]* | Start Page

¥ Button? * & Click -
HPublic Class Formil 1

-

= Frivate Zub Buttonl Click(EyVal sender Ais Zystem.Chject, EyVal e
Dim LastNamwe L= Ztring

LastMame = "Luther”
Labell.Text = LastName

LastName = "Bodenstein von Earlstado” =
Labeli.Text = LastName

- End Zub

= Frivate Zub Buttoni Click(EyVal sender Ais Zystem.Chject, Eyval e
End

- End Zub

“End Class

10. Click the Save All button on the Standard toolbar to save your changes.
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11. Click the Start Debugging button on the Standard toolbar to run the program.
The program runs in the IDE.
12. Click the Show button.

The program declares the variable, assigns two values to it, and copies each value
to the appropriate label on the form. The program produces the output shown in
the following figure.

o5 Wariable Test = ||ﬂ|@

| Shaw | Luther

| Bodenstein von Karlstadt

‘ Cluit

13. Click the Quit button to stop the program.

The program stops, and the development environment returns.

Variable Naming Conventions

Naming variables can be a little tricky because you need to use names that are short
but intuitive and easy to remember. To avoid confusion, use the following conventions
when naming variables:

B Begin each variable name with a letter or underscore. This is a Visual Basic re-
quirement. Variable names can contain only letters, underscores, and numbers.

B Although variable names can be virtually any length, try to keep them under 33
characters to make them easier to read. (Variable names are limited to 255 char-
acters in Visual Basic 6, but that's no longer a constraint.)

B Make your variable names descriptive by combining one or more words when
it makes sense to do so. For example, the variable name SalesTaxRate is much
clearer than Tax or Rate.

B Use a combination of uppercase and lowercase characters and numbers. An
accepted convention is to capitalize the first letter of each word in a variable; for
example, DateOfBirth. However, some programmers prefer to use so-called camel
casing (making the first letter of a variable name lowercase) to distinguish variable
names from functions and module names, which usually begin with uppercase
letters. Examples of camel casing include dateOfBirth, employeeName, and
counter.
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B Don't use Visual Basic keywords, objects, or properties as variable names. If you
do, you'll get an error when you try to run your program.

B Optionally, you can begin each variable name with a two-character or three-
character abbreviation corresponding to the type of data that's stored in the
variable. For example, use strName to show that the Name variable contains
string data. Although you don’t need to worry too much about this detail now,
you should make a note of this convention for later—you'll see it in parts of the
Visual Studio documentation and in many of the advanced books about Visual
Basic programming. (This convention and abbreviation scheme was originally
created by Microsoft Distinguished Engineer Charles Simonyi and is sometimes
called the Hungarian Naming Convention.)

Using a Variable to Store Input

One practical use for a variable is to temporarily hold information that was entered by the
user. Although you can often use an object such as a list box or a text box to gather this infor-
mation, at times you might want to deal directly with the user and save the input in a variable
rather than in a property. One way to gather input is to use the InputBox function to display a
dialog box on the screen and then use a variable to store the text the user types. You'll try this
approach in the following example.

Get input by using the /InputBox function

1. On the File menu, click Open Project.
The Open Project dialog box opens.

2. Open the Input Box project in the c:\vb08sbs\chap05\input box folder.
The Input Box project opens in the IDE. Input Box is a skeleton program.

3. If the project’s form isn't visible, click Form1.vb in Solution Explorer, and then click the
View Designer button.

The form contains one label and two buttons. You'll use the InputBox function to get
input from the user, and then you'll display the input in the label on the form.

4. Double-click the Input Box button.
The Button1_Click event procedure appears in the Code Editor.
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Type the following program statements to declare two variables and call the InputBox
function:

Dim Prompt, FullName As String
Prompt = "Please enter your name."

FullName = InputBox(Prompt)

Labell.Text = FullName

This time, you're declaring two variables by using the Dim statement: Prompt and
FullName. Both variables are declared using the String type. (You can declare as many
variables as you want on the same line, as long as they are of the same type.) Note that
in Visual Basic 6, this same syntax would have produced different results. Dim would
create the Prompt variable using the Variant type (because no type was specified) and
the FullName variable using the String type. But this logical inconsistency has been
fixed in Visual Basic versions 2002 and later.

The second line in the event procedure assigns a text string to the Prompt variable.
This message is used as a text argument for the InputBox function. (An argument is

a value or an expression passed to a procedure or a function.) The next line calls the
InputBox function and assigns the result of the call (the text string the user enters) to
the FullName variable. InputBox is a special Visual Basic function that displays a dia-
log box on the screen and prompts the user for input. In addition to a prompt string,
the InputBox function supports other arguments you might want to use occasionally.
Consult the Visual Studio documentation for details.

After InputBox has returned a text string to the program, the fourth statement in the
procedure places the user’s name in the Text property of the Labell object, which
displays it on the form.

Note In older versions of BASIC, the InputBox function included a $ character at the end
to help programmers remember that the function returned information in the string ($)
data type. String variables were also identified with the $ symbol on occasion. These days
we don't use character abbreviations for data types. String ($), Integer (%), and the other
type abbreviations are now relics.

Save your changes.

Click the Start Debugging button on the Standard toolbar to run the program.
The program runs in the IDE.

Click the Input Box button.

Visual Basic executes the ButtonI_Click event procedure, and the Input Box dialog box
opens on your screen, as shown here:
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H

Input Box

Fleaze enter your name. oK

| Cancel |

9. Type your full name, and then click OK.

The InputBox function returns your name to the program and places it in the FullName
variable. The program then uses the variable to display your name on the form, as
shown here:

o5 Input Box | =]

0

| iooiEa | Maria Chavez

| Cluit |

Use the InputBox function in your programs anytime you want to prompt the user for
information. You can use this function in combination with the other input controls to
regulate the flow of data into and out of a program. In the next exercise, you'll learn
how to use a similar function to display text in a dialog box.

10. Click the Quit button on the form to stop the program.

The program stops, and the development environment reappears.

What Is a Function?

InputBox is a special Visual Basic keyword known as a function. A function is a statement
that performs meaningful work (such as prompting the user for information or calculating
an equation) and then returns a result to the program. The value returned by a function
can be assigned to a variable, as it was in the Input Box program, or it can be assigned to
a property or another statement or function. Visual Basic functions often use one or more
arguments to define their activities. For example, the InputBox function you just executed
used the Prompt variable to display dialog box instructions for the user. When a function
uses more than one argument, commas separate the arguments, and the whole group of
arguments is enclosed in parentheses. The following statement shows a function call that
has two arguments:

FullName = InputBox(Prompt, Title)

Notice that I'm using italic in this syntax description to indicate that certain items are
placeholders for information you specify. This is a style you'll find throughout the book
and in the Visual Studio documentation.
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Using a Variable for Output

You can display the contents of a variable by assigning the variable to a property (such as
the Text property of a label object) or by passing the variable as an argument to a dialog box
function. One useful dialog box function for displaying output is the MsgBox function. When
you call the MsgBox function, it displays a dialog box, sometimes called a message box, with
various options that you can specify. Like InputBox, it takes one or more arguments as input,
and the results of the function call can be assigned to a variable. The syntax for the MsgBox
function is

ButtonClicked = MsgBox(Prompt, Buttons, Title)

where Prompt is the text to be displayed in the message box; Buttons is a number that specifies
the buttons, icons, and other options to display for the message box; and Title is the text dis-
played in the message box title bar. The variable ButtonClicked is assigned the result returned
by the function, which indicates which button the user clicked in the dialog box.

If you're just displaying a message using the MsgBox function, the ButtonClicked variable, the
assignment operator (=), the Buttons argument, and the Title argument are optional. You'll
be using the Title argument, but you won't be using the others in the following exercise; for
more information about them (including the different buttons you can include in MsgBox
and a few more options), search for MsgBox Function in the Visual Studio documentation.

Note Visual Basic provides both the MsgBox function and the MessageBox class for displaying
text in a message box. The MessageBox class is part of the System.Windows.Forms namespace, it
takes arguments much like MsgBox, and it is displayed by using the Show method. I'll use both
MsgBox and MessageBox in this book.

Now you'll add a MsgBox function to the Input Box program to display the name the user
enters in the Input Box dialog box.

Display a message by using the MsgBox function

1. If the Code Editor isn't visible, double-click the Input Box button on the Input Box form.

The Button1_Click event procedure appears in the Code Editor. (This is the code you
entered in the last exercise.)

2. Select the following statement in the event procedure (the last line):

Labell.Text = FullName

This is the statement that displays the contents of the FullName variable in the label.
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3. Press the Delete key to delete the line.
The statement is removed from the Code Editor.
4. Type the following line into the event procedure as a replacement:

MsgBox(FullName, , "Input Results")

This new statement will call the MsgBox function, display the contents of the FullName
variable in the dialog box, and place the words Input Results in the title bar. (The op-
tional Buttons argument and the ButtonClicked variable are irrelevant here and have
been omitted.) Your event procedure looks like this:

Forml.vb® Forrnlwb [Design]* | Start Page

¥ Buttonl * & Click -
[ Public Class Forml =
-
J—] Frivate Zub Buttoni Click(EyVal sender Ais Zystem.Chject, Eyval e
End
- End Zub
=] Priwvate Jub Buttonl Click{ByVal sender As System.Chject, ByVal e
Dim Prompt, FulllName L= Ztring
Prompt = "Flease enter vyour name., '™

m

FullMatme = InputBox (Prompt)

M=gBox (FulllWame, , "Input Eesults™)
- End Sub|
End Class

5. Click the Start Debugging button on the Standard toolbar.
6. Click the Input Box button, type your name in the input box, and then click OK.

Visual Basic stores the input in the program in the FullName variable and then displays
it in a message box. Your screen looks similar to this:

a5 Input Box = = &R

Input Box P ———
Input Results (=3
\L’ Maria Chavez

7. Click OK to close the message box. Then click Quit to close the program.

The program closes, and the development environment returns.
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Working with Specific Data Types

The String data type is useful for managing text in your programs, but what about numbers,
dates, and other types of information? To allow for the efficient memory management of all
types of data, Visual Basic provides several additional data types that you can use for your
variables. Many of these are familiar data types from earlier versions of BASIC or Visual Basic,
and some of the data types were introduced in Visual Studio 2005 to allow for the efficient
processing of data in newer 64-bit computers.

The following table lists the fundamental (or elementary) data types in Visual Basic. Four new
data types were added in Visual Basic 2005: SByte, UShort, Ulnteger, and ULong. SByte allows
for “signed” byte values—that is, for both positive and negative numbers. UShort, Ulnteger,
and ULong are "unsigned” data types—meaning that they cannot hold negative numbers.
(However, as unsigned data types they offer twice the positive-number range of their signed
counterparts, as shown in the table below.) If your program needs to perform a lot of calcu-
lations, you'll gain a performance advantage in your programs if you choose the right data
type for your variables—a size that's neither too big nor too small. In the next exercise, you'll
see how several of these data types work.

Note Variable storage size is measured in bits. The amount of space required to store one
standard (ASCII) keyboard character in memory is 8 bits, which equals 1 byte.

Data type Size Range Sample usage
Short 16-bit -32,768 through 32,767 Dim Birds As Short
Birds = 12500
UShort 16-bit 0 through 65,535 Dim Days As UShort
Days = 55000
Integer 32-bit -2,147,483,648 through Dim Insects As Integer
2,147483,647 Insects = 37500000
Ulnteger 32-bit 0 through 4,294,967,295 Dim Joys As UInteger
Joys = 3000000000
Long 64-bit -9,223,372,036,854,775,808 to 9,223, Dim WorldPop As Long
372,036,854,775,807 WorldPop = 4800000004
ULong 64-bit 0 through 18,446,744,073,709,551, Dim Stars As UlLong
615 Stars = _
1800000000000000000
Single 32-bit -3.4028235E38 through Dim Price As Single
floating point ~ 3.4028235E38 Price = 899.99
Double 64-bit -1.79769313486231E308 through Dim Pi As Double

floating point  1.79769313486231E308 Pi = 3.1415926535



Data type
Decimal

Byte

SByte

Char

String

Boolean

Date

Object
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Size
128-bit

8-bit

8-bit

16-bit

Usually 16-bits
per character

16-bit

64-bit

32-bit

Range

0 through +/-79,228,162,514,264,
337,593,543,950,335 (+/-7.9..E+28)
with no decimal point; 0 through
+/-7.922816251426433759354395
0335 with 28 places to the right of
the decimal. Append "D” if you want
to force Visual Basic to initialize a
Decimal.

0 through 255 (no negative
numbers)

-128 through 127

Any Unicode symbol in the range
0-65,535. Append “c” when initial-
izing a Char.

0 to approximately 2 billion

16-bit Unicode characters

True or False. (During conversions,
0 is converted to False, other values
to True.)

January 1, 0001, through
December 31, 9999

Any type can be stored in a variable
of type Object.

Use fundamental data types in code

1. On the File menu, click Open Project.

The Open Project dialog box opens.
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Sample usage

Dim Debt As Decimal
Debt = 7600300.5D

Dim RetKey As Byte
RetKey = 13

Dim NegVal As SByte
Negval = -20
Dim UnicodeChar As Char

non

UnicodeChar = C

Dim Dog As String
Dog = "pointer"

Dim Flag as Boolean
Flag = True

Dim Birthday as Date
Birthday = #3/1/1963#

Dim MyApp As Object
MyApp = CreateObject _
("Word.AppTlication™)

2. Open the Data Types project from the c:\\vb08sbs\chap05\data types folder.

3. If the project’s form isn't visible, click Form1l.vb in Solution Explorer, and then click the

View Designer button.

Data Types is a complete Visual Basic program that | created to demonstrate how the
fundamental data types work. You'll run the program to see what the data types look
like, and then you'll look at how the variables are declared and used in the program

code. You'll also learn where to place variable declarations so that they're available to
all the event procedures in your program.
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4. Click the Start Debugging button on the Standard toolbar.

The following application window opens:

o5 Data Type Tester [E=HE=H|E=D|

Fundamental Data Types

Chooze a data type

Short
Integer
Laong
Single
Double
Decimal
Byte
Char
Shing
Boolean )
Date Quit

Sample Data

The Data Types program lets you experiment with 11 data types, including integer,
single-precision floating point, and date. The program displays an example of each
type when you click its name in the list box.

5. Click the Integer type in the list box.

The number 37500000 appears in the Sample Data box. Note that with the Short,
Integer, and Long data types, you can't insert or display commas. To display commas,
you'll need to use the Format function.

o5 Data Type Tester == s

Fundamental Data Types

Chooze a data type

Shatt Sample Data
37500000

Laong

Single

Double

Decimal

Byte

Char

Shing

Boolean e

Date Quit

6. Click the Date type in the list box.
The date 3/1/1963 appears in the Sample Data box.
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7. Click each data type in the list box to see how Visual Basic displays it in the Sample

Data box.
Click the Quit button to stop the program.

Now you'll examine how the fundamental data types are declared at the top of the
form and how they're used in the ListBox1_SelectedindexChanged event procedure.

Double-click the form itself (not any objects on the form), and enlarge the Code Editor
to see more of the program code.

The Code Editor looks like this:

Start Page "Forml.vb “Farmlvb [Design]

“Forml ~ [i](Declarations) -
HPublic Class Formil 1
o

é 'Declare wariables here =so that they can he used in

- 'all of this form's ewvent procedures
Dim Birds ALs Short

Dim Insects Ls Integer
Diirm WorldPop Ls Long
Dim Price ALs Single

Dim Pi As Double

Dim Debt As Decimal

Diim RetKey Ls Evte

Dim UnicodeChar Ls Char
Dim Dog hs String

Dim Flag is Boolean
Dim Birthday Ls Date

m

Scroll to the top of the Code Editor to see the dozen or so program statements | added
to declare 11 variables in your program—one for each of the fundamental data types
in Visual Basic. (I didn't create an example for the SByte, UShort, Ulnteger, and ULong
types, because they closely resemble their signed or unsigned counterparts.) By placing
each Dim statement here, at the top of the form’s code initialization area, I'm ensuring
that the variables will be valid, or will have scope, for all of the form’s event procedures.
That way, | can set the value of a variable in one event procedure and read it in another.
Normally, variables are valid only in the event procedure in which they're declared.

To make them valid across the form, you need to declare variables at the top of your
form's code.

Note I've given each variable the same name as | did in the data types table earlier in the
chapter so that you can see the examples | showed you in actual program code.
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10. Scroll down in the Code Editor, and examine the Form1_Load event procedure.

You'll see the following statements, which add items to the list box object in the
program. (You might remember this syntax from Chapter 3, “Working with Toolbox
Controls"—I used some similar statements there.)

Start Page "Forml.vb “Farmlvb [Design]

“Forml ~ [i](Declarations) -
End Zelect —1
F End Sub g

= Frivate Zub Forml Load(EyVal sender Ais Zystem.Chject, EyvVal e is

'add names to the list box (see chapter 3)
ListBoxl.Items. A dd |("Short'™)
ListBoxl.Items. A dd (" "Integer™)
ListBoxl.Items. A dd("Long'™)
ListBoxl.Items.Add("Single™)
ListBoxl.Items.Add("Doukle™)
ListBoxl.Items. A dd ("Decimal™)
ListBoxl.Items.Add("Evyte'™)
ListBoxl.Items.Add("Char'™)
ListBoxl.Items.Add("Scring™)
ListBoxl.Items. A dd("Eoolean™)
ListBoxl.Items.Add("Date')
- End Zub

m

11. Scroll down and examine the ListBox1_SelectedindexChanged event procedure.

The ListBox1_SelectedindexChanged event procedure processes the selections you
make in the list box and looks like this:

Start Page "Forml.vb “Farmlvb [Design]

“Forml ~ [](Declarations) -
J] =
= Frivate Zub ListBoxl ZelectedIndexChanged (EyVal sender is System.'

Select Case ListBoxl.SelectedIndex
Case 0

Birds = 12500

Labeli.Text = Birds
Case 1

Insects = 37500000

Lakheli.Text = Insects
Caze 2

Wor ldPop = 4300000004

Lakbeld.Text = WorldFop
Casze 3

Price = §599.95

Labeli.Text = Price
Case 4

Pi = 3.1415926535

Labeli.Text = Pi
Case 5

Debt = 7600300.5

Lalheli.Text = Debt
Case 6

RetKey = 13

Lakelld.Text = RetHey

m




12.

13.
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The heart of the event procedure is a Select Case decision structure. In the next chapter,
we'll discuss how this group of program statements selects one choice from many. For
now, notice how each section of the Select Case block assigns a sample value to one of
the fundamental data type variables and then assigns the variable to the Text property
of the Label4 object on the form. | used code like this in Chapter 3 to process list box
choices, and you can use these techniques to work with list boxes and data types in
your own programs.

Note If you have more than one form in your project, you need to declare variables in a
slightly different way (and place) to give them scope throughout your program (that is, in
each form that your project contains). The type of variable that you'll declare is a public, or
global, variable, and it's declared in a module, a special file that contains declarations and
procedures not associated with a particular form. For information about creating public
variables in modules, see Chapter 10, “Creating Modules and Procedures.”

Scroll through the ListBox1_SelectedindexChanged event procedure, and examine each
of the variable assignments closely.

Try changing the data in a few of the variable assignment statements and running the
program again to see what the data looks like. In particular, you might try assigning
values to variables that are outside their accepted range, as shown in the data types
table presented earlier. If you make such an error, Visual Basic adds a jagged line below
the incorrect value in the Code Editor, and the program won't run until you change it.
To learn more about your mistake, you can point to the jagged underlined value and
read a short tooltip error message about the problem.

Tip By default, a green jagged line indicates a warning, a red jagged line indicates a syntax
error, a blue jagged line indicates a compiler error, and a purple jagged line indicates some
other error.

If you made any changes you want to save to disk, click the Save All button on the
Standard toolbar.
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User-Defined Data Types

Visual Basic also lets you create your own data types. This feature is most useful when
you're dealing with a group of data items that naturally fit together but fall into different
data categories. You create a user-defined type (UDT) by using the Structure statement,
and you declare variables associated with the new type by using the Dim statement. Be
aware that the Structure statement cannot be located in an event procedure—it must
be located at the top of the form along with other variable declarations, or in a code
module.

For example, the following declaration creates a user-defined data type named Employee
that can store the name, date of birth, and hire date associated with a worker:
Structure Employee

Dim Name As String

Dim DateOfBirth As Date

Dim HireDate As Date
End Structure

After you create a data type, you can use it in the program code for the form's or module’s
event procedures. The following statements use the new Employee type. The first state-
ment creates a variable named ProductManager, of the Employee type, and the second
statement assigns the name “Greg Baker” to the Name component of the variable:

Dim ProductManager As Employee

ProductManager.Name = "Greg Baker"

This looks a little similar to setting a property, doesn't it? Visual Basic uses the same
notation for the relationship between objects and properties as it uses for the rela-
tionship between user-defined data types and component variables.

Constants: Variables That Don’t Change

If a variable in your program contains a value that never changes (such as 7, a fixed math-
ematical entity), you might consider storing the value as a constant instead of as a variable.
A constant is a meaningful name that takes the place of a number or a text string that
doesn't change. Constants are useful because they increase the readability of program
code, they can reduce programming mistakes, and they make global changes easier to
accomplish later. Constants operate a lot like variables, but you cant modify their values
at run time. They are declared with the Const keyword, as shown in the following example:

Const Pi As Double = 3.14159265
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This statement creates a constant named Pi that can be used in place of the value of  in the
program code. To make a constant available to all the objects and event procedures in your
form, place the statement at the top of your form along with other variable and structure
declarations that will have scope in all of the form'’s event procedures. To make the constant
available to all the forms and modules in a program (not just Form1I), create the constant in a
code module, with the Public keyword in front of it. For example:

Public Const Pi As Double = 3.14159265

The following exercise demonstrates how you can use a constant in an event procedure.

Use a constant in an event procedure

1. On the File menu, click Open Project.
The Open Project dialog box opens.
2. Open the Constant Tester project in the c:\vb08sbs\chap05\constant tester folder.

3. If the project’s form isn't visible, click Form1.vb in Solution Explorer, and then click the
View Designer button.

The Constant Tester form opens in the Designer. Constant Tester is a skeleton program.
The user interface is finished, but you need to type in the program code.

4. Double-click the Show Constant button on the form.
The Button1_Click event procedure appears in the Code Editor.

5. Type the following statements in the Button1_Click event procedure:

Const Pi As Double = 3.14159265
Labell.Text = Pi

Q Tip The location you choose for your declarations should be based on how you plan to

use the constants or the variables. Programmers typically keep the scope for declarations
as small as possible, while still making them available for code that needs to use them. For
example, if a constant is needed only in a single event procedure, you should put the con-
stant declaration within that event procedure. However, you could also place the declara-
tion at the top of the form’s code, which would give all the event procedures in your form
access to it.

6. Click the Start Debugging button on the Standard toolbar to run the program.
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7. Click the Show Constant button.

The Pi constant appears in the label box, as shown here:

o5 Constant Tester

! Show Constant |

| Cluit |

= flEE=

314159265

8. Click the Quit button to stop the program.

Constants are useful in program code, especially in involved mathematical formulas,
such as Area = mr2. The next section describes how you can use operators and variables
to write similar formulas.

Working with Visual Basic Operators

A formula is a statement that combines numbers, variables, operators, and keywords to create
a new value. Visual Basic contains several language elements designed for use in formulas. In
this section, you'll practice working with arithmetic (or mathematical) operators, the symbols
used to tie together the parts of a formula. With a few exceptions, the arithmetic symbols
you'll use are the ones you use in everyday life, and their operations are fairly intuitive. You'll
see each operator demonstrated in the following exercises.

Visual Basic includes the following arithmetic operators:

Operator
+

Description

Addition

Subtraction

Multiplication

Division

Integer (whole number) division
Remainder division

Exponentiation (raising to a power)

String concatenation (combination)
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Basic Math: The + -, * and / Operators

The operators for addition, subtraction, multiplication, and division are pretty straightforward
and can be used in any formula where numbers or numeric variables are used. The following
exercise demonstrates how you can use them in a program.

Work with basic operators

1.
2.
3.

On the File menu, click Open Project.
Open the Basic Math project in the c:\\vb08sbs\chap05\basic math folder.

If the project’s form isn't visible, click Form1.vb in Solution Explorer, and then click the
View Designer button.

The Basic Math form opens in the Designer. The Basic Math program demonstrates how
the addition, subtraction, multiplication, and division operators work with numbers you
type. It also demonstrates how you can use text box, radio button, and button objects
to process user input in a program.

Click the Start Debugging button on the Standard toolbar.

The Basic Math program runs in the IDE. The program displays two text boxes in which
you enter numeric values, a group of operator radio buttons, a box that displays results,
and two button objects (Calculate and Quit).

Type 100 in the Variable 1 text box, and then press Tab.

The insertion point, or focus, moves to the second text box.

. Type 17 in the Variable 2 text box.

You can now apply any of the mathematical operators to the values in the text boxes.
Click the Addition radio button, and then click the Calculate button.

The operator is applied to the two values, and the number 117 appears in the Result
box, as shown in the following illustration.

o Basic Math Tests EI@
“Yariable 1 Operator Result
1aa ©) Addiion [+] "z
Subtraction [-]
Variable 2 Multiplication [*) | Calculate |

17 Drivigion [/]
| Quit |
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Practice using the subtraction, multiplication, and division operators with the two
numbers in the variable boxes. (Click Calculate to calculate each formula.)

The results appear in the Result box. Feel free to experiment with different numbers in
the variable text boxes. (Try a few numbers with decimal points if you like.) | used the
Double data type to declare the variables, so you can use very large numbers.

Now try the following test to see what happens:

Type 100 in the Variable 1 text box, type 0 in the Variable 2 text box, click the Division
radio button, and then click Calculate.

Dividing by zero is not allowed in mathematical calculations, because it produces an
infinite result. But Visual Basic is able to handle this calculation and displays a value of
Infinity in the Result text box. Being able to handle some divide-by-zero conditions is a
feature that Visual Basic 2008 automatically provides.

When you've finished contemplating this and other tests, click the Quit button.

The program stops, and the development environment returns.

Now take a look at the program code to see how the results were calculated. Basic Math
uses a few of the standard input controls you experimented with in Chapter 3 and an event
procedure that uses variables and operators to process the simple mathematical formulas.
The program declares its variables at the top of the form so that they can be used in all of
the Form1 event procedures.

Examine the Basic Math program code

1.

Double-click the Calculate button on the form.

The Code Editor displays the ButtonI_Click event procedure. At the top of the form's
code, you'll see the following statement, which declares two variables of type Double:

'Declare FirstNum and SecondNum variables

Dim FirstNum, SecondNum As Double

| used the Double type because | wanted a large, general purpose variable type that
could handle many different numbers—integers, numbers with decimal points, very
big numbers, small numbers, and so on. The variables are declared on the same line
by using the shortcut notation. Both FirstNum and SecondNum are of type Double,
and are used to hold the values input in the first and second text boxes, respectively.

Scroll down in the Code Editor to see the contents of the Buttonl_Click event
procedure.

Your screen looks similar to this:
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Forml.wb “Start Page | Forrnlawh [Design]

¥ Buttonl * & Click -

HPublic Class Formil 1
'Declare FirstMNum and SecondNum variables
Dim FirstMum, SecondNum Ls Double

= Frivate Zub Buttonl Click(EyVal sender Ais Zystem.Chject, Eyval e
'Assign text bhox wvalues to wvarishles

FirstMum = TextBoxl.Text

SecondMNum = TextBoxi.Text

m

'Determine checked button and calculate

If RadioButtonl.Checked = True Then
TextBox3.Text = FirstMNum + ZJecondium

End If

If RadioButtonZ.Checked = True Then
TextBox3.Text = FirstMNum - ZSecondium

End If

If RadioButtoni.Checked = True Then
TextBox3.Text = FirstMNum * Zecondium

End If

If RadioButton4.Checked = True Then
TextBox3.Text = FirstMNum / Zecondium

End If

End Zub

The first two statements in the event procedure transfer data entered in the text box
objects into the FirstNum and SecondNum variables.

'Assign text box values to variables

FirstNum = TextBox1l.Text

SecondNum = TextBox2.Text

The TextBox control handles the transfer with the Text property—a property that accepts
text entered by the user and makes it available for use in the program. I'll make frequent
use of the TextBox control in this book. When it's set to multiline and resized, it can dis-
play many lines of text—even a whole file!

After the text box values are assigned to the variables, the event procedure determines
which radio button has been selected, calculates the mathematical formula, and dis-
plays the result in a third text box. The first radio button test looks like this:

'Determine checked button and calculate
If RadioButtonl.Checked = True Then

TextBox3.Text = FirstNum + SecondNum
End If
Remember from Chapter 3 that only one radio button object in a group box object can
be selected at any given time. You can tell whether a radio button has been selected by
evaluating the Checked property. If it's True, the button has been selected. If the Checked
property is False, the button has not been selected. After this simple test, you're ready to
compute the result and display it in the third text box object. That's all there is to using
basic arithmetic operators. (You'll learn more about the syntax of If...Then tests in
Chapter 6, "Using Decision Structures.”)

You're done using the Basic Math program.
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Shortcut Operators

An interesting feature of Visual Basic is that you can use shortcut operators for math-
ematical and string operations that involve changing the value of an existing variable.
For example, if you combine the + symbol with the = symbol, you can add to a vari-
able without repeating the variable name twice in the formula. Thus, you can write the
formula X = X + 6 by using the syntax X += 6. The following table shows examples of

these shortcut operators.

Operation Long-form syntax
Addition (+) X=X+6
Subtraction (-) X=X-6
Multiplication (*) X=X*6

Division (/) X=X/6

Integer division (\) X=X\6
Exponentiation () X=X"6

String concatenation (&) X =X&"ABC”

Shortcut syntax
X+=6

X -=

X*=6

X/=6

X\=6

XA=6

X &= "ABC"

Using Advanced Operators: \, Mod, *, and &

In addition to the four basic arithmetic operators, Visual Basic includes four advanced opera-
tors, which perform integer division (\), remainder division (Mod), exponentiation (*), and string
concatenation (&). These operators are useful in special-purpose mathematical formulas and
text processing applications. The following utility (a slight modification of the Basic Math pro-
gram) shows how you can use each of these operators in a program.

Work with advanced operators

1. On the File menu, click Open Project.

The Open Project dialog box opens.

2. Open the Advanced Math project in the c:\vb08sbs\chap05\advanced math folder.

3. If the project’s form isn't visible, click Form1l.vb in Solution Explorer, and then click the

View Designer button.

The Advanced Math form opens in the Designer. The Advanced Math program is
identical to the Basic Math program, with the exception of the operators shown in

the radio buttons and in the program.
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. Click the Start Debugging button on the Standard toolbar.

The program displays two text boxes in which you enter numeric values, a group of
operator radio buttons, a text box that displays results, and two buttons.

. Type 9 in the Variable 1 text box, and then press Tab.

. Type 2 in the Variable 2 text box.

You can now apply any of the advanced operators to the values in the text boxes.
. Click the Integer Division radio button, and then click the Calculate button.

The operator is applied to the two values, and the number 4 appears in the Result box,
as shown here:

o5 Advanced bath Tests EI@
“ariable 1 Result
q Operator 4

@ Integer Division [4)
Remainder [tod)
Variable 2 E xponentiation (] [

Calculate |
Concatenation

2 e
[ Guit |

Integer division produces only the whole number result of the division operation.
Although 9 divided by 2 equals 4.5, the integer division operation returns only the first
part, an integer (the whole number 4). You might find this result useful if you're work-
ing with quantities that can't easily be divided into fractional components, such as the
number of adults who can fit in a car.

. Click the Remainder radio button, and then click the Calculate button.

The number 1 appears in the Result box. Remainder division (modulus arithmetic)
returns the remainder (the part left over) after two numbers are divided. Because 9
divided by 2 equals 4 with a remainder of 1 (2 * 4 + 1 = 9), the result produced by
the Mod operator is 1. In addition to adding an early-seventies vibe to your code, the
Mod operator can help you track “leftovers” in your calculations, such as the amount
of money left over after a financial transaction.

. Click the Exponentiation radio button, and then click the Calculate button.

The number 81 appears in the Result box. The exponentiation operator (*) raises a
number to a specified power. For example, 9 ~ 2 equals 92, or 81. In a Visual Basic
formula, 92 is written 9 A 2.
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Click the Concatenation radio button, and then click the Calculate button.

The number 92 appears in the Result box. The string concatenation operator (&) com-
bines two strings in a formula, but not through addition. The result is a combination
of the "9" character and the “2" character. String concatenation can be performed on
numeric variables—for example, if you're displaying the inning-by-inning score of a
baseball game as they do in old-time score boxes—but concatenation is more com-
monly performed on string values or variables.

Because | declared the FirstNum and SecondNum variables as type Double, you can't
combine words or letters by using the program code as written. As an example, try the
following test, which causes an error and ends the program.

Type birth in the Variable 1 text box, type day in the Variable 2 text box, verify that
Concatenation is selected, and then click Calculate.

Visual Basic is unable to process the text values you entered, so the program stops
running, and an error message appears on the screen.

[ Advanced Math (Debugging) - Micraseft Visual Studio = |[eP | 8
File Edit View Project Build Debug Tools Test Window Help
=Ry =N | EVRERA RX RN =K bon @ %= (F % | e A
A ER®E %3
Form1l.¥b | “Farmleb [Design] ~ X | Solution Explorer ~ 3 x
¥ Button1 ~ 7 Cick JBlaEEEA
S Punlic Class Formi || & "fd‘”“‘adM“"‘
'Declare FirstNum and SecondNum varishles 4| i BB My Project
Dim FirstNun, Secondiun is Double E Formub
=] Private Sub Buttonl Click(ByVal sender As System.Ohject, ByVal
' =1 =5 .ED wvariables
Secondiim \i TevrRnvs Tavr
i InvalidCastException was unhandled %

' Determine
If RadicBut
TextEox Troubleshooting tips:

Conversion fram string "birth" ta type ‘Double’ is not valid, G

End If ghen casting from a number, the walue musk be 3 nurmber less than infinity, -
If RadioBut

Make sure the source type i3 convertible to the destination type.

4
0
<
<
n
3
i

m

« | | Get general help for this exception.

T InnerException: Make sure your method arguments are in the right format.
T | Innersception: When converting a string ta DateTime, parse the string ta take the dote before putting

Search for more Help Online...

Actions:

View Detail...

Copy excaption detail to the clipboard
[ ateh 1 [Tmmediate Window

Ready Ln7 Cold Che NS

This type of error is called a run-time error—an error that surfaces not during the design
and compilation of the program, but later, when the program is running and encounters
a condition that it doesn't know how to process. If this seems odd, you might imagine
that Visual Basic is simply offering you a modern rendition of the robot plea “Does not
compute!” from the best science fiction films of the 1950s. The computer-speak message
“Conversion from string “birth” to type ‘Double’ is not valid” means that the words you
entered in the text boxes ("birth” and "day”) could not be converted, or cast, by Visual
Basic to variables of the type Double. Double types can only contain numbers. Period.
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As we shall explore in more detail later, Visual Studio doesn't leave you hanging with
such a problem, but provides a dialog box with different types of information to help
you resolve the run-time error. For now, you have learned another important lesson
about data types and when not to mix them.

Click the Stop Debugging button on the Standard toolbar to end the program.

Your program ends and returns you to the development environment.

Note In Chapter 8, “Debugging Visual Basic Programs,” you'll learn about debugging
mode, which allows you to track down the defects, or bugs, in your program code.

Now take a look at the program code to see how variables were declared and how the
advanced operators were used.

Scroll to the code at the top of the Code Editor.
You see the following comment and program statement:

'Declare FirstNum and SecondNum variables
Dim FirstNum, SecondNum As Double

As you might recall from the previous exercise, FirstNum and SecondNum are the
variables that hold numbers coming in from the TextBox1 and TextBox2 objects.

Change the data type from Double to String so that you can properly test how the
string concatenation (&) operator works.

Scroll down in the Code Editor to see how the advanced operators are used in the
program code.

You see the following code:

'Assign text box values to variables
FirstNum = TextBoxl.Text
SecondNum = TextBox2.Text

'Determine checked button and calculate

If RadioButtonl.Checked = True Then
TextBox3.Text = FirstNum \ SecondNum

End If

If RadioButton2.Checked = True Then
TextBox3.Text = FirstNum Mod SecondNum

End If

If RadioButton3.Checked = True Then
TextBox3.Text = FirstNum A SecondNum

End If

If RadioButton4.Checked = True Then
TextBox3.Text = FirstNum & SecondNum

End If
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Like the Basic Math program, this program loads data from the text boxes and places it
in the FirstNum and SecondNum variables. The program then checks to see which radio
button the user checked and computes the requested formula. In this event procedure,
the integer division (1), remainder (Mod), exponentiation (*), and string concatenation
(&) operators are used. Now that you've changed the data type of the variables to String,
run the program again to see how the & operator works on text.

Click the Start Debugging button.

Type birth in the Variable 1 text box, type day in the Variable 2 text box, click
Concatenation, and then click Calculate.

The program now concatenates the string values and doesn’t produce a run-time error,
as shown here:

o5 Advanced bath Tests EI@
“ariable 1 Result
irth Operator birthday

Integer Division [4]
Fiemainder [kod]

“ariable 2 Exnopegtiatiogl) | Calculate |
@ Concatenation

day —

[ Guit |

Click the Quit button to close the program.
You're finished working with the Advanced Math program.

Tip Run-time errors are difficult to avoid completely—even the most sophisticated application
programs, such as Microsoft Word or Microsoft Excel, sometimes run into error conditions that
they can't handle, producing run-time errors, or crashes. Designing your programs to handle many
different data types and operating conditions helps you produce solid, or robust, applications. In
Chapter 9, “Trapping Errors by Using Structured Error Handling,” you'll learn about another helpful
tool for preventing run-time error crashes—the structured error handler.

Working with Methods in the Microsoft .NET Framework

Now and then you'll want to do a little extra number crunching in your programs. You might

need

to round a number, calculate a complex mathematical expression, or introduce random-

ness into your programs. The math methods shown in the following table can help you work
with numbers in your formulas. These methods are provided by the Microsoft .NET Framework,
a class library that lets you tap into the power of the Windows operating system and accom-
plish many of the common programming tasks that you need to create your projects. The
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.NET Framework is a major feature of Visual Studio that is shared by Visual Basic, Microsoft

Visual C++, Microsoft Visual C#, and other tools in Visual Studio. It's an underlying interface
that becomes part of the Windows operating system itself, and it is installed on each com-

puter that runs Visual Studio programs.

The .NET Framework is organized into classes that you can use in your programming
projects. The process is quite simple, and you'll experiment with how it works now by
using a math method in the System.Math class of the .NET Framework.

What's New in Microsoft .NET Framework 3.5?

Visual Studio 2008 includes a new version of the .NET Framework—Microsoft .NET
Framework 3.5. This is an update to the .NET Framework 3.0 software that provided
support for the Windows Vista operating system, and the .NET Framework 2.0 soft-
ware that shipped with Visual Studio 2005 and provided support for 64-bit processors.
Version 3.5 adds new classes that provide additional functionality for distributed mo-
bile applications, interprocess communication, time zone operations, ASP.NET, Visual
Web Developer, and much more. The .NET Framework 3.5 also includes support for
new advanced technologies, such as Language Integrated Query (LINQ) for querying
different types of data, Windows Presentation Foundation (WPF) for creating complex
graphics, Windows Communication Foundation (WCF) for creating applications that
work with Web services, and Windows Workflow Foundation (WF) for creating work-
flow-type applications. Many of the improvements in the .NET Framework will come
to you automatically as you use Visual Basic 2008, and some will become useful as you
explore advanced programming techniques.

The following table offers a partial list of the math methods in the System.Math class. The
argument n in the table represents the number, variable, or expression you want the
method to evaluate. If you use any of these methods, be sure that you put the statement

Imports System.Math

at the very top of your form'’s code in the Code Editor.

Method Purpose

Abs(n) Returns the absolute value of n.

Atan(n) Returns the arctangent, in radians, of n.

Cos(n) Returns the cosine of the angle n. The angle n is expressed in radians.
Exp(n) Returns the constant e raised to the power n.

Sign(n) Returns -1 if nis less than 0, 0 if nis 0, and +1 if n is greater than 0.
Sin(n) Returns the sine of the angle n. The angle n is expressed in radians.
Sqrt(n) Returns the square root of n.

Tan(n) Returns the tangent of the angle n. The angle n is expressed in radians.
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Use the System.Math class to compute square roots

1.

N o u

10.

On the File menu, click New Project.
The New Project dialog box opens.

Create a new Visual Basic Windows Forms Application project named My Framework
Math.

The new project is created, and a blank form opens in the Designer.

Click the Button control on the Windows Forms tab of the Toolbox, and create a button
object at the top of your form.

Click the TextBox control in the Toolbox, and draw a text box below the button object.
Set the Text property of the button object to Square Root.
Double-click the button object to display the Code Editor.

At the very top of the Code Editor, above the Public Class Form1 statement, type the
following program statement:

Imports System.Math

The System.Math class is a collection of methods provided by the .NET Framework for
arithmetic operations. The .NET Framework is organized in a hierarchical fashion and can
be very deep. The Imports statement makes it easier to reference classes, properties, and
methods in your project. For example, if you didn't include the previous Imports state-
ment, to call the Sgrt method you would have to type System.Math.Sqrt instead of just
Sqgrt. The Imports statement must be the first statement in your program—it must come
even before the variables that you declare for the form and the Public Class Form1 state-
ment that Visual Basic automatically provides.

Move down in the Code Editor, and add the following code to the Buttonl_Click event

procedure between the Private Sub and End Sub statements:

Dim Result As Double
Result = Sqrt(625)
TextBox1l.Text = Result

These three statements declare a variable of the double type named Result, use the
Sgrt method to compute the square root of 625, and assign the Result variable to the
Text property of the text box object so that the answer is displayed.

Click the Save All button on the Standard toolbar to save your changes. Specify the
c:\vb08sbs\chap05 folder as the location.

Click the Start Debugging button on the Standard toolbar.

The Framework Math program runs in the IDE.
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11. Click the Square Root button.

Visual Basic calculates the square root of 625 and displays the result (25) in the text box.
As you can see here, the Sqrt method works!

o5 Forml == |

Square Root |

25

12. Click the Close button on the form to end the program.

To make it easier to reference classes, properties, and methods in the .NET Framework, in-
clude the Imports statement, and specify the appropriate namespace or class. You can use
this technique to use any class in the .NET Framework, and you'll see many more examples
of this technique as you work through Microsoft Visual Basic 2008 Step by Step.

One Step Further: Establishing Order of Precedence

In the previous few exercises, you experimented with several arithmetic operators and one
string operator. Visual Basic lets you mix as many arithmetic operators as you like in a formula,
as long as each numeric variable and expression is separated from another by one operator.
For example, this is an acceptable Visual Basic formula:

Total = 10 + 15 * 2 / 4 A 2

The formula processes several values and assigns the result to a variable named Total. But
how is such an expression evaluated by Visual Basic? In other words, what sequence does
Visual Basic follow when solving the formula? You might not have noticed, but the order of
evaluation matters a great deal in this example.

Visual Basic solves this dilemma by establishing a specific order of precedence for math-
ematical operations. This list of rules tells Visual Basic which operator to use first, second,
and so on when evaluating an expression that contains more than one operator.



158

Part Il Programming Fundamentals

The following table lists the operators from first to last in the order in which they are evaluated.
(Operators on the same level in this table are evaluated from left to right as they appear in an
expression.)

Operator Order of precedence
() Values within parentheses are always evaluated first.
A Exponentiation (raising a number to a power) is second.

- Negation (creating a negative number) is third.

*/ Multiplication and division are fourth.
\ Integer division is fifth.

Mod Remainder division is sixth.

+ - Addition and subtraction are last.

Given the order of precedence in this table, the expression
Total = 10 + 15 * 2 / 4 A 2

is evaluated by Visual Basic in the following steps. (Shading is used to show each step in the
order of evaluation.)

Total = 10 + 15 * 2 / 4 A 2
Total = 10 + 15 * 2 / 16
Total = 10 + 30 / 16

Total = 10 + 1.875

Total = 11.875

Using Parentheses in a Formula

You can use one or more pairs of parentheses in a formula to clarify the order of precedence.
For example, Visual Basic calculates the formula

Number = (8 - 5 * 3) A 2

by determining the value within the parentheses (-7) before doing the exponentiation—even
though exponentiation is higher in order of precedence than subtraction and multiplication,
according to the preceding table. You can further refine the calculation by placing nested
parentheses in the formula. For example,

Number = ((8 - 5) * 3) A2

directs Visual Basic to calculate the difference in the inner set of parentheses first, perform
the operation in the outer parentheses next, and then determine the exponentiation. The
result produced by the two formulas is different: the first formula evaluates to 49 and the
second to 81. Parentheses can change the result of a mathematical operation, as well as
make it easier to read.
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Chapter 5 Quick Reference

Do this

Type Dim followed by the variable name, the As keyword, and the variable
data type in the program code. To make the variable valid in all of a form'’s
event procedures, place this statement at the top of the code for the form,
before any event procedures. For example:

Dim Country As String

Assign a new value with the assignment operator of (=). For example:
Country = "Japan"

Use the InputBox function, and assign the result to a variable. For example:
UserName = InputBox("What is your name?")

Use the MsgBox function. (The string to be displayed in the dialog box can
be stored in a variable.) For example:

Forecast = "Rain, mainly on the plain."

MsgBox(Forecast, , "Spain Weather Report")

Type the Const keyword followed by the constant name, the assignment
operator (=), the constant data type, and the fixed value. For example:
Const JackBennysAge As Short = 39

Link together numeric variables or values with one of the seven arithmetic
operators, and then assign the result to a variable or a property. For example:

Result = 1 A2 * 3\ 4 'this equals 0

Use the string concatenation operator (&). For example:

Msg = "Hello" & "," & " world!"

Place an Imports statement at the very top of the form’'s code that identifies
the class library. For example:

Imports System.Math

Use the method name, and include any necessary arguments so that it can
be used in a formula or a program statement. For example, to make a call to
the Sqrt method in the System.Math class:

Hypotenuse Sqrt(x A2 +y A 2)

Use parentheses in the formula. For example:

Result
Result

1+2A3\ 4
1+2)A(C3\4

'this equals 3
'this equals 1






Chapter 6
Using Decision Structures

After completing this chapter, you will be able to:
B Write conditional expressions.

B Use an If..Then statement to branch to a set of program statements based on a varying
condition.

B Use the MaskedTextBox control to receive user input in a specific format.

B Short-circuit an /f...Then statement.

B Use a Select Case statement to select one choice from many options in program code.
B Use the Name property to rename objects within a program.

B Manage mouse events and write a MouseHover event handler.

In the past few chapters, you used several features of Microsoft Visual Basic 2008 to process
user input. You used menus, toolbars, dialog boxes, and other Toolbox controls to display
choices for the user, and you processed input by using property settings, variables, operators,
formulas, and the Microsoft .NET Framework.

In this chapter, you'll learn how to branch conditionally to a specific area in your program
based on input you receive from the user. You'll also learn how to evaluate one or more prop-
erties or variables by using conditional expressions, and then execute one or more program
statements based on the results. In short, you'll increase your programming vocabulary by
creating code blocks called decision structures that control how your program executes, or
flows, internally.

161
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Event-Driven Programming

The programs you've written so far in this book have displayed Toolbox controls, menus, tool-
bars, and dialog boxes on the screen, and with these programs, users could manipulate the
screen elements in whatever order they saw fit. The programs put the user in charge, waited
patiently for a response, and then processed the input predictably. In programming circles, this
methodology is known as event-driven programming. You build a program by creating a group
of "“intelligent” objects that know how to respond when the user interacts with them, and then
the program processes the input by using event procedures associated with the objects. The
following diagram shows how an event-driven program works in Visual Basic:

a5 Byte's Pizza Delivery =[]

Make a Selection

() Pepperoni @ ‘egetaian ——————— Racejve input by
] : using object.

() Double Cheese () House Special

Youhaveselected ~ ___.-d ---Process input by
Yegetarian e using event procedure.

Order ] [ Quit

Return control
to the user.

Program input can also come from the computer system itself. For example, your program
might be notified when a piece of electronic mail arrives or when a specified period of
time has elapsed on the system clock. The computer, not the user, triggers these events.
Regardless of how an event is triggered, Visual Basic reacts by calling the event procedure
associated with the object that recognized the event. So far, you've dealt primarily with the
Click, CheckedChanged, and SelectedindexChanged events. However, Visual Basic objects
also can respond to several other types of events.

The event-driven nature of Visual Basic means that most of the computing done in your
programs is accomplished by event procedures. These event-specific blocks of code process
input, calculate new values, display output, and handle other tasks.

In this chapter, you'll learn how to use decision structures to compare variables, properties,
and values, and how to execute one or more statements based on the results. In Chapter 7,
“Using Loops and Timers,” you'll use loops to execute a group of statements over and over
until a condition is met or while a specific condition is true. Together, these powerful flow-
control structures will help you build your event procedures so that they can respond to
almost any situation.
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Events Supported by Visual Basic Objects

Each object in Visual Basic has a predefined set of events to which it can respond. These
events are listed when you select an object name in the Class Name list box at the top
of the Code Editor and then click the Method Name arrow. (Events are visually identified
in Visual Studio by a lightning bolt icon.) You can write an event procedure for any of
these events, and if that event occurs in the program, Visual Basic will execute the event
procedure that'’s associated with it. For example, a list box object supports more than 60
events, including Click, DoubleClick, DragDrop, DragOver, GotFocus, KeyDown, KeyPress,
KeyUp, LostFocus, MouseDown, MouseMove, MouseUp, MouseHover, TextChanged, and
Validated. You probably won't need to write code for more than three or four of these
events in your applications, but it's nice to know that you have so many choices when
you create elements in your interface. The following illustration shows a partial listing

of the events for a list box object in the Code Editor:

— Class Name
W Inputontrols - Microsoft Wisual Studio # MouseCaptureChanged 7
r 4 .
File Edit ‘iew Project Build Debug Data Tag”, MouseClick
——my # MouseDoubleClick
HeE -l a| 4B E] = S| MouseDown
= 4
b= /Fgml-VhfForml.vb [Design] | Start Page | 7 MouseEnter
. # MouseHower
= ¥ ListBoxl ¥ ¥ Mouseleave
g LJ] # Mousehdove
|l & Private Sub ListBoxl Selectedl” Mouselp

'The item you picked (0-2)7 MouseWheel
Select Case ListBoxl.Selec” Move
Case O # ParentChanged
PictureBox3 . Image PrevienkeyDown
("o vhiBshsh che 7 QuerybecessibiliyHelp
Casze 1 # QueryContinueDrag

PictureBox3. Image » RegionChanged
("o whiSsba' che 7 esize Events
Case 2 ightToleftChanged

PictureBox3 . Image & Eelasioel Qlsad i) N

("o yvhigshs' che 7 SelectedifalueChanged

THHEMHN NN NN N N N N NN NNY .

End Zelect # SizeChanged
- End Sub # StyleChanged
# SystemColorsChanged
=) Frivate Sub CheckBoxl_Checkedc‘/ TablndexChanged E

'If the Check3tate propert'/ Tab3tapChanged
If CheckBoxl.Check3tate = '/:TextChanged
PictureBoxz. Image = Sg'// Yalidated
(" vhOSshah chapoay ¥ Validating

PictureBoxZz.Visihle = 7 ValueMemberChanged
o C yisikleChanoed
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Using Conditional Expressions

One of the most useful tools for processing information in an event procedure is a conditional
expression. A conditional expression is a part of a complete program statement that asks a
True-or-False question about a property, a variable, or another piece of data in the program
code. For example, the conditional expression

Price < 100

evaluates to True if the Price variable contains a value that is less than 100, and it evaluates to
False if Price contains a value that is greater than or equal to 100.

You can use the following comparison operators in a conditional expression:

Comparison operator Meaning

= Equal to

< Not equal to

> Greater than

< Less than

>= Greater than or equal to
<= Less than or equal to

The following table shows some conditional expressions and their results. You'll work with
conditional expressions several times in this chapter.

Conditional expression Result

10 <> 20 True (10 is not equal to 20)

Score < 20 True if Score is less than 20; otherwise, False

Score = Labell.Text True if the Text property of the Labell object contains the same value

as the Score variable; otherwise, False
TextBoxl.Text = "Bill" True if the word “Bill" is in the TextBox1 object; otherwise, False
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If...Then Decision Structures

When a conditional expression is used in a special block of statements called a decision
structure, it controls whether other statements in your program are executed and in what
order they're executed. You can use an /f...Then decision structure to evaluate a condition in
the program and take a course of action based on the result. In its simplest form, an If..Then
decision structure is written on a single line:

If condition Then statement

where condition is a conditional expression, and statement is a valid Visual Basic program
statement. For example,

If Score >= 20 Then Labell.Text = "You win!"

is an If...Then decision structure that uses the conditional expression

Score >= 20

to determine whether the program should set the Text property of the Labell object to "You
win!” If the Score variable contains a value that's greater than or equal to 20, Visual Basic sets
the Text property; otherwise, it skips the assignment statement and executes the next line in
the event procedure. This sort of comparison always results in a True or False value. A condi-
tional expression never results in maybe.

Testing Several Conditions in an /f..Then Decision Structure

Visual Basic also supports an /f...Then decision structure that you can use to include several
conditional expressions. This block of statements can be several lines long and contains the
important keywords Elself, Else, and End If.

If conditionl Then
statements executed if conditionl is True
ElseIf condition2 Then
statements executed if condition2 is True
[Additional ElseIf conditions and statements can be placed here]
Else
statements executed if none of the conditions is True
End If

In this structure, conditionl is evaluated first. If this conditional expression is True, the block of
statements below it is executed, one statement at a time. (You can include one or more pro-
gram statements.) If the first condition isn't True, the second conditional expression (condition2)
is evaluated. If the second condition is True, the second block of statements is executed. (You
can add additional Elself conditions and statements if you have more conditions to evaluate.)

If none of the conditional expressions is True, the statements below the Else keyword are
executed. Finally, the whole structure is closed by the End If keywords.
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The following code shows how a multiple-line If..Then structure could be used to determine
the amount of tax due in a hypothetical progressive tax return. (The income and percentage
numbers are from the projected United States Internal Revenue Service 2007 Tax Rate Schedule
for single filing status.)

Dim AdjustedIncome, TaxDue As Double
AdjustedIncome = 50000

If AdjustedIncome <= 7825 Then '10% tax bracket
TaxDue = AdjustedIncome * 0.1

ElseIf AdjustedIncome <= 31850 Then '15% tax bracket
TaxDue = 782.5 + ((AdjustedIncome - 7825) * 0.15)

ElseIf AdjustedIncome <= 77100 Then '25% tax bracket
TaxDue = 4386.25 + ((AdjustedIncome - 31850) * 0.25)

ElseIf AdjustedIncome <= 160850 Then '28% tax bracket
TaxDue = 15698.75 + ((AdjustedIncome - 77100) * 0.28)

ElseIf AdjustedIncome <= 349700 Then '33% tax bracket
TaxDue = 39148.75 + ((AdjustedIncome - 160850) * 0.33)

Else '35% tax bracket
TaxDue = 101469.25 + ((AdjustedIncome - 349700) * 0.35)

End If

W Important The order of the conditional expressions in your If..Then and Elself statements is

critical. What happens if you reverse the order of the conditional expressions in the tax com-
putation example and list the rates in the structure from highest to lowest? Taxpayers in the 10
percent, 15 percent, 25 percent, 28 percent, and 33 percent tax brackets are all placed in the
35 percent tax bracket because they all have an income that's less than or equal to $349,700.
(Visual Basic stops at the first conditional expression that is True, even if others are also True.)
Because all the conditional expressions in this example test the same variable, they need to be
listed in ascending order to get the taxpayers to fall out in the right places. Moral: when you
use more than one conditional expression, consider the order carefully.

This useful decision structure tests the double-precision variable Adjustedincome at the first
income level and subsequent income levels until one of the conditional expressions evaluates
to True, and then determines the taxpayer's income tax accordingly. With some simple modifi-
cations, it could be used to compute the tax owed by any taxpayer in a progressive tax system,
such as the one in the United States. Provided that the tax rates are complete and up to date
and that the value in the Adjustedincome variable is correct, the program as written will give
the correct tax owed for single U.S. taxpayers for 2007. If the tax rates change, it's a simple
matter to update the conditional expressions. With an additional decision structure to deter-
mine taxpayers’ filing status, the program readily extends itself to include all U.S. taxpayers.
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Tip Expressions that can be evaluated as True or False are also known as Boolean expressions,
and the True or False result can be assigned to a Boolean variable or property. You can assign
Boolean values to certain object properties or Boolean variables that have been created by using
the Dim statement and the As Boolean keywords.

In the next exercise, you'll use an /f...Then decision structure that recognizes users as they
enter a program—a simple way to get started with writing your own decision structures.
You'll also learn how to use the MaskedTextBox control to receive input from the user in a
specific format.

Validate users by using /f..Then

1. Start Visual Studio, and create a new Windows Forms Application project named My
User Validation.

The new project is created, and a blank form opens in the Designer.
2. Click the form, and set the form’s Text property to “User Validation”.

3. Use the Label control to create a label on your form, and use the Properties window to
set the Text property to “Enter Your Social Security Number”.

4. Use the Button control to create a button on your form, and set the button’s Text
property to “Sign In".

5. Click the MaskedTextBox control on the Common Controls tab in the Toolbox, and
then create a masked text box object on your form below the label.

The MaskedTextBox control is similar to the TextBox control that you have been using,
but by using MaskedTextBox, you can control the format of the information entered by
the user into your program. You control the format by setting the Mask property; you
can use a predefined format supplied by the control or choose your own format.

You'll use the MaskedTextBox control in this program to require that users enter a
Social Security Number in the standard nine-digit format used by the United States
Internal Revenue Service.

6. With the MaskedTextBox1 object selected, click the Mask property in the Properties
window, and then click the ellipses button next to it.

The Input Mask dialog box opens, showing a list of your predefined formatting
patterns, or masks.
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7. Click Social Security Number in the list.
The Input Mask dialog box looks like this:

Input Mask 8- =)

Select a predefined mask description from the list below or select Custorn to define a custom rmask.

hask Description Data Format Walidating Type

Murneric (3-digits) 12345 Int32

Phone nurmber (574 555-0123 {none)

Phone number no area code  555-0123 {none)

Short date 1271142003 DateTime

Short date and time (US) 121172003 1120 DateTime

Social security number 000-00-1234 {none)

Tirne (European/Mdilitary) 23:20 DateTime

Tirne (US) 1120 DateTime

Zip Code 98052-6349 {none)

<Custom= {none)
Mask: ao0-00-0000 V| Use Walidating Type
Preview: __-_ -

| Ok | | Cancel |

Although you won't use it now, take a moment to note the <Custom> option, which
you can use later to create your own input masks using numbers and placeholder
characters such as a hyphen (-).

8. Click OK to accept Social Security Number as your input mask.

Visual Studio displays your input mask in the MaskedTextBox1 object, as shown in the
following illustration:

o5 UserWalidation El@

Enter vour Social Security Nurrﬁ_r__
o___ o

| Ssignln |

9. Double-click the Sign In button.
The Button1_Click event procedure appears in the Code Editor.



10.

11.

12.

13.

14.
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Type the following program statements in the event procedure:

If MaskedTextBoxl.Text = "555-55-1212" Then

MsgBox ("Welcome to the system!")
Else

MsgBox ("I don’t recognize this number™)
End If
This simple /f..Then decision structure checks the value of the MaskedTextBox1
object's Text property, and if it equals "555-55-1212" the structure displays the mes-
sage "Welcome to the system!”. If the number entered by the user is some other value,
the structure displays the message “I don't recognize this number”. The beauty in this
program, however, is how the MaskedTextBox1 object automatically filters input to

ensure that it is in the correct format.

Click the Save All button on the Standard toolbar to save your changes. Specify the
c\vb08sbs\chap06 folder as the location for your project.

Click the Start Debugging button on the Standard toolbar.

The program runs in the IDE. The form prompts the user to enter a Social Security
number (SSN) in the appropriate format, and displays underlines and hyphens to offer
the user a hint of the format required.

Type abcd to test the input mask.

Visual Basic prevents the letters from being displayed, because letters do not fit the
requested format. A nine-digit SSN is required.

Type 1234567890 to test the input mask.

Visual Basic displays the number 123-45-6789 in the masked text box, ignoring the
tenth digit that you typed. Again, Visual Basic has forced the user’s input into
the proper format. Your form looks like this:

o= UserWalidation El@

Enter vour Social Security Mumber
123-45-6739

| Signin |




170 Part Il Programming Fundamentals
15. Click the Sign In button.

Visual Basic displays the message “I don't recognize this number”, because the SSN
does not match the number the /f..Then decision structure is looking for.

16. Click OK, delete the SSN from the masked text box, enter 555-55-1212 as the number,
and then click Sign In again.

This time the decision structure recognizes the number and displays a welcome message.
You see the following message box:

a5 User Walidation = [ = [ £2

Enter vour Social Security Mumber
555-65-1212

User Walidation ==
| Sianln |

Welcome to the system!

Your code has prevented an unauthorized user from using the program, and you've
learned a useful skill related to controlling input from the user.

17. Exit the program.

Using Logical Operators in Conditional Expressions

You can test more than one conditional expression in If...Then and Elself clauses if you
want to include more than one selection criterion in your decision structure. The extra
conditions are linked together by using one or more of the logical operators listed in the
following table.

Logical operator Meaning

And If both conditional expressions are True, then the result is True.

Or If either conditional expression is True, then the result is True.

Not If the conditional expression is False, then the result is True. If the conditional

expression is True, then the result is False.

Xor If one and only one of the conditional expressions is True, then the result is
True. If both are True or both are False, then the result is False. (Xor stands for
exclusive Or)
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evaluates mathematical operators first, comparison operators second, and logical operators third.

Q Tip When your program evaluates a complex expression that mixes different operator types, it

The following table lists some examples of the logical operators at work. In the expressions, it
is assumed that the Vehicle string variable contains the value "Bike”, and the integer variable
Price contains the value 200.

Logical expression Result

Vehicle = "Bike" And Price < 300 True (both conditions are True)
Vehicle = "Car" Or Price < 500 True (one condition is True)
Not Price < 100 True (condition is False)
Vehicle = "Bike" Xor Price < 300 False (both conditions are True)

In the following exercise, you'll modify the My User Validation program to prompt the user
for a personal identification number (PIN) during the validation process. To do this, you will
add a second text box to get the PIN from the user, and then modify the If..Then clause in

the decision structure so that it uses the And operator to verify the PIN.

Add password protection by using the And operator

1.

Display the User Validation form, and use the Label control to add a second descriptive
label to the form below the first masked text box.

Set the new label’s Text property to "PIN".

Add a second MaskedTextBox control to the form below the first masked text box and
the new label.

Click the shortcut arrow on the MaskedTextBox2 object to open the MaskedTextBox
Tasks list, and then click the Set Mask command to display the Input Mask dialog box.

Click the Numeric (5 digits) input mask, and then click OK.

Like many PINs found online, this PIN will be five digits long. Again, if the user types a
password of a different length or format, it will be rejected.

Double-click the Sign In button to display the Button1_Click event procedure in the
Code Editor.

Modify the event procedure so that it contains the following code:

If MaskedTextBoxl.Text = "555-55-1212" _
And MaskedTextBox2.Text = "54321" Then
MsgBox("Welcome to the system!")
Else
MsgBox ("I don’t recognize this number™)
End If
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The statement now includes the And logical operator, which requires that the user’s
PIN correspond with his or her SSN before the user is admitted to the system. (In this
case, the valid PIN is 54321; in a real-world program, this value would be extracted
along with the SSN from a secure database.) | modified the earlier program by adding
a line continuation character (_) to the end of the first line, and by adding the second
line beginning with And.

Click the Start Debugging button on the Standard toolbar.
The program runs in the IDE.

. Type 555-55-1212 in the Social Security Number masked text box.

Type 54321 in the PIN masked text box.
Click the Sign In button.

The user is welcomed to the program, as shown in the following screen.

a5 User Walidation = |[E ][ £2

Enter vour Social Security Mumber
555-65-1212

PIM
54321

| Signln | UserWalidation @

Welcome to the system!

Click OK to close the message box.
Experiment with other values for the SSN and PIN.

Test the program carefully to be sure that the welcome message is not displayed when
other PINs or SSNs are entered.

Click the Close button on the form when you're finished.

The program ends, and the development environment returns.

Tip You can further customize this program by using the PasswordChar property in
masked text box objects. The PasswordChar property can be used to display a placeholder
character, such as an asterisk (*), when the user types. (You specify the character by using
the Properties window.) Using a password character gives users additional secrecy as they
enter their protected password—a standard feature of such operations.
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Short-Circuiting by Using AndAlso and OrElse

Visual Basic offers two logical operators that you can use in your conditional statements,
AndAlso and OrElse. These operators work the same as And and Or respectively, but offer
an important subtlety in the way they're evaluated that will be new to programmers experi-
enced with Visual Basic 6.

Consider an If statement that has two conditions that are connected by an AndAlso operator.
For the statements of the /f structure to be executed, both conditions must evaluate to True.
If the first condition evaluates to False, Visual Basic skips to the next line or the Else statement
immediately, without testing the second condition. This partial, or short-circuiting, evaluation
of an If statement makes logical sense—why should Visual Basic continue to evaluate the If
statement if both conditions cannot be True?

The OrElse operator works in a similar fashion. Consider an If statement that has two condi-
tions that are connected by an OrElse operator. For the statements of the /f structure to be
executed, at least one condition must evaluate to True. If the first condition evaluates to True,
Visual Basic begins to execute the statements in the /f structure immediately, without testing
the second condition.

Here's an example of the short-circuit situation in Visual Basic, a simple routine that uses
an If statement and an AndAlso operator to test two conditions and display the message
“Inside If" if both conditions are True:

Dim Number As Integer = 0

If Number = 1 AndAlso MsgBox("Second condition test") Then
MsgBox("Inside If")

Else
MsgBox("Inside Else™)

End If

The MsgBox function itself is used as the second conditional test, which is somewhat
unusual, but the strange syntax is completely valid and gives us a perfect opportunity

to see how short-circuiting works up close. The text “"Second condition test” appears in

a message box only if the Number variable is set to 1; otherwise, the AndAlso operator
short-circuits the /f statement, and the second condition isn't evaluated. If you actually try
this code, remember that it's for demonstration purposes only—you wouldn’t want to use
MsgBox with this syntax as a test because it doesn't really test anything. But by changing
the Number variable from 0 to 1 and back, you can get a good idea of how the AndAlso
statement and short-circuiting work.
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Here's a second example of how short-circuiting functions in Visual Basic when two condi-
tions are evaluated using the AndAlso operator. This time, a more complex conditional test
(7 / HumanAge <= 1)is used after the AndAlso operator to determine what some people
call the "dog age” of a person:

Dim HumanAge As Integer
HumanAge = 7
'One year for a dog is seven years for a human
If HumanAge <> 0 AndAlso 7 / HumanAge <= 1 Then
MsgBox("You are at least one dog year old")
Else
MsgBox("You are less than one dog year old™)
End If

As part of a larger program that determines the so-called dog age of a person by dividing
his or her current age by 7, this bare-bones routine tries to determine whether the value in
the HumanAge integer variable is at least 7. (If you haven't heard the concept of "dog age”
before, bear with me—following this logic, a 28-year-old person would be four dog years
old. This has been suggested as an interesting way of relating to dogs, since dogs have a
lifespan of roughly one-seventh that of humans.) The code uses two If statement conditions
and can be used in a variety of different contexts—I used it in the Click event procedure
for a button object. The first condition checks to see whether a non-zero number has been
placed in the HumanAge variable—I've assumed momentarily that the user has enough
sense to place a positive age into HumanAge because a negative number would produce
incorrect results. The second condition tests whether the person is at least seven years old.
If both conditions evaluate to True, the message “You are at least one dog year old” is dis-
played in a message box. If the person is less than seven, the message “You are less than
one dog year old” is displayed.

Now imagine that I've changed the value of the HumanAge variable from 7 to 0. What
happens? The first If statement condition is evaluated as False by the Visual Basic compiler,
and that evaluation prevents the second condition from being evaluated, thus halting, or
short-circuiting, the /f statement and saving us from a nasty “divide by zero” error that
could result if we divided 7 by 0 (the new value of the HumanAge variable). We wouldn’t
have had the same luck in Visual Basic 6. Setting the HumanAge variable to 0 in Visual
Basic 6 would have produced a run-time error and a crash, because the entire /f statement
would have been evaluated, and division by zero isn't permitted in Visual Basic 6. In Visual
Studio, we get a benefit from the short-circuiting behavior.

In summary, the AndAlso and OrElse operators in Visual Basic open up a few new possibilities
for Visual Basic programmers, including the potential to prevent run-time errors and other
unexpected results. It's also possible to improve performance by placing conditions that

are time consuming to calculate at the end of the condition statement, because Visual Basic
doesn’t perform these expensive condition calculations unless it's necessary. However, you
need to think carefully about all the possible conditions that your /f statements might en-
counter as variable states change during program execution.
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Select Case Decision Structures

With Visual Basic, you can also control the execution of statements in your programs by using
Select Case decision structures. You used Select Case structures in Chapters 3 and 5 of this book
when you wrote event procedures to process list box and combo box choices. A Select Case
structure is similar to an If...Then...Elself structure, but it's more efficient when the branching
depends on one key variable, or test case. You can also use Select Case structures to make

your program code more readable.

The syntax for a Select Case structure looks like this:

Select Case variable
Case valuel
statements executed if valuel matches variable
Case value2
statements executed if value2 matches variable
Case value3
statements executed if value3 matches variable

Case Else
statements executed if no match is found
End Select

A Select Case structure begins with the Select Case keywords and ends with the End Select key-
words. You replace variable with the variable, property, or other expression that is to be the

key value, or test case, for the structure. You replace valuel, value2, and value3 with numbers,
strings, or other values related to the test case being considered. If one of the values matches
the variable, the statements below the Case clause are executed, and then Visual Basic jumps to
the line after the End Select statement and picks up execution there. You can include any num-
ber of Case clauses in a Select Case structure, and you can include more than one value in a
Case clause. If you list multiple values after a case, separate them with commas.

The following example shows how a Select Case structure could be used to print an appropriate
message about a person’s age and cultural milestones in a program. Since the Age variable con-
tains a value of 18, the string “You can vote now!” is assigned to the Text property of the label
object. (You'll notice that the "milestones” have an American slant to them; please customize
freely to match your cultural setting.)

Dim Age As Integer
Age = 18

Select Case Age

Case 16
Labell.Text = "You can drive now!"
Case 18
Labell.Text = "You can vote now!"
Case 21
Labell.Text = "You can drink wine with your meals."
Case 65
Labell.Text = “Time to retire and have fun!”

End Select



176

Part Il Programming Fundamentals

A Select Case structure also supports a Case Else clause that you can use to display a mes-
sage if none of the preceding cases matches the Age variable. Here's how Case Else would
work in the following example—note that I've changed the value of Age to 25 to trigger
the Case Else clause:

Dim Age As Integer
Age = 25

Select Case Age

Case 16

Labell.Text = "You can drive now!"
Case 18

Labell.Text = "You can vote now!"
Case 21

Labell.Text = "You can drink wine with your meals."
Case 65

Labell.Text = "Time to retire and have fun!"
Case Else

Labell.Text = "You’re a great age! Enjoy it!"

End Select

Using Comparison Operators with a Select Case Structure

You can use comparison operators to include a range of test values in a Select Case structure.
The Visual Basic comparison operators that can be used are =, <>, >, <, >=, and <=. To use
the comparison operators, you need to include the /s keyword or the To keyword in the ex-
pression to identify the comparison you're making. The /s keyword instructs the compiler to
compare the test variable to the expression listed after the /s keyword. The To keyword iden-
tifies a range of values. The following structure uses /s, To, and several comparison operators
to test the Age variable and to display one of five messages:

Select Case Age
Case Is < 13
Labell.Text = "Enjoy your youth!"
Case 13 To 19
Labell.Text = "Enjoy your teens!"
Case 21
Labell.Text = "You can drink wine with your meals."
Case Is > 100
Labell.Text = "Looking good!"
Case Else
Labell.Text = "That’s a nice age to be."
End Select
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If the value of the Age variable is less than 13, the message “Enjoy your youth!” is displayed.
For the ages 13 through 19, the message “Enjoy your teens!” is displayed, and so on.

A Select Case decision structure is usually much clearer than an /f...Then structure and is more
efficient when you're making three or more branching decisions based on one variable or
property. However, when you're making two or fewer comparisons, or when you're working
with several different values, you'll probably want to use an If...Then decision structure.

In the following exercise, you'll see how you can use a Select Case structure to process input
from a list box. You'll use the ListBox1.Text and ListBox1.SelectedIndexChanged properties to
collect the input, and then you'll use a Select Case structure to display a greeting in one of
four languages.

Use a Select Case structure to process input from a list box

1.

On the File menu, click New Project.

The New Project dialog box opens.

. Create a new Windows Forms Application project named My Select Case.

A blank form opens in the Designer.

Click the Label control in the Toolbox, and then draw a label near the top of the form to
display a title for the program.

Use the Label control to create a second label object below the first.
You'll use this label as a title for the list box.

Click the ListBox control in the Toolbox, and then create a list box below the second
label.

Use the Label control to draw two more labels below the list box to display program
output.

Use the Button control to create a small button on the bottom of the form.

Open the Properties window, and then set the properties shown in the table on the
following page for the objects that you have just created.
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Since there are so many objects, you'll also assign Name properties to help you easily
identify the control on the form and within your program code. (When the properties in
the Properties window are sorted alphabetically, you'll find Name listed in parentheses
near the top of the Properties window.) | recommend that you use the Name property
whenever you have more than four or five objects in a program. In this example, I've
given the objects names that feature a three-character prefix to identify the object
type, such as btn (for button), Ibl (for label), and Ist (for list box).

Object
Forml1
Labell

Label2

Label3

Label4

ListBox1
Buttonl

Property
Text

Font
Name
Text
Name
Text

Font
Name
Text
AutoSize
BorderStyle
ForeColor
Name
Text
Name
Name
Text

Setting

"Case Greeting”

Times New Roman, Bold, 12-point
IbITitle

“International Welcome Program”
IbITextBoxLabel

“Choose a country”

10-point

IblCountry

(empty)

False

Fixed3D

Red

IblGreeting

(empty)

IstCountryBox

btnQuit

"Quit”

When you've finished setting properties, your form looks similar to this:

Chooze a country

lstCountryBiox

o5 Case Greeting EI@

International Welcome Program
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Now you'll enter the program code to initialize the list box.
Double-click the form.
The Form1_Load event procedure appears in the Code Editor.

Type the following program code to initialize the list box:

TstCountryBox.Items.Add("England")

TstCountryBox.Items.Add("Germany")

TstCountryBox.Items.Add("Mexico")

TstCountryBox.Items.Add("Italy™)

These lines use the Add method of the list box object to add entries to the list box on

your form.

Click the Form1.vb [Design] tab at the top of the Code Editor to switch back to the
Designer, and then double-click the list box object on your form to edit its event
procedure.

The IstCountryBox_SelectedIndexChanged event procedure appears in the Code Editor.

Type the following lines to process the list box selection made by the user:

TbTCountry.Text = 1stCountryBox.Text
Select Case 1stCountryBox.SelectedIndex
Case 0
Tb1Greeting.Text = "Hello, programmer"
Case 1
Tb1Greeting.Text = "Hallo, programmierer"
Case 2
1b1Greeting.Text = "Hola, programador"
Case 3
Tb1Greeting.Text = "Ciao, programmatore"
End Select
The first line copies the name of the selected list box item to the Text property of the
third label on the form (which you renamed /b/Country). The most important property
used in the statement is IstCountryBox.Text, which contains the exact text of the item
selected in the list box. The remaining statements are part of the Select Case decision
structure. The structure uses the IstCountryBox.SelectedIndex property as a test case
variable and compares it to several values. The Selectedindex property always contains
the number of the item selected in the list box; the item at the top is 0 (zero), the second
item is 1, the next item is 2, and so on. By using SelectedIndex, the Select Case structure
can quickly identify the user’s choice and display the correct greeting on the form.

Display the form again, and double-click the Quit button (btnQuit).
The btnQuit_Click event procedure appears in the Code Editor.

Type End in the event procedure.
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15. Click the Save All button on the Standard toolbar to save your changes. Specify the
c\vb08sbs\chap06 folder as the location.

Now run the program, and see how the Select Case statement works.

Q Tip The complete Select Case project is located in the c:\vb08sbs\chap06\select case
folder.

16. Click the Start Debugging button on the Standard toolbar to run the program.
17. Click each of the country names in the Choose A Country list box.

The program displays a greeting for each of the countries listed. The following illustra-
tion shows the greeting for Italy:

o5 Case Greeting EI@

International Welcome Program

Chooze a country

| England
| Germary
| Mexico

1
i
I |
| |
|
|

[ty

Ciao, programmatore

Cluit

18. Click the Quit button to stop the program.
The program stops, and the development environment returns.

You've finished working with If..Then and Select Case decision structures in this chapter. You'll
have several additional opportunities to work with them in this book, however. If..Then and
Select Case are two of the crucial decision-making mechanisms in the Visual Basic program-
ming language, and you'll find that you use them in almost every program that you write.
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One Step Further: Detecting Mouse Events

| began this chapter by discussing a few of the events that Visual Basic programs can respond
to, and as the chapter progressed, you learned how to manage different types of events by
using the /f...Then and Select Case decision structures. In this section, you'll add an event han-
dler to the Select Case program that detects when the pointer “hovers” over the Country list
box for a moment or two. You'll write the special routine, or event handler, by building a list
box event procedure for the MouseHover event, one of several mouse-related activities that
Visual Basic can monitor and process. This event procedure will display the message “Please
click the country name” if the user points to the country list box for a moment or two but
doesn’t make a selection, perhaps because he or she doesn't know how to make a selection
or has become engrossed in another task.

Add a mouse event handler

1. Open the Code Editor if it isn't already open.

2. At the top of the Code Editor, click the Class Name arrow, and then click the IstCountryBox
object.

You can use the ToolTip feature to help identify elements like the Class Name list box in
Visual Studio, which is another example of the MouseHover event within the IDE.

3. Click the Method Name arrow, and then click the MouseHover event.
Visual Basic opens the IstCountryBox_MouseHover event procedure in the Code Editor,

as shown here:

r Class Name MouseHover event

S |stCauntryBox ~ ¥ MouseHover -
=

Frivate Zub lstCountryBox MouseHover (EyWal sender Az Chject, By\fe‘

End Sub

Each object on the form has one event procedure that opens automatically when you
double-click the object on the form. You need to open the remaining event procedures
by using the Method Name list box.
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Type the following program statements in the /stCountryBox_MouseHover event
procedure:

If 1stCountryBox.SelectedIndex < 0 Or _

T1stCountryBox.SelectedIndex > 4 Then

Tb1Greeting.Text = "Please click the country name"

End If
This If statement evaluates the SelectedIndex property of the list box object by using
two conditional statements and the Or operator. The event handler assumes that if
there's a value between 1 and 4 in the SelectedIndex property, the user doesn’t need
help picking the country name (he or she has already selected a country). But if the
SelectedIndex property is outside that range, the event handler displays the message
“Please click the country name” in the greeting label at the bottom of the form. This
Help message appears when the user holds the pointer over the list box and dis-
appears when a country name is selected.

Click the Start Debugging button to run the program.
Hold the pointer over the country list box, and wait a few moments.

The message "Please click the country name” appears in red text in the label, as
shown here:

o5 Case Greeting EI@

International Welcome Program

Chooze a country
| England ]
| Germany |
| Mesico |
' Italy i
i
| |

|

Fleaze click the country name

Cluit

Click a country name in the list box.
The translated greeting appears in the label, and the Help message disappears.
Click the Quit button to stop the program.

You've learned how to process mouse events in a program, and you've also learned
that writing event handlers is quite simple. Try writing additional event handlers on
your own as you continue reading this book—it will help you learn more about the
events available to Visual Studio objects, and it will give you more practice with
If...Then and Select Case decision structures.
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Write a conditional
expression

Use an If..Then
decision structure

Receive input from the
user in a specific format

Use a Select Case
decision structure

Rename an object in a
program

Make two comparisons in
a conditional expression

Short-circuit an If...Then
statement

Write an event handler
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Chapter 6 Quick Reference

Do this

Use one of the following comparison operators
between two values: =, <>, >, <, >=, or <=,

Use the following syntax:

If conditionl Then

statements executed if conditionl True
ElseIf condition2 Then

statements executed if condition2 True
Else

statements executed if none are True
End If

Add a MaskedTextBox control to your form, and specify the input format
by configuring the Mask property.

Use the following syntax:

Select Case variable
Case valuel

statements executed if valuel matches
Case value2

statements executed if value2 matches
Case Else

statements executed if none match
End Select

Select the object that you want to rename, and then modify the
object’s (Name) property by using the Properties window. If you give
the object a three-character prefix that identifies its object type (btn,
Ibl, Ist, etc.), the object is easier to spot in program code.

Use a logical operator between comparisons (And, Or, Not, or Xor).

If...Then statements can be short-circuited when the AndAlso and OrElse
operators are used and two or more conditional expressions are given.
Depending on the result of the first condition, Visual Basic might not
evaluate the additional conditions, and the statement is short-circuited.

In the Code Editor, click an object name in the Class Name list box, and
then click an event name in the Method Name list box. Add program
statements to the event procedure (called an event handler) that respond
to the event you are customizing.






Chapter 7
Using Loops and Timers

After completing this chapter, you will be able to:
B Use a For...Next loop to execute statements a set number of times.
B Display output in a multiline text box by using string concatenation.
B Use a Do loop to execute statements until a specific condition is met.
B Use the Timer control to execute code at specific times.
B Create your own digital clock and timed password utility.

B Use the new Insert Snippet command to insert ready-made code templates or snippets
into the Code Editor.

In Chapter 6, “"Using Decision Structures,” you learned how to use the /f...Then and Select Case
decision structures to choose which statements to execute in a program. You also learned
how to process user input and evaluate different conditions in a program, and how to de-
termine which block of program statements to execute based on changing conditions. Now
you'll continue learning about program execution and flow control by using loops to execute
a block of statements over and over again. You'll also create a digital clock and other inter-
esting utilities that perform actions at set times or in relation to intervals on your computer’s
system clock.

In this chapter, you'll use a For...Next loop to execute statements a set number of times,

and you'll use a Do loop to execute statements until a conditional expression is met. You'll
also learn how to display more than one line of text in a text box object by using the string
concatenation (&) operator, and you'll learn how to use the Visual Studio Timer control to
execute code at specific intervals in your program. Finally, you'll learn how to use the Insert
Snippet command to insert code templates into your programs—a time-saving feature with-
in the Microsoft Visual Studio IDE.
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Writing For...Next Loops

With a For...Next loop, you can execute a specific group of program statements a set number
of times in an event procedure or a code module. This approach can be useful if you're per-
forming several related calculations, working with elements on the screen, or processing several
pieces of user input. A For...Next loop is really just a shorthand way of writing out a long list of
program statements. Because each group of statements in such a list does essentially the same
thing, you can define just one group of statements and request that it be executed as many
times as you want.

The syntax for a For...Next loop looks like this:

For variable = start To end
statements to be repeated
Next [variable]

In this syntax statement, For, To, and Next are required keywords, as is the equal to operator (=).
You replace variable with the name of a numeric variable that keeps track of the current loop
count (the variable after Next is optional), and you replace start and end with numeric values
representing the starting and stopping points for the loop. (Note that you must declare vari-
able before it's used in the For...Next statement.) The line or lines between the For and Next
statements are the instructions that are repeated each time the loop is executed.

For example, the following For...Next loop sounds four beeps in rapid succession from the
computer’s speaker (although the result might be difficult to hear):

Dim i As Integer
For i = 1 To 4

Beep()
Next i

This loop is the functional equivalent of writing the Beep statement four times in a procedure.
The compiler treats it the same as

Beep()
Beep()
Beep()
Beep()

The variable used in the loop is /, a single letter that, by convention, stands for the first integer
counter in a For...Next loop and is declared as an Integer type. Each time the loop is executed,
the counter variable is incremented by one. (The first time through the loop, the variable con-
tains a value of 1, the value of start; the last time through, it contains a value of 4, the value of
end.) As you'll see in the following examples, you can use this counter variable to great advan-
tage in your loops.



Chapter 7 Using Loops and Timers 187

Displaying a Counter Variable in a TextBox Control

A counter variable is just like any other variable in an event procedure. It can be assigned to
properties, used in calculations, or displayed in a program. One of the practical uses for a
counter variable is to display output in a TextBox control. You used the TextBox control earlier
in this book to display a single line of output, but in this chapter, you'll display many lines of
text by using a TextBox control. The trick to displaying more than one line is simply to set the
Multiline property of the TextBox control to True and to set the ScrollBars property to Vertical.
Using these simple settings, the one-line text box object becomes a multiline text box object
with scroll bars for easy access.

Display information by using a For...Next loop

1.

Start Visual Studio, and create a new Visual Basic Windows Forms Application project
named My For Loop.

A blank form opens in the Designer. Your first programming step is to add a Button
control to the form, but this time you'll do it in a new way.

Double-click the Button control in the Toolbox.

Visual Studio places a button object in the upper-left corner of the form. With the
Button control and many others, double-clicking is a quick way to create a standard-
sized object on the form. Now you can drag the button object where you want it and
customize it with property settings.

Drag the button object to the right, and center it near the top of the form.

Open the Properties window, and then set the Text property of the button to “Loop”.
Double-click the TextBox control in the Toolbox.

Visual Studio creates a small text box object on the form.

Set the Multiline property of the text box object to True, and then set the ScrollBars
property of the text box object to Vertical.

These settings prepare the text box for displaying more than one line of text.

Move the text box below the button, and enlarge it so that it takes up two-thirds of
the form.

Double-click the Loop button on the form.

The Button1_Click event procedure appears in the Code Editor.
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Type the following program statements in the procedure:

Dim i As Integer
Dim Wrap As String
Wrap = Chr(13) & Chr(10)
For i = 1 To 10
TextBox1l.Text = TextBox1l.Text & "Line " & i & Wrap
Next i
This event procedure declares two variables, one of type Integer (i) and one of type
String (Wrap). It then assigns a string value representing the carriage return character to
the second variable.

Tip In programmer terms, a carriage return character is the equivalent of pressing the
Enter key on the keyboard. | created a special variable for this character in the program
code, which is made up of return and linefeed elements, to make coding a carriage return
less cumbersome. The return element, Chr(13) moves the I-beam to the beginning of the
line. The linefeed element, Chr(10), reminiscent of an older style typewriter, moves the I-
beam to the next line.

After the variable declaration and assignment, | use a For...Next loop to display Line

X 10 times in the text box object, where X is the current value of the counter variable
(in other words, Line 1 through Line 10). The string concatenation characters (&) join
together the component parts of each line in the text box. First, the entire value of the
text box, which is stored in the Text property, is added to the object so that previous
lines aren't discarded when new ones are added. Next, the "Line” string, the current line
number, and the carriage return character (Wrap) are combined to display a new line
and move the |-beam to the left margin and down one line. The Next statement com-
pletes the loop.

Note that Visual Studio automatically adds the Next statement to the bottom of the
loop when you type For to begin the loop. In this case, | edited the Next statement to
include the i variable name—this is an optional syntax clarification that I like to use.
(The variable name makes it clear which variable is being updated, especially in nested
For...Next loops.)

Click the Save All button on the Standard toolbar to save your changes, and specify the
c\vb08sbs\chap07 folder as the location.

Now you're ready to run the program.

Tip The complete For Loop program is available in the c:\vb08sbs\chap07\for loop folder.
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11. Click the Start Debugging button on the Standard toolbar.
12. Click the Loop button.

The For...Next loop displays 10 lines in the text box, as shown here:

s/ Farml (= e )

[ Lloop |

Line 1
Line 2
Line 3
Line 4
Line 5
Line B
Line 7
Line &
Line 9
Line 10

13. Click the Loop button again.

The For...Next loop displays another 10 lines on the form. (You can see any nonvisible
lines by using the vertical scroll bar to scroll down.) Each time the loop is repeated, it
adds 10 more lines to the text box object.

Q Tip Worried about running out of room in the text box object? It will take a while if you're
displaying only simple text lines. A multiline text box object has a limit of 64 KB of text! If

you want even more space and formatting options, you can use the RichTextBox control in

the Toolbox—a similar but even more capable control for displaying and manipulating text.

14. Click the Close button on the form to stop the program.

As you can see, a For...Next loop can considerably simplify your code and reduce the
total number of statements that you need to type. In the previous example, a loop
three lines long processed the equivalent of 10 program statements each time you
clicked the Loop button.
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Creating Complex For...Next Loops

The counter variable in a For...Next loop can be a powerful tool in your programs. With a
little imagination, you can use it to create several useful sequences of numbers in your loops.
To create a loop with a counter pattern other than 1, 2, 3, 4, and so on, you can specify a dif-
ferent value for start in the loop and then use the Step keyword to increment the counter at
different intervals. For example, the code

Dim i As Integer
Dim Wrap As String
Wrap = Chr(13) & Chr(10)

For i = 5 To 25 Step 5
TextBox1l.Text = TextBox1l.Text & "Line " & i & Wrap
Next i

displays the following sequence of line numbers in a text box:

Line 5

Line 10
Line 15
Line 20
Line 25

You can also specify decimal values in a loop if you declare i as a single-precision or double-
precision type. For example, the For...Next loop

Dim i As Single
Dim Wrap As String
Wrap = Chr(13) & Chr(10)

For i = 1 To 2.5 Step 0.5
TextBox1l.Text = TextBoxl.Text & "Line " & i & Wrap
Next i

displays the following line numbers in a text box:

Line
Line
Line
Line

.5

NN R R

.5

In addition to displaying the counter variable, you can use the counter to set properties,
calculate values, or process files. The exercise on the following page shows how you can
use the counter to open Visual Basic icons that are stored on your hard disk in files that
have numbers in their names. You'll find many icons, bitmaps, and animation files in the
c:\program files\microsoft visual studio 9.0\common7\vs2005imagelibrary folder. These
files are contained in a compressed .zip file, so you will need to extract the files. Also note
that Microsoft changes the location for these types of files on occasion.
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Open files by using a For...Next loop

1.

O

On the File menu, click the New Project command.
The New Project dialog box opens.
Create a new Windows Forms Application project named My For Loop Icons.

Your new project starts, and a blank form opens in the Designer.

Note If you're opening the project from the practice files | provided, you'll see slightly
different code than what is shown in step 7 below, because we modify the For Loop Icons
project in the next exercise.

Click the PictureBox control in the Toolbox, and then draw a medium-sized picture box
object centered on the top half of the form.

Click the Button control, and then draw a very wide button below the picture box.
(You'll put a longer than usual label on the button.)

Set the following properties for the two objects:

Object Property Setting
PictureBox1 BorderStyle Fixed3D

SizeMode Stretchimage
Buttonl Text "Display Four Faces”

Double-click the Display Four Faces button on the form to display the event procedure
for the button object.

The Button1_Click event procedure appears in the Code Editor.
Type the following For...Next loop:

Dim i As Integer
For i =1 To 4
PictureBoxl.Image = System.Drawing.Image.FromFile _
("c:\vb08sbs\chap07\face0" & i & ".ico™)
MsgBox("Click here for next face.")
Next

Tip The FromFile method in this event procedure is too long to fit on one line in this book,
so | broke it into two lines by using a space and the line continuation character (_). You can
use this character anywhere in your program code except within a string expression.
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The loop uses the FromFile method to load four icon files from the c:\vb08sbs\chap07
folder on your hard disk. The file name is created by using the counter variable and the
concatenation operator you used earlier in this chapter. The code

PictureBoxl.Image = System.Drawing.Image.FromFile _

("c:\vb08sbs\chap07\face0" & i & ".ico™)
combines a path, a file name, and the .ico extension to create four valid file names of
icons on your hard disk. In this example, you're loading face0Ol.ico, face02.ico, face03.
ico, and faceO4.ico into the picture box. This statement works because several files in
the c:\vb08sbs\chap07 folder have the file name pattern facexx.ico. By recognizing the
pattern, you can build a For...Next loop around the file names.

Note The message box function (MsgBox) is used primarily to slow the action down so
that you can see what's happening in the For...Next loop. In a normal application, you
probably wouldn't use such a function (but you're welcome to).

Click the Save All button on the Standard toolbar to save your changes. Specify the
c:\vb08sbs\chap07 folder as the location.

Click the Start Debugging button to run the program, and then click the Display Four
Faces button.

The For...Next loop loads the first face into the picture box, and then displays this
message box:

=

o5 Forml — e

L
Y

For Loop Icons (==

| Dizplay Four Faces |
— Click here for next face,

0K

Note If Visual Basic displays an error message, ensure that your program code has no typos,
and then verify that the icon files are in the path you specified in the program. If you installed
the Step by Step practice files in a folder other than the default folder, or if you moved your
icon files after installation, the path in the event procedure might not be correct.
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10. Click OK to display the next face.

Your screen looks something like this:

a5l Forml = |[= 2=

For Loop Icons (3]

Dizplay Four Faces

Click here for next face,

o

11. Click OK three more times to see the entire face collection.
You can repeat the sequence if you want.
12. When you're finished, click the Close button on the form.

The program stops, and the development environment returns.

Using a Counter That Has Greater Scope

Are there times when using a For...Next loop isn't that efficient or elegant? Sure. In fact,
the preceding example, although useful as a demonstration, was a little hampered by the
intrusive behavior of the message box, which opened four times in the For...Next loop and
distracted the user from the form, where we want his or her attention to be. Is there a way
we can do away with that intrusive message box?

One solution is to remove both the MsgBox function and the For...Next loop, and substi-
tute in their place a counter variable that has greater scope throughout the form. As you
learned in Chapter 5, "Visual Basic Variables and Formulas, and the .NET Framework,” you
can declare a variable that has scope (or maintains its value) throughout the entire form

by placing a Dim statement for the variable at the top of the form in the Code Editor—a
special location above the event procedures. In the following exercise, you'll use an Integer
variable named Counter that maintains its value between calls to the Button1_Click event
procedure, and you'll use that variable to open the same icon files without using the
MsgBox function to pause the action.
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Use a global counter

1. Open the Code Editor for the My For Loop Icons project.

2. Move the insertion point above the Buttonl_Click event procedure, and directly below
the Public Class Form1 statement, declare an Integer variable named Counter by using
this syntax:

Dim Counter As Integer = 1

Notice that Visual Studio separates the declaration that you've just entered from the
event procedure with a solid line and displays the word “(Declarations)” in the Method
Name list box. You've also done something unusual here—in addition to declaring the
Counter variable, you've also assigned the variable a value of 1. Declaring and assign-
ing at the same time isn't permitted in Visual Basic 6, but it has been a handy feature
of Visual Basic since version 2002. In Chapter 5, | used this syntax to declare a constant,
but this is the first time that I've used it for variable declarations.

3. Within the Buttonl_Click event procedure, change the code so that it precisely matches
the following group of program statements. (Delete any statements that aren't here.)

PictureBox1l.Image = System.Drawing.Image.FromFile _

("c:\vb08sbs\chap07\face0" & Counter & ".ico")
Counter += 1
If Counter = 5 Then Counter = 1
As you can see, I've deleted the declaration for the i integer, the For and Next statements,
and the MsgBox function, and I've changed the way the FromFile method works. (I've
replaced the i variable with the Counter variable.) I've also added two new statements
that use the Counter variable. The first statement adds 1 to Counter (Counter += 1), and
the second statement resets the Counter variable if the value has been incremented to
5. (Resetting the variable in this way allows the list of icon files to cycle indefinitely.) The
Counter += 1 syntax is a shortcut feature in Visual Basic 2005 and 2008—the functional
equivalent of the following statement:

Counter = Counter + 1

Now you'll run the program.

Tip The modified For Loop Icons program is available in the c:\vb08sbs\chap07\for loop
icons folder.

4. Click the Start Debugging button on the Standard toolbar to run the program.
The program runs in the development environment.

5. Click the Display Four Faces button several times. (Notice how the mood of the faces
develops from glum to cheery.)
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a5 Farml =5 EoE =T

| Dizplay Four Faces |

6. When you're finished, click the Close button on the form to stop the program.

As you can see, this solution is a little more elegant than the previous example because the
user can click just one button, not a form button and a message box button. The shortcoming
of the interface in the first program wasn't the fault of the For...Next loop, however, but rather
the limitation | imposed that the Button1_Click event procedure use only local variables (in
other words, variables that were declared within the event procedure itself). Between button
clicks, these local variables lost their value, and the only way | could increment the counter
was to build a loop. By using an Integer variable with a greater scope, | can preserve the value
of the Counter variable between clicks and use that numeric information to display files within
the Button1_Click event procedure.

The Exit For Statement

Most For...Next loops run to completion without incident, but now and then you'll find it
useful to end the computation of a For...Next loop if a particular “exit condition” occurs.

Visual Basic allows for this possibility by providing the Exit For statement, which you can
use to terminate the execution of a For...Next loop early and move execution to the first

statement after the loop.

For example, the following For...Next loop prompts the user for 10 names and displays
them one by one in a text box unless the user enters the word “Done”:

Dim i As Integer

Dim InpName As String

For i = 1 To 10
InpName = InputBox("Enter your name or type Done to quit.")
If InpName = "Done" Then Exit For
TextBox1.Text = InpName

Next i

If the user does enter “Done”, the Exit For statement terminates the loop, and execution
picks up with the statement after Next.
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Writing Do Loops

As an alternative to a For..Next loop, you can write a Do loop that executes a group of state-
ments until a certain condition is True. Do loops are valuable because often you can't know
in advance how many times a loop should repeat. For example, you might want to let the
user enter names in a database until the user types the word “Done” in an input box. In that
case, you can use a Do loop to cycle indefinitely until the “Done” text string is entered.

A Do loop has several formats, depending on where and how the loop condition is evaluated.
The most common syntax is

Do While condition
block of statements to be executed
Loop

For example, the following Do loop prompts the user for input and displays that input in a
text box until the word “Done” is typed in the input box:

Dim InpName As String

Do While InpName <> "Done"
InpName = InputBox("Enter your name or type Done to quit.")
If InpName <> "Done" Then TextBox1l.Text = InpName

Loop

The conditional statement in this loop is InpName <> "Done", which the Visual Basic com-
piler translates to mean “loop as long as the InpName variable doesn't contain exactly the
word ‘Done"” This brings up an interesting fact about Do loops: if the condition at the top of
the loop isn't True when the Do statement is first evaluated, the Do loop is never executed.
Here, if the InpName string variable did contain the “Done” value before the loop started
(perhaps from an earlier assignment in the event procedure), Visual Basic would skip the

loop altogether and continue with the line below the Loop keyword.

If you always want the loop to run at least once in a program, put the conditional test at the
bottom of the loop. For example, the loop

Dim InpName As String

Do
InpName = InputBox("Enter your name or type Done to quit.")
If InpName <> "Done" Then TextBoxl.Text = InpName

Loop While InpName <> "Done"

is essentially the same as the previous Do loop, but here the loop condition is tested after a
name is received from the InputBox function. This has the advantage of updating the InpName
variable before the conditional test in the loop so that a preexisting “Done” value won't cause
the loop to be skipped. Testing the loop condition at the bottom ensures that your loop is ex-
ecuted at least once, but often it forces you to add a few extra statements to process the data.
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Note The previous code samples asked the user to type “Done” to quit. Note that the test of the
entered text is case sensitive, which means that typing “done” or "DONE" doesn't end the program.
You can make the test case-insensitive by using the StrComp function, which I'll discuss in Chapter
13, “Exploring Text Files and String Processing.”

Avoiding an Endless Loop

Because of the relentless nature of Do loops, it's very important to design your test conditions
so that each loop has a true exit point. If a loop test never evaluates to False, the loop executes
endlessly, and your program might not respond to input. Consider the following example:

Dim Number as Double

Do
Number = InputBox("Enter a number to square. Type -1 to quit.")
Number = Number * Number
TextBox1l.Text = Number

Loop While Number >= 0

In this loop, the user enters number after number, and the program squares each number and
displays it in the text box. Unfortunately, when the user has had enough, he or she can't quit
because the advertised exit condition doesn't work. When the user enters -1, the program
squares it, and the Number variable is assigned the value 1. (The problem can be fixed by set-
ting a different exit condition.) Watching for endless loops is essential when you're writing Do
loops. Fortunately, they're pretty easy to spot if you test your programs thoroughly.

v Important Be sure that each loop has a legitimate exit condition.

The following exercise shows how you can use a Do loop to convert Fahrenheit temperatures
to Celsius temperatures. The simple program prompts the user for input by using the InputBox
function, converts the temperature, and displays the output in a message box.

Convert temperatures by using a Do loop

1. On the File menu, click New Project.
The New Project dialog box opens.

2. Create a new Visual Basic Windows Forms Application project named My Celsius
Conversion.
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The new project is created, and a blank form opens in the Designer. This time, you'll
place all the code for your program in the Form1_Load event procedure so that Visual
Basic immediately prompts you for the Fahrenheit temperature when you start the
application. You'll use an InputBox function to request the Fahrenheit data, and
you'll use a MsgBox function to display the converted value.

Double-click the form.

The Form1_Load event procedure appears in the Code Editor.

. Type the following program statements in the Form1_Load event procedure:

Dim FTemp, Celsius As Single
Dim strFTemp As String
Dim Prompt As String = "Enter a Fahrenheit temperature."
Do
strFTemp = InputBox(Prompt, "Fahrenheit to Celsius™)
If strFTemp <> "" Then
FTemp = CSng(strFTemp)
Celsius = Int((FTemp + 40) * 5 / 9 - 40)
MsgBox(Celsius, , "Temperature in Celsius")
End If
Loop While strFTemp <> ""
End

Tip Be sure to include the End statement at the bottom of the Form1_Load event procedure.

This code handles the calculations for the project. The first line declares two single-
precision variables, FTemp and Celsius, to hold the Fahrenheit and Celsius temperatures,
respectively. The second line declares a string variable named strfFTemp that holds a
string version of the Fahrenheit temperature. The third line declares a string variable
named Prompt, which will be used in the InputBox function, and assigns it an initial
value. The Do loop repeatedly prompts the user for a Fahrenheit temperature, converts
the number to Celsius, and then displays it on the screen by using the MsgBox function.

The value that the user enters in the input box is stored in the strFTemp variable. The
InputBox function always returns a value of type string, even if the user enters numbers.
Because we want to perform mathematical calculations on the entered value, strFTemp
must be converted to a number. The CSng function is used to convert a string into the
Single data type. CSng is one of many conversion functions you can use to convert a string
to a different data type. The converted single value is then stored in the FTemp variable.

The loop executes until the user clicks the Cancel button or until the user presses Enter
or clicks OK with no value in the input box. Clicking the Cancel button or entering no
value returns an empty string (). The loop checks for the empty string by using a
While conditional test at the bottom of the loop. The program statement

Celsius = Int((FTemp + 40) * 5 / 9 - 40)
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handles the conversion from Fahrenheit to Celsius in the program. This statement
employs a standard conversion formula, but it uses the Int function to return a value
that contains no decimal places to the Celsius variable. (Everything to the right of the
decimal point is discarded.) This cutting sacrifices accuracy, but it helps you avoid long,
unsightly numbers such as 21.11111, the Celsius value for 70 degrees Fahrenheit.

Click the Save All button on the Standard toolbar to save your changes. Specify the
c\vb08sbs\chap07 folder as the location.

Now you'll try running the program.

Tip The complete Celsius Conversion program is available in the c:\vb08sbs\chap07\celsius
conversion folder.

Click the Start Debugging button on the Standard toolbar.
The program starts, and the InputBox function prompts you for a Fahrenheit temperature.
Type 212.
Your screen looks like this:
Fahrenheit to Celsius ==
Enter a Fahrenheit temperature. |T|
| Cancel |
214
. Click OK.
The temperature 212 degrees Fahrenheit is converted to 100 degrees Celsius, as shown
in this message box:
Ternperature in Celsius [£35]
100
—Ta—
. Click OK. Then type 72 in the input box, and click OK again.
The temperature 72 degrees Fahrenheit is converted to 22 degrees Celsius.
Click OK, and then click Cancel in the input box.

The program closes, and the development environment returns.
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Using the Until Keyword in Do Loops

The Do loops you've worked with so far have used the While keyword to execute a
group of statements as long as the loop condition remains True. With Visual Basic,
you can also use the Until keyword in Do loops to cycle until a certain condition is
True. Use the Until keyword at the top or bottom of a Do loop to test a condition, just
like the While keyword. For example, the following Do loop uses the Until keyword to
loop repeatedly until the user enters the word “Done” in the input box:
Dim InpName As String
Do

InpName = InputBox("Enter your name or type Done to quit.™)

If InpName <> "Done" Then TextBoxl.Text = InpName
Loop Until InpName = "Done"

As you can see, a loop that uses the Until keyword is similar to a loop that uses the While
keyword, except that the test condition usually contains the opposite operator—the =
(equal to) operator versus the <> (not equal to) operator, in this case. If using the Until
keyword makes sense to you, feel free to use it with test conditions in your Do loops.

The Timer Control

As we wrap up our consideration of flow control tools and techniques in this chapter, you
should also consider the benefits of using the Visual Studio Timer control, which you can use
to execute a group of statements for a specific period of time or at specific intervals. The Timer
control is essentially an invisible stopwatch that gives you access to the system clock in your
programs. The Timer control can be used like an egg timer to count down from a preset time,
to cause a delay in a program, or to repeat an action at prescribed intervals.

Although timer objects aren't visible at run time, each timer is associated with an event proce-
dure that runs every time the timer’s preset interval has elapsed. You set a timer's interval by
using the Interval property, and you activate a timer by setting the timer's Enabled property
to True. Once a timer is enabled, it runs constantly—executing its event procedure at the pre-
scribed interval—until the user stops the program or the timer object is disabled.
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Creating a Digital Clock by Using a Timer Control

One of the most straightforward uses for a Timer control is creating a custom digital clock. In
the following exercise, you'll create a simple digital clock that keeps track of the current time
down to the second. In the example, you'll set the Interval property for the timer to 1000,
directing Visual Studio to update the clock time every 1000 milliseconds, or once a second.
Because the Windows operating system is a multitasking environment and other programs
also require processing time, Visual Studio might not update the clock every second, but it
always catches up if it falls behind. To keep track of the time at other intervals, such as once
every tenth of a second, you simply adjust the number in the Interval property.

Create the Digital Clock program

1. On the File menu, click the New Project command, and create a new Windows Forms
Application project named My Digital Clock.

The new project is created and a blank form opens in the Designer.

2. Resize the form to a small rectangular window (one that's wider than it is tall).
You don't want the clock to take up much room.

3. Double-click the Timer control on the Components tab of the Toolbox.

This is the first time that you have used the Components tab and the Timer control in
this book. (The Components tab provides a number of interesting controls that work
“behind the scenes” in your programs.) Visual Studio creates a small timer object in the
component tray beneath your form, as shown here:

0 Digital Clock - Microsoft Wisual Studio
File Edit ‘“iew Project Build Debug Data  Format Tools  Test  Window  Help
Desia-d@ Rl=2|9-0o 2.0 sz (=

Form1.vb [Design] Start Page X

HOQOOL %

a5 Digital Clock

Timerl
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Recall from Chapter 4, “Working with Menus, Toolbars, and Dialog Boxes,” that cer-
tain Visual Studio controls don't have a visual representation on the form, and when
objects for these controls are created, they appear in the component tray beneath

the form. (This was the case for the MenuStrip and ToolStrip controls that you used in
Chapter 4.) However, you can still select controls in this special pane and set properties
for them, as you'll do for the timer object in this exercise.

Click the Label control in the Toolbox, and then draw a very large label object on the
form—a label that's almost the size of the entire form itself.

You'll use the label to display the time in the clock, and you want to create a very big
label to hold the 24-point type you'll be using.

Note When you first create the label object, it resizes automatically to hold the text
“Labell” in the default size. But when you set the AutoSize property to False in the next
step, the label object is restored to the size you originally created.

Open the Properties window, and set the following properties for the form and the two
objects in your program:

Object Property Setting
Labell AutoSize False
Font Times New Roman, Bold, 24-point
Text (empty)
TextAlign MiddleCenter
Timerl Enabled True
Interval 1000
Forml Text “Digital Clock”

Tip If you'd like to put some artwork in the background of your clock, set the Background-
Image property of the Form1 object to the path of a graphics file.

Now you'll write the program code for the timer.
Double-click the timer object in the component tray.

The Timer1_Tick event procedure appears in the Code Editor. Experienced Visual Basic 6
programmers will notice that this event procedure has been renamed from Timerl_Timer
to Timer1_Tick, clarifying what this event procedure does in the program (that is, the
event procedure runs each time that the timer clock ticks).

Type the following statement:

Labell.Text = TimeString
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This statement gets the current time from the system clock and assigns it to the Text
property of the Labell object. (If you'd like to have the date displayed in the clock as well
as the time, use the System.DateTime.Now property instead of the TimeString property.)
Only one statement is required in this program because you set the Interval property for
the timer by using the Properties window. The timer object handles the rest.

Click the Save All button on the Standard toolbar to save your changes. Specify
c:\vb08sbs\chap07 as the folder location.

Tip The complete Digital Clock program is available in the c:\vb08sbs\chap07\digital
clock folder.

Click the Start Debugging button on the Standard toolbar to run the clock.

The clock appears, as shown in the following illustration. (Your time will be different,
of course.)

a Digital Clock =] B[R]

10:30:12

If you used the System.DateTime.Now property, you'll see the date in the clock also, as
shown here:

o) Digital Clock [E=5[EER(F%=)|

9/18/2008 10:30:12 AM

| needed to enlarge the label object and the form a little here to get the date and time
to appear on one line. If your system clock information also wrapped, close the program,
and resize your label and form.

Watch the clock for a few moments.
Visual Basic updates the time every second.

Click the Close button in the title bar to stop the clock.

The Digital Clock program is so handy that you might want to compile it into an executable
file and use it now and then on your computer. Feel free to customize it by using your own
artwork, text, and colors.
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Using a Timer Object to Set a Time Limit

Another interesting use of a timer object is to set it to wait for a given period of time before
either permitting or prohibiting an action. You can also use this timer technique to display
a welcome message or a copyright message on the screen or to repeat an event at a set in-
terval, such as saving a file every 10 minutes. Again, this is a little like setting an egg timer in
your program. You set the Interval property with the delay you want, and then you start the
clock ticking by setting the Enabled property to True.

The following exercise shows how you can use this approach to set a time limit for entering a
password. (The password for this program is “secret.”) The program uses a timer to close its
own program if a valid password isn't entered in 15 seconds. (Normally, a program like this
would be part of a larger application.)

Set a password time limit

1. On the File menu, click the New Project command, and create a new Windows Forms
Application project named My Timed Password.

The new project is created, and a blank form opens in the Designer.
2. Resize the form to a small rectangular window about the size of an input box.

3. Click the TextBox control in the Toolbox, and then draw a text box for the password in
the middle of the form.

4. Click the Label control in the Toolbox, and then draw a long label above the text box.
5. Click the Button control in the Toolbox, and then draw a button below the text box.
6. Double-click the Timer control on the Components tab of the Toolbox.

Visual Studio adds a timer object to the component tray below the form.

7. Set the properties in the following table for the program:

Object Property Setting
Labell Text "Enter your password within 15 seconds”
TextBox1 PasswordChar o
Buttonl Text “Try Password”
Timerl Enabled True
Interval 15000

Form1 Text "Password”
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The PasswordChar setting displays asterisk (*) characters in the text box as the user enters
a password. Setting the timer Interval property to 15000 gives the user 15 seconds to
enter a password and click the Try Password button. Setting the Enabled property to True
starts the timer running when the program starts. (If the timer wasn't needed until later in
the program, you could disable this property and then enable it in an event procedure.)

Your form looks like this:

Form1.vb [Design] Start Page

o Password =[]z

Enter vour pazsword within 15 seconds

Try Pazzword

Double-click the timer object in the component tray, and then type the following
statements in the Timerl_Tick event procedure:

MsgBox("Sorry, your time is up.")

End

The first statement displays a message indicating that the time has expired, and the
second statement stops the program. Visual Basic executes this event procedure if the
timer interval reaches 15 seconds and a valid password hasn't been entered.

Display the form, double-click the button object, and then type the following statements
in the Button_Click event procedure:

If TextBoxl.Text = "secret" Then

Timerl.Enabled = False

MsgBox("Welcome to the system!™)

End
Else

MsgBox("Sorry, friend, I don’t know you.")
End If
This program code tests whether the password entered in the text box is “secret.” If
it is, the timer is disabled, a welcome message is displayed, and the program ends.
(A more useful program would continue working rather than ending here.) If the
password entered isn't a match, the user is notified with a message box and is given

another chance to enter the password. But the user has only 15 seconds to do so!

Click the Save All button on the Standard toolbar to save your changes. Specify the
c:\vb08sbs\chap07 folder as the location.
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Test the Timed Password program

Tip The complete Timed Password program is available in the c:\vb08sbs\chap07\timed
password folder.

1. Click the Start Debugging button to run the program.
The program starts, and the 15-second clock starts ticking.
2. Type open in the text box.

The asterisk characters hide your input, as shown here:

a Passward =l Es
Enter vour pazsword within 15 seconds

xxx1

| Try Pazzword |

3. Click the Try Password button.

The following message box opens on the screen, noting your incorrect response:

Timed Password (==

Sorry, friend, I don‘t know you,

oK |

4. Click OK, and then wait patiently until the sign-on period expires.

The program displays the time-up message shown in this message box:

Timed Password (=3

Sorry, your tirme is up,

—

5. Click OK to end the program.

6. Run the program again, type secret (the correct password) in the text box, and then
click Try Password.
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The program displays this message:

Timed Password (=3

Welcome to the system!

7. Click OK to end the program.
The Visual Basic development environment appears.

As you can imagine, there are many practical uses for timer objects. As with For...Next loops
and Do loops, you can use timer objects to repeat commands and procedures as many times
as you need in a program. Combined with what you learned about the /f...Then and Select
Case decision structures in Chapter 6, you now have several statements, controls, and tech-
niques that can help you organize your programs and make them respond to user input and
data processing tasks in innovative ways. Learning to pick the best tool for the flow-control
situation at hand takes some practice, of course, but you'll have ample opportunity to try
these tools and techniques as you continue working in the following chapters, and as you
construct interesting applications on your own. In fact, you might take the opportunity right
now to create a simple project or two from scratch before you tackle the next chapter, which
discusses debugging. How about creating a digital clock that displays a different piece of art
in a picture box object every 30 seconds?

One Step Further: Inserting Code Snippets

If you enjoyed using the system clock and other Windows resources in this chapter, you
might enjoy one additional example that uses the Computer.Info object to display useful
information about the operating system you're currently using. This example also demon-
strates an interesting feature of Visual Studio called the Insert Snippet command, which
lets you insert ready-made code templates or snippets into the Code Editor from a list of
common programming tasks. Visual Studio comes automatically configured with a library
of useful code snippets, and you can add additional snippets from your own programs or
from online resources such as MSDN. The following exercise shows you how to use this
helpful feature.

Insert the Current Windows Version Snippet

1. On the File menu, click the New Project command, and create a new Windows Forms
Application project named My Windows Version Snippet.

The new project is created, and a blank form opens in the Designer.
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Create a new button object in the middle of the form, and set the Text property of the
button to “Display Windows Version”.

Double-click the button object to display the Buttonl_Click event procedure.

Now you'll use the Insert Snippet command to insert a code template that automatically
returns information about the version of Windows installed on your computer. Note that
this particular snippet is just one example from a list of dozens of useful code templates.

Click the Edit menu, point to the Microsoft IntelliSense submenu, and then click the
Insert Snippet command.

The Insert Snippet list box appears in the Code Editor, as shown in the following illustra-
tion. Depending on what components of Visual Studio you have installed, your snippet
list will have some differences.

5 Windows ersion Snippet - Microsoft Wisual Studis ==
Fil: Edit View Project Buld Debug Dsts Tosls Test Window Help
Ae S -Had| 4G B =29 -c-8- » SE(E2 R R RBE .
5 Formlvh*  Fammiub [Design]) Start Page + X | Solution Explarer - x
3 =
g 57 Buttanl - 7 Gick =IREEEA
g OPunlic Class Formi || (5 Windows Yersion Snippet
S Ea My Projct
Private Sub Buttonl Click(ByVal sender ks Systew.Cbject, Byy L. [E Formlvb
Tnsert Snippet:
End ub

CaEppiication - Compiling, Resources, and Settings -
[ Code Patterns - If, For Each, Try Catch, Property, stc

[ erystal reports

[ Dats - LING, XML, Designer, ADO.NET

[ Fundamentals - Collections, Data Types, File Systern, Math =
[ Office Developrent

[ Other - Connectivity, Crystal Reparts, Security

[ Smart Devices FrIT —rrse
[ Winduows Forms Applications

[ Windows System - Logging, Processes, Registry, Services =

End Class

£ || |3 Solution Explo... | 31Data Sources

Buttonl Click Attributes -

o5 4

Ready Lnd Col9 Cha IS

Tip You can also open the snippet list by right-clicking in the Designer and selecting
Insert Snippet.

The Insert Snippet list box is a navigation tool that you can use to explore the snippet
library and insert snippets into your program at the insertion point. To open a folder in
the list box, double click the folder name. To return to the previous folder in the folder
hierarchy, press the Backspace key.

Scroll to the bottom of the list box, and then double-click the Windows System -
Logging, Processes, Registry, Services folder.
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In this folder you'll find snippets related to querying and setting operating system
settings.

. Double-click the Windows - System Information folder.

A list of system information snippets appears. Now you'll select the snippet that returns
information about the current version of Windows.

. Double-click the snippet entitled “Determine the Current Windows Version.”

Visual Studio inserts the following two lines of code into the Button1_Click event
procedure at the insertion point:

Dim osVersion As String

osVersion = My.Computer.Info.0SVersion

These statements declare the string variable osVersion to hold version information about
the operating system, and then use the Computer.Info object to fill the variable with cur-
rent information. The snippet also uses the My namespace to gather information about
your computer. The My namespace is a “speed-dial” feature of Visual Basic designed

to reduce the time it takes to code common tasks, and | will introduce it more fully in
Chapter 13.

This code snippet is called a template because it supplies the majority of the code that
you need to insert for a particular task, but the code is not fully integrated into your
project yet. In this case, we should add a second variable to hold the name of the op-
erating system (because there are different Windows versions), and we'll add a MsgBox
function to display the results for the user. (In other cases, you might need to add con-
trols to your form, create new variables or data structures, or write additional program
statements that use the snippet.)

. Press the Enter key twice to add a blank line below the snippet.

. Type the following program statements:

Dim osName As String

osName = My.Computer.Info.0SFullName

MsgBox (osName & vbCr & osVersion)

These statements declare a second variable named osName that will hold the Windows
version retrieved by the OSFullName property of the Computer.Info object. There is
also a MsgBox function that displays the two returned values: the operating system
name (osName) and the operating system version number (osVersion). As you prob-
ably know, the operating system version number has now become quite detailed in
Microsoft Windows, because Windows has the ability to be updated automatically over
the Web each time a new security update or improvement is released. Examining the
version number is therefore a handy way to see whether your system is up-to-date and
safe.
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You'll also notice that | used vbCr. This is a constant that represents a carriage return.
This can be used as an alternative to the Chr(13) statement that was used earlier in the
chapter. There are several of these constants that can be helpful. When you type “vb” in
the Code Editor, you'll see a list of all of these constants. Your screen looks like this:

7 Windows Version Snippet - Microsoft Visual Studio =0 Fe o
File Edit View Project Build Debug Dsts Tools Test Window Help
Ao Ee-Had| s B =29 -c-8- » Lo R el Y =R
5 Formlvh® Farmiub [Design]) Start Page + X | Solution Explarer TEx
1 =
E 5% Buttanl - 7 Click L RIAEIE R &
g SFublic Class Formi - ;E Windows Yersion Snippet
a 4 My Project
Private Sus Buttonl Click(ByVal sender ks Systew.Cbject, ByV L. [E Formlvb
Diw osVersion ks String
osVersion = Hy.Computer.Info.0SVersion
Dim osWame is String
osliame = Hy.Computer.Info.0SFulllame
MsgBox (osName & vhir & osVersion)
End Sub ] Solution Explo.., |31 Dsta Sources
End Class L
Properies -0 x
Buttonl_Click Attributes -
B= 4l
4 i v
Ready Ln10 Colg tha INS

10. Click Save All to save your changes, and specify the c:\vb08sbs\chap07 folder as the
location.

11. Click Start Debugging to run the program.
Visual Studio runs the program in the IDE.

12. Click the Display Windows Version button to display the version information returned
by the snippet.

Your dialog box looks similar to the following:

Windows Wersion Snippet [E=<E)

Microsoft® Windows Vista™ Business
6.0.6000.0

13. Click OK to close the dialog box, and then click the Close button to end the program.

You've learned a handy skill that will allow you to insert a variety of useful code templates
into your own programs.
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Tip To insert new snippets or reorganize the snippets you have, click the Code Snippets Manager
command on the Tools menu. The Code Snippets Manager dialog box gives you complete control
over the contents of the Insert Snippet list box, and also contains a mechanism for gathering new

snippets online.

Chapter 7 Quick Reference

To

Execute a group of
program statements
a specific number of
times

Use a specific se-
quence of numbers
with statements

Avoid an endless Do
loop

Declare a variable and
assign a value to it at
the same time

Exit a For...Next loop
prematurely

Execute a group of
program statements
until a specific condi-
tion is met

Do this

Insert the statements between For and Next statements in a loop. For
example:

Dim i As Integer
For i = 1 To 10

MsgBox("Press OK already!")
Next

Insert the statements in a For...Next loop, and use the To and Step keywords
to define the sequence of numbers. For example:

Dim i As Integer
For i = 2 To 8 Step 2

TextBox1l.Text = TextBoxl.Text & i
Next

Be sure the loop has a test condition that can evaluate to False.

Use Dim to declare the variable, and then assign a value with the equal to
(=) operator. For example:

Dim Counter As Integer = 1

Use the Exit For statement. For example:

Dim InpName As String

Dim i As Integer

For i = 1 To 10
InpName = InputBox("Name?")
If InpName = "Trotsky" Then Exit For
TextBox1l.Text = InpName

Next

Insert the statements between Do and Loop statements. For example:

"

Dim Query As String =
Do While Query <> "Yes"

Query = InputBox("Trotsky?™")

If Query = “Yes” Then MsgBox("Hi")
Loop
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To

Loop until a specific
condition is True

Loop for a specific
period of time in your
program

Insert a code snippet
into your program

Add or reorganize
snippets in the Insert
Snippet list box

Do this
Use a Do loop with the Until keyword. For example:

Dim GiveIn As String
Do

GiveIn = InputBox("Say 'Uncle'")
Loop Until GiveIn = "Uncle"

Use the Timer control.

In the Code Editor, position the insertion point (I-beam) at the location
where you want to insert the snippet. On the Edit menu, click IntelliSense,
and then click Insert Snippet. Browse to the snippet that you want to
use, and then double-click the snippet name.

Click the Code Snippet Manager command on the Tools menu.



Chapter 8
Debugging Visual Basic Programs

After completing this chapter, you will be able to:
®m  [dentify different types of errors in your programs.
B Use Visual Studio debugging tools to set breakpoints and correct mistakes.
B Use the Autos and Watch windows to examine variables during program execution.
B Use a visualizer to examine string data types and complex data types within the IDE.

®  Use the Immediate and Command windows to change the value of variables and
execute commands in Visual Studio.

B Remove breakpoints.

In the past few chapters, you've had plenty of opportunity to make programming mistakes in
your code. Unlike human conversation, which usually works well despite occasional grammati-
cal mistakes and mispronunciations, communication between a software developer and the
Microsoft Visual Basic compiler is successful only when the precise rules and regulations of the
Visual Basic programming language are followed.

In this chapter, you'll learn more about the software defects, or bugs, that stop Visual Basic
programs from running. You'll learn about the different types of errors that turn up in pro-
grams and how to use the Microsoft Visual Studio debugging tools to detect and correct
these defects. What you learn will be useful as you experiment with the programs in this
book and when you write longer programs in the future.

Why focus on debugging now? Some programming books skip this topic altogether or
place it near the end of the book (after you've learned all the language features of a par-
ticular product). There is a certain logic to postponing the discussion, but | think it makes
the most sense to master debugging techniques while you learn to program so that detect-
ing and correcting errors becomes part of your standard approach to writing programs
and solving problems. At this point in Microsoft Visual Basic 2008 Step by Step, you know
just enough about objects, decision structures, and statement syntax to create interest-

ing programs but also enough to get yourself into a little bit of trouble! As you'll soon see,
however, Visual Studio 2008 makes it easy to uncover your mistakes and get back on the
straight and narrow.

213
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Finding and Correcting Errors

The defects you've encountered in your programs so far have probably been simple typing
mistakes or syntax errors. But what if you discover a nastier problem in your program—one
you can't find and correct by a simple review of the objects, properties, and statements
you've used? The Visual Studio IDE contains several tools that help you track down and fix
errors in your programs. These tools won't stop you from making mistakes, but they often
ease the pain when you encounter one.

Three Types of Errors

Three types of errors can occur in a Visual Basic program: syntax errors, run-time errors, and
logic errors:

B A syntax error (or compiler error) is a mistake (such as a misspelled property or keyword)
that violates the programming rules of Visual Basic. Visual Basic will point out several
types of syntax errors in your programs while you enter program statements, and it
won't let you run a program until you fix each syntax error.

B A run-time error is a mistake that causes a program to stop unexpectedly during ex-
ecution. Run-time errors occur when an outside event or an undiscovered syntax error
forces a program to stop while it's running. For instance, if you misspell a file name
when you use the System.Drawing.Image.FromFile method, or if you try to read the
floppy drive and it doesn't contain a disk, your code will generate a run-time error.

B A ogic error is a human error—a mistake that causes the program code to produce
the wrong results. Most debugging efforts are focused on tracking down logic errors
introduced by the programmer.

If you encounter a syntax error, you often can solve the problem by using the Visual Studio
documentation to learn more about the error message, and you can fix the mistake by pay-
ing close attention to the exact syntax of the functions, objects, methods, and properties
that you have used. In the Code Editor, incorrect statements are underlined with a jagged
line, and you can learn more about the error by holding the mouse pointer over the state-
ment. The illustration on the following page shows the error message that appears in Visual
Studio when | type the keyword Case incorrectly as “Csae” and then hold the mouse pointer
over the error. This error message appears as a ScreenTip.
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If you encounter a run-time error, you often can address the problem by correcting your

typing. For example, if a bitmap loads incorrectly into a picture box object, the problem
might simply be a misspelled path. However, many run-time errors require a more thorough
solution. You can add a structured error handler—a special block of program code that

recognizes a run-time error when it happens, suppresses any error messages, and adjusts
program conditions to handle the problem—to your programs. | discuss the new syntax for

structured error handlers in Chapter 9, “Trapping Errors by Using Structured Error Handling.’

Identifying Logic Errors

Logic errors in your programs are often the most difficult to fix. They're the result of faulty
reasoning and planning, not a misunderstanding about Visual Basic syntax. Consider the

following If..Then decision structure, which evaluates two conditional expressions and then
displays one of two messages based on the result.

If Age > 13 And Age < 20 Then
TextBox2.Text = "You're a teenager"

Else

TextBox2.Text

End If

"You're not a teenager"

4
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Can you spot the problem with this decision structure? A teenager is a person who is between
13 and 19 years old, inclusive, but the structure fails to identify the person who's exactly 13.
(For this age, the structure erroneously displays the message “You're not a teenager.”) This
type of mistake isn't a syntax error (because the statements follow the rules of Visual Basic); it's
a mental mistake or logic error. The correct decision structure contains a greater than or equal
to operator (>=) in the first comparison after the If..Then statement, as shown here:

If Age >= 13 And Age < 20 Then

Believe it or not, this type of mistake is the most common problem in a Visual Basic program.
Code that produces the expected results most of the time—but not all of the time—is the
hardest to test and to fix.

Debugging 101: Using Debugging Mode

One way to identify a logic error is to execute your program code one line at a time and
examine the content of one or more variables or properties as they change. To do this, you
can enter debugging mode (or break mode) while your program is running and then view
your code in the Code Editor. Debugging mode gives you a close-up look at your program
while the Visual Basic compiler is executing it. It's kind of like pulling up a chair behind the
pilot and copilot and watching them fly the airplane. But in this case, you can touch the
controls.

While you're debugging your application, you'll use buttons on the Standard toolbar and
the Debug toolbar, as well as commands on the Debug menu and special buttons and win-
dows in the IDE. The following illustration shows the debugging buttons on the Standard
and Debug toolbars, which you can open by pointing to the Toolbars command on the
View menu and then clicking Standard or Debug.

Navigate Backward Error List
’> |—Navigate Forward Immediate
B E-hdo | $Ea@E R =2 9--E-E | @ SE(E | S5 E R

> O @A % B

L |-Breakpoints Step Out
Show Threads in Source Step Over
Call Stack Step Into
Watch 1 Stop Debugging
Locals Break All
Immediate — Start Debugging

— Show Next Statement
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In the following exercise, you'll set a breakpoint—a place in a program where execution stops.
You'll then use debugging mode to find and correct the logic error you discovered earlier in
the If..Then structure. (The error is part of an actual program.) To isolate the problem, you'll
use the Step Into button on the Standard toolbar to execute program instructions one at a
time, and you'll use the Autos window to examine the value of key program variables and
properties. Pay close attention to this debugging strategy. You can use it to correct many
types of glitches in your own programs.

Debug the Debug Test program

1. Start Visual Studio.

2. On the File menu, click Open Project.
The Open Project dialog box opens.

3. Open the Debug Test project in the c:\vb08sbs\chap08\debug test folder.
The project opens in the development environment.

4. If the form isn't visible, display it now.

The Debug Test program prompts the user for his or her age. When the user clicks
the Test button, the program informs the user whether he or she is a teenager. The
program still has the problem with 13-year-olds that we identified earlier in the
chapter, however. You'll open the Debug toolbar now, and set a breakpoint to find
the problem.

5. If the Debug toolbar isn't visible, click the View menu, point to Toolbars, and then
click Debug.

The Debug toolbar appears below or to the right of the Standard toolbar.
6. Click the Start Debugging button on the Standard toolbar.
The program runs and the Debug Test form opens.
7. Remove the 0 from the Age text box, type 14, and then click the Test button.

The program displays the message "You're a teenager.” So far, the program displays
the correct result.

®

Type 13 in the Age text box, and then click the Test button.
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The program displays the message "You're not a teenager,” as shown in the following
illustration.

25! Debug Test (===
Debugging Test: Can you find the programming error?

Haow old are pou?

E
Output
You're nat a teenager

This result is a bug.

This answer is incorrect, and you need to look at the program code to fix the problem.
Click the Quit button on the form, and then open the Code Editor.

Move the mouse pointer to the Margin Indicator bar (the gray bar just beyond the left
margin of the Code Editor window), next to the statement Age = TextBox1.Text in the
Button1_Click event procedure, and then click the bar to set a breakpoint.

The breakpoint immediately appears in red. See the following illustration for the
breakpoint’s location and shape:
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] Friwvate Sub Buttoni Click(EyVal sender As System.Chbject, EyV
End
r End Sub

= Private Sub Buttonl Click(EyVal sender Ls 3System.Chject, EyV
Dim Age Lz Integer

\) If Age » 13 And Age < 20 Then
TextBoxi.Text = "You're a teenager'”
Else
TextBoxZ.Text = "¥ou're not & Teenadger”
End If
+ End Sub H
“Eqd Class

— Breakpoint
Margin Indicator bar

Click the Start Debugging button to run the program again.
The form opens just like before, and you can continue your tests.

Type 13 in the Age text box, and then click Test.
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Visual Basic opens the Code Editor again and displays the Buttonl_Click event
procedure—the program code currently being executed by the compiler. The state-
ment that you selected as a breakpoint is highlighted in yellow, and an arrow appears
in the Margin Indicator bar, as shown in the following illustration:

o Debug Test (Debugging) - Microsoft Visual Studio

File Edit ‘iew Project Build Debug Tools  Test ‘Window Help

A n 3 | -— w3 = o= [=
S oo~ J | & Ga ®R|=2|9-6-8- » @ = [ %=
=lP=T- 1R
Forml.vb Forrnlab [Design] - X
¥ Buttonl * & Click -
[ Public Class Forml =
-
é Frivate Zub Buttoni Click(EyVal sender Ais ZJystem.Chject, EyVal
End
- End Zub =
= Private Zub Buttonl Click(ByVal sender As Zystem.Chject, ByVal
Dim Age As Integer
[=h] Lge = TextBDxl.Texd

If hge > 13 And Age < 20 Then
TextBoxZ.Text = "You're a teenager™
Elze
TextBoxZ.Text =
End If

L Wl Sl

"You're not a teenager™

You can tell that Visual Studio is now in debugging mode because the word
“Debugging” appears in its title bar. In debugging mode you have an opportunity
to see how the logic in your program is evaluated.

Note You can also enter debugging mode in a Visual Basic program by placing the Stop
statement in your program code where you'd like to pause execution. This is an older, but
still reliable, method for entering debugging mode in a Visual Basic program.

Place the pointer over the Age variable in the Code Editor.

Visual Studio displays the message “Age | 0.” While you're in debugging mode, you can
display the value of variables or properties by simply holding the mouse pointer over
the value in the program code. Age currently holds a value of 0 because it hasn't yet
been filled by the TextBox1 text box—that statement is the next statement the com-
piler will evaluate.

Click the Step Into button on the Debug toolbar to execute the next program statement.

The Step Into button executes the next program statement in the event procedure (the
line that's currently highlighted). By clicking the Step Into button, you can see how
the program state changes when just one more program statement is evaluated. If
you hold the pointer over the Age variable now, you'll see that it contains a value of 13.
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On the Debug menu, point to Windows, and then click Autos.

The Windows submenu provides access to the entire set of debugging windows in
Visual Studio. The Autos window shows the state of variables and properties currently
being used (not only the properties you are currently setting, but others as well).

As you can see in the following illustration, the Age variable holds a value of 13, the
TextBox1.Text property holds a string of “13", and the TextBox2.Text property currently
holds an empty string (").
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Click the Step Into button twice more.

The If statement evaluates the conditional expression to False, and the compiler moves
to the Else statement in the decision structure. Here's our bug—the decision structure
logic is incorrect because a 13-year-old is a teenager.

Select the conditional test Age > 13, and then hold the pointer over the selected text.
Visual Studio evaluates the condition and displays the message “Age > 13 | False.”
Select the conditional test Age < 20, and then hold the pointer over the selected text.

Visual Studio displays the message "Age < 20 | True.” The pointer has given us an addi-
tional clue—only the first conditional test is producing an incorrect result! Because a
13-year-old is a teenager, Visual Basic should evaluate the test to True, but the Age > 13
condition returns a False value. And this forces the Else clause in the decision structure
to be executed. Do you recognize the problem? The first comparison needs the greater
than or equal to (>=) operator to specifically test for this boundary case of 13. You'll stop
debugging now so that you can fix this logic error.
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19. Click the Stop Debugging button on the Standard toolbar.

20. In the Code Editor, add the equal to sign (=) to the first condition in the If statement so
that it reads

If Age >= 13 And Age < 20 Then

21. Run the program again and test your solution, paying particular attention to the numbers
12,13, 19, and 20—the boundary, or “fringe,” cases that are likely to cause problems.

Remember that you still have a breakpoint set, so you'll enter debugging mode
when you run the program again. Use the Step In button to watch the program flow
around the crucial /f statement, and use the Autos window to track the value of your
variables as you complete the tests. When the form opens, enter a new value and try
the test again. In addition, you might find that selecting certain expressions, such as
the conditional tests, and holding the pointer over them gives you a better under-
standing of how they're being evaluated. (You'll learn how to remove the breakpoint
later in the chapter.)

22. When you're finished experimenting with debugging mode, click the Stop Debugging
button on the Standard toolbar to end the program.

Congratulations! You've successfully used debugging mode to find and correct a logic error
in a program.

Tracking Variables by Using a Watch Window

The Autos window is useful for examining the state of certain variables and properties as
they're evaluated by the compiler, but items in the Autos window persist, or maintain their
values, only for the current statement (the statement highlighted in the debugger) and the
previous statement (the statement just executed). When your program goes on to execute
code that doesn't use the variables, they disappear from the Autos window.

To view the contents of variables and properties throughout the execution of a program,
you need to use a Watch window, a special Visual Studio tool that tracks important values
for you as long as you're working in debugging mode. In Visual Basic 6, you can open one
Watch window to examine variables as they change. In Visual Studio, you can open up to
four Watch windows, numbered Watch 1, Watch 2, Watch 3, and Watch 4. When you are in
debugging mode, you can open these windows, by pointing to the Windows command on
the Debug menu, pointing to Watch, and then clicking the window you want on the Watch
submenu. You can also add expressions, such as Age >= 13, to a Watch window.
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Open a Watch window

O

Tip The Debug Test project is located in the c:\vb08sbs\chap08\debug
test folder.

Click the Start Debugging button on the Standard toolbar to run the Debug Test
program again.

I'm assuming that the breakpoint you set on the line Age = TextBox1.Text in the
previous exercise is still present. If that breakpoint isn't set, stop the program now,
and set the breakpoint by clicking in the Margin Indicator bar next to the statement,
as shown in step 10 of the previous exercise, and then start the program again.

. Type 20 in the Age text box, and then click Test.

The program stops at the breakpoint, and Visual Studio enters debugging mode, which
is where you need to be if you want to add variables, properties, or expressions to a
Watch window. One way to add an item is to select its value in the Code Editor, right
click the selection, and then click the Add Watch command.

Select the Age variable, right click it, and then click the Add Watch command.

Visual Studio opens the Watch 1 window and adds the Age variable to it. The value
for the variable is currently 0, and the Type column in the window identifies the Age
variable as an Integer type.

Another way to add an item is to drag the item from the Code Editor into the Watch
window.

Select the TextBox2.Text property, and drag it to the empty row in the Watch 1 window.

When you release the mouse button, Visual Studio adds the property and displays its
value. (Right now, the property is an empty string.)

Select the expression Age < 20, and add it to the Watch window.

Age < 20 is a conditional expression, and you can use the Watch window to display
its logical, or Boolean, value, much as you did by holding the pointer over a condition
earlier in this chapter. Your Watch window looks like this:

Wiatch 1 -« 1 X
Marme Walue Type
J hoge u] Inkeger
o0 TextBoxZ, Text " 3, = Skring
o Age <20 True Boolean

=] Autos &-:]Watch 1| E Immediate Windou
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Now step through the program code to see how the values in the Watch 1 window
change.

6. Click the Step Into button on the Debug toolbar.

Tip Instead of clicking the Step Into button on the Debug toolbar, you can press the F8
key on the keyboard.

The Age variable is set to 20, and the Age < 20 condition evaluates to False. These values
are displayed in red type in the Watch window because they've just been updated.

7. Click the Step Into button three more times.

The Else clause is executed in the decision structure, and the value of the TextBox2.Text
property in the Watch window changes to “You're not a teenager.” This conditional test
is operating correctly. Because you're satisfied with this condition, you can remove the
test from the Watch window.

8. Click the Age < 20 row in the Watch window, and then press Delete.

Visual Studio removes the value from the Watch window. As you can see, adding and
removing values from the Watch window is a speedy process.

Leave Visual Studio running in debugging mode for now. You'll continue using the Watch
window in the next section.

Visualizers: Debugging Tools That Display Data

Although you can use the Watch, Autos, and Locals windows to examine simple data
types such as Integer and String in the IDE, you'll eventually be faced with more complex
data in your programs. For example, you might be examining a variable or property con-
taining structured information from a database (a dataset) or a string containing HTML or
XML formatting information from a Web page. So that you can examine this type of item
more closely in a debugging session, Visual Studio offers a set of tools in the IDE called
visualizers. The icon for a visualizer is a small magnifying glass.

The Visual Studio 2008 IDE offers four standard visualizers: the text, HTML, and XML visualizers
(which work on string objects), and the dataset visualizer (which works for DataSet, DataView,
and DataTable objects). Microsoft has implied that it will offer additional visualizers as down-
loads at some point in the future, and they have designed Visual Studio so that third-party
developers can write their own visualizers and install them into the Visual Studio debugger. In
the following exercise, you'll see how the text visualizer works. (For this exercise, | assume that
you are still in debugging mode and that the Watch window is open with a few expressions in
it from the Debug Test program.)
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Open a text visualizer in the debugger

1.

Look on the right side of the Watch window for a small magnifying glass icon.

A magnifying glass icon indicates that a visualizer is available for the variable or property
that you are examining in a Watch window, an Autos window, or a Locals window. If you
completed the previous exercise, the TextBox2.Text property shows a visualizer now.

Click the visualizer arrow.

When the property you are examining is a text (string) property, Visual Studio offers
three visualizers: a simple text visualizer that displays the selected string expression as
readable text, an HTML visualizer that converts HTML code to a Web page, and an XML
visualizer that converts XML code to a viewable document. The Watch window looks
like this:
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Click the Text Visualizer option.

Visual Studio opens a dialog box and displays the contents of the TextBox2.Text property.
Your screen looks like this:

Text Wisualizer = (B[R]

Expression: TextBoxd Text
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Although this particular result offers little more than the Watch window did, the ben-
efits of the visualizer tool become immediately obvious when the Text property of a
multiline text box object is displayed, or when you examine variables or properties
containing database information or Web documents. You'll experiment with these
more sophisticated data types later in the book.

4. Click Close to close the Text Visualizer dialog box.

Leave Visual Studio running in debugging mode. You'll continue using the Watch window
in the next section, too.

Q Tip In debugging mode, visualizers also appear within pop-up windows called DataTips in
the Code Editor. When you point to a variable or property within the Code Editor during a
debugging session, a DataTip appears, and you can click the visualizer icon for more infor-

mation as you did in the previous exercise.

Using the Immediate and Command Windows

So far, you've used the Visual Studio debugging tools that allow you to enter debugging
mode, execute code one statement at a time, and examine the value of important variables,
properties, and expressions in your program. Now you'll learn how to change the value of

a variable by using the Immediate window, and you'll learn how to run commands, such as
Save All or Print, within the Visual Studio IDE by using the Command window. The windows
contain scroll bars, so you can execute more than one command and view the results by
using the arrow keys.

The following exercises demonstrate how the Immediate and Command windows work. |
discuss these windows together because, with the following special commands, you can
switch between them:

B |n the Immediate window, the >cmd command switches to the Command window.
®  |n the Command window, the immed command switches to the Immediate window.

The exercises assume that you're debugging the Debug Test program in debugging mode.

Use the Immediate window to modify a variable

1. On the Debug menu, point to Windows, and then click Immediate.

When you select the command, Visual Studio opens the Immediate window and prepares
the compiler to receive commands from you while the Debug Test program is running.
This is a very handy feature, because you can test program conditions on the fly, without
stopping the program and inserting program statements in the Code Editor.
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In the Immediate window, type Age = 17, and then press Enter.

You've just used the Immediate window to change the value of a variable. The value of
the Age variable in the Watch window immediately changes to 17, and the next time
the If statement is executed, the value in the TextBox2.Text property will change to
“You're a teenager.” Your Immediate window looks like this:

Immediate Window > 0 x
Age = 17

=] Autos| g ]Wsteh 1) =Immediate Window

. Type the following statement in the Immediate window, and then press Enter:

TextBox2.Text = "You're a great age!"

The Text property of the TextBox2 object is immediately changed to "You're a great
age!” In the Immediate window, you can change the value of properties, as well as
variables.

Display the Watch 1 window if it is not currently visible. (Click the Watch 1 tab in the
Visual Studio IDE.)

The Watch window looks like this:

Wiatch 1 - 1 X
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As you can see, both items now contain new values, and this gives you the opportunity
to test the program further.

Click the Step Into button two times to display the Debug Test form again.

Notice that the Text property of the TextBox2 object has been changed, as you directed,
but the Text property of the TextBoxI object still holds a value of 20 (not 17). This is
because you changed the Age variable in the program, not the property that assigned

a value to Age. Your screen looks like the one on the following page.
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a5/ Debug Test =@
Debugging Test: Can you find the programming error?

Hows old are you?
20 | Test |

Clutput
ou're not & teenager | Guit |

The Immediate window has many uses—it provides an excellent companion to the Watch
window, and it can help you experiment with specific test cases that might otherwise be very
difficult to enter into your program.

Switching to the Command Window

The text-based Command window offers a complement to the Visual Studio Immediate
window. Reminiscent of the MS-DOS command prompt, it can be used to run interface
commands in the Visual Studio IDE. For example, entering the File.SaveAll command in

the Command window saves all the files in the current project. (This command is the equiva-
lent of the Save All command on the File menu.) If you already have the Immediate window
open, you can switch between the Immediate and the Command windows by entering the
>cmd and immed commands, respectively. You can also click the View menu, point to Other
Windows, and then click Command Window to open the Command window. You'll practice
using the Command window in the following exercise.

Run the File.SaveAll command

1. In the Immediate window, type >cmd, and then press Enter to switch to the Command
window.

The Command window opens, and the Immediate or Watch window might now be
partially (or totally) hidden. (You can return to the Immediate window by clicking its
tab or typing immed in the Command window.) The > prompt appears, a visual clue
that you are now working in the Command window.

2. Type File.SaveAll in the Command window, and then press Enter.
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As you begin typing File, all the Visual Studio commands associate with the File
menu and file operations appear in a pop-up list box. This Microsoft IntelliSense
feature offers a useful way to learn about the many commands that can be executed
within the Command window. After you type File.SaveAll and press Enter, Visual
Studio saves the current project, and the command prompt returns, as shown in

the following illustration:
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Experiment with other commands now if you like. (Begin your commands with menu
names to discover the different commands available.) When you're finished, click the
Close button in both the Command and Immediate windows. You're finished with them
for now.

One Step Further: Removing Breakpoints

If you've been following the instructions in this chapter carefully, the Debug Test program is
still running and has a breakpoint in it. Follow these steps to remove the breakpoint and end
the program. You're finished debugging the Debug Test program.

Remove a breakpoint

1.

In the Code Editor, click the red circle associated with the breakpoint in the Margin
Indicator bar.

The breakpoint disappears. That's all there is to it! But note that if you have more
than one breakpoint in a program, you can remove them all by clicking the Delete All
Breakpoints command on the Debug menu. Visual Studio saves breakpoints with your
project, so it's important to know how to remove them; otherwise, they'll still be in
your program, even if you close Visual Studio and restart it!

Click the Stop Debugging button on the Standard toolbar.
The Debug Test program ends.
On the View menu, point to Toolbars, and then click Debug.

The Debug toolbar closes.
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You've learned the fundamental techniques of debugging Visual Basic programs with
Visual Studio. Place a bookmark in this chapter so that you can return to it as you encoun-
ter problems later in the book. In the next chapter, you'll learn how to handle run-time
errors by using structured error handling techniques.

To
Display the Debug toolbar
Set a breakpoint

Execute one line of code in
the Code Editor

Examine a variable, a
property, or an expression
in the Code Editor

Use the Autos window to
examine a variable on the
current or previous line
Add a variable, a property,
or an expression to a Watch
window

Display a Watch window

Display HTML, XML, or
dataset information during
a debugging session

Open the Immediate
window

Run a command in the
Visual Studio IDE from the
Command window

Switch to the Command
window from the
Immediate window

Remove one or more
breakpoints

Stop debugging

Chapter 8 Quick Reference

Do this
On the View menu, point to Toolbars, and then click Debug.
In the Code Editor, click in the Margin Indicator bar next to the state-

ment where you want to stop program execution. When the compiler
reaches the breakpoint, it will enter debugging mode.

or

Place a Stop statement in the program code where you want to enter
debugging mode.

Click the Step Into button on the Standard toolbar.

In debugging mode, select the value in the Code Editor, and then hold
the pointer over it.

In debugging mode, click the Debug menu, point to Windows, and
then click Autos.

In debugging mode, select the value in the Code Editor, right click the
value, and then click Add Watch.

In debugging mode, click the Debug menu, point to Windows, point
to Watch, and then click the window.

Click the visualizer icon in an Autos, a Watch, a Locals, or a DataTip
window during a debugging session.

Click the Debug menu, point to Windows, and then click Immediate.

At the > prompt, type the name of the command, and then press
Enter. For example, to save the current project, type File.SaveAll, and
then press Enter.

Type >cmd, and then press Enter. To switch back to the Immediate
window, type immed, and then press Enter.

Click the breakpoint in the Margin Indicator bar of the Code Editor.
or
Click the Delete All Breakpoints command on the Debug menu.

Click the Stop Debugging button on the Standard toolbar.






Chapter 9
Trapping Errors by Using Structured
Error Handling

After completing this chapter, you will be able to:
B Manage run-time errors by using the Try...Catch error handler.

B (Create a disc drive error handler that tests specific error conditions by using the Catch
When statement.

®  Write complex error handlers that use the Err object and Err. Number and Err.Description
properties to identify exceptions.

B Build nested Try...Catch statements.
m  Use error handlers in combination with defensive programming techniques.
B Leave error handlers prematurely by using the Exit Try statement.

In Chapter 8, "Debugging Visual Basic Programs,” you learned how to recognize run-time
errors in a Microsoft Visual Basic program and how to locate logic errors and other defects
in your program code by using the Microsoft Visual Studio 2008 debugging tools. In this
chapter, you'll learn how to build blocks of code that handle run-time errors, also referred
to as exceptions, which occur as a result of normal operating conditions—for example, errors
due to a CD or DVD not being in an optical drive, a broken Internet connection, or an offline
printer. These routines are called structured error handlers (or structured exception handlers),
and you can use them to recognize run-time errors, suppress unwanted error messages, and
adjust program conditions so that your application can regain control and run again.

Fortunately, Visual Basic offers the powerful Try...Catch code block for handling errors. In
this chapter, you'll learn how to trap run-time errors by using Try...Catch code blocks, and
you'll learn how to use the Err.Number and Err.Description properties to identify specific
run-time errors. You'll also learn how to use multiple Catch statements to write more flex-
ible error handlers, build nested Try...Catch code blocks, and use the Exit Try statement to
exit a Try...Catch code block prematurely. The programming techniques you'll learn are a
major improvement over what was possible with Visual Basic 6.0, and they are similar to
the structured error handlers provided by the most advanced programming languages,
such as Java and C++. The most reliable, or robust, Visual Basic programs make use of
several error handlers to manage unforeseen circumstances and provide users with con-
sistent and trouble-free computing experiences.
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Processing Errors by Using the Try...Catch Statement

A program crash is an unexpected problem from which a program can't recover. You might
have experienced your first program crash when Visual Basic couldn't load artwork from a
file, or in the previous chapter, when you intentionally introduced errors into your program
code during debugging. It's not that Visual Basic isn't smart enough to handle the glitch; it's
just that the program hasn't been “told” what to do when something goes wrong.

Fortunately, you don't have to live with occasional errors that cause your programs to crash.
You can write special Visual Basic routines, called structured error handlers, to manage and
respond to run-time errors before they force the Visual Basic compiler to terminate your pro-
gram. An error handler handles a run-time error by telling the program how to continue when
one of its statements doesn't work. Error handlers can be placed in each event procedure
where there is potential for trouble, or in generic functions or subprograms that receive control
after an error has occurred and handle the problem systematically. (You'll learn more about
writing functions and subprograms in Chapter 10, “Creating Modules and Procedures.”)

Error handlers handle, or trap, a problem by using a Try...Catch code block and a
special error-handling object named Err. The Err object has a Number property that
identifies the error number and a Description property that you can use to display a
description of the error. For example, if the run-time error is associated with loading

a file from a CD or DVD drive, your error handler might display a custom error message
that identifies the problem and prompts the user to insert a CD or DVD, rather than
allowing the failed operation to crash the program.

When to Use Error Handlers

You can use error handlers in any situation where an action (either expected or unexpected)
has the potential to produce an error that stops program execution. Typically, error handlers
are used to manage external events that influence a program—for example, events caused

by a failed network or Internet connection, a CD, DVD or diskette not being inserted correctly
in the drive, or an offline printer or scanner. The table on the following page lists potential
problems that can be addressed by error handlers.



Problem

Network/Internet
problems

Database problems
Disk drive problems
Path problems
Printer problems
Software not installed

Security problems

Permissions problems
Overflow errors

Out-of-memory errors

Clipboard problems

Logic errors
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Description

Network servers, Internet connections, and other resources that fail, or go
down, unexpectedly.

Unable to make a database connection, a query can't be processed or
times out, a database returns an error, and so on.

Unformatted or incorrectly formatted CDs, DVDs, diskettes, or media that
aren't properly inserted, bad sectors, CDs, DVDs, or diskettes that are full,
problems with a CD or DVD drive, and so on.

A path to a necessary file that is missing or incorrect.

Printers that are offline, out of paper, out of memory, or otherwise
unavailable.

A file or component that your application relies on but that is not installed
on the user's computer, or an operating system incompatibility.

An application or process that attempts to modify operating system files,
use the Internet inappropriately, or modify other programs or files.

User permissions that are not appropriate for performing a task.
An activity that exceeds the allocated storage space.

Insufficient application or resource space available in the Microsoft
Windows memory management scheme.

Problems with data transfer or the Windows Clipboard.

Syntax or logic errors undetected by the compiler and previous tests (such
as an incorrectly spelled file name).

Setting the Trap: The Try...Catch Code Block

The code block used to handle a run-time error is called Try...Catch. You place the Try
statement in an event procedure right before the statement you're worried about, and

the Catch statement follows immediately with a list of the statements that you want to run
if a run-time error actually occurs. A number of optional statements, such as Catch When,
Finally, Exit Try, and nested Try...Catch code blocks can also be included, as the examples in
this chapter will demonstrate. However, the basic syntax for a Try...Catch exception handler
is simply the following:

Try

Statements that might produce a run-time error
Catch

Statements to run if a run-time error occurs
Finally

Optional statements to run whether an error occurs or not
End Try
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The Try statement identifies the beginning of an error handler in which Try, Catch, and End
Try are required keywords, and Finally and the statements that follow are optional. Note
that programmers sometimes call the statements between the Try and Catch keywords
protected code because any run-time errors resulting from these statements won't cause
the program to crash. (Instead, Visual Basic executes the error-handling statements in the
Catch code block.)

Path and Disc Drive Errors

The following example demonstrates a common run-time error situation—a problem with
a path, disc drive, or attached peripheral device. To complete this exercise, you'll load a
sample Visual Basic project that | created to show how artwork files are opened in a picture
box object on a Windows form.

To prepare for the exercise, insert a blank CD or DVD into drive D (or equivalent), and use
Windows Explorer or your CD or DVD creation software to copy or burn the fileopen.bmp
file to it. Alternatively, you can copy the .bmp file to a diskette in drive A or another type
of removable storage media, such as an attached digital camera, memory stick, or lomega
Zip Drive.

Tip You'll find the fileopen.bmp file, along with the Disc Drive Error project, in the
c:\vb08sbs\chap09 folder.

To complete the exercise, you'll need to be able to remove the CD or DVD, or connect and
disconnect your external storage device, as test conditions dictate, and you'll need to modify
the program code below with the drive letter you're using. You'll use the CD or DVD (or
equivalent media) throughout the chapter to force run-time errors and recover from them.

Experiment with disc drive errors

1. Insert a blank CD or DVD in drive D (or the drive in which you create CDs or DVDs), and
copy the fileopen.bmp file to it.

Use Windows Explorer or a third-party CD or DVD creation program to copy the file and
burn the disc. If you're using a different external storage device, connect the device or
insert a blank disc, copy fileopen.bmp to it, and make a note of the drive letter Windows
assigns to the device.

2. Start Visual Studio, and then open the Disc Drive Error project, which is located in the
c\vb08sbs\chap09\disc drive error folder.

The Disc Drive Error project opens in the IDE.
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3. If the project’s form isn't visible, display it now.

The Disc Drive Error project is a skeleton program that displays the fileopen.bmp file in
a picture box when the user clicks the Check Drive button. | designed the project as a
convenient way to create and trap run-time errors, and you can use it throughout this
chapter to build error handlers by using the Try...Catch code block.

4. Double-click the Check Drive button on the form to display the Button1_Click event
procedure.

You'll see the following line of program code between the Private Sub and End Sub
statements:

PictureBox1l.Image = _

System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)
As you've learned in earlier chapters, the FromFile method opens the specified file.
This particular use of FromFile opens the fileopen.bmp file on drive D and displays it
in a picture box. However, if the CD or DVD is missing, the CD or DVD tray is open, the
file is not on the CD or DVD, or there is another problem with the path or drive letter
specified in the code, the statement produces a “File Not Found” error in Visual Basic.
This is the run-time error we want to trap.

Note If your CD or DVD drive or attached peripheral device is using a drive letter other
than "D" now, change the drive letter in this program statement to match the letter you're
using. For example, a floppy disk drive typically requires the letter “A.” Memory sticks, digital
cameras, and other detachable media typically use “E,” “F" or higher letters for the drive.

5. With your CD or DVD still in drive D (or equivalent), click the Start Debugging button
on the Standard toolbar to run the program.

The form for the project opens, as shown here:

o= Disc Drive Errar El@

Thiz program checks D:% for the bitmap
FileOpen.brp. If the file does nat exist or if
the drive is unready, an error ocours. Click
Check Drive when ready.

Check Diive |
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6. Click the Check Drive button on the form.

The program loads the fileopen.bmp file from the CD or DVD and displays it in the
picture box, as shown in the following illustration:

o= Disc Drive Errar El@

Thiz program checks D:% for the bitmap
FileOpen.brp. If the file does nat exist or if
the drive is unready, an error ocours. Click
Check Drive when ready.

Check Drive

The SizeMode property of the picture box object is set to Stretchimage, so the file fills
the entire picture box object. Now see what happens when the CD or DVD isn't in the
drive when the program attempts to load the file.

7. Remove the CD or DVD from the drive.

If you are using a different media type, remove it now. If you are testing with a
removable storage device, follow your usual procedure to safely remove or turn
it off, and remove the media containing fileopen.bmp.

8. Click the Check Drive button again on the form.

The program can't find the file, and Visual Basic issues a run-time error, or unhandled
exception, which causes the program to crash. Visual Studio enters debugging mode,
highlights the problem statement, and displays the dialog box shown on the fol-
lowing page.
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W Disc Drive Error (Debugging) - Microsoft Visual Studia
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i FileNotFoundException was unhandled
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Notice how helpful Visual Studio is trying to be here, by offering troubleshooting
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tips to assist you in locating the source of the unhandled exception that has stopped
the program. The Actions list allows you to learn even more about the specific error
message that is displayed at the top of the dialog box.

9. Click the Stop Debugging button on the Standard toolbar to close the program.

The development environment returns.

Now you'll modify the code to handle this plausible error scenario in the future.

Writing a Disc Drive Error Handler

The problem with the Disc Drive Error program isn't that it somehow defies the inherent

capabilities of Visual Basic to process errors. We just haven't specified what Visual Basic

should do when it encounters an exception that it doesn't know how to handle. The solu-
tion to this problem is to write a Try...Catch code block that recognizes the error and tells
Visual Basic what to do about it. You'll add this error handler now.
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Use Try...Catch to trap the error

1.

Display the Button1_Click event procedure if it isn't visible in the Code Editor.

You need to add an error handler to the event procedure that's causing the problems.
As you'll see in this example, you actually build the Try...Catch code block around the
code that's the potential source of trouble, protecting the rest of the program from
the run-time errors it might produce.

Modify the event procedure so that the existing FromFile statement fits between Try
and Catch statements, as shown in the following code block:

Try

PictureBox1l.Image = _

System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)

Catch

MsgBox("Please insert the disc in drive D!")
End Try
You don't need to retype the FromFile statement—just type the Try, Catch, MsgBox, and
End Try statements above and below it. If Visual Studio adds Catch, variable declaration,
or End Try statements in the wrong place, simply delete the statements and retype them
as shown in the book. (The Code Editor tries to be helpful, but its Auto Complete feature
sometimes gets in the way.)

This program code demonstrates the most basic use of a Try...Catch code block. It
places the problematic FromFile statement in a Try code block so that if the program
code produces an error, the statements in the Catch code block are executed. The
Catch code block simply displays a message box asking the user to insert the required
disc in drive D so that the program can continue. This Try...Catch code block contains
no Finally statement, so the error handler ends with the keywords End Try.

Again, if you are using a removable storage device or media associated with a different
drive letter, you would make those changes in the statements that you just typed.

Test the error handler

1.

2.

Remove the CD or DVD from drive D, and click the Start Debugging button to run the
program.

Click the Check Drive button.
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Instead of stopping program execution, Visual Basic invokes the Catch statement, which
displays the following message box:

Disc Drive Error (=3

Please insert the disc in drive D!

3. Click OK, and then click the Check Drive button again.

The program displays the message box again, asking you to insert the disc properly in
drive D. Each time there's a problem loading the file, this message box appears.

4. Insert the disc in drive D, wait a moment for the system to recognize the CD or DVD
(close any windows that appear when you insert the disc), click OK, and then click the
Check Drive button again.

The bitmap graphic appears in the picture box, as expected. The error handler has
completed its work effectively—rather than the program crashing inadvertently, it's
told you how to correct your mistake, and you can now continue working with the
application.

5. Click Close on the form to stop the program.

It's time to learn some of the variations of the Try...Catch error handler.

Using the Finally Clause to Perform Cleanup Tasks

As the syntax description for Try...Catch noted earlier in the chapter, you can use the optional
Finally clause with Try...Catch to execute a block of statements regardless of how the compiler
executes the Try or Catch blocks. In other words, whether or not the Try statements produced
a run-time error, there might be some code that you need to run each time an error handler is
finished. For example, you might want to update variables or properties, display the results of
a computation, close database connections, or perform “cleanup” operations by clearing vari-
ables or disabling unneeded objects on a form.

The following exercise demonstrates how the Finally clause works, by displaying a second
message box whether or not the FromFile method produces a run-time error.
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Use Finally to display a message box

1. Display the Button1_Click event procedure, and then edit the Try...Catch code block so
that it contains two additional lines of code above the End Try statement. The complete
error handler should look like this:

Try

PictureBoxl.Image = _

System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)

Catch

MsgBox("Please insert the disc in drive D!™)
Finally

MsgBox("Error handler complete")
End Try
The Finally statement indicates to the compiler that a final block of code should be
executed whether or not a run-time error is processed. To help you learn exactly how
this feature works, I've inserted a MsgBox function to display a test message after the
Finally statement. Although this simple use of the Finally statement is helpful for test-
ing purposes, in a real program you'll probably want to use the Finally code block
to update important variables or properties, display data, or perform other cleanup
operations.

2. Remove the CD or DVD from drive D, and then click the Start Debugging button to run
the program.

3. Click the Check Drive button.
The error handler displays a dialog box asking you to insert the disc in drive D.
4. Click OK.

The program executes the Finally clause in the error handler, and the following message
box appears:

Disc Drive Error (=3l

Errar handler complete

5. Click OK, insert the disc in drive D, and then click the Check Drive button again.

The file appears in the picture box as expected. In addition, the Finally clause is exe-
cuted, and the “Error handler complete” message box appears again. As | noted earlier,
Finally statements are executed at the end of a Try...Catch block whether or not there’s
an error.

6. Click OK, and then click the Close button on the form to stop the program.
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More Complex Try...Catch Error Handlers

As your programs become more sophisticated, you might find it useful to write more complex
Try...Catch error handlers that manage a variety of run-time errors and unusual error-handling
situations. Try...Catch provides for this complexity by:

B Permitting multiple lines of code in each Try, Catch, or Finally code block.
B Offering the Catch When syntax, which tests specific error conditions.

B Allowing nested Try...Catch code blocks, which can be used to build sophisticated and
robust error handlers.

In addition, by using a special error-handling object named Err, you can identify and pro-
cess specific run-time errors and conditions in your program. You'll investigate each of
these error-handling features in the following section.

The Err Object

As a legacy of earlier versions of Visual Basic, a useful mechanism in Visual Basic 2008
called the Err object is updated with detailed error-handling information each time a run-
time error occurs in a program. Although there are newer ways to manage errors utilizing
the Microsoft .NET Framework, such as the powerful Exception object, we'll begin our work
with error handling messages by seeing how the Err object provides information about the
type of error that has taken place in a program.

The most useful Err properties for identifying run-time errors are Err.Number and Err.Description.
Err.Number contains the number of the most recent run-time error, and Err.Description contains
a short error message that matches the run-time error number. By using the Err. Number
and Err.Description properties together in an error handler, you can recognize specific
errors and respond to them, and you can give the user helpful information about how

he or she should respond.

You can clear the Err object by using the Err.Clear method (which discards previous error
information), but if you use the Err object within a Catch code block, clearing the Err object
isn't usually necessary because Catch blocks are entered only when a run-time error has just
occurred in a neighboring Try code block.

The table on the following page lists many of the run-time errors that Visual Basic applications
can encounter. In addition to these error codes, you'll find that some Visual Basic libraries and
other components (such as database and system components) provide their own unique error
messages, which often can be discovered by using the Visual Studio documentation. Note that
despite the error message descriptions, some errors don't appear as you might expect them
to, so you'll need to specifically test the error numbers (when possible) by observing how the
Err.Number property changes during program execution. Unused error numbers in the range
1-1000 are reserved for future use by Visual Basic.
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Error number

5

6

7

9
11
13
48
51
52
53
55
57
58
61
62
67
68
70
71
74
75
76
91
321
322
380
381
422
423
424
429
430
438
440
460

Programming Fundamentals

Default error message

Procedure call or argument is not valid
Overflow

Out of memory

Subscript out of range

Division by zero

Type mismatch

Error in loading DLL

Internal error

Bad file name or number

File not found

File already open

Device 1/O error

File already exists

Disk full

Input past end of file

Too many files

Device unavailable

Permission denied

Disk not ready

Cannot rename with different drive

Path/File access error

Path not found

Object variable or With block variable not set
File format is not valid

Cannot create necessary temporary file
Property value is not valid

Property array index is not valid

Property not found

Property or method not found

Object required

Cannot create Microsoft ActiveX component
Class does not support Automation or does not support expected interface
Object does not support this property or method
Automation error

Clipboard format is not valid



Chapter 9 Trapping Errors by Using Structured Error Handling 243

Error number Default error message

461 Method or data member not found

462 The remote server machine does not exist or is unavailable
463 Class not registered on local machine

481 Picture is not valid

482 Printer error

The following exercise uses the Err.Number and Err.Description properties in a Try...Catch
error handler to test for more than one run-time error condition. This capability is made
possible by the Catch When syntax, which you'll use to test for specific error conditions in
a Try...Catch code block.

Test for multiple run-time error conditions

1. In the Buttonl_Click event procedure, edit the Try...Catch error handler so that it looks
like the following code block. (The original FromFile statement is the same as the code
you used in the previous exercises, but the Catch statements are all new.)

Try
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)
Catch When Err.Number = 53 'if File Not Found error
MsgBox ("Check pathname and disc drive™)
Catch When Err.Number = 7 'if Out Of Memory error

MsgBox("Is this really a bitmap?", , Err.Description)
Catch

MsgBox("Problem loading file", , Err.Description)
End Try

The Catch When syntax is used twice in the error handler, and each time the syntax is
used with the Err. Number property to test whether the Try code block produced a par-
ticular type of run-time error. If the Err. Number property equals the number 53, the File
Not Found run-time error has occurred during the file open procedure, and the mes-
sage "Check pathname and disc drive” is displayed in a message box. If the Err. Number
property is equal to the number 7, an Out of Memory error has occurred—probably the
result of loading a file that doesn't actually contain artwork. (I get this error if | acciden-
tally try to open a Microsoft Office Word document in a picture box object by using the
FromFile method.)

The final Catch statement handles all other run-time errors that could potentially
occur during a file-opening process—it's a general “catch-all” code block that prints
a general error message inside a message box and a specific error message from the
Err.Description property in the title bar of the message box.

2. Click the Start Debugging button to run the program.
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Remove the CD or DVD from drive D.
Click the Check Drive button.

The error handler displays the error message “Check pathname and disc drive” in a
message box. The first Check When statement works.

Click OK, and then click Close on the form to end the program.

Insert the CD or DVD again, and then use Windows Explorer or another tool to copy
a second file to the CD or DVD that isn't an artwork file. For example, copy a Word
document or a Microsoft Office Excel spreadsheet to the CD or DVD.

You won't open this file in Word or Excel, but you will try to open it (unsuccessfully,
we hope) in your program’s picture box object. (If your CD or DVD software or drive
doesn't allow you to add additional files to a CD or DVD after you have burned it, you
might need to create a second CD or DVD with the two files.)

In the Code Editor, change the name of the fileopen.bmp file in the FromFile program
statement to the name of the file (Word, Excel, or other) you copied to the CD or DVD
in drive D.

Using a file with a different format gives you an opportunity to test a second type of
run-time error—an Out of Memory exception, which occurs when Visual Basic attempts
to load a file that isn't a graphic or has too much information for a picture box.

Run the program again, and click the Check Drive button.

The error handler displays the following error message:

Out of memaory. (=3

Is this really a bitmap?

Notice that | have used the Err.Description property to display a short description of the
problem (“Out of memory.”) in the message box title bar. Using this property in your
error handler can give the user a clearer idea of what has happened.

Click OK, and then click Close on the form to stop the program.

Change the file name back to fileopen.bmp in the FromFile method. (You'll use it in the
next exercise.)

The Catch When statement is very powerful. By using Catch When in combination with the
Err.Number and Err.Description properties, you can write sophisticated error handlers that
recognize and respond to several types of exceptions.
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Raising Your Own Errors

For testing purposes and other specialized uses, you can artificially generate your own
run-time errors in a program with a technique called throwing, or raising, exceptions.
To accomplish this, you use the Err.Raise method with one of the error numbers in the
table presented earlier. For example, the following syntax uses the Raise method to
produce a Disc Full run-time error and then handles the error by using a Catch When
statement:
Try

Err.Raise(61) 'raise Disc Full error
Catch When Err.Number = 61

MsgBox("Error: Disc is full")
End Try
When you learn how to write your own procedures, you can generate your own errors
by using this technique and return them to the calling routine.

Specifying a Retry Period

Another strategy you can use in an error handler is to try an operation a few times and then
disable it if the problem isn't resolved. For example, in the following exercise, a Try...Catch
block employs a counter variable named Retries to track the number of times the message
“Please insert the disc in drive D!" is displayed, and after the second time, the error handler
disables the Check Drive button. The trick to this technique is declaring the Retries variable
at the top of the form’s program code so that it has scope throughout all of the form's event
procedures. The Retries variable is then incremented and tested in the Catch code block.
The number of retries can be modified by simply changing the “2" in the statement, as
shown here:

If Retries <= 2

Use a variable to track run-time errors

1. In the Code Editor, scroll to the top of the form’s program code, and directly below the
Public Class Form1 statement, type the following variable declaration:
Dim Retries As Short = 0

Retries is declared as a Short integer variable because it won't contain very big numbers.
It's assigned an initial value of 0 so that it resets properly each time the program runs.
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In the Buttonl_Click event procedure, edit the Try...Catch error handler so that it looks
like the following code block:

Try
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)
Catch
Retries += 1
If Retries <= 2 Then
MsgBox("Please insert the disc in drive D!™)
Else
MsgBox("File Load feature disabled")
Buttonl.Enabled = False
End If
End Try

The Try block tests the same file-opening procedure, but this time, if an error occurs,
the Catch block increments the Retries variable and tests the variable to be sure that
it's less than or equal to 2. The number 2 can be changed to allow any number of
retries—currently it allows only two run-time errors. After two errors, the Else clause
is executed, and a message box appears indicating that the file-loading feature has
been disabled. The Check Drive button is then disabled—in other words, grayed out
and rendered unusable for the remainder of the program.

Tip This revised version of the error handler that you have been building has been renamed
Disc Drive Handler and is stored in the c:\\vb08sbs\chap09\disc drive handler folder.

Click the Start Debugging button to run the program.
Remove the CD or DVD from drive D.
Click the Check Drive button.

The error handler displays the error message "Please insert the disc in drive D!" in
a message box, as shown here. Behind the scenes, the Retries variable is also incre-
mented to 1.

Disc Drive Handler (==

Please insert the disc in drive D!

QK
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6. Click OK, and then click the Check Drive button again.

The Retries variable is set to 2, and the message “Please insert the disc in drive D!"
appears again.

7. Click OK, and then click the Check Drive button a third time.

The Retries variable is incremented to 3, and the Else clause is executed. The message
“File Load feature disabled” appears, as shown here:

Disc Drive Handler (=3

File Load feature disabled

8. Click OK in the message box.

The Check Drive button is disabled on the form, as shown here:

o= Disc Drive Errar El@

Thiz program checks D:% for the bitmap
FileOpen.brp. If the file does nat exist or if
the drive is unready, an error ocours. Click
Check Drive when ready.

The error handler has responded to the disc drive problem by allowing the user a few
tries to fix the problem, and then it has disabled the problematic button. (In other
words, the user can no longer click the button.) This disabling action stops future
run-time errors, although the program might no longer function exactly as it was
originally designed.

9. Click the Close button to stop the program.
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Using Nested Try...Catch Blocks

You can also use nested Try...Catch code blocks in your error handlers. For example, the
following disc drive error handler uses a second Try...Catch block to retry the file open
operation a single time if the first attempt fails and generates a run-time error:

Try
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)

Catch
MsgBox("Insert the disc in drive D, then click OK!™)
Try
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)
Catch
MsgBox("File Load feature disabled")
Buttonl.Enabled = False
End Try
End Try

If the user inserts the disc in the drive as a result of the message prompt, the second Try
block opens the file without error. However, if a file-related run-time error still appears, the
second Catch block displays a message saying that the file load feature is being disabled,
and the button is disabled.

In general, nested Try...Catch error handlers work well as long as you don't have too many
tests or retries to manage. If you do need to retry a problematic operation many times, use
a variable to track your retries, or develop a function containing an error handler that can
be called repeatedly from your event procedures. (For more information about creating
functions, see Chapter 10.)

Comparing Error Handlers with Defensive
Programming Techniques

Error handlers aren’t the only mechanism for protecting a program against run-time errors.
For example, the following program code uses the File.Exists method in the System./O name-
space of the .NET Framework class library to check whether a file exists on CD or DVD before
it's opened:

If File.Exists("d:\fileopen.bmp") Then
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile("d:\fileopen.bmp")
Else
MsgBox("Cannot find fileopen.bmp on drive D.")
End If



Chapter 9 Trapping Errors by Using Structured Error Handling 249

This If...Then statement isn't an actual error handler because it doesn't prevent a run-time
error from halting a program. Instead, it's a validation technique that some programmers
call defensive programming. 1t uses a handy method in the .NET Framework class library to
verify the intended file operation before it's actually attempted in the program code. And in
this particular case, testing to see whether the file exists with the .NET Framework method
is actually faster than waiting for Visual Basic to issue an exception and recover from a run-
time error using an error handler.

Note To get this particular program logic to work, the following statement must be included
in the declarations section at the very top of the form’s program code to make reference to the
.NET Framework class library that's being invoked:

Imports System.IO

For more information about utilizing the Imports statement to use the objects, properties,
and methods in the .NET Framework class libraries, see Chapter 5, “Visual Basic Variables and
Formulas, and the .NET Framework.”

When should you use defensive programming techniques, and when should you use structured
error handlers? The answer is really that you should use a combination of defensive program-
ming and structured error-handling techniques in your code. Defensive programming logic is
usually the most efficient way to manage potential problems. As | mentioned earlier when dis-
cussing the If..Then code block, the File.Exists method is actually faster than using a Try...Catch
error handler, so it also makes sense to use a defensive programming technique if performance
issues are involved. You should use defensive programming logic for errors that you expect

to occur frequently in your program. Use structured error handlers for errors that you don't
expect to occur very often. Structured error handlers are essential if you have more than one
condition to test and if you want to provide the user with numerous options for responding to
the error. Structured error handlers also allow you to gracefully handle errors that you aren't
even aware of!

One Step Further: The Exit Try Statement

You've learned a lot about error handlers in this chapter; now you're ready to put them to
work in your own programs. But before you move on to the next chapter, here's one more
syntax option for Try...Catch code blocks that you might find useful: the Exit Try statement.
Exit Try is a quick and slightly abrupt technique for exiting a Try...Catch code block prema-
turely. If you've written Visual Basic programs before, you might notice its similarity to the
Exit For and Exit Sub statements, which you can use to leave a structured routine early. Using
the Exit Try syntax, you can jump completely out of the current Try or Catch code block. If
there's a Finally code block, this code will be executed, but Exit Try lets you jump over any
remaining Try or Catch statements you don't want to execute.
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The following sample routine shows how the Exit Try statement works. It first checks to see
whether the Enabled property of the PictureBox1 object is set to False, a flag that might in-
dicate that the picture box isn't ready to receive input. If the picture box isn't yet enabled,
the Exit Try statement skips to the end of the Catch code block, and the file load operation
isn't attempted.

Try
If PictureBoxl.Enabled = False Then Exit Try
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile("d:\fileopen.bmp™)
Catch
Retries += 1
If Retries <= 2 Then
MsgBox("Please insert the disc in drive D!™)
Else
MsgBox("File Load feature disabled")
Buttonl.Enabled = False
End If
End Try

The example builds on the last error handler you experimented with in this chapter (the
Disc Drive Handler project). If you'd like to test the Exit Try statement in the context of that
program, open the Disc Drive Handler project and enter the /f statement that contains the
Exit Try in the Code Editor. You'll also need to use the Properties window to disable the pic-
ture box object on the form (in other words, set its Enabled property to False).

Congratulations! You've learned a number of important fundamental programming tech-
niques in Visual Basic, including how to write error handlers. Now you're ready to increase
your programming efficiency by learning to write Visual Basic modules and procedures.

Chapter 9 Quick Reference

To Do this
Detect and process Build an error handler by using one or more Try...Catch code blocks. For
run-time errors example, the following error handler code tests for path or disc drive
problems:
Try

PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile _
("d:\fileopen.bmp™)

Catch

MsgBox("Check path or insert disc")
Finally

MsgBox("Error handler complete")
End Try



To

Test for specific error
conditions in an event
handler

Create your own

errors in a program

Write nested Try...
Catch error handlers

Exit the current Try or
Catch code block
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Do this
Use the Catch When syntax and the Err.Number property. For example:

Try
PictureBox1l.Image = _
System.Drawing.Bitmap.FromFile _
("d:\fileopen.bmp™)
Catch When Err.Number = 53 'if File Not Found
MsgBox ("Check pathname and disc drive")
Catch When Err.Number = 7 'if Out Of Memory
MsgBox("Is this really a bitmap?", ,
Err.Description)

Catch
MsgBox("Problem Tloading file", , _
Err.Description)
End Try

Use the Err.Raise method. For example, the following code generates a Disc
Full error and handles it:

Try
Err.Raise(61) 'raise Disc Full error
Catch When Err.Number = 61
MsgBox("Error: Disc is full")
End Try

Place one Try...Catch code block within another. For example:

Try
PictureBox1l.Image = _
System.Drawing.Bitmap.FromFile _
("d:\fileopen.bmp™)
Catch
MsgBox("Insert the disc in drive D!™)
Try
PictureBoxl.Image = _
System.Drawing.Bitmap.FromFile
("d:\fileopen.bmp™")

Catch
MsgBox("File Load feature disabled")
Buttonl.Enabled = False
End Try
End Try

Use the Exit Try statement in the Try or the Catch code block. For example:

If PictureBoxl.Enabled = False Then Exit Try






Chapter 10
Creating Modules and
Procedures

After completing this chapter, you will be able to:

B Employ structured programming techniques and create modules containing public
variables and procedure definitions.

B Practice using public variables that have a global scope.

B ncrease programming efficiency by creating user-defined functions and Sub
procedures.

B Master the syntax for calling and using user-defined procedures.
B Pass arguments to procedures by value and by reference.

In the first nine chapters of this book, you have used event procedures such as Button1_Click,
Timer1_Tick, and Form1_Load to manage events and organize the flow of your programs. In
Microsoft Visual Basic programming, all executable statements must be placed inside some
procedure; only general declarations and instructions to the compiler can be placed outside
a procedure’s scope. In this chapter, you'll continue to organize your programs by breaking
computing tasks into discrete logical units.

You'll start by learning how to create modules, which are separate areas within a pro-
gram that contain global, or public, variables and Function and Sub procedures. You'll
learn how to declare and use public variables, and you'll learn how to build general-
purpose procedures that save coding time and can be used in more than one project.
The skills you'll learn will be especially applicable to larger programming projects and
team development efforts.

253
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Working with Modules

As you write longer programs, you're likely to have several forms and event procedures
that use some of the same variables and routines. By default, variables are local to an event
procedure—they can be read or changed only within the event procedure in which they
were created. You can also declare variables at the top of a form’s program code and give
the variables a greater scope throughout the form. However, if you create multiple forms in
a project, the variables declared at the top of a form are valid only in the form in which they
were declared. Likewise, event procedures are by default declared as private and are only
local to the form in which they are created. For example, you can't call the Button1_Click
event procedure from a second form named Form?2 if the event procedure is declared to

be private to Form1. (You'll learn how to add additional forms to your project in Chapter 14,
“Managing Windows Forms and Controls at Run Time.")

To share variables and procedures among all the forms and event procedures in a project, you
can declare them in one or more modules included in the project. A module is a special file
that has a .vb file name extension and contains variable declarations and procedures that can
be used anywhere in the program. (In Visual Basic 6, standard modules have a .bas extension.)

Like forms, modules are listed separately in Solution Explorer. Unlike forms, modules
contain only code and don't have a user interface. And although modules have some simi-
larities with classes (formerly called class modules), they are unlike classes in that they are
not object-oriented, do not define the structure and characteristics of objects, and cannot
be inherited. (You'll learn more about creating classes in Chapter 16, “Inheriting Forms and
Creating Base Classes.”)

Creating a Module

To create a new module in a program, you click the Add New Item button on the Standard
toolbar or click the Add New Item command on the Project menu. You can also click the
Add Module command on the Project menu.) A dialog box opens, in which you select the
Module template and specify the name of the module. A new, blank module then appears in
the Code Editor. The first module in a program is named Modulel.vb by default, but you can
change the name by right-clicking the module in Solution Explorer, selecting Rename, and
typing a new name. You can also rename a module by changing the File Name property in
the Properties window. Try creating an empty module in a project now.
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Create and save a module

1. Start Microsoft Visual Studio 2008, and create a new Visual Basic Windows Forms
Application project named My Module Test.

The new project is created, and a blank form opens in the Designer.
2. Click the Add New Item command on the Project menu.

The Add New Item dialog box opens.
3. Select the Module template.

The default name, Modulel.vb, appears in the Name text box.

Add Mew Frern - Module Test =
et Tty B=
Common Items Visual Studio installed templates o
Code 2 —
b B 8 &2 bt &
General About Box Class Class CodeFil  COMClass  Custom
Weh Diagram Cantral E
Windows Forms - 2
DataSet Dizlog Ezplarer Interface JSeript File  LING to SQL
Form Classes
Local Local  LoginForm  MDIParent | Module | Report
Database Databa.., Form
= == = = 7l
A file for storing groups of functions
Marne: todulelvh
Add Cancel
Tip The Add New Item dialog box offers several templates that you can use in your
projects. Each template has different characteristics and includes starter code to help

you use them. Visual Studio 2008 includes many new and updated Windows Forms
templates, including Explorer Form, Splash Screen, and Login Form, plus numerous
class-related templates. You'll use these templates after you read the introductory
material about object-oriented programming in Chapter 16.

4. Click the Add button.
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Visual Basic adds Modulel to your project. The module appears in the Code Editor, as
shown here:

0 Module Test - Microsoft Visual Studio
File Edit ‘iew Project Build Debug Data  Tools  Test  ‘Window Help

HeEiE-Ha s aaR=2(9-0-8- 4 o= (= %=
>§ Modulel.vb | Formivh [Design] -~ Start Page - X
= e
2 . Modulel ~ [](Declarations) -
§ E||Module Hodulel —1

End Module

The Method Name list box indicates that the general declarations section of the mod-
ule is open. Variables and procedures declared in this section are available to the entire
project. (You'll try declaring variables and procedures later.)

5. Double-click the Solution Explorer title bar to see the entire Solution Explorer window.

Select Modulel.vb if it is not already highlighted. Solution Explorer appears, as
shown here:

Solution Explorer El
2|2 E| E &K
22 Module Test

=d| My Project

=] Forrnlub

..:ilSqution Explorer _J:]Data Sources

Solution Explorer lists the module you added to the program in the list of components
for the project. The name Modulel identifies the default file name of the module. You'll
change this file name in the following steps.

6. Double-click the Properties window title bar to see the window full size.

The Properties window displays the properties for Modulel.vb, as shown here:
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Properties &l
Modulel.vb File Properties -

E=z: (A
B= (£

Compile |Z|
Copy to Output Directory Do not copy
Custom Toal
Custorn Tool Mamespace
File Marne Modulelwh

Build Action
Howw the file relates to the build and deployment processes,

Because a module contains only code, it has only a few properties. By using the most
significant property, File Name, you can create a custom file name for the module to
describe its purpose. Give this identifying label some thought because later you might
want to incorporate your module into another solution. The remaining properties for
the module are useful for more sophisticated projects—you don't need to worry about
them now.

7. Change the File Name property to Math Functions.vb or another file name that
sounds impressive, and then press Enter. (I'm granting you considerable leeway here
because this project is simply for testing purposes—you won't actually create math
functions or any other “content” for the module, and later you'll discard it.)

The file name for your module is updated in the Properties window, Solution Explorer,
and the Code Editor.

8. Return the Properties window and Solution Explorer to their regular docked positions
by double-clicking their title bars.

As you can see, working with modules in a project is a lot like working with forms. In the next
exercise, you'll add a public variable to a module.

Tip To remove a module from a project, click the module in Solution Explorer, and then click
the Exclude From Project command on the Project menu. Exclude From Project doesn't delete the
module from your hard disk, but it does remove the link between the specified module and

the current project. You can reverse the effects of this command by clicking the Add Existing
Iltem command on the Project menu, selecting the file that you want to add to the project,

and then clicking Add.
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Working with Public Variables

Declaring a global, or public, variable in a module is simple—you type the keyword Public
followed by the variable name and a type declaration. After you declare the variable, you can
read it, change it, or display it in any procedure in your program. For example, the program
statement

Public RunningTotal As Integer

declares a public variable named RunningTotal of type Integer.

The following exercises demonstrate how you can use a public variable named Wins in a
module. You'll revisit Lucky Seven, the first program you created in this book, and you'll use
the Wins variable to record how many spins you win as the slot machine runs.

Note Lucky Seven is the slot machine program from Chapter 2, "Writing Your First Program.”

Revisit the Lucky Seven project

1. Click the Close Project command on the File menu to close the Module Test project.

Because you have named (but not saved) the project yet, you see the following

dialog box:

Close Project:

1 Do you want to save or discard changes to the current
2 praject?

| Save | | Discard | | Cancel |

==l

You don't need to keep this project on your hard disk; it was only for testing purposes.
To demonstrate the “close without saving” feature in Visual Studio 2008, you'll discard

the project now.

Click the Discard button.

Visual Studio discards the entire project, removing any temporary files associated with

the module from your computer’s memory

and hard disk. It seems like a rather obvious

feature, but | wanted to demonstrate that the ability to close a project without saving it

is a welcome improvement to the software

and just the thing for this type of test. (Just

be careful with it, OK?) Now you'll open a more substantial project and modify it.

Open the TrackWins project in the c:\vb08sbs\chapl0\trackwins\lucky7 folder.

The project opens in the IDE.
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If the form isn't visible, display it now.

You see the following user interface:

a5 Track Wins = | B[z
| Spin |

[ e ] 0 0 0

Lucky Seven

The Track Wins project is the same slot machine program that you created in Chapter
2. With this program, the user can click a spin button to display random numbers in
three number boxes, and if the number 7 appears in one of the boxes, the computer
beeps and displays a bitmap showing an enticing, though quite dated, cash payout. I've
simply renamed the Lucky7 solution in this chapter so that you won't confuse this new
version with the original.

Click the Start Debugging button on the Standard toolbar to run the program.
Click the Spin button six or seven times, and then click the End button.

As you might recall, the program uses the Rnd function to generate three random
numbers each time you click the Spin button. If one of the numbers is a 7, the event
procedure for the Spin button (Buttonl_Click) displays a cash payout picture and beeps.

Now you'll edit the form and add a module to enhance the program.

Add a module

1.

Click the Label control in the Toolbox, and then create a new rectangular label on the
form below the Lucky Seven label.

Set the properties shown in the following table for the new label. To help identify the
new label in the program code, you'll change the new label object’s name to IbIWins.

Object Property Setting

Label5 Font Arial, Bold ltalic, 12-point
ForeColor Green (on Custom tab)
Name IbIWins
Text "Wins: 0"

TextAlign MiddleCenter
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When you've finished, your form looks similar to this:

2 Track Wins =) E =)
Spin |
[ End | 0 0 0

Lucky Seven

Now you'll add a new module to the project.

Click the Add New Item command on the Project menu, select the Module template,
and then click Add.

A module named Modulel.vb appears in the Code Editor.

Move the insertion point to the blank line between the Module Modulel and End
Module statements, type Public Wins As Short, and then press Enter.

This program statement declares a public variable of the Short integer type in your
program. It's identical to a normal variable declaration you might make in your pro-
gram code, except the Public keyword has been substituted for the Dim keyword.
When your program runs, each event procedure in the program will have access to
this variable. Your module looks like this:

0 TrackMins - Microsoft Wisual Studio
File Edit ‘iew Project Build Debug Data  Tools  Test  Window Help

GeZia-Hd|sRAR 2|9 -0-8-5]»

Ll
Il
Il

% Modulel.vb* “Trackiivinswb* | TrackWins.wh [Design]* | Start Page > X

=1 >

2 ||| Modulel + [Z](Declarations) -

=

=] E Module Modulel 1
L Public Wins is Short i
End Module

In Solution Explorer, click TrackWins.vb, click the View Designer button, and then
double-click the Spin button.

The Button1_Click event procedure for the Spin button appears in the Code Editor.

Type the following statements below the Beep() statement in the event procedure:

Wins = Wins + 1
TbTWins.Text = "Wins: " & Wins
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This part of the program code increments the Wins public variable if a 7 appears
during a spin. The second statement uses the concatenation operator (&) to assign a
string to the /b/Wins object in the format Wins: X, in which X is the number of wins.
The completed event procedure looks like the graphic on the following page.

0 TrackMins - Microsoft Wisual Studio
File Edit ‘iew Project Build Debug Data  Tools  Test  Window Help

e E W@ dRB(R =220 -8-B|F 1 @5(c
b hodulelvb* " TrackWins.vb® - TrackiWins.wh [Design]* | Start Page > X
.

= ¥ Buttonl v 7 Click -
§ [E Fublic Class TrackWins

= Frivate Zub Buttoni Click(EyVal sender Ais 3Jystem.Chbject, By
End
- End Zub

= Frivate Zub Buttonl Click(EyVal sender is 3Jystem.Chbject, By
PictureBoxl.Visikhle = False 'hide picture
Lakbell.Text = C3tr(Int(Rnd() * 10)) 'pick nwrbers
Labelz.Text = C3tr{Int(Bnd{) * 10}
Labeld.Text = C3tr{Int(Bnd{) * 10}
' if any nuwber is 7 display picture and heep
If (Labell.Text = "7") Or (Labelz.Text = "7") _
Or [(Label3.Text = "7") Then
PictureBoxl.Visible = True
Beepl()
Wins = Winz + 1
lblWins.Text = "Wins: " & Wins
End If
= End Zub

m

7. Click the Save All button on the Standard toolbar to save all your changes to disk.

Save All saves your module changes as well as the changes on your form and in your
event procedures.

8. Click the Start Debugging button to run the program.
9. Click the Spin button until you have won a few times.

The Wins label keeps track of your jackpots. Each time you win, it increments the total
by 1. After 10 spins, | had the output shown below.

- Track Wins = |[ B[
| Spin |

[ End 0 4 7

Lucky Seven
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Note The exact number of wins will be different each time you run the program, due to
the Randomize statement in the Form1_Load event procedure.

Click End to exit the program.

The public variable Wins was useful in the previous procedure because it maintained its
value through several calls to the Button1_Click event procedure. If you had declared
Wins locally in the Button1_Click event procedure, the variable would have reset each
time, just as the trip odometer in your car does when you reset it. By using a public
variable in a module, you can avoid “hitting the reset button.”

Public Variables vs. Form Variables

In the preceding exercise, you used a public variable to track the number of wins in
the slot machine program. Alternatively, you could have declared the Wins variable
at the top of the form’s program code. Both techniques produce the same result

because both a public variable and a variable declared in the general declarations area
of a form have scope throughout the entire form. Public variables are unique, however,
because they maintain their values in all the forms and modules you use in a project—
in other words, in all the components that share the same project namespace. The
project namespace keyword is set automatically when you first save your project. You
can view or change the namespace name by selecting the project in Solution Explorer,
clicking the TrackWins Properties command on the Project menu, and then examining
or changing the text in the Root Namespace text box on the Application tab.

Creating Procedures

Procedures provide a way to group a set of related statements to perform a task. Visual Basic
includes two primary types of procedures:

B function procedures are called by name from event procedures or other procedures.
Often used for calculations, function procedures can receive arguments and always
return a value in the function name.

B Sub procedures are called by name from event procedures or other procedures. They
can receive arguments and also pass back modified values in an argument list. Unlike
functions, however, Sub procedures don't return values associated with their particular
Sub procedure names. Sub procedures are typically used to receive or process input,
display output, or set properties.
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Function procedures and Sub procedures can be defined in a form’s program code, but for
many users, creating procedures in a module is more useful because then the procedures
have scope throughout the entire project. This is especially true for procedures that might
be called general-purpose procedures—blocks of code that are flexible and useful enough
to serve in a variety of programming contexts.

For example, imagine a program that has three mechanisms for printing a bitmap on differ-
ent forms: a menu command named Print, a Print toolbar button, and a drag-and-drop printer
icon. You could place the same printing statements in each of the three event procedures, or
you could handle printing requests from all three sources by using one procedure in a module.

Advantages of General-Purpose Procedures

General-purpose procedures provide the following benefits:

They enable you to associate an often-used group of program statements with a
familiar name.

They eliminate repeated lines. You can define a procedure once and have your
program execute it any number of times.

They make programs easier to read. A program divided into a collection of
small parts is easier to take apart and understand than a program made up of
one large part.

They simplify program development. Programs separated into logical units are
easier to design, write, and debug. Plus, if you're writing a program in a group
setting, you can exchange procedures and modules instead of entire programs.

They can be reused in other projects and solutions. You can easily incorporate
standard-module procedures into other programming projects.

They extend the Visual Basic language. Procedures often can perform tasks
that can’t be accomplished by individual Visual Basic keywords or Microsoft
.NET Framework methods.
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Writing Function Procedures

A Function procedure is a group of statements located between a Function statement
and an End Function statement. The statements in the function do the meaningful work—
typically processing text, handling input, or calculating a numeric value. You execute, or
call, a function in a program by placing the function name in a program statement along
with any required arguments.

Arguments are the data used to make functions work, and they must be included between
parentheses and be separated by commas. Basically, using a Function procedure is exactly
like using a built-in function or method such as Int, Rnd, or FromFile.

Tip Functions declared in modules are public by default. As a result, you can use them in any
event procedure within the project.

Function Syntax

The basic syntax of a function is as follows:

Function FunctionName([arguments]) As Type
function statements
[Return value]

End Function

The following syntax items are important:

B FunctionName is the name of the function you're creating.

B As Type is a pair of keywords that specifies the function return type. (In Visual Basic 6,
a specific type declaration is optional, but it's strongly recommended in Visual Basic
2008. If you don't provide a type, the return type defaults to Object.)

B arguments is a list of optional arguments (separated by commas) to be used in the
function. Each argument should also be declared as a specific type. (By default, Visual
Basic adds the ByVal keyword to each argument, indicating that a copy of the data is
passed to the function through this argument but that any changes to the arguments
won't be returned to the calling routine.)
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B function statements is a block of statements that accomplishes the work of the function.
The first statements in a function typically declare local variables that will be used in
the function, and the remaining statements perform the work of the function.

B Return is a newer statement that is not offered in Visual Basic 6—with it, you can indi-
cate when in the function code block you want to return a value to the calling procedure
and what that value is. When a Return statement is executed, the function is exited, so if
there are any function statements after the Return statement, these won't be executed.
(Alternatively, you can use the Visual Basic 6 syntax and return a value to the calling
routine by assigning the value to FunctionName.)

B Brackets ([]) enclose optional syntax items. Visual Basic requires those syntax items
not enclosed by brackets.

Functions always return a value to the calling procedure in the function’s name (FunctionName).
For this reason, the last statement in a function is often an assignment statement that
places the final calculation of the function in FunctionName. For example, the Function
procedure TotalTax computes the state and city taxes for an item and then assigns the
result to the TotalTax name, as shown here:

Function TotalTax(ByVal Cost as Single) As Single
Dim StateTax, CityTax As Single
StateTax = Cost * 0.05 'State tax is 5%
CityTax = Cost * 0.015 'City tax is 1.5%
TotalTax = StateTax + CityTax

End Function

Alternatively, you can use the Visual Basic 2008 syntax and return a value to the calling
procedure by using the Return statement, as shown in the following function declaration:

Function TotalTax(ByVal Cost as Single) As Single
Dim StateTax, CityTax As Single
StateTax = Cost * 0.05 'State tax is 5%
CityTax = Cost * 0.015 'City tax is 1.5%
Return StateTax + CityTax

End Function

I'll use the Return syntax most often in this book, but you can use either mechanism for
returning data from a function.
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Calling a Function Procedure

To call the TotalTax function in an event procedure, you use a statement similar to the
following:

Tb1Taxes.Text = TotalTax(500)

This statement computes the total taxes required for a $500 item and then assigns the result
to the Text property of the /b/Taxes object. The TotalTax function can also take a variable as
an argument, as shown in the following statements:

Dim TotalCost, SalesPrice As Single
SalesPrice = 500
TotalCost = SalesPrice + TotalTax(SalesPrice)

The last statement uses the TotalTax function to determine the taxes for the number in the
SalesPrice variable and then adds the computed tax to SalesPrice to get the total cost of an
item. See how much clearer the code is when a function is used?

Using a Function to Perform a Calculation

In the following exercise, you'll add a function to the Track Wins program to calculate the win
rate in the game—in other words, the percentage of spins in which one or more 7s appear.

To perform the calculation, you'll add a function named HitRate and a public variable named
Spins to the module. Then you'll call the HitRate function every time the Spin button is clicked.
You'll display the results in a new label that you'll create on the form.

Create a win rate function

1. Display the form for the Track Wins program that you've been modifying.
The user interface for the slot machine game appears.

2. Use the Label control to create a new label below the Wins label. Set the following
properties for the label:

Object Property Setting

Label5 Font Arial, Bold lItalic, 12-point
ForeColor Red (on Custom tab)
Name IbIRate
Text "0.0%"
TextAlign MiddleCenter

Your form looks similar to the graphic on the following page.
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- Track Wins = |[ B[
| Spin |

Erd 0 0 0

Lucky Seven

In Solution Explorer, click the Modulel.vb module, and then click the View Code
button.

The Modulel module appears in the Code Editor.

Type the following public variable declaration below the Public Wins As Short statement:

Public Spins As Short

The module now includes two public variables, Wins and Spins, that will be available
to all the procedures in the project. You'll use Spins as a counter to keep track of the
number of spins you make.

Insert a blank line in the module, and then type the following function declaration:

Function HitRate(ByVal Hits As Short, ByVal Tries As Short) As String
Dim Percent As Single
Percent = Hits / Tries
Return Format(Percent, "0.0%")

End Function

After you type the first line of the function code, Visual Basic automatically adds an
End Function statement. After you type the remainder of the function’s code, your
screen looks like this:

0 TrackMins - Microsoft Wisual Studio
File  Edit Miew Project Build Debug Data  Tools  Test ‘Window Help

FeZiH-Hd @@ =2(9-¢-8-5|b °= (= %z [ A E
X Start Page " Modulel.vb® | Trackins.wb® | Trackiivinswb [Design]* > X
b e
g % Modulel ~ [i](Declarations) -
{=
2 £ Module Modulel =

Fublic Wins As Short
Public Spins Ls Short

Function HitRate (EyWal Hits As Zhort, ByWal Tries As Zhort) As String
Dim Percent ALs Single
Percent = Hits / Tries
Feturn Format (Percent, "0.0%7)
End Functiod
End Module

m
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The HitRate function determines the percentage of wins by dividing the Hits argument

by the Tries argument and then adjusts the appearance of the result by using the Format
function. The HitRate function is declared as a string because the Format function returns
a string value. The Hits and the Tries arguments are placeholders for the two short integer
variables that will be passed to the function during the function call. The HitRate function
is general-purpose enough to be used with any shorter integer numbers or variables, not
only with Wins and Spins.

Display the form again, and then double-click the Spin button on the TrackWins form
to bring up the Button1_Click event procedure.

Below the fourth line of the event procedure (Label3.Text = CStr(Int(Rnd() * 10))), type
the following statement:

Spins = Spins + 1

This statement increments the Spins variable each time the user clicks Spin, and new
numbers are placed in the spin windows.

Scroll down in the Code Editor, and then, between the End If and the End Sub statements,
type the following statement as the last line in the Button1_Click event procedure:

Tb1Rate.Text = HitRate(Wins, Spins)

As you type the HitRate function, notice how Visual Studio automatically displays the
names and types of the arguments for the HitRate function you just built (a nice touch).

The purpose of this statement is to call the HitRate function by using the Wins and the
Spins variables as arguments. The result returned is a percentage in string format, and
this value is assigned to the Text property of the /b/Rate label on the form after each
spin. Now remove the Randomize function from the FormI_Load event procedure, so
that while you test the project, your results will follow a familiar pattern.

Scroll down in the Code Editor to the FormI_Load event procedure, and remove or
“comment out” (place a comment character (') before) the Randomize function.

each time that you run this program, the random numbers generated will follow a

predictable pattern. This helps you test your code, but when you're finished testing, you'll
want to add the function back again so that your results are truly random.
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Now you'll run the program.

Run the Track Wins program

1. Click the Start Debugging button to run the modified Track Wins program.
2. Click the Spin button 10 times.

The first five times you click Spin, the win rate stays at 100.0%. You're hitting the
jackpot every time. As you continue to click, however, the win rate adjusts to 83.3%,
71.4%, 75.0% (another win), 66.7%, and 60.0% (a total of 6 for 10). After 10 spins, your
screen looks like this:

o Track Wins |E||E|@ 1
| Spin |
[ End | 6 ) 2
Lucky Seven
60.0%

If you continue to spin, you'll notice that the win rate drops to about 28%. The HitRate
function shows that you were really pretty lucky when you started spinning, but after a
while reality sets in.

3. When you're finished with the program, click the End button.

The program stops, and the development environment returns. You can add the
Randomize function to the Form1_Load event procedure again to see how the program
works with “true” randomness. After about 100 spins (enough iterations for statistical
variation to even out a little), you should be close to the 28% win-rate each time that
you run the program. If you like numbers, it is an interesting experiment.

4. Click the Save All button on the Standard toolbar to save your changes.
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Writing Sub Procedures

A Sub procedure is similar to a Function procedure, except that a Sub procedure doesn't return
a value associated with its name. Sub procedures are typically used to get input from the user,
display or print information, or manipulate several properties associated with a condition. Sub
procedures can also be used to process and update variables received in an argument list dur-
ing a procedure call, and pass back one or more of these values to the calling program.

Sub Procedure Syntax

The basic syntax for a Sub procedure is

Sub ProcedureName([arguments])
procedure statements
End Sub

The following syntax items are important:

B ProcedureName is the name of the Sub procedure you're creating.

B arguments is a list of optional arguments (separated by commas if there’s more than one)
to be used in the Sub procedure. Each argument should also be declared as a specific
type. (Visual Studio adds the ByVal keyword by default to each argument, indicating that
a copy of the data is passed to the function through this argument but that any changes
to the arguments won't be returned to the calling routine.)

B procedure statements is a block of statements that accomplishes the work of
the procedure.

In the Sub procedure call, the number and type of arguments sent to the procedure must
match the number and type of arguments in the Sub procedure declaration, and the entire
group must be enclosed in parentheses. If variables passed to a Sub procedure are modified
during the procedure, the updated variables aren’t passed back to the program unless the
procedure defined the arguments by using the ByRef keyword. Sub procedures declared in a
module are public by default, so they can be called by any event procedure in a project.

Important Starting in Visual Basic .NET 2002, all calls to a Sub procedure must include par-
entheses after the procedure name. A set of empty parentheses is required if there are no
arguments being passed to the procedure. This is a change from Visual Basic 6, where paren-
theses are required only when an argument is being passed by value to a Sub procedure.
You'll learn more about passing variables by reference and by value later in this chapter.
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For example, the following Sub procedure receives a string argument representing a person’s
name and uses a text box to wish that person happy birthday. If this Sub procedure is declared
in a module, it can be called from any event procedure in the program.

Sub BirthdayGreeting (ByVal Person As String)
Dim Msg As String
If Person <> "" Then
Msg = "Happy birthday " & Person & "!"
Else
Msg = "Name not specified."
End If
MsgBox(Msg, , "Best Wishes™)
End Sub

The BirthdayGreeting procedure receives the name to be greeted by using the Person
argument, a string variable received by value during the procedure call. If the value of
Person isn't empty, or null, the specified name is used to build a message string that will
be displayed with a MsgBox function. If the argument is null, the procedure displays the
message “Name not specified.”

Calling a Sub Procedure

To call a Sub procedure in a program, you specify the name of the procedure, and then list
the arguments required by the Sub procedure. For example, to call the BirthdayGreeting
procedure, you could type the following statement:

BirthdayGreeting(""Robert™)

In this example, the BirthdayGreeting procedure would insert the name “Robert” into a
message string, and the routine would display the following message box:

Best Wishes (=3

Happy birthday Robert!

—T—

The space-saving advantages of a procedure become clear when you call the procedure
many times using a variable, as shown in the example below:

Dim NewName As String

Do
NewName = InputBox("Enter a name for greeting.", "Birthday List™)
BirthdayGreeting(NewName)

Loop Until NewName = ""
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Here the user can enter as many names for birthday greetings as he or she likes. The next
exercise gives you a chance to practice using a Sub procedure to handle another type of
input in a program.

Using a Sub Procedure to Manage Input

Sub procedures are often used to handle input in a program when information comes from
two or more sources and needs to be in the same format. In the following exercise, you'll create
a Sub procedure named AddName that prompts the user for input and formats the text so that
it can be displayed on multiple lines in a text box. The procedure will save you programming
time because you'll use it in two event procedures, each associated with a different text box.
Because the procedure will be declared in a module, you'll need to type it in only one place.

If you add additional forms to the project, the procedure will be available to them as well.

Create a text box Sub procedure

1. On the File menu, click the Close Project command.
Visual Studio closes the current project (the Track Wins slot machine).

2. Create a new Windows Forms Application project named My Text Box Sub.
The new project is created, and a blank form opens in the Designer.

3. Use the TextBox control to create two text boxes, side by side, in the middle of
the form.

Today you'll make some personnel decisions, and you'll use these text boxes to hold
the names of employees you'll be assigning to two departments.

4. Use the Label control to create two labels above the text boxes.
These labels will hold the names of the departments.

5. Use the Button control to create three buttons: one under each text box and one at the
bottom of the form.

You'll use the first two buttons to assign employees to their departments and the last
button to quit the program.

6. Set the properties shown in the following table for the objects on the form.

Because the text boxes will contain more than one line, you'll set their Multiline proper-
ties to True and their ScrollBars properties to Vertical. These settings are typically used
when multiple lines are displayed in text boxes. You'll also set their TabStop properties to
False and their ReadOnly properties to True so that the information can't be modified.



Object
TextBox1

TextBox2

Labell

Label2

Buttonl

Button2

Button3

Forml1
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Property
Muiltiline
Name
ReadOnly
ScrollBars
TabStop
Multiline
Name
ReadOnly
ScrollBars
TabStop
Font
Name
Text

Font
Name
Text
Name
Text
Name
Text
Name
Text

Text

Setting
True
txtSales
True
Vertical
False

True

txtMkt
True
Vertical
False

Bold
IblSales
"Sales”

Bold

IbIMkt
"Marketing”
btnSales
"Add Name”
btnMkt
"Add Name”
btnQuit
"Quit”
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"Assign Department Teams”

7. Resize and position the objects so that your form looks similar to this:

Sales

bdd Mame |

a5 Assign Departrment Tearns

Cluit

[E=5[ECH ==

Marketing

| el Mame

Now you'll add a module and create the general-purpose AddName Sub procedure.
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8. On the Project menu, click the Add New Item command, select the Module template,
and then click Add.

A new module appears in the Code Editor.

9. Type the following AddName procedure between the Module Modulel and End Module
statements:

Sub AddName(ByVal Team As String, ByRef ReturnString As String)
Dim Prompt, Nm, WrapCharacter As String
Prompt = "Enter a " & Team & " employee."
Nm = InputBox(Prompt, "Input Box")
WrapCharacter = Chr(13) + Chr(10)
ReturnString = Nm & WrapCharacter
End Sub

This general-purpose Sub procedure uses the InputBox function to prompt the user for an
employee name. It receives two arguments during the procedure call: Team, a string con-
taining the department name; and ReturnString, an empty string variable that will contain
the formatted employee name. ReturnString is declared with the ByRef keyword so that

any changes made to this argument in the procedure will be passed back to the calling
routine through the argument.

Before the employee name is returned, carriage return and linefeed characters are
appended to the string so that each name in the text box will appear on its own line.
You can use this general technique in any string to create a new line.

Your Code Editor looks like this:

0 Text Box Sub - Microsoft Wisual Studio
File Edit ‘iew Project Build Debug Data  Tools  Test  ‘Window Help

HeEE-Hd| %G R/ = 2|9 -0-&- 3 S= [E &
e Modulel.vb “Forrnlob [Design] | Start Page = &
=1 -

2 ||| Modulel + [Z](Declarations) -
=
=] E Module Modulel 1

Sub AddName (EvVal Tesmn As String, EvyREef ReturnZtring Ls Strin®
Diim Prompt, Nm, WrapCharacter Ls Ztring
Prompt = "Enter a " & Team & " employes.™
Nm = InputBox (Prompt, "Input Box™)
WrapCharacter = Chr(13) + Chr(l0)
ReturnString = Nm & WrapCharacter

End Subj

End Module
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10. Display the form again, and then double-click the first Add Name button on the form
(the button below the Sales text box). Type the following statements in the btnSales_
Click event procedure:

o

Dim SalesPosition As String =
AddName("Sales", SalesPosition)
txtSales.Text = txtSales.Text & SalesPosition

The call to the AddName Sub procedure includes one argument passed by value
(“Sales”) and one argument passed by reference (SalesPosition). The last line uses the
argument passed by reference to add text to the txtSales text box. The concatenation
operator (&) adds the new name to the end of the text in the text box.

11. In the Code Editor, click the Class Name arrow, and click the btnMkt object in the list.
Then click the Method Name arrow, and click the Click event.

The btnMkt_Click event procedure appears in the Code Editor. Using the Class Name
and Method Name list boxes is another way to practice adding event procedures.

12. Type the following statements in the event procedure:

Dim MktPosition As String = ""
AddName ("Marketing", MktPosition)
txtMkt.Text = txtMkt.Text & MktPosition

This event procedure is identical to btnSales_Click, except that it sends “Marketing”
to the AddName procedure and updates the txtMkt text box. (The name of the local
return variable MktPosition was renamed to make it more intuitive.)

13. Click the Class Name arrow, and click the btnQuit object in the list. Then click the
Method Name arrow, and click the Click event.

The btnQuit_Click event procedure appears in the Code Editor.
14. Type End in the btnQuit_Click event procedure.

15. Click the Save All button on the Standard toolbar, and then specify the c:\vb08sbs\chap10
folder as the location.

That's it! Now you'll run the Text Box Sub program.
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Run the Text Box Sub program

O

Tip The complete Text Box Sub program is located in the c:\vb08sbs\chap10\text box
sub folder.

. Click the Start Debugging button on the Standard toolbar to run the program.

Click the Add Name button under the Sales text box, and then type Maria Palermo in
the input box. (Feel free to type a different name.)

Your input box looks like this:

Input Box <=
Enter a Sales employee. |
| Cancel |

Waria Palermo|

. Click the OK button to add the name to the Sales text box.

The name appears in the first text box.

. Click the Add Name button under the Marketing text box, type Abraham Asante in

the Marketing input box, and then press Enter.

The name appears in the Marketing text box. Your screen looks like this:

a5 Assign Department Tearns =] =] =)
Sales Marketing
I aria Palerma - Abraham &zante
dld Mame | | addMame |
| Cluit |
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5. Enter a few more names in each of the text boxes. This is your chance to create your
own dream employee configurations.

Each name appears on its own line in the text boxes. The text boxes don't scroll auto-
matically, so you won't see every name you've entered if you enter more names than
can fit in a text box. You can use the scroll bars to access names that aren't visible.

6. When you've finished, click the Quit button to stop the program.

You've demonstrated that one Sub procedure can manage input tasks from two or more event
procedures. Using this basic concept as a starting point, you can now create more sophisticated
programs that use Sub and Function procedures as organizing tools and that place common
tasks in logical units that can be called over and over again.

One Step Further: Passing Arguments by Value and
by Reference

In the discussion of Sub and Function procedures, you learned that arguments are passed to
procedures by value or by reference. Using the ByVal keyword indicates that variables should
be passed to a procedure by value (the default). Any changes made to a variable passed in by
value aren't passed back to the calling procedure. However, as you learned in the Text Box Sub
program, using the ByRef keyword indicates that variables should be passed to a procedure by
reference, meaning that any changes made to the variable in the procedure are passed back
to the calling routine. Passing by reference can have significant advantages, as long as you're
careful not to change a variable unintentionally in a procedure. For example, consider the fol-
lowing Sub procedure declaration and call:

Sub CostPlusInterest(ByRef Cost As Single, ByRef Total As Single)
Cost = Cost * 1.05 'add 5% to cost...
Total = Int(Cost) 'then make integer and return

End Sub

Dim Price, TotalPrice As Single

Price = 100

TotalPrice = 0

CostPlusInterest(Price, TotalPrice)

MsgBox(Price & " at 5% interest is " & TotalPrice)
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In this example, the programmer passes two single-precision variables by reference to the
CostPlusinterest procedure: Price and TotalPrice. The programmer plans to use the updated
TotalPrice variable in the subsequent MsgBox call but has unfortunately forgotten that the
Price variable was also updated in an intermediate step in the CostPlusinterest procedure.
(Because Price was passed by reference, changes to Cost automatically result in the same
changes to Price.) This produces the following erroneous result when the program is run:

Byfal Test (=3

105 at 5% interest is 105

Lok

However, the programmer probably wanted to show the following message:

Byfal Test (=3

100 at 5% interest is 105

T

So how should the CostPlusinterest procedure be fixed to produce the desired result? The
easiest way is to declare the Cost argument by using the ByVal keyword, as shown in the
following program statement:

Sub CostPlusInterest(ByVal Cost As Single, ByRef Total As Single)

By declaring Cost using ByVal, you can safely modify Cost in the CostPlusinterest procedure
without sending the changes back to the calling procedure. By keeping Total declared using
ByRef, you can modify the variable that's being passed, and only those changes will be passed
back to the calling procedure. In general, if you use ByRef only when it's needed, your pro-
grams will be freer of defects.

Here are some guidelines on when to use ByVal and when to use ByRef:

B Use ByVal when you don't want a procedure to modify a variable that's passed to the
procedure through an argument.

B Use ByRef when you want to allow a procedure to modify a variable that's passed to the
procedure.

B When in doubt, use the ByVal keyword.
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Do this

Click the Add New Item button on the Standard toolbar, and then select the
Module template; or click the Add New Item command on the Project menu,
and then select the Module template.

Select the module in Solution Explorer. In the Properties window, specify a
new name in the File Name property; or right-click the module in Solution
Explorer, select Rename, and specify a new name.

Select the module in Solution Explorer, and then click the Exclude From
Project command on the Project menu.

On the Project menu, click the Add Existing Iltem command.

Declare the variable by using the Public keyword between the Module and
End Module keywords in a module. For example:

Public TotalSales As Integer

Place the function statements between the Function and End Function
keywords in a module. Functions are public by default. For example:

Function HitRate(ByVal Hits As Short, Byval _
Tries As Short) As String
Dim Percent As Single
Percent = Hits / Tries
Return Format(Percent, “0.0%”)
End Function

Type the function name and any necessary arguments in a program
statement, and assign it to a variable or property of the appropriate
return type. For example:

Tb1Rate.Text = HitRate(Wins, Spins)

Place the procedure statements between the Sub and End Sub keywords in a
module. Sub procedures are public by default. For example:

Sub CostPlusInterest(ByVal Cost As Single, _
ByRef Total As Single)

Cost = Cost * 1.05
Total = Int(Cost)
End Sub

Type the procedure name and any necessary arguments in a program
statement. For example:

CostPlusInterest(Price, TotalPrice)

Use the ByVal keyword in the procedure declaration. For example:
Sub GreetPerson(ByVal Name As String)

Use the ByRef keyword in the procedure declaration. For example:

Sub GreetPerson(ByRef Name As String)






Chapter 11
Using Arrays to Manage Numeric
and String Data

After completing this chapter, you will be able to:
B Organize information in fixed-size and dynamic arrays.
B Preserve array data when you redimension arrays.
B Use arrays in your code to manage large amounts of data.
B Use the Sort and Reverse methods in the Array class to reorder arrays.
B Use the ProgressBar control in your programs to show how long a task is taking.

Managing information in a Microsoft Visual Basic application is an important task, and as your
programs become more substantial, you'll need additional tools to store and process data.

A classic approach to data management in programs is to store and retrieve information in
auxiliary text files, as you'll see in Chapter 13, “Exploring Text Files and String Processing.”
However, the most comprehensive approach is storing and retrieving information by using
databases, and you'll start learning how to integrate Visual Basic programs with databases in
Chapter 18, "Getting Started with ADO.NET.

In this chapter, you'll learn how to organize variables and other information into useful con-
tainers called arrays. You'll learn how to streamline data-management tasks with fixed-size
and dynamic arrays, and how to use arrays in your code to manage large amounts of data.
You'll learn how to redimension arrays and preserve the data in arrays when you decide to
change an array’s size. To demonstrate how large arrays can be processed, you'll use the
Sort and Reverse methods in the Microsoft .NET Framework Array class to reorder an array
containing random six-digit integer values. Finally, you'll learn to use the ProgressBar control
to give your users an indication of how long a process (array-related or otherwise) is taking.
The techniques you'll learn provide a solid introduction to the database programming tech-
niques that you'll explore later in the book.

Working with Arrays of Variables

In this section, you'll learn about arrays, a useful method for storing almost any amount of data
during program execution. Arrays are a powerful and time-tested mechanism for storing logically
related values in a program. The developers of BASIC, Pascal, C, and other popular programming
languages incorporated arrays into the earliest versions of these products to refer to a group of
values by using one name and to process those values individually or collectively.

281
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Arrays can help you track a small set of values in ways that are impractical using traditional
variables. For example, imagine creating a nine-inning baseball scoreboard in a program. To
save and recall the scores for each inning of the game, you might be tempted to create two
groups of nine variables (a total of 18 variables) in the program. You'd probably name them
something like InningIHomeTeam, Inning1VisitingTeam, and so on, to keep them straight.
Working with these variables individually would take considerable time and space in your
program. Fortunately, with Visual Basic you can organize groups of similar variables into an
array that has one common name and an easy-to-use index. For example, you can create a
two-dimensional array (two units high by nine units wide) named Scoreboard to contain the
scores for the baseball game. Let's see how this works.

Creating an Array

You create, or declare, arrays in program code just as you declare simple variables. As usual, the
place in which you declare the array determines where it can be used, or its scope, as follows:

B |f you declare an array locally in a procedure, you can use it only in that procedure.
B |f you declare an array at the top of a form, you can use it throughout the form.
B [f you declare an array publicly in a module, you can use it anywhere in the project.

When you declare an array, you typically include the information shown in the following
table in your declaration statement.

Information in an array
declaration statement Description

Array name The name you'll use to represent your array in the program. In general,
array names follow the same rules as variable names. (See Chapter 5,
“Visual Basic Variables and Formulas, and the .NET Framework,” for
more information about variables.)

Data type The type of data you'll store in the array. In most cases, all the variables
in an array are the same type. You can specify one of the fundamental
data types, or if you're not yet sure which type of data will be stored in
the array or whether you'll store more than one type, you can specify
the Object type.

Number of dimensions The number of dimensions your array will contain. Most arrays are one-
dimensional (a list of values) or two-dimensional (a table of values), but
you can specify additional dimensions if you're working with a complex
mathematical model, such as a three-dimensional shape.

Number of elements The number of elements your array will contain. The elements in your
array correspond directly to the array index. In Visual Basic 2008, the
first array index is always 0 (zero).
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Tip Arrays that contain a set number of elements are called fixed-size arrays. Arrays that contain
a variable number of elements (arrays that can expand during the execution of the program) are
called dynamic arrays.

Declaring a Fixed-Size Array

The basic syntax for a public fixed-size array is

Dim ArrayName(DimlIndex, Dim2Index, ...) As DataType
The following arguments are important:

B Dim is the keyword that declares the array. Use Public instead if you place the array in
a module.

B ArrayName is the variable name of the array.

B Dimlindex is the upper bound of the first dimension of the array, which is the number
of elements minus 1.

B DimZindex is the upper bound of the second dimension of the array, which is the num-
ber of elements minus 1. (Additional dimensions can be included if they're separated by
commas.)

B DataType is a keyword corresponding to the type of data that will be included in the
array.

For example, to declare a one-dimensional string array named Employees that has room for 10
employee names (numbered 0 through 9), you can type the following in an event procedure:

Dim Employees(9) As String

In a module, the same array declaration looks like this:

Public Employees(9) As String

Using newer syntax supported by Visual Basic 2005 and 2008 (but not by Microsoft Visual
Basic .NET 2002 or 2003), you can also explicitly specify the lower bound of the array as zero
by using the following code in an event procedure:

Dim Employees(0 To 9) As String

This "0 to 9" syntax is included to make your code more readable—newcomers to your pro-
gram will understand immediately that the Employees array has 10 elements numbered 0
through 9. However, the lower bound of the array must always be zero. You cannot use this
syntax to create a different lower bound for the array.
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Setting Aside Memory

When you create an array, Visual Basic sets aside room for it in memory. The following
illustration shows conceptually how the 10-element Employees array is organized. The
elements are numbered 0 through 9 rather than 1 through 10 because array indexes
always start with 0. (Again, the Option Base statement in Visual Basic 6, which allows
you to index arrays beginning with the number 1, is no longer supported.)

Employees

L - - N L N ]

To declare a public two-dimensional array named Scoreboard that has room for two rows
and nine columns of Short integer data, you can type this statement in an event procedure
or at the top of the form:

Dim Scoreboard(l, 8) As Short

Using the Visual Basic 2008 syntax that emphasizes the lower (zero) bound, you can also
declare the array as follows:

Dim Scoreboard(0 To 1, 0 To 8) As Short

After you declare such a two-dimensional array and Visual Basic sets aside room for it in
memory, you can use the array in your program as if it were a table of values, as shown in
the following illustration. (In this case, the array elements are numbered 0 through 1 and 0
through 8.)

Scoreboard
Columns
0 1 2 3 4 5 6 7 8

Rows
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Working with Array Elements

To refer to an element of an array, you use the array name and an array index enclosed
in parentheses. The index must be an integer or an expression that results in an integer.
For example, the index could be a number such as 5, an integer variable such as num, or
an expression such as num-1. (The counter variable of a For...Next loop is often used.) For
example, the following statement assigns the value “Leslie” to the element with an index
of 5 in the Employees array example in the previous section:

Employees(5) = "Leslie"

This statement produces the following result in our Employees array:

Employees

Leslie

Lo e R B S T N

Similarly, the following statement assigns the number 4 to row 0, column 2 (the top of the
third inning) in the Scoreboard array example in the previous section:

Scoreboard(0, 2) = 4

This statement produces the following result in our Scoreboard array:

Scoreboard
Columns
0 1 2 3 4 5 6 7 8

0 4

Rows

You can use these indexing techniques to assign or retrieve any array element.
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Creating a Fixed-Size Array to Hold Temperatures

The following exercise uses a one-dimensional array named Temperatures to record the
daily high temperatures for a seven-day week. The program demonstrates how you can use
an array to store and process a group of related values on a form. The Temperatures array
variable is declared at the top of the form, and then temperatures are assigned to the array
by using an InputBox function and a For...Next loop, which you learned about in Chapter 7,
“Using Loops and Timers.” The loop counter is used to reference each element in the array.
The array contents are then displayed on the form by using a For...Next loop and a text box
object. The average high temperature is also calculated and displayed.

The UBound and LBound Functions

To simplify working with the array, the Fixed Array program uses the UBound function to
check for the upper bound, or top index value, of the array. UBound is an earlier Visual
Basic keyword that's still quite useful. With it you can process arrays without referring to
the declaration statements that defined exactly how many values the array would hold.
The closely related LBound function, which confirms the lower index value, or lower
bound, of an array, is still valid in Visual Basic. However, because all Visual Basic arrays
now have a lower bound of zero (0), the function simply returns a value of 0. The UBound
and LBound functions have the syntax

LBound (ArrayName)
UBound (ArrayName)

where ArrayName is the name of an array that's been declared in the project.

Use a fixed-size array

1. Start Microsoft Visual Studio, and create a new Visual Basic Windows Forms Application
project named My Fixed Array.

2. Draw a text box object on the form.

3. Set the Multiline property of the TextBox1 object to True so that you can resize the
object.

4. Resize the text box object so that it fills up most of the form.

5. Draw two wide button objects on the form below the text box object, oriented one
beside the other.
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Set the following properties for the form and its objects:

Object Property Setting

TextBox1 ScrollBars Vertical

Buttonl Text "Enter Temps”
Button2 Text "Display Temps”
Form1 Text "Fixed Array Temps”

Your form looks like the one shown in the following graphic.

o5 Fixed Array Terps |£||ﬂ|

| Enter Temps | |DisplayTemps

In Solution Explorer, click the View Code button to display the Code Editor.

Scroll to the top of the form'’s program code, and directly below the Public Class Form1
statement, type the following array declaration:

Dim Temperatures(0 To 6) As Single

This statement creates an array named Temperatures (of the type Single) that contains
seven elements numbered 0 through 6. Because the array has been declared at the top
of the form, it is available in all the event procedures in the form.

Display the form again, and then double-click the Enter Temps button (ButtonI).
The Button1_Click event procedure appears in the Code Editor.

Type the following program statements to prompt the user for temperatures and to
load the input into the array:

Dim Prompt, Title As String
Dim i As Short
Prompt = "Enter the day's high temperature."
For i = 0 To UBound(Temperatures)

Title = "Day " & (i + 1)

Temperatures(i) = InputBox(Prompt, Title)
Next
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The For...Next loop uses the short integer counter variable / as an array index to load
temperatures into array elements 0 through 6. Rather than using the simplified For
loop syntax

For i = 0 to 6

to process the array, | chose a slightly more complex syntax involving the UBound
function for future flexibility. The For loop construction

For i = 0 To UBound(Temperatures)

determines the upper bound of the array by using the UBound statement. This tech-
nique is more flexible because if the array is expanded or reduced later, the For loop
automatically adjusts itself to the new array size.

To fill the array with temperatures, the event procedure uses an InputBox function,
which displays the current day by using the For loop counter.

Display the form again, and then double-click the Display Temps button (Button?2).

Type the following statements in the Button2_Click event procedure:

Dim Result As String
Dim i As Short
Dim Total As Single = 0
Result = "High temperatures for the week:" & vbCrLf & vbCrLf
For i = 0 To UBound(Temperatures)

Result = Result & "Day " & (i + 1) & vbTab & _

Temperatures(i) & vbCrLf

Total = Total + Temperatures(i)
Next
Result = Result & vbCrLf & _

"Average temperature: " & Format(Total / 7, "0.0™)

TextBox1l.Text = Result

This event procedure uses a For...Next loop to cycle through the elements in the array,
and it adds each element in the array to a string variable named Result, which is declared
at the top of the event procedure. I've used several literal strings, constants, and string
concatenation operators (&) to pad and format the string by using carriage returns
(vbCrLf), tab characters (vbTab), and headings. The vbCrLf constant, used here for the
first time, contains the carriage return and line feed characters and is an efficient way
to create new lines. The vbTab constant is also used here for the first time to put some
distance between the day and temperature values in the Result string. At the end of the
event procedure, an average for the temperatures is determined, and the final string is
assigned to the Text property of the text box object, as shown in this statement:

TextBox1l.Text = Result



13.

14.
15.

16.

17.

Chapter 11 Using Arrays to Manage Numeric and String Data 289

Click the Save All button on the Standard toolbar to save the project. Specify the
c:\vb08sbs\chapll folder as the location.

Now you'll run the program.

Tip The complete Fixed Array program is located in the c:\vb08sbs\chap11\fixed array
folder.

Click the Start Debugging button on the Standard toolbar to run the program.

Click the Enter Temps button, and when prompted by the /nputBox function, enter seven
different temperatures. (How about using the temperatures from your last vacation?)

The InputBox function dialog box looks like this:

Day1 ==
Enter the day’s high termperature. | oK
| Cancel |
74

After you've entered the temperatures, click the Display Temps button.

Using the array, Visual Basic displays each of the temperatures in the text box and
prints an average at the bottom. Your screen looks similar to this:

o5 Fixed Array Ternps El@

High temperatures for the week:

Dap 1 74
Dap2 755
Dapd 78
Dapd 80
Daph 74
DayE B8
Dap? EES

Average temperature; 73.7

Enter Temps | | Dizplay Temps

Click the Close button on the form to end the program.
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Creating a Dynamic Array

As you can see, arrays are quite handy for working with lists of numbers, especially if you
process them by using For...Next loops. But what if you're not sure how much array space
you'll need before you run your program? For example, what if you want to let the user
choose how many temperatures are entered into the Fixed Array program?

Visual Basic handles this problem efficiently with a special elastic container called a dynamic
array. Dynamic arrays are dimensioned at run time, either when the user specifies the size of
the array or when logic you add to the program determines an array size based on specific
conditions. Dimensioning a dynamic array takes several steps because although the size of the
array isn't specified until the program is running, you need to make “reservations” for the array
at design time. To create a dynamic array, you follow these basic steps:

1.

Specify the name and type of the array in the program at design time, omitting the
number of elements in the array. For example, to create a dynamic array named
Temperatures, you type

Dim Temperatures() As Single

. Add code to determine the number of elements that should be in the array at run time.

You can prompt the user by using an InputBox function or a text box object, or you
can calculate the storage needs of the program by using properties or other logic. For
example, the following statements get the array size from the user and assign it to the
Days variable of type Short:

Dim Days As Short

Days = InputBox("How many days?", "Create Array")

Use the variable in a ReDim statement to dimension the array, subtracting 1 because
arrays are zero-based. For example, the following statement sets the size of the
Temperatures array at run time by using the Days variable:

ReDim Temperatures(Days - 1)

Important With ReDim, you should not try to change the number of dimensions in an
array that you've previously declared.

Use the UBound function to determine the upper bound in a For...Next loop, and process
the array elements as necessary, as shown here:

For i = 0 to UBound(Temperatures)
Temperatures(i) = InputBox(Prompt, Title)
Next
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In the following exercise, you'll use these steps to revise the Fixed Array program so that it
can process any number of temperatures by using a dynamic array.

Use a dynamic array to hold temperatures

1.
2.

Open the Code Editor to display the program code for the Fixed Array project.

Scroll to the top of the form's code, in which you originally declared the Temperatures
fixed array.

Remove 0 To 6 from the Temperatures array declaration so that the array is now a
dynamic array.

The statement looks like the following:

Dim Temperatures() As Single

Add the following variable declaration just below the Temperatures array declaration:

Dim Days As Integer

The integer variable Days will be used to receive input from the user and to dimension
the dynamic array at run time.

Scroll down in the Code Editor to display the Button1_Click event procedure, and
modify the code so that it looks like the following. (The changed or added elements
are shaded.)

Dim Prompt, Title As String
Dim i As Short
Prompt = "Enter the day's high temperature."
Days = InputBox("How many days?", "Create Array")
If Days > 0 Then ReDim Temperatures(Days - 1)
For i = 0 To UBound(Temperatures)

Title = "Day " & (i + 1)

Temperatures(i) = InputBox(Prompt, Title)
Next
The fourth and fifth lines prompt the user for the number of temperatures he or she
wants to save, and then the user’s input is used to dimension a dynamic array. The /f..
Then decision structure is used to verify that the number of days is greater than 0.
(Dimensioning an array with a number less than 0 or equal to zero generates an error.)
Because index 0 of the array is used to store the temperature for the first day, the Days
variable is decremented by 1 when dimensioning the array. The Days variable isn't
needed to determine the upper bound of the For...Next loop—as in the previous

example, the UBound function is used instead.



292

Part Il

6.

10.
11.
12.

13.
14.

Programming Fundamentals

Scroll down in the Code Editor to display the Button2_Click event procedure. Modify
the code so that it looks like the following routine. (The changed elements are shaded.)

Dim Result As String
Dim i As Short
Dim Total As Single = 0
Result = "High temperatures:" & vbCrLf & vbCrLf
For i = 0 To UBound(Temperatures)

Result = Result & "Day " & (i + 1) & vbTab & _

Temperatures(i) & vbCrLf

Total = Total + Temperatures(i)
Next
Result = Result & vbCrLf & _

"Average temperature: " & Format(Total / Days, "0.0")

TextBox1l.Text = Result
The Days variable replaces the number 7 in the average temperature calculation at the
bottom of the event procedure. | also edited the “High temperatures” heading that will

be displayed in the text box.
Display the form.
Change the Text property of Form1 to "Dynamic Array.”

Save your changes to disk.

Tip On the companion CD, | gave this project a separate name to keep it distinct from
the Fixed Array project. The complete Dynamic Array project is located in the c:\vb08sbs\
chapll\dynamic array folder.

Click the Start Debugging button to run the program.
Click the Enter Temps button.

Type 5 when you're prompted for the number of days you want to record, and then
click OK.

Enter five temperatures when prompted.
When you've finished entering temperatures, click the Display Temps button.

The program displays the five temperatures on the form along with their average. Your
screen looks similar to the illustration on the following page.
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o5 Dynarmic Array El@

High temperatures:

Dap 1 Fic}
Dap2 77
Dapyd 75
Dapd 70
Dayh B8

Average temperature; 726

Enter Temps | | Dizplay Temps |

15. Click the Close button on the form to end the program.

You've practiced using the two most common array types in Visual Basic programming.
When you write your own programs, you'll soon use much larger arrays, but the concepts
are the same, and you'll be amazed at how fast Visual Basic can complete array-related
computations.

Preserving Array Contents by Using ReDim Preserve

In the previous exercise, you used the ReDim statement to specify the size of a dynamic array
at run time. However, one potential shortcoming associated with the ReDim statement is that

if you redimension an array that already has data in it, all the existing data is irretrievably lost.
After the ReDim statement is executed, the contents of a dynamic array are set to their default
value, such as zero or null. Depending on your outlook, this can be considered a useful feature
for emptying the contents of arrays, or it can be an irksome feature that requires a workaround.

Fortunately, Visual Basic 2008 provides the same useful feature that Visual Basic 6 provides
for array redimensioning, the Preserve keyword, which you use to preserve the data in an
array when you change its dimensions. The syntax for the Preserve keyword is as follows:

ReDim Preserve ArrayName(DimlElements, Dim2Elements, ...)

In such a ReDim statement, the array must continue to have the same number of dimensions
and contain the same type of data. In addition, there's a caveat that you can resize only the last
array dimension. For example, if your array has two or more dimensions, you can change the
size of only the last dimension and still preserve the contents of the array. (Single-dimension
arrays automatically pass this test, so you can freely expand the size of dynamic arrays by using
the Preserve keyword.)
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The following examples show how you can use Preserve to increase the size of the last
dimension in a dynamic array without erasing any existing data contained in the array.

If you originally declared a dynamic string array named Philosophers by using the syntax
Dim Philosophers() As String

you can redimension the array and add data to it by using code similar to the following:

ReDim PhiTlosophers(200)
Philosophers(200) = "Steve Harrison"

You can expand the size of the Philosophers array to 301 elements (0-300) and preserve the
existing contents, by using the following syntax:

ReDim Preserve Philosophers(300)

Three-Dimensional Arrays

A more complex example involving a three-dimensional array uses a similar syntax. Imagine
that you want to use a three-dimensional, single-precision, floating-point array named myCube
in your program. You can declare the myCube array by using the following syntax:

Dim myCube(,,) As Single
You can then redimension the array and add data to it by using the following code:

ReDim myCube(25, 25, 25)
myCube (10, 1, 1) = 150.46

after which you can expand the size of the third dimension in the array (while preserving the
array’s contents) by using this syntax:

ReDim Preserve myCube(25, 25, 50)

In this example, however, only the third dimension can be expanded—the first and
second dimensions cannot be changed if you redimension the array by using the Preserve
keyword. Attempting to change the size of the first or second dimension in this example
produces a run-time error when the ReDim Preserve statement is executed.

Experiment a little with ReDim Preserve, and see how you can use it to make your own arrays
flexible and robust.
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One Step Further: Processing Large Arrays by Using
Methods in the Array Class

In previous sections, you learned about using arrays to store information during program
execution. In this section, you'll learn about using methods in the Array class of the Microsoft
.NET Framework, which you can use to quickly sort, search, and reverse the elements in an
array, as well as perform other functions. The sample program I've created demonstrates
how these features work especially well with very large arrays. You'll also learn how to use
the ProgressBar control.

The Array Class

When you create arrays in Visual Basic, you are using a base class that is defined by Visual
Basic for implementing arrays within user-created programs. This Array class also provides a
collection of methods that you can use to manipulate arrays while they are active in programs.
The most useful methods include Array.Sort, Array.Find, Array.Reverse, Array.Copy, and Array.
Clear. You can locate other interesting methods by experimenting with the Array class in the
Code Editor (by using IntelliSense) and by checking the Visual Studio documentation. The
Array class methods function much like the .NET Framework methods you have already used
in this book; that is, they are called by name and (in this case) require a valid array name as an
argument. For example, to sort an array of temperatures (such as the Temperatures array that
you created in the last exercise), you would use the following syntax:

Array.Sort(Temperatures)

You would make such a call after the Temperatures array had been declared and filled with
data in the program. When Visual Basic executes the Array.Sort method, it creates a temporary
storage location for the array in memory and uses a sorting routine to reorganize the array in
alphanumeric order. After the sort is complete, the original array is shuffled in ascending order,
with the smallest value in array location 0 and the largest value in the last array location. With
the Temperatures example above, the sort would produce an array of daily temperatures or-
ganized from coolest to hottest.

In the following exercise, you'll see how the Array.Sort and Array.Reverse methods can be used
to quickly reorder a large array containing six-digit numbers randomly selected between 0 and
1,000,000. You'll also experiment with the ProgressBar control, which provides useful visual
feedback for the user during long sorts.
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Use Array methods to sort an array of 3000 elements

1.

On the File menu, click Open Project, and then open the Array Class Sorts project
located in the c:\vb08sbs\chapll folder.

Display the form if it is not already visible.

Your screen looks like this:

o Array Class Sorts =R
Fill Asrray | | Sort Aray | | Fieverse
Frogress 0

This form looks similar to the earlier projects in this chapter and features a test box
for displaying array data. However, it also contains three buttons for manipulating
large arrays and a progress bar object that gives the user feedback during longer
array operations. (Visual feedback is useful when computations take longer than a
few seconds to complete, and if you use this code to sort an array of 3000 array
elements, a slight delay is inevitable.)

Click the progress bar on the form.

The ProgressBarl object is selected on the form and is listed in the Properties window.
| created the progress bar object by using the ProgressBar control on the Common
Controls tab in the Toolbox. A progress bar is designed to display the progress of a
computation by displaying an appropriate number of colored rectangles arranged in
a horizontal progress bar. When the computation is complete, the bar is filled with
rectangles. (In Windows Vista, a smoothing effect is applied so that the progress bar
is gradually filled with a solid band of color—an especially attractive effect.) You've
probably seen the progress bar many times while you downloaded files or installed
programs within Microsoft Windows. Now you can create one in your own programs!

The important properties that make a progress bar work are the Minimum, Maximum,
and Value properties, and these are typically manipulated using program code. (The
other progress bar properties, which you can examine in the Properties window, control
how the progress bar looks and functions.) You can examine how the Minimum and
Maximum properties are set by looking at this program’s Form1_Load event procedure.
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4. Double-click the form to display the FormI1_Load event procedure.

You see the following code:

Forml.vb Forrnlob [Design] | Start Page > X
+ {Forml Events) v & Load -
HPublic Class Formil =

Dim Randirray(0 To 499) Ls Long

'Initialize the Progress bar object and display num of elements

Frivate Zub Forml Load(EyVal sender Ais Zystem.Chject, EyvVal & is Zystem.Event
ProgressBarl.Minimun = 0
ProgressBarl.Maximun = UBound|Randlrray)
Labeli.Text = UBound (Randirray) + 1

End Zub

m

'Fill the array with random nwrbers and display in text box

Private Jub Buttonl Click(EBEyVal sender As Jystem.Chject, ByVal e As Jystem.Ev
Dim i As Integer
For i = 0 To UBound(Randirray)

Randirray(i) = Int{BEnd{) * 1000000)
TextBoxl.Text = TextBoxl.Text & Randirray(i) & wbCrLf
ProgressBarl.Value = 1 'move progress bar

Next i

End Zub

'Sort the array using the Array.3ort method and display

Frivate Zub Buttoni Click(EyVal sender iz System.Chject, EyVal e iz Zystem.Ev
Dim i As Integer
TextBoxl.Text = "
Array.S3ort (Randirray)

m 3

For a progress bar to display an accurate indication of how long a computing task
will take to complete, you need to set relative measurements for the beginning and
the end of the bar. This is accomplished with the Minimum and Maximum properties,
which are set to match the first and the last elements in the array that we are building.
As | have noted, the first array element is always 0 but the last array element depends
on the size of the array, so | have used the UBound function to return that number
and set the progress bar Maximum property accordingly. The array that we are
manipulating in this exercise is RandArray, a Long integer array declared initially
to hold 500 elements (0 to 499).

Click the Start Debugging button to run the program.

297

The program runs, and the Array Class Sorts form opens on the screen. In its Form1_Load
event procedure, the program declared an array named RandArray and dimensioned
it with 500 elements. A progress bar object was calibrated to track a calculation of 500

units (the array size), and the number 500 appears to the right of the progress bar (the
work of a label object and the UBound function).

6. Click the Fill Array button.
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The program loads RandArray with 500 random numbers (derived by the Rnd function),
and displays the numbers in the text box. As the program processes the array and fills
the text box object with data, the progress bar slowly fills with the color green. Your
screen looks like this when the process is finished:

ol Array Class Sorts =[]z
705547 -
533424
579518
2859562
201948
774740
147
7E0723
214440
709037
45352
414032
BE2619
790420 -
| Fill may || Sart Aray | | Reverse
Frogress RO0

The code that produced this result is the Buttonl_Click event procedure, which contains
the following program statements:

'Fi11 the array with random numbers and display in text box
Private Sub Buttonl Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim i As Integer
For i = 0 To UBound(RandArray)
RandArray(i) = Int(Rnd() * 1000000)
TextBox1l.Text = TextBoxl.Text & RandArray(i) & vbCrLf
ProgressBarl.Value = i 'move progress bar
Next i
End Sub
To get random numbers that are integers, | used the Int and Rnd functions together as |
did in Chapter 2, “Writing Your First Program,” and | multiplied the random number pro-
duced by Rnd by 1,000,000 to get whole numbers that are six digits or less. Assigning
these numbers to the array is facilitated by using a For...Next loop with an array index
that matches the loop counter (/). Filling the array is an extremely fast operation; the
slowdown (and the need for the progress bar) is caused by the assignment of array
elements to the text box object one at a time. This involves updating a user interface
component on the form 500 times, and the process takes a few seconds to complete. It
is instructional, however—the delay provides a way for me to show off the ProgressBar
control. Since the progress bar object has been calibrated to use the number of array
elements as its maximum, assigning the loop counter (i) to the progress bar's Value
property allows the bar to display exactly how much of the calculation has been
completed.

Click the Sort Array button.
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The program follows a similar process to sort RandArray, this time using the Array.Sort

method to reorder the array in ascending order. (The 500 elements are listed from

lowest to highest.) Your screen looks like this:

o Array Class Sorts =[]
241 -
2805
4014
10293
14017
14241
15682
15703
16297
16388
18758
22629
28246
28885 -

Fill Asrray || Sort Aray | | Fieverse
Frogress RO0

The code that produced this result is the Button2_Click event procedure, which contains

the following program statements:

'Sort the array using the Array.Sort method and display
Private Sub Button2_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button2.Click
Dim i As Integer
TextBox1l.Text =
Array.Sort(RandArray)
For i = 0 To UBound(RandArray)
TextBox1l.Text = TextBox1l.Text & RandArray(i) & vbCrLf
ProgressBarl.Value = i 'move progress bar
Next i
End Sub

This event procedure clears the text box object when the user clicks the Sort Array

button, and then sorts the array by using the Array.Sort method described earlier. The
sorting process is very quick. Again, the only slowdown is rebuilding the text box object
one line at a time in the For...Next loop, a process that is reported by the ProgressBarl

object and its Value property. See how simple it is to use the Array.Sort method?

Click the Reverse button.

The program uses the Array.Reverse method to manipulate RandArray, reordering the
array in backward or reverse order; that is, the first element becomes last and the last

element becomes first.

Note This method does not always produce a sorted list; the array elements are in descend-

ing order only because RandArray had been sorted previously in ascending order by the
Array.Sort method. (To examine the list more closely, use the scroll bars or the arrow keys.)
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Your screen looks like this:

ol Array Class Sorts =[]z
993414 -
996771
99371
992572
991402
983428
986093
985373
904253
984046
980003
979829
979531
973077 -

Fill Asrray || Sort Aray | | Fieverse
Frogress RO0

The code that produced this result is the Button3_Click event procedure, which contains
the following program statements:

'Reverse the order of array elements using Array.Reverse
Private Sub Button3_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button3.Click
Dim i As Integer
TextBox1l.Text = ""
Array.Reverse(RandArray)
For i = 0 To UBound(RandArray)
TextBox1l.Text = TextBoxl.Text & RandArray(i) & vbCrLf
ProgressBarl.Value = i 'move progress bar
Next i
End Sub

This event procedure is identical to the Button2_Click event procedure, with the
following exception:

Array.Sort(RandArray)
has become
Array.Reverse(RandArray)

9. Click the Stop Debugging button to end the program.
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10. Scroll to the top of the Code Editor, and locate the program statement that declares
the RandArray array:

Dim RandArray(0 To 499) As Long
11. Replace 499 in the array declaration statement with 2999.

The statement now looks like this:

Dim RandArray(0 To 2999) As Long

12. Run the program again to see how declaring and filling an array with 3000 elements
affects program performance.

Because processing 3000 elements is much more work, Visual Basic takes a little while
to update the text box object again and again as you fill, sort, and reverse RandArray.
However, the progress bar keeps you posted, and you can see that with just a small
change, you can adapt what you've learned in this chapter to different situations. (The
secret was using the UBound function to report the size of the array to the program's
event procedures, rather than "hard coding” the upper bound at 499.)

You can further experiment with this program by adding a Randomize statement to the
FormI_Load event procedure (to make the results truly random each time that you run the
program), or by trying additional array sizes and array types. (Try an array size of 100, 800,
2000, or 5000 elements, for example.) If you try larger numbers, you'll eventually exceed
the amount of data that the text box object can display, but it takes you a while before you
exceed the maximum array size allowed by Visual Basic.

If you want to focus on array operations without displaying the results, place a comment
character (') before each line of code that manipulates a text box object to “comment out
the text box (but not the progress bar) portions of the program. You'll be amazed at how
fast array operations run when the results do not need to be displayed on the form. (An
array of 100,000 elements loads in just a few seconds.)

"



302

Part Il

Programming Fundamentals

Chapter 11 Quick Reference

To
Create an array

Create a public array

Create a public array
specifying upper and
lower bounds

Assign a value to an
array

Format text strings
with carriage return
and tab characters

Create a dynamic
array

Process the elements
in an array

Redimension an array
while preserving the
datain it

Reorder the contents
of an array

To give the user visual
feedback during long
calculations

Do this

Dimension the array by using the Dim keyword. For example:

Dim Employees(9) As String

Dimension the array by using the Public keyword in a module. For example:

Public EmpTloyees(9) As String

Dimension the array as described earlier, but also use the To keyword. For
example:

PubTic Employees(0 To 9) As String

Note: The lower bound of the array must always be zero (0). As a result, this
syntax is primarily useful for code readability (and is not supported in Visual
Basic .NET 2002 and 2003).

Specify the array name, the index of the array element, and the value. For
example:

Employees(5) = "Leslie"

Use the vbCrLf and vbTab constants within your program code. (To add these
values to strings, use the & operator.)

Specify the name and type of the array, but omit the number of elements. (If
the array has multiple dimensions, insert commas but no numbers between
the dimensions.) In your program code, specify the size of the array by using
the ReDim statement. For example:

ReDim Temperatures(10)

Write a For...Next loop that uses the loop counter variable to address each
element in the array. For example:

Dim i As Short

Dim Total As Single

For i = 0 To UBound(Temperatures)
Total = Total + Temperatures(i)

Next

Use the Preserve keyword in your ReDim statement. For example:

ReDim Preserve myCube(25, 25, 50)

Use methods in the Array class of the .NET Framework. To sort an array
named RandArray in ascending order, use the Array.Sort method as follows:

Array.Sort(RandArray)

To reverse the order of an array named RandArray, use the Array.Reverse
method as follows:

Array.Reverse(RandArray)

Add a ProgressBar control to your form. (You can find the ProgressBar control
on the Common Controls tab of the Toolbox.) Set the Minimum, Maximum,
and Value properties for the control by using program code. The counter vari-
able in a For...Next loop often offers a good way to set the Value property.



Chapter 12
Working with Collections and the
System.Collections Namespace

After completing this chapter, you will be able to:
B Manipulate the Controls collection on a form.
®  Use a For Each...Next loop to cycle through objects in a collection.
B Create your own collections for managing Web site URLs and other information.
B Use VBA collections within Office.

In this chapter, you'll learn how to use groups of objects called collections in a Microsoft
Visual Basic program. You'll learn how to manage information with collections, process
collection objects by using For Each...Next loops, and explore new objects within the
System.Collections namespace. When you combine collection-processing skills with what
you learned about arrays in Chapter 11, “Using Arrays to Manage Numeric and String
Data,” you'll have much of what you need to know about managing data effectively in

a program, and you'll have taken your first steps in manipulating the object collections
exposed by Microsoft Visual Studio 2008 and popular Windows applications.

Working with Object Collections

In this section, you'll learn about collections, a powerful mechanism for controlling objects
and other data in a Visual Basic program. You already know that objects on a form are stored
together in the same file. But did you also know that Visual Basic considers the objects to be
members of the same group? In Visual Studio terminology, the entire set of objects on a form
is called the Controls collection, which is part of the System.Collections namespace provided
by the .NET Framework. The Controls collection is created automatically when you open a
new form, and when you add objects to the form, they become part of that collection. In
addition, Visual Studio maintains several standard object collections that you can use when
you write your programs. In the rest of this chapter, you'll learn the basic skills you need to
work with any collection you encounter.

Each collection in a program has its own name so that you can reference it as a distinct unit in
the program code. For example, as you just learned, the collection containing all the objects
on a form is called the Controls collection. This grouping method is similar to the way arrays
group a list of elements together under one name, and like Visual Basic arrays, the Controls
collection is zero-based.
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If you have more than one form in a project, you can create public variables associated with
the form names and use those variables to differentiate one Controls collection from another.
(You'll learn more about using public variables to store form data in Chapter 14, “Managing
Windows Forms and Controls at Run Time.”) You can even add controls programmatically to
the Controls collection in a form.

In addition to working with collections and objects in your own programs, you can use Visual
Studio to browse your system for other application objects and use them in your programs.

Referencing Objects in a Collection

You can reference the objects in a collection, or the individual members of the collection, by
specifying the index position of the object in the group. Visual Basic stores collection objects
in the reverse order of that in which they were created, so you can use an object’s “birth
order” to reference the object individually, or you can use a loop to step through several
objects. For example, to identify the last object created on a form, you can specify the 0
(zero) index, as shown in this example:

Controls(0).Text = "Business"

This statement sets the Text property of the last object on the form to “Business”. (The
second-to-the-last object created has an index of 1, the third-to-the-last object created
has an index of 2, and so on.) Considering this logic, it's important that you don't always
associate a particular object on the form with an index value, because if a new object is
added to the collection, the new object takes the 0 index spot, and the remaining object
indexes are incremented by 1.

The following For...Next loop uses a message box to display the names of the last four controls
added to a form:

Dim i As Integer
For i = 0 To 3

MsgBox (Controls(i).Name)
Next i

Note that I've directed this loop to cycle from 0 to 3 because the last control object added to
a form is in the 0 position. In the following section, you'll learn a more efficient method for
writing such a loop.

Writing For Each...Next Loops

Although you can reference the members of a collection individually, the most useful way to
work with objects in a collection is to process them as a group. In fact, the reason collections
exist is so that you can process groups of objects efficiently. For example, you might want to
display, move, sort, rename, or resize an entire collection of objects at once.
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To handle this kind of task, you can use a special loop called For Each...Next to cycle through
objects in a collection one at a time. A For Each...Next loop is similar to a For...Next loop.
When a For Each...Next loop is used with the Controls collection, it looks like this:

Dim CtrilVar As Control

For Each CtriVar In Controls
process object
Next CtrilVar

The CtrlVar variable is declared as a Control type and represents the current object in the
For Each...Next loop. Controls (note the “s”) is the collection class | introduced earlier that
represents all the control objects on the current form. The body of the loop is used to
process the individual objects of the collection. For example, you might want to change
the Enabled, Left, Top, Text, or Visible properties of the objects in the collection, or you
might want to list the name of each object in a list box.

Experimenting with Objects in the Controls Collection

In the following exercises, you'll use program code to manipulate the objects on a form by
using the Controls collection. The project you'll create will have three button objects, and
you'll create event procedures that change the Text properties of each object, move objects
to the right, and give one object in the group special treatment. The program will use three
For Each...Next loops to manipulate the objects each time the user clicks one of the buttons.

Use a For Each...Next loop to change Text properties

1. Create a new Visual Basic Windows Forms Application project named My Controls
Collection.

2. Use the Button control to draw three button objects on the left side of the form, as
shown here:

a5 Forml = |

| Buttar |

| Button2 |

| Button3 |
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Use the Properties window to set the Name property of the third button object
(Button3) to "btnMoveObjects".

Double-click the first button object (Buttonl) on the form.
The Button1_Click event procedure appears in the Code Editor.

. Type the following program statements:

For Each ctrl In Controls

ctrl.Text = "Click Me!"
Next
This For Each...Next loop steps through the Controls collection on the form one control
at a time and sets each control's Text property to “Click Me!". The loop uses ctr/ as an
object variable in the loop, which you'll declare in the following step.

Scroll to the top of the form's program code, and directly below the statement Public

Class Form1, type the following comment and variable declaration:

'Declare a variable of type Control to represent form controls
Dim ctr1 As Control

This global variable declaration creates a variable in the Control class type that repre-
sents the current form’s controls in the program. You're declaring this variable in the
general declarations area of the form so that it is valid throughout all of the form'’s
event procedures.

Now you're ready to run the program and change the Text property for each button on
the form.

Click the Start Debugging button on the Standard toolbar to run the program.
Click the first button on the form (Buttonl).

The Button1_Click event procedure changes the Text property for each control in the
Controls collection. Your form looks like this:

a5 Farml = o =

Click Mgl

| mick el |

| cickMel |




Chapter 12 Working with Collections and the System.Collections Namespace 307
9. Click the Close button on the form.

The program ends.

Note The Text property changes made by the program have not been replicated on the
form within the Designer. Changes made at run time do not change the program'’s core
property settings.

10. Click the Save All button on the Standard toolbar to save your changes. Specify the
c\vb08sbs\chapl2 folder as the location.

Now you're ready to try a different experiment with the Controls collection: using the Left
property to move each control in the Controls collection to the right.

Use a For Each...Next loop to move controls

1. Display the form again, and then double-click the second button object (Button2).

2. Type the following program code in the Button2_Click event procedure:

For Each ctrl In Controls

ctrl.Left = ctrl.Left + 25
Next
Each time the user clicks the second button, this For Each...Next loop steps through
the objects in the Controls collection one by one and moves them 25 pixels to the
right. (To move objects 25 pixels to the left, you would subtract 25 instead.) A pixel
is a device-independent measuring unit with which you can precisely place objects
on a form.

Tip In Visual Basic 6, you normally use TWIPs instead of pixels to specify measurements.
(A TWIP is a typographical measure equal to one-twentieth of a 